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About This Guide

Overview
Introduction

This manual describes Oracle Express Administrator (hereinafter referred
to as “Administrator”) for client applications. It describes how to use
Administrator with Oracle Express Server 6 (hereinafter referred to as
“Express Server”) and Personal Express 6. Appendix C of this manual
describes how to use Administrator with Express Server 5.x and Personal
Express 5.x.

You use Administrator to create Express databases and to customize them
to optimize the way client applications display data. The configuration
procedures described in this manual are optional. However, many of the
features that make client applications powerful and easy to use are available
only if you have configured your database.

Intended audience

This manual is intended for a database administrator (DBA) who manages
the databases shared by a community of users. These users might create
projects, queries, or briefings and distribute them to other client application
users in the community. Since data configuration information must be
consistent among all the users, it is important that a database administrator
coordinate configuration activities for all the users in a community.

The reader of this manual should also be familiar with the prebuilt client
application products offered by Oracle, which are described in Chapter 2.
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Since the effects of the configuration procedures will be seen in tables,
graphs, and spreadsheets, as well as in the Selector and Database Browser
in these products, the DBA doing the configuration should understand how
these components display data for the user.

Structure of this document

The Oracle Express Database Administration Guide contains the following
information:   

� Chapters 1 through 4 provide an overview to Express and Administrator
and discuss your role as database administrator.

� Chapters 5 through 7 describe tasks related to planning your database
and creating databases.

� Chapters 8 through 11 provide information about working with and
maintaining databases, importing and exporting data, and configuring
dimensions and measures.

� Chapters 12 through 17 cover additional topics such as using Express
commands and programs, sparse data, performance issues, controlling
access to a database, configuring for SQL connections, and using
Oracle Express Relational Access Manager.

� Appendixes A through D describe Administrator installation, the use of
conjoint dimensions, upgrading from Express 5, and the new features in
Administrator 6.2.

Online Help for Administrator

The Administrator Help system provides procedural and reference
information for using Administrator, both to create and maintain databases
and to optimize existing Express databases for use with client applications. 

Related documentation

This manual is part of a comprehensive set of Express documentation that
also includes:

� Installation and Configuration Guide — Explains how to install,
configure, and manage Express Server or Personal Express 6
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� Express Language Reference Manual — Explains the syntax and usage
of the individual commands, functions, options, and programs that
make up the Express language

� Express Language Programming Guide — Explains the Express
programming environment and illustrates programming strategies for
accessing and analyzing data

� SNAPI Guide — Explains how to use SNAPI to develop client
applications that interact with Express Server

� Oracle Express Spreadsheet Add-In User’s Guide — Explains how to
use the Oracle Express Spreadsheet Add-In to develop client
applications that interact with Express Server

For information on purchasing documentation, call Oracle Documentation
Sales at 800-252-0303.

In addition to the preceding manuals, the following Help systems are
available with Express Server and Personal Express 6:

� Service Manager Help — Provides online Help for managing services
on your Windows NT system

� Session Manager Help — Provides online Help for managing individual
Express sessions

� Configuration Manager Help — Provides online Help for selecting
Express modules and configuring runtime settings

� Express Language Help — Provides online Help for the syntax and
usage of the commands, functions, options, and programs that make up
the Express language

� Express Spreadsheet Add-In Help — Provides online Help for the
Express Spreadsheet Add-In
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Conventions
Text conventions

You will find the following text conventions in this document.

Convention Usage

Boldface  text Indicates menu items, command buttons, options, and field
names.

Bold text is also used for notes and other secondary
information in tables (e.g., Result ).

Fixed-width  text Indicates folder names, file names, and operating system
commands. Also indicates examples and anything that you
must type exactly as it appears.

For example:  If you are asked to type show eversion ,
you would type all the characters exactly as shown in the
fixed-width font.

Italic text Indicates variables, including variable text. Variable text is
used when dialog boxes or their components are unlabeled or
have labels that change dynamically based on their current
context. The wording of variable text does not exactly match
what you see on your screen.

Italic type is also used for emphasis and for titles of
documents.

SMALL CAPITALS Indicates a key name.

Note:  The UP ARROW, DOWN ARROW, LEFT ARROW, and RIGHT

ARROW keys are collectively referred to as the “arrow keys.”

For example:  The Control key is shown as CTRL.

UPPERCASE text Indicates Express commands and objects and acronyms.

Mouse usage

Always use the left mouse button unless you are specifically instructed to
use the right mouse button.

The term “left mouse button” refers to the dominant button. If you have
reconfigured your mouse to reverse the functions of the left and right
buttons, you will need to use the reverse button when following the
procedures in this manual.
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Formats for key combinations and sequences

Key combinations and key sequences appear in the following formats.

Format Meaning

KEY1+KEY2 A plus sign (+) between key names means to press and hold down
the first key while pressing the second key. For example, “press
ALT+TAB” means to press and hold down the ALT key while
pressing the TAB key.

KEY1, KEY2 A comma (,) between key names means to press and release the
keys one after the other. For example, “press ALT, F, O” means to
press and release the ALT key, press and release the F key, then
press and release the O key.

Related information

For definitions of basic mouse terms, refer to the Microsoft Windows
documentation.
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Chapter 1

Understanding Express

Overview
Introduction

This chapter provides an overview of Oracle Express Administrator and
the basic concepts related to Express databases.

In this chapter

� The Express Environment

� Oracle Express Administrator

� Using Administrator Versus Using Express

� An Overview of Multidimensional Data

� Relational Versus Multidimensional Databases

� Differences in Database Models

� Express Databases

� Dimensions

� Planning the Dimensions for Your Database

� Dimension Values

� Hierarchies

� Rollup

� Variables

� Relations
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� Formulas

� Measures

� Other Express Objects

� Your Users’ Client Application

� The Data Dictionary

The Express Environment
What is Express?

Oracle Express Server 6 (hereinafter referred to as “Express Server”) and
Personal Express 6 are multidimensional database systems for analyzing,
tracking, and reporting information about your business. Express Server
and Personal Express 6 allow you to create multidimensional Express
databases, which provide users of Express client applications with the
ability to easily select and analyze data. This guide refers to Express Server
and Personal Express 6 collectively as “Express.”

Common uses of Express

Express provides sophisticated data analysis and forecasting tools that you
can use for business applications such as:

� Tracking market share

� Analyzing pricing models

� Analyzing promotion and advertising effectiveness

� Long-range planning and budgeting
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Oracle Express Administrator
Definition: Administrator

Oracle Express Administrator (hereinafter referred to as “Administrator”) is
a utility that provides a convenient interface for creating Express databases
and configuring them for use with a client application.

Common uses of Administrator

This manual tells you how to use Administrator to perform database
administration tasks. You will do most or all of your work using
Administrator. In some cases, using the Express programming language
gives you additional flexibility and power in performing certain tasks.

The Administrator Help system

This manual is intended to give you the basics in using Administrator, as
well as more detailed information about Express database administration.
For your convenience, Administrator provides you with an extensive Help
system.

Finding the procedures you need

As you work with Administrator, the Help system gives you a quick and
easy way to find (and print) detailed information about Administrator
features and step-by-step procedures.

To help get you started using Administrator Help, this manual often
suggests the Help topics you can refer to for more in-depth information.
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Using Administrator Versus Using
Express
Performing database administration tasks

Most of the time, using Administrator is the easiest and fastest way to
perform database administration tasks.

You can also use Express commands to perform database tasks. To do so,
you can write an Express program or enter Express commands in the
Express Command window, which is available in Administrator.

Advantages of using Administrator versus Express

The advantage of using Administrator to perform database administration
tasks is ease of use. The advantage of using Express commands is greater
flexibility.

What to expect from this manual

This manual focuses on using Administrator and mentions using Express
commands to perform some tasks.

Related information

Consult the following sources:

� The Administrator Help menu provides online Help for both
Administrator and the Express programming language.

� For more information about using Express commands, see the Express
Language Help or reference manual.

� For more information about writing Express programs, refer to the
Express Language Programming Guide.
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An Overview of Multidimensional Data
Introduction

You are probably familiar with two-dimensional data from spreadsheets,
pictured as a matrix of rows and columns. You can think of
three-dimensional data (an example of multidimensional data) as a cube or
as a multilayer spreadsheet.

Example: Two-dimensional versus multidimensional data

The following figure compares a two-dimensional spreadsheet with a
multidimensional array.

MONTH

P
R
O
D
U
C
T

P
R
O
D
U
C
T

MONTH
DISTRICT

Two-Dimensional Spreadsheet Multidimensional Array

Sales data for each district is
in a separate spreadsheet

Sales data for all districts is
in a single array

Definition: Slice

In Express, each subset of multidimensional data is called a slice. A slice is
defined by selecting specific values of the data’s dimensions.
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Viewing different slices of data

No matter how you define your data, you can view it sliced by any of its
dimensions. The following figure shows an example of a data cube
(SALES) divided into three different slices.

P

R

O

D
U

C

T

MONTH
DISTRICT

All products and months
for one district

All products and districts
for one month

All districts and months
for one product

SALES

data

How many dimensions can each variable have?

A variable can be dimensioned by a maximum of 32 dimensions.

How client application users view data in the database

Client application users can specify how they want to view the data from
your database by using the Selector, which is a feature of prebuilt client
applications. The Selector enables a user to select specific values of
dimensions, such as districts, months, and products, for which to view data.
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Relational Versus Multidimensional
Databases
How relational databases record and store data

Relational databases offer an efficient method of recording and storing vast
amounts of information using an interface created in Structured Query
Language ( SQL). SQL is the ANSI-standard programming language for
relational databases.

Relational databases are suited for OLTP purposes

Relational databases are best suited to recording large numbers of
individual transactions, as in the case of OLTP (online transaction
processing) systems.  However, a database designed primarily for OLTP
does not lend itself easily to analytical processing, such as comparing
groups of transactions over a period of time.

Multidimensional databases are suited for OLAP purposes

Multidimensional databases and OLAP (online analytical processing) tools
are much better suited for data analysis purposes than are relational
databases. Express databases are designed specifically to support analytical
processing and are able to use data from relational databases.

Differences in Database Models
How a relational database stores information

A relational database stores information in tables that are organized by
rows and columns.

Each table contains a column or a combination of columns whose values
uniquely identify each row. These unique values are called primary keys
and help ensure the integrity of the data. When the values in a column
match the values of another table’s primary key, that column is called a
foreign key. Relationships between tables are established through primary



Chapter 1  Understanding Express

8

and foreign keys. You can select columns of data from different tables and
view them together as long as the tables are related in this way.

How an Express multidimensional database stores information

In contrast to a relational database, Express stores information in
multidimensional variables.

A variable contains information that quantifies a particular aspect of your
business. For example, you might record sales data in dollars (a Sales
variable) and units (a Units variable). All of the data in a variable represent
the same unit of measurement. Your business might have several ways of
measuring its transactions — through dollars, units, percentages, and so on
— and each one will be stored in its own variable.

SQL concepts versus Express concepts

It might be helpful to look at SQL concepts and terms in comparison to the
comparable concepts and terms used by Express, as shown in the following
table.

SQL Concept or Term Comparable Express Concept or Term

Database Database

Table Table

View Formula

Column Variable (Array) or dimension

Row Variable limited by n-1 dimensions

Primary key Dimension

Foreign key NA (dimension only exists once)

Declarative referential integrity Implied by singular definition of dimensions

Indices NA

System catalog EXPRESS.DB

JOIN clause Relation

WHERE clause LIMIT command

GROUP BY clause GROUP keyword (in commands such as
REPORT)
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SQL Concept or Term Comparable Express Concept or Term

ORDER BY clause SORT command

GRANT PERMIT command

Stored procedures, scripts,
stored SQL

Programs, user-defined functions, and INFILE
command

Control of flow language
(Transact-SQL, PL/SQL, and so
on)

Express programming language

Aggregations (Sum, Avg, Count,
Min, Max)

Express functions and formulas using dimensions

SELECT REPORT command

INSERT MAINTAIN ADD command

DELETE DELETE command, MAINTAIN DELETE
command

UPDATE SET command

Express Databases
Introduction

An Express database is a multidimensional collection of data that is
organized so that you can look at it from different perspectives. An Express
database is made up of data and objects.

Definition: Object

Objects are definitions in the database dictionary, which is the index to the
database. They are places to store information, such as data, program code,
and dimension values.
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The purpose of objects

Express has several kinds of objects. The following table lists these objects
and their respective purposes.

Object Purpose

Dimension To organize data

Variable To store data

Relation To associate the values of one dimension with the values of another
dimension

Formula To define an expression, which will calculate temporary data that you
do not need to store permanently in your database, thus making your
database more efficient

Program To store a sequence of commands that manipulate your data

Model To store and solve a set of interrelated equations

Composite To store data in a compact form, which saves disk space

Valueset To store a list of dimension values for a particular dimension

Worksheet To import text data from external files and transfer that data to
variables and dimensions in your database

The importance of objects

To get the most out of an Express database, you should first understand its
objects and how you can use them to your advantage. The more you
understand about an Express database before you create one, the easier your
job will be.

What you must do first

When you create an Express database, you must create your dimensions
before you create your variables. In other words, your job is to determine
how to organize data before deciding how to store it. Therefore, the first
object you should understand is the dimension.
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Dimensions
Definition: Dimension

A dimension is a list of values that provides an index to your data.
Dimensions are the foundation of your database.

How dimensions organize data

One set of data can be organized in several different ways. The following
table lists various examples of how data can be organized by dimensions.

IF you want to organize data
by . . . 

THEN you can define a dimension
named . . .

Time, MONTH, QUARTER, or YEAR.

Geography, COUNTRY, REGION, or CITY.

Product, PRODUCT, BRAND, or CATEGORY.

Organization, DIVISION or COMPANY.

Finance, ACCOUNT.

Example: Deciding how many dimensions you should define

Suppose you want to study sales data by location, product, and time period.
This means you need at least three dimensions, representing location,
product, and time. If you do not care about separating data by location, you
can total all locations and define sales (a variable) to be dimensioned by
product and time period only.

Planning the Dimensions for Your
Database
Introduction

You define dimensions for your database based on how your data is
organized and the level of detail you are interested in maintaining.
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Planning to create a dimension for every level of detail

You need dimensions for each level of detail in your data. If your company
is divided into sales districts and each district handles several store
accounts, you need to decide whether you want sales figures for every store
or only for each district.

If you need store data, you can define a STORE dimension; if you always
look at each district as a whole, all you need is a DISTRICT dimension. Or,
you can have both a STORE and a DISTRICT dimension. Then, by
creating a relation between STORE and DISTRICT, you can organize data
by store and view aggregates of data by district.

What kinds of dimensions can I define?

Express allows you to define three basic types of dimensions:

� Time  Values represent time periods. Express provides special
features for ease in handling and maintaining the values.

� Text  Values are brief descriptions of the entities they represent.

� Integer  Values are identified only by their numeric positions.
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What data types can I use for each kind of dimension?

The following data types are available for each type of dimension.

Dimension Type Data Type for
Dimension

Usage

Time dimension DAY One-day periods.

Time dimension WEEK Periods of 1 to 52 weeks.

Time dimension MONTH Periods of 1, 2, 3, 4, or 6 months.

Time dimension QUARTER Three-month periods.

Time dimension YEAR Twelve-month periods.

Text dimension ID Dimension values up to eight characters in
length. Express processes ID dimensions
very efficiently. If your dimension will have a
large number of values, then you should
define it with a data type of ID and use values
of eight characters or less.

Text dimension TEXT Dimension values of more than eight
characters.

Integer
dimension

INTEGER Lists that do not require text labels as
dimension values.

When to use time dimensions

Define a time dimension to hold values of the data types DAY, WEEK,
MONTH, QUARTER, or YEAR.

When to use text dimensions

For dimensions that do not hold time values, text dimensions (with a data
type of TEXT or ID) are generally more useful than integer dimensions.
The values of text dimensions give a clear description of the data and
provide ready-made labels for client applications to use.

When to use integer dimensions

If you cannot find logical unique names for the dimension’s values, you can
use an integer dimension.
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Example: Using an integer dimension

It is easy to create unique names for products and districts and use those
names as dimension values. However, an employee dimension that uses last
names would run into trouble if two employees had the same name.

In this case, you could define a dimension with the data type of INTEGER
named EMPLOYEE_INDEX. An integer dimension is a sequence of
numbers — one integer for each dimension value — that always begins
with “1” (for example, “1, 2, 3, . . . n”). Each EMPLOYEE_INDEX
dimension value would serve as a unique identifying number for each
employee.

The employees’ last names and other information would be stored in
variables dimensioned by EMPLOYEE_INDEX. An alternative would be
to define a text dimension with the employees’ social security numbers as
dimension values.

Dimension Values
Definition: Dimension values

After you define a dimension, you add values to that dimension. For
example, if you define a text dimension named DISTRICT, the values you
add might be BOSTON, CHICAGO, and DENVER.

The purpose of dimension values

Dimension values let you identify your data.

Dimension values also provide an easy way to target the data you need for
a particular purpose. When your users display a report or graph to analyze
your data, they select the values to work with.
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Using dimension values to select data

The following figure illustrates some selections a user might make while
working with SALES data.

TENTS

RACQUETS

CANOES

SPORTSWEAR

FOOTWEAR

DENVER
CHICAGO

BOSTON

JAN FEB MAR

TENTS

RACQUETS

CANOES

SPORTSWEAR

FOOTWEAR

DENVER
CHICAGO

BOSTON

JAN FEB MAR

Data selected

MONTH: MAR
PRODUCT: TENTS, CANOES, SPORTSWEAR
DISTRICT: All districts

Data selected
MONTH: All months
PRODUCT: TENTS, CANOES
DISTRICT: CHICAGO

How does selecting dimension values affect a database?

Selecting dimension values has no permanent effect on your database.
Every dimension has all its values available whenever your users connect to
your database, and they can change the selection at any time as they work
with your database.

Hierarchies
Definition: Hierarchy

A hierarchy is a way of organizing a dimension’s values and of providing
for drilling in tables and graphs.

If the client application is the Express Spreadsheet Add-In, the hierarchy
provides drilling in a spreadsheet.

The dimension values are grouped into levels, with the lower levels
aggregating into the higher levels. The client application can use dimension
hierarchies to enable users to select and display data conveniently.
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Figure: Sample hierarchy

The following figure presents a hierarchy that organizes the PRODUCT
dimension in the XADEMO database.

TOTALPROD

AUDIODIV VIDEODIV ACCDIV

PORTAUDIO AUDIOCOMP

PORTCD
PORTST
PORTCAS

TUNER
CDPLAYER
RECEIVER
AMPLIFIER
CASDECK

VCR

STNDVCR
STRVCR

TV

COLORTV
BWTV
PORTTV

CAMCORDER

VHSCMCDR

AUDIOTAPE VIDEOTAPE

CHROMECAS
METALCAS
STNDCAS

STNDVHSVIDEO
8MMVIDEO
HI8VIDEO

8MMCMCDR
HI8CMCDR

Description of the sample hierarchy

The PRODUCT dimension hierarchy in the preceding example has four
levels. The lowest is the detail level, which is made up of dimension values
such as TUNER and COLORTV. The three higher levels represent
aggregations of the levels below. The TOTALPROD value, at the top of the
hierarchy, is referred to as the “root.”

The PRODUCT dimension is an embedded-total dimension, because its
values include all the values shown in the example — the detail values and
the aggregate values. The aggregate values are not automatically rolled up
(or calculated), but rather are specific data values.
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The first 10 values of the PRODUCT dimension are listed below.

TOTALPROD
AUDIODIV
PORTAUDIO
PORTCD
PORTST
PORTCAS
AUDIOCOMP
TUNER
CDPLAYER
RECEIVER

The purpose of creating a hierarchical dimension is to allow client
application users to choose groups of dimension values (by level or family)
when they are selecting and displaying data. However, an embedded-total
dimension alone does not give the client application enough information to
allow it to know which dimension values belong to the various levels.

The information that defines the level to which a dimension value belongs
is kept in a parent relation, which records the parent for each value in the
embedded-total dimension. A value’s parent is at the level immediately
above that value in the hierarchy structure. For example, in the sample
hierarchy in “Figure: Sample hierarchy,” the diagram shows that the parent
for PORTCD is PORTAUDIO, and the parent for PORTAUDIO is
AUDIODIV. The value at the root of the hierarchy (TOTALPROD) has no
parent.
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The first 10 values of the PRODUCT dimension are listed again below.
This time, the associated values in the parent relation are listed to the right,
and each product is indented to indicate its level.

Dimension Value Parent

TOTALPROD NA
AUDIODIV TOTALPROD

PORTAUDIO AUDIODIV
PORTCD PORTAUDIO
PORTST PORTAUDIO
PORTCAS PORTAUDIO

AUDIOCOMP AUDIODIV
TUNER AUDIOCOMP
CDPLAYER AUDIOCOMP
RECEIVER AUDIOCOMP

An indented list is easier to understand, because all the values at a given
level are positioned at the same depth, and children are placed deeper than
their parents. The order of the dimension values also clarifies the
relationships in the hierarchy. Furthermore, a dimension is easier to
understand when siblings (values that share a parent) appear together, either
above or below their parents.

Criteria for a dimension value’s membership in a hierarchy

A dimension value is part of a hierarchy only if it meets one of the
following criteria:

� It has a parent (except for the root)

� It has at least one child

� It has an ordering number

How hierarchical information is displayed in a client application

When you set up a hierarchy for a dimension, you give the client
application the information it needs to present a dimension as a hierarchy in
the Selector, in dimension list boxes, and in tables.
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If the client application is the Express Spreadsheet Add-In, it presents a
dimension hierarchically in the Selector and in spreadsheets.

Definition: Metadata

Metadata is a set of Data Dictionary structures (for example, a parent
relation) that hold information about characteristics, such as parent-child
relationships and sibling order.

When you have configured a database for a client application and you have
specified dimensions as hierarchical, those dimensions are embedded-total
dimensions. Administrator generates metadata to support those dimensions.

You can create multiple hierarchies for a single dimension

A configured database is not limited to one hierarchy for a given
dimension.

For example, “Figure: Sample hierarchy” presents a hierarchy that can be
considered the standard one for the PRODUCT dimension in the
XADEMO database. “Figure: An alternative to the sample hierarchy”
presents a second hierarchy that divides the same detail-level products into
product types.
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Figure: An alternative to the sample hierarchy

The hierarchy in the following figure divides the same detail-level products
(as shown in “Figure: Sample hierarchy”) into product types.

TOTALPROD

AUDIOTYPE VIDEOTYPE

AUDIOEQ AUDIOACC

PORTCD
PORTST
PORTCAS
TUNER
CDPLAYER
RECEIVER
AMPLIFIER
CASDECK

STNDVCR
STRVCR

COLORTV
BWTV
PORTTV

VHSCMCDR

VIDEOEQ VIDEOACC

CHROMECAS
METALCAS
STNDCAS

STNDVHSVIDEO
8MMVIDEO
HI8VIDEO

8MMCMCDR
HI8CMCDR

Description of the alternative hierarchy

To support the hierarchy shown in “Figure: An alternative to the sample
hierarchy,” you would add AUDIOTYPE, AUDIOEQ, AUDIOACC,
VIDEOTYPE, VIDEOEQ, and VIDEOACC as values in the PRODUCT
dimension.

In addition, the database would need modifications to the Data Dictionary
structures in order to accommodate the second hierarchy. For example, the
parent relation for the second hierarchy would have to be filled in.

Rollup
Definition: Rollup

The term rollup refers to the consolidation of data for several dimension
values into a single value, such as the total units sold for all cities, or into a
smaller set of values, such as the average units sold for cities in each
region. Data is often collected at the lowest level of detail and aggregated,
or rolled up, into higher level totals for analysis.
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Example: Rollup

For example, suppose your product is sold worldwide. You can define a
GEOGRAPHY dimension with four levels: cities, countries or regions,
continents, and world.

An example of a city would be TORONTO. It would belong to the
CANADA country or region level, which would belong to the AMERICAS
continent level.

All continents would belong to the WORLD level.

A SALES variable dimensioned by GEOGRAPHY might have data only at
the cities level.

Typically, you will add data to a variable (that is dimensioned by a
hierarchical dimension) for the lowest level of the hierarchy. For example,
in a variable dimensioned by GEOGRAPHY, you will add data for just the
cities level.

You can then roll up the data, which means that Express will compute the
sum for every level of the hierarchy. Thus, if you add sales figures for cities
only to a variable, you can then roll up data in order to get sales figures for
all other levels (the countries or regions level, the continents level, and the
world level).

Variables
Definition: Variable

Each array of data is called a variable. Each variable contains a particular
kind of data, such as sales data or salary data.

How variables share dimensions

If two variables use the same dimensions, such as MONTH and
PRODUCT, these dimensions are not stored in the database twice. Instead,
the two variables share the dimensions.
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Example: Sharing dimensions

A database might contain the SALES variable shown above as well as other
variables, such as EXPENSE and PRICE, all of which share the MONTH
and PRODUCT dimensions.

MONTH

P
R
O
D
U
C
T

EXPENSE variableSALES variable PRICE variable

P
R
O
D
U
C
T

MONTH
DISTRICT

P
R
O
D
U
C
T

MONTH
DISTRICT

Why sharing dimensions is important

Shared dimensions provide an important link between variables that have
some or all of the same dimensions. For example:

� If you look at SALES and EXPENSE data, notice that the same months,
products, and districts are used for both variables.

� If you add, delete, or rename products, then the products are added,
deleted, or renamed for all variables that have the PRODUCT
dimension.

� If your users select products to use in their client application, then the
same products are selected for all variables that have the PRODUCT
dimension.

By sharing dimensions, Express ensures the referential integrity of your
database. Whatever changes you make to the dimension values in your
database, those changes are automatically reflected throughout your data.
You can always depend on the consistency of your data throughout any
reports, graphs, or analyses your users’ client applications may use.
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Relations
Definition: Relation

A relation is a correspondence or association between the values of two
dimensions.

Example: How a relation associates the values of two dimensions

Suppose a company manufactures five products. Each product is made by a
division of the company. You can create a relation called
DIVISION_PRODUCT to associate each product with the division that
makes it.

CAMPING

SPORTING

CLOTHING

TENTS

CANOES

RACQUETS

SPORTSWEAR

FOOTWEAR

DIVISION dimension PRODUCT dimension DIVISION_PRODUCT relation

CAMPING

CAMPING

SPORTING

CLOTHING

CLOTHING

TENTS

CANOES

RACQUETS

SPORTSWEAR

FOOTWEAR

dimensioned by PRODUCT

Definition: Parent relation

A parent relation records the parent for each value in an embedded-total
dimension.

The importance of the parent relation

An embedded-total dimension alone does not give the client application
enough information to allow it to know which dimension values belong to
the various levels. This information is kept in a parent relation.
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Formulas
Definition: Formula

Formulas are objects that define an expression. Formulas calculate
temporary data that you do not need to store permanently in your database.

Example: Using a formula

If sales are always units sold multiplied by price, you can define a formula
to calculate sales and avoid storing redundant data in the database. You can
analyze the value of sales just as you would analyze any variable; however,
every time you refer to sales, the value is recalculated.

Measures
Definition: Measure

Variables, relations, and formulas are collectively referred to as measures.
You will find that many database tasks involve working with measures,
because these are the objects your users will be viewing or analyzing in
their client applications.

The information you specify for measures

When you set up measures with Administrator, you specify:

� Whether the client application should give users access to the measures

� How the measure names will be displayed

� For numeric measures, how their data will be formatted

Whether a given measure is stored as a formula, as a relation, or as a
variable makes no difference in the steps you take in configuring it for the
client application.
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Other Express Objects
Definition: Program

Programs let you store sequences of commands that manipulate your data.
Some commands, which can only be used in programs, enable you to loop
over sets of data.

Using a program instead of a formula

If you need to use a very complex calculation, you might want to define it
in a program rather than as a formula.

If you define a program that uses a RETURN command to return a value,
you can use the program as a function wherever you would use an
expression or a formula. (An expression is one or more data values, which
you use as an argument in commands or functions. See the Glossary in the
Express Language Help for a detailed definition of “expression.”)

Definition: Composite

Composites are objects that store sparse data in a compact form, which
saves disk space. A composite is an artificial dimension that combines the
dimension values of two dimensions along which data is sparse. A
composite is automatically created by Express when you define a sparse
variable.

Definition: Model

Models let you store and solve a set of interrelated equations. The equations
can be based on the values of variables or dimensions. For example, you
can define a financial model with equations based on the values of a line
item dimension. The equations in the model can use input data for some
line items, such as revenue and expenses, to calculate other line items, such
as net income and return on sales.

Definition: Valueset

Valuesets let you store a list of dimension values for a particular dimension.
The values in a valueset can be saved across Express sessions. You can
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limit a dimension to the values that are stored in a valueset for that
dimension.

See the LIMIT command entry in the Express language Help or reference
manual for information on valuesets.

Definition: Worksheet

Worksheets let you import text data from external files and transfer it to
variables and dimensions in your database.

See the DEFINE WORKSHEET command in the Express language Help or
reference manual for more information about worksheets.

Your Users’ Client Application
Typical client applications

Your users will be using one of the following types of client applications:

� A prebuilt Express Client application available from Oracle

� A client application that you build yourself

Oracle Express Client applications

Oracle Express Client applications include the Express Spreadsheet Add-In
and the Express Client products (Oracle Express Analyzer and Oracle
Express Objects).

Benefits of using Oracle Express Client applications

If your users use an Oracle Express Client application, the application takes
advantage of the data structures that are generated by Administrator. For
example, when you configure your database, Administrator generates data
structures that the Oracle Express Client application uses to display short
and long labels for the database objects you create.

The Express Client applications do not require that you perform any of the
configuration procedures described in this manual, but taking these steps



The Data Dictionary

27

makes the data in your databases easier to use and more attractive when
displayed. Configuring your databases also lets your users take advantage
of prebuilt client application features, such as drilling.

Writing your own client application

Instead of using an Oracle Express Client application, you can use SNAPI
(Structured N-Dimensional Application Programming Interface) to write
your own client application to use with Express.

Like the prebuilt Express Client applications, your client application can
take advantage of the data structures that are generated by Administrator.
Whether or not you want to use these data structures is up to you.

Related information

See the Oracle Express Server SNAPI Guide for information about SNAPI
and how to use it to develop client applications that interact with Express
Server.

The Data Dictionary
Definition: Data Dictionary

The Data Dictionary is a collection of information about configured
databases and their dimensions and measures. The Data Dictionary includes
the data structures that are generated by Administrator, which the client
application uses to organize data and to present it more clearly.

For example, in a configured database, the Data Dictionary contains the
hierarchical information that allows client users to drill down from more
aggregate dimension values (such as “Eastern Region”) to greater levels of
detail (such as “Boston”).

Advantages of a configured database

Express Client applications can work with any Express database, because
they are programmed to access dimensions, variables, relations, and
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formulas. However, you can customize databases to optimize the way your
client application displays data.

If the database has not been configured with the procedures presented in
this manual, the client application uses default values for the settings
described here.

Example: What you can customize

The following are a few of the characteristics you can customize:

� The list of measures accessible to the client application user

� The ways the client application will handle labels and other display
attributes of the data

� Saved selections of dimension values that provide customized subsets
of the data to be displayed

� Hierarchy definitions for dimensions, which allow users to view, select,
and drill data with reference to aggregate groupings

Where client application users see the benefit of configured databases

Configuring a database allows client application users to perform more
sophisticated analyses on the data.

In the Express Spreadsheet Add-In and other Express Client applications,
the advantages are most apparent in the Selector, where the user selects
from lists of measures and dimension values. Using the configuration
procedures, you can provide descriptive names for measures and
dimensions, saved selections of dimension values, and dimension
hierarchies. These names make it easier for users to analyze or work with
the data.

In Express Client applications other than the Express Spreadsheet Add-In,
the advantages are also apparent in tables and graphs, where the user sees
data values. You can specify the formatting characteristics for numeric data
(for example, the format for negative numbers and the currency symbol to
use) and the way users drill to higher and lower levels of detail.
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Where the configuration information is stored

When you configure a database, information about that configuration is
automatically stored in Express application database files. You must make
these database files available to each client application user who needs
access to the user database you configure.

A database called XPDDDATA.DB is especially important for configured
databases; it contains data structures that hold information that is specific to
the databases you configure with Administrator.

See “Databases You Should Know About” in Chapter 3 for further
information XPDDDATA and other application databases.





31

Chapter 2

Your Role as a Database
Administrator

Overview
Introduction

This chapter outlines the tasks you perform as a Database Administrator
and refers you to other chapters in this manual for detailed information.

In this chapter

� Setting Up Administrator with Express

� Building an Express Database

� Ensuring Good Performance

� Making an Express Database Secure

� Connecting Your Users to Express

� Maintaining an Express Database



Chapter 2  Your Role as a Database Administrator

32

Setting Up Administrator with Express
Overview

This chapter provides an overview of the tasks you need to perform as a
DBA in regard to Administrator and other Express products. You will be
referred to other chapters in this manual for details.

Administrator is a database administration tool that you use on your PC.

Once you have set up Administrator, you will start Administrator, connect
Administrator to an instance of Express, and create and work with
databases that reside in that instance of Express.

The following procedure shows the basic steps you need to take in order to
set up Administrator to work with Express.

Step Action

1 Install Administrator and the other Oracle Express products it requires on
your PC.

2 Get information about the instance of Express in which you want to define
and maintain databases.

3 Use the information about Express to create connection files, which are
used by Administrator and the Express Client applications to connect to
Express.

4 Install on your PC the software that is required to communicate with
Express.

The following topics explain each step in detail.

Installing Administrator

First, you install Administrator on your PC. Use Oracle Installer
(hereinafter referred to as “Installer”) to install the following on your PC:

� Administrator, which you use on your PC as an administrator tool

� Express Connection Editor, which you use to create connection files
that both you and your users will need to connect to Express

� SNAPI, which makes the actual connection to Express
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� Personal Express 6 (optional), which you can use instead of Express
Server

If you have any questions about installing Administrator, see Appendix A.

Getting information about the Express instance

It is possible to have multiple instances of Express Server running on one
remote machine. Once you have installed Administrator, your next step is
to get information to identify the instance of Express to which you want to
connect.

If . . THEN you need to know . . .

Express Server is installed on Unix, � The name of the machine on which
Express Server is installed

� The end point

Express Server is installed on NT, � The name of the machine on which
Express Server is installed

� The UUID (only if you want to connect
to any instance other than the default
instance)

If you plan to use Personal Express 6 instead of Express Server, you do not
need to get any information, because you can have only one instance of
Personal Express 6 running on your PC.

Setting up connections to Express

To connect Administrator to an instance of Express, you need a connection
(.XCF) file, which contains information about that instance of Express and
how Administrator will connect to it. Use the Express Connection Editor to
create connection files.

You will need a separate connection file for every instance of Express to
which you want to connect.

When you create a connection file, one of the specifications you make is a
description of the file. Make the description as specific as possible, because
this is the description that you will see when you start Administrator and
are prompted to connect to Express. A dialog box will list the description of
every connection file you have defined.
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See Chapter 3 for information about defining connection files. See the
Connection Editor Help system for information about using the Express
Connection Editor.

Installing other software that is required to connect to Express Server

When you install Administrator, you will also install SNAPI, which is
required to connect Administrator to Express. SNAPI depends on the
Microsoft RPC runtime DLLs (MS-RPC) and TCP/IP support, which are
provided as part of the Windows NT and the Windows 95 operating
systems.

Starting Administrator

Once you have installed Administrator and created the connection files that
are required for connecting to Express, you can start Administrator. When
you start Administrator, you are prompted to select a description (that you
specified when you defined its related connection file) of an Express
connection.

Building an Express Database
Where do databases reside?

When you have successfully started Administrator and connected it to the
Express instance of your choice, you can open databases that reside on the
remote machine on which Express is installed. If you define a new
database, it will reside on the remote machine, as well. If you use Personal
Express 6, any database that you open or create will reside on the PC on
which Personal Express 6 is installed.

Planning your database

Once you understand the Express data model and you gain some experience
in designing Express databases, you can take advantage of the many
powerful features that Express offers. However, there is a significant
learning curve.
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It is a good idea to plan your database before you build it. Otherwise, you
may discover that you need to rethink your database and redesign it. That
means you would have to delete all of your work and build a new database
from scratch. The more time you invest in planning a database before you
build it, the more time and frustration you are likely to save.

Chapter 5 gives advice about how to plan your database. It provides an
example of building a database that is based on user needs and existing
data, as well as an example of building a database that is based on the data
in an existing relational database.

Defining an Express database

Once you have planned your database, you can define it. First, you define
the database itself. Then, you define the database objects that will hold and
organize the data.

Administrator provides a Data Wizard that you can use to define a database
and its objects. It is a good idea to use the wizard as much as possible — it
gives you a fast, easy way to define your database and its objects. Every
step in the wizard has its own Help topic, in case you have any questions
while using the wizard.

Alternatively, you can use the dialog boxes provided by Administrator to
create a database manually. In this case, you first define the database itself,
then you define every individual database object. Every dialog box has its
own Help topic with detailed information.

See Chapter 6 to learn how to define a database by using the Data Wizard.
See Chapter 7 for information about defining a database manually.

Adding data to an Express database

Once you have defined a database and database objects, your next step is to
add data to the database. The data will be stored in the database objects you
have already created.

You will add data to your database in one of the following ways:

� Import data from one or more files

� Import data from a SQL database
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� Make a SQL connection to a relational database, where the data resides

� Make a Relational Access Manager connection to a relational database,
where the data resides

� Enter the data by hand

Chapter 5 gives an overview of the tasks you need to perform in order to
add data using any of the above methods.

Chapter 9 describes how to import data from a file or from a SQL database.

Chapter 16 describes how to make a SQL connection to a relational
database. Chapter 17 describes how to make a Relational Access Manager
connection to a relational database.

Chapter 7 describes how to enter data by hand in a database.

The methods you can use for adding data

If the data resides in a file, and that file’s format meets the requirements of
the Data Wizard, you can define your database and add data to it by using
the Data Wizard.

If the data resides in a file whose format cannot be used by the Data Wizard
— or if you import SQL data — use the Import dialog boxes to specify how
you want the data to be imported. Administrator will then automatically
generate a data loading program for you, which you can choose to run
immediately or schedule to run at a later time.

Chapter 6 gives an overview of using the Data Wizard, both to define a
database and to add data to that database.

Chapter 9 describes how to import data from a file or from a SQL database.

Rolling up data

In most cases, you will organize your data into several levels that form a
hierarchy. Typically, you will add data only to the lowest level of each
hierarchy. Once you have added data to your database, your next task is to
roll it up, meaning, to aggregate it for each level of the hierarchy.
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For example, suppose you have sales data for products that are sold at a
variety of stores worldwide. Your users might want to see sales data by
continent and country and city. That means you need to create a hierarchy
whose levels are Store, City, Country, and Continent. Your job is to define
the hierarchy, load the data at the lowest level (in this case, Store), and roll
up that data for every level of the hierarchy.

In this example, once you have added the data to the Store level of your
hierarchy, you would roll up the data for all stores in each city. You would
then roll up the data for all cities in each country. Finally, you would roll up
the data for all countries in each continent.

Rolling up data in Administrator is easy. Use the Rollup Wizard to specify
how you want the data to be rolled up. Administrator then automatically
generates a rollup program for you. You can either run the rollup program
immediately or schedule it to run at a later time.

The Administrator Help system provides detailed information for every step
in the Rollup Wizard.

Configuring databases for your users

If your users access Express databases with Express Client applications,
you should configure the databases so that the data is displayed for your
users in the way in which they need to view it. See Chapter 11 for
information about configuring databases.

Ensuring Good Performance
Plan a new database before you define it

If you define a database and its objects before you think about how to
ensure good performance, it may already be too late. You should invest
time in understanding the Express data model and the ways in which you
can design a database that will make good performance possible.

Refer to Chapter 1 to learn about the Express data model.
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Chapter 5 describes the issues you should consider when you plan a
database.

Define database objects that will ensure efficiency

Before you define database objects, learn how to do so in a way that will
maximize good performance. A common problem with databases is
inefficient use of disk space. You can define your objects so that the disk
space taken up by the data that is stored and organized by those objects is
kept to a minimum. Therefore, you can keep the size of your database to a
minimum.

For information about defining database objects, refer to Chapter 6 (which
describes how to use the Data Wizard to define database objects) or
Chapter 7 (which describes how to use Administrator dialog boxes to
define database objects).

See Chapter 13 to learn how to define database objects in a way that will
ensure good performance.

Creating and using calculations

If users need information that is calculated from the data that is stored in
the database, consider using formulas that will calculate the information at
the time the users request it.

An alternative method is to calculate the information and then store it in the
database. This method can take up a great deal of space, which in turn can
slow performance, sometimes by a considerable margin.

However, if you define a formula in which you enter and store a
calculation, only that formula and the calculation are stored. The
information is calculated only when it is needed, and it is not stored in the
database.

See Chapter 7 for information about defining formulas.

Search for the following topics in the Administrator Help system:

“Define a Formula Dialog Box”
“Defining Formulas”
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Make sure Express is tuned for good performance

The performance of Express can affect both you and your client application
users. If Express is tuned to run as efficiently as possible on the machine on
which it is installed, the data loader and the rollup programs you execute
will perform well.

If you have taken as many steps as possible to ensure good performance
and there seem to be performance problems, make sure that Express is
tuned to run efficiently on the server.

See Chapter 14 for information about performance issues.

Making an Express Database Secure
Overview

As the DBA, you are responsible for database security. You can provide
security for any Express database by using Express commands, regardless
of the platform on which Express is installed.

Additionally, if Express is installed on an NT server, Administrator makes
it easy for you to take advantage of NT security features.

Using Express commands to make the database secure

You can use the Express DATABASE command with the PASSWORD
keyword to assign a password to an individual database.

In addition, you can use Express options and commands to control access to
your database. You can write stored procedures (Express programs) to
provide security for your database.

Refer to Chapter 15 for information about writing a stored procedure to
provide database security.
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Why you might not need Express commands to make the database secure

You might not need to use Express commands to establish database
security when both of the following conditions are true:

� If you can establish or restrict database access through the operating
system on the remote machine on which Express is installed

� If you do not need to establish access rights to objects within the
database

See Chapter 15 to determine whether or not you need to use Express
commands to provide database security.

Authenticating access to an Express database on an NT server

If Express Server is installed on an NT server, you can take advantage of
the security features offered by NT. When you define a connection file, you
can specify how users should be authenticated when they attempt to
connect to Express.

Refer to Chapter 3 for information about the NT security features of which
you can take advantage, when and why you should use them, and which
specifications you should make in the Express Connection Editor when you
define a connection file.

Connecting Your Users to Express
Overview

When you create a new database, you define the database and the database
objects, add data and roll it up, take steps to ensure good performance, and
make the database secure.

The database is then ready to be used by client application users. Your
responsibility as the DBA is to perform the tasks that enable the client
application users to connect to the Express database.



Connecting Your Users to Express

41

The following procedure shows the basic steps you need to take in order to
set up your Express Client application users to work with Express.

Step Action

1 Define connection files, which are used by the Express Client applications to
connect to Express.

2 Make sure your users have installed the software that is required to
communicate with Express.

The following topics explain each step in detail.

Define connection (.XCF) files for your users

In order to connect to Express, your users will need a connection file that
you define for them. Use the Express Connection Editor to create
connection files.

The connection file that you define for your users will be similar, if not
identical, to the connection file you defined for yourself in order to connect
Administrator to Express. The difference is that you may want to take extra
steps, such as prompting users for a password before establishing the
connection to Express.

Your users will need a separate connection file for every instance of
Express to which they want to connect.

See Chapter 3 for information about defining connection files for client
application users. See the Connection Editor Help system for information
about using the Express Connection Editor.

Make sure your users have installed the required software

In order to connect to Express, your users must have the same software
installed on their PCs as the software you installed on your own PC to
connect Administrator to Express.

Your users will use Installer to install the following on their PCs:

� Client application product (for example, Oracle Express Objects),
which they will use as their application tool

� SNAPI, which they will use to make the actual connection to Express
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SNAPI depends on the Microsoft RPC runtime DLLs (MS-RPC) and
TCP/IP support, which are provided as part of the Windows NT and the
Windows 95 operating systems.

If your users have any problems connecting their client applications to the
Express database, be sure that they have all of the above software installed
on their PCs.

Maintaining an Express Database
Overview

After you have defined a database, added data to it, and rolled up that data,
you can set up your client application users so that they can connect to
Express and use the database.

However, new data is constantly gathered on a regular basis, whether daily,
weekly, or otherwise. You are responsible for making sure the data in every
database is current.

The maintenance tasks that you need to perform depend on how you have
chosen to add data to the database.
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How you maintain data depends on how you add it to the database

The following table outlines the tasks you perform to maintain a database,
which depend on how you add data.

IF you add data by . . . THEN . . .

importing data from one or
more files,

define a new data loader program (or use an existing
one) to import the new data, then roll up that data.

using the Database
Wizard,

specify a new data loader program (or use an existing
one) to import the new data, then roll up that data.

importing data from a SQL
database,

define a new data loader program to import the new
data, then use your existing rollup program to roll up that
data.

making a SQL connection
to a relational database,

add new data to the relational database. If the relational
database has the same hierarchy as your database and
the new data is rolled up in the relational database, you
need do nothing. Otherwise, use your existing rollup
program to roll up the new data in your Express
database.

making a Relational
Access Manager
connection to a relational
database,

add new data to the relational database. If the relational
database has the same hierarchy as your database and
the new data is rolled up in the relational database, you
need do nothing. Otherwise, use your existing rollup
program to roll up the new data in your Express
database.

entering the data by hand, after entering new data, use your existing rollup program
to roll up the new data.

What if there is a small change to the database?

If there is a small change to the data in your database, consider generating a
new rollup program that will roll up only the new data instead of all of the
data in the database.

Whether or not you should generate a new rollup program depends on
several factors. How large is your database? How long does it take your
existing rollup program to execute? When do you typically execute the
rollup program? When you roll up data, your users should not have access
to the database. Do your users have to wait until the rollup program finishes
executing or are you able to run the rollup program at a time when there are
no users who need to access the database?
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If the existing rollup program does not take long to execute or if you can
run it when no users need to access the database, it is probably in your best
interest to use the existing rollup program regardless of the extent of the
change to the database.

On the other hand, if the amount of time it takes to execute the rollup
program matters, you can reduce that time significantly by generating a
new rollup program in which you specify exactly which data should be
rolled up.

The Rollup Wizard provides a detailed Help topic for every step of the
wizard. To generate a new rollup program that rolls up only the data you
specify, refer to the Help topics in the Rollup Wizard.

How to make maintenance easy

The key to maintenance is that the data in a database should always be
accurate. That means that whenever you add new data to a database, it is
important to immediately roll it up. Otherwise, it is likely that the data at all
levels of the hierarchy, except for the lowest level, will be inaccurate.

Administrator makes maintenance easy by providing a way to schedule
programs to run on any day and time you wish. Therefore, once you have
generated a data loader program and a rollup program, you can schedule
those programs to run at a time when you know that users will not need to
access the database. Schedule the data loader program to run first. In this
way, you can add the new data to the database. Schedule the rollup program
to run as soon as the data loader program finishes executing.

By using this strategy, the data in the database will always be accurate.

Related information

See the following for further information

� Search for the following topics in the Administrator Help system:

“Schedule the Program Dialog Box”
“Scheduling Programs”

� See Chapter 10 for more information about maintaining databases.
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Chapter 3

Setting Up as a Database
Administrator

Overview
Introduction

This chapter describes the tasks you need to perform before you can use
Administrator.

In this chapter

� Databases You Should Know About

� Overview of Configuring Connections

� Step 1: Choosing a Connection Type

� Step 2: Setting the Path for Connection Files

� Step 3: Setting Up a Personal Express 6 Connection

� Step 4: Setting Up an Express Server 6 Connection

� Step 5: Determining Security for an Express Server 6 Connection

� Step 6: Setting .INI File Options

� Using the Connections
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Databases You Should Know About
The Oracle Express Client support files

Four application database files (XPDB.DB, XPDDCODE.DB,
XPDDDATA.DB, and XPADMIN.DB), are installed on the same machine
as Express when it is installed. These application databases are referred to
as the Oracle Express Client support files.

The Oracle Express Client support files are necessary for connecting to
Express and configuring user databases. When you connect Administrator
to Express, the Oracle Express Client support files are automatically
opened with read-only access.

If you have any problems connecting Administrator to Express, check to be
sure that the Oracle Express Client support files are installed.

If Express Server 6 is installed on a server machine, the Oracle Express
Client support files will reside in a directory path such as the following.

\<oracle home directory>\olap\oes620\service\oec620

If the files have been installed but you still have a problem connecting to
Express, refer to “Procedure: Making the Oracle Express Client support
files available for Express Server 6.”

If Personal Express 6 is installed on your PC, the Oracle Express Client
support files will reside in a directory path such as:

\<oracle home directory>\olap\pex620\service\pec620

Demonstration database

A demonstration database, XADEMO.DB, is also installed in the same
directory as the Oracle Express Client support files as part of the Express
installation.
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Overview of Configuring Connections
There are several steps involved in the process of configuring connections
to Express. Some of these steps involve the use of a utility called the
Express Connection Editor. The following sections describe this editor and
outline the basic configuration steps, which are explained later in this
chapter.

What is the Express Connection Editor?

The Express Connection Editor is a utility that you use to configure
connections to Express. You cannot use or successfully start Administrator
until you connect it to Express.

Install the Express Connection Editor with Oracle Installer. The Express
Connection Editor is a set of dialog boxes that assists you in specifying
much of the information that is necessary to make Express connections.

When the Express Connection Editor is installed, an icon for the editor is
created in the Express Client program group. The following figure
illustrates this icon.

Connection (.XCF) files

The specifications that you make in the Express Connection Editor are
stored in files that have an .XCF extension. These files are called
connection files. Each connection file stores the specifications for one
connection to Express.

You can store connection files on a LAN, so that your users can access
them. This allows you to create one set of connection files that all users can
share. If you store connection files on a LAN, you should give the files
read-only access so that users cannot modify them.
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You can also distribute the connection files to users using e-mail or floppy
disks.

Keep in mind that each user’s XCONNECT.INI file must specify the
directory path in which the .XCF file exists, regardless of where it is
located.

Connection descriptions

Every time you define a new connection file, you should include a detailed
description about the connection. Once you have saved the new connection
file, its description will be displayed in the Express Connection Editor, as
well as in the Connect dialog box that is displayed when you start
Administrator or when a client application user elects to connect to
Express.

The main dialog box of the Express Connection Editor contains a box that
lists the descriptions of connections that have already been defined. The
editor obtains this list by searching the directories you have specified as
containing connection files. See the later topic “Step 2: Setting the Path for
Connection Files” for information.

Modifying connection files

The Express Connection Editor does not provide the ability to delete or
rename connection files or change their attributes (such as read-only). You
perform such operations on the files using your operating system. When
renaming files, do not change the .XCF extension, or the file will no longer
be considered a connection file.
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Basic configuration steps

The following table outlines the basic steps for configuring Express
connections, as detailed in the next several topics.

Step Action

1 Choose which types of connections are needed.

2 Set the path for connection information.

3 Set up for connections to Personal Express 6.

4 Set up for connections to Express Server 6.

5 Set up security for the Express Server 6 connection.

6 Set .INI file options for each product that will connect to Express. If the
product is Administrator, set the XADMIN.INI file options. If the product is an
Express Client application, set the file options in the .INI file that is
associated with that product.

Step 1: Choosing a Connection Type
Do you want to connect to Express Server 6 or Personal Express 6?

You need to know to which version of Express you want to connect:

� Personal Express 6 is installed on a PC. You are the only user. You
install Administrator and one or more client applications on the same
PC. These applications can communicate with Personal Express 6 using
a local SNAPI (Structured N-dimensional API) connection. To access
Express data, you connect to Personal Express 6.

� Express Server 6 is installed on a remote machine. You install
Administrator on your PC, and your users install their client
applications on their PCs. Administrator and the client applications
communicate directly with Express Server 6 using SNAPI. To access
data, you and your users connect to the Express Server 6 machine.

Next, you set up connections to Express.
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Step 2: Setting the Path for Connection
Files
Introduction

Before you can begin specifying connection information in the Express
Connection Editor, you must specify the directories in which you will store
the connection files.

About path specifications

In the main dialog box of the Express Connection Editor, you choose
Set Path to display a dialog box in which you make this specification.

Later, as you complete the process of defining a connection, the editor
prompts you to select which of the specified directories should hold the
new connection file.

The editor also uses the path specification to display in its main dialog box
a list of the descriptions of connections that have already been set up. The
path specification is stored in the ConnectionPath setting of the
XCONNECT.INI file.

How Express connections occur

When Administrator and a client application attempt to connect to Express,
they use the same technique as the editor to search for the path specification
for the connection files. Depending on the ServerPrompt and ServerDefault
settings in each user’s .INI file, these products will either prompt the user
for the desired connection (using the Connect dialog box) or use the default
connection. See the topic “Step 6: Setting .INI File Options” for more
information on the ServerPrompt and ServerDefault settings.
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How lists of available connections are made

The Connect dialog box contains a list of connection descriptions that have
already been set up. The list of available connections is created as shown in
the following table.

Stage Description

1 Administrator or the Express Client product looks in the ConnectionPath
setting of the XCONNECT.INI file to find the path specification for the
locations that contain connection files. There may be several different
locations.

The XCONNECT.INI file is in your ECF directory, such as ECF620.

2 Administrator or the Express Client product browses the .XCF files and puts
the name of each connection in the Connect dialog box’s list box.

Where users must store XCONNECT.INI

Users should store their copy of the XCONNECT.INI file in their ECF
directory (for example, ECF620), which is created when they use Oracle
Installer.

The ECF directory will be located in a directory path such as the following.

\<oracle home directory>\olap\ecf620

Comparison of connection lists for Administrator and the client applications

The list of connections that appears in the Connect dialog box in
Administrator and the client applications is similar to the list that appears in
the Express Connection Editor, with the following exceptions:

� If a connection file is specified as read-only, the characters
“(read-only)” appear after the connection description in the main dialog
box of the Express Connection Editor. The read-only specification does
not appear in the Connect dialog box.

� The Connect dialog box in Administrator does not list connections that
use Relational Access Manager, because such connections are not
supported by Administrator.
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Related information

Search for the following topic in the Express Connection Editor Help
system:

“Setting the Path for Connection Files”

Step 3: Setting Up a
Personal Express 6 Connection
Before you read this topic

If you plan to have a Personal Express 6 connection, then read the
information in this topic. If you do not need to set up a Personal Express 6
connection, then go to Step 4 for information on Express Server 6
connections.

Before you begin

Before setting up connections to Personal Express 6, you must understand
the system requirements involved in connecting, as described in the
following list:

� Personal Express 6 — Use Oracle Installer to install Personal
Express 6 on the same PC on which Administrator and your client
applications are installed.

� SNAPI — Use Oracle Installer to install SNAPI on the same PC on
which Personal Express 6, Administrator, and the client applications are
installed. SNAPI depends on the Microsoft RPC runtime DLLs (MS-
RPC), which are provided as part of the Windows NT and the Windows
95 operating systems.

Before following the instructions in the remainder of this chapter, ensure
that the products listed above are properly installed on your systems. For
information about configuring and using SNAPI, see the Oracle Express
SNAPI Guide.
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A connection file for Personal Express 6 is provided

One connection file is provided with the Express Connection Editor: a file
(PEX620.XCF) that specifies a connection to Personal Express 6. This
.XCF file is provided in the ECF directory.

When you start Administrator, the Connect dialog box will display
“Personal Express 6.2.0” in the Express Connection list. Select “Personal
Express 6.2.0” to connect Administrator to Personal Express 6.

Defining a connection file for a Personal Express 6 connection

If you should need to define another connection file to make a connection
to Personal Express 6 (for example, if your PEX620.XCF file becomes
damaged or is inadvertently deleted), use the following steps to define a
connection.

Step Action

1 Use the Express Connection Editor to define a new .XCF file.

If you do not know how to define a new .XCF file, refer to “Defining
Connections” in the Express Connection Editor Help system.

2 Choose the Define  button.

3 Enter the connection file name and description of your choice.

4 Choose Personal Express 6.x as the Express version.

5 Save the new .XCF file.

Related information

Search for the following topics in the Express Connection Editor Help
system:

“Defining Connections”
“Editing Existing Connections”
“Managing Connections to Relational Databases”
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Step 4: Setting Up an Express Server 6
Connection
Before you begin

Before setting up connections to Express Server 6, you must understand the
system requirements involved in connecting, as described in this list:

� Express Server 6 — Express Server 6 must be installed on the system
where the Express data will reside. Your system administrator will
probably install Express Server 6.

� SNAPI — You must install SNAPI on the system that contains
Administrator or a client application. Use Oracle Installer to do so.
SNAPI depends on the Microsoft RPC runtime DLLs (MS-RPC) and
TCP/IP support, which are provided as part of the Windows NT and the
Windows 95 operating systems.

Before following the instructions in the remainder of this chapter, ensure
that the products listed above are properly installed on your systems. For
information about configuring and using SNAPI, see the Oracle Express
SNAPI Guide.

More than one Administrator user can connect to Express

Express supports multiple Administrator users.

In previous versions of Administrator, only one Administrator user could
connect to an instance of Express. Now multiple Administrator users can
connect to the same instance of Express.

About write access

Each database on Express supports one read/write database attachment and
multiple read-only database attachments.

Administrator supports read/write database attachments, meaning, when
you open a data database, it is opened with read/write access but the
XPDDDATA database is opened as read-only. Metadata that is
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automatically generated by Administrator for a data database is stored in
the data database itself.

Client applications will open a database as read-only, unless you set that
database’s ReadOnly property to “No,” which allows a client application to
open your database as read/write.

Defining the connection using the Express Connection Editor

Defining an Express Server 6 connection using the Express Connection
Editor requires information about the server string, the authentication type,
the security level, and so on. Additionally, you can make specifications for
accessing data in a relational database management system (RDBMS).

The instructions for defining a connection are located in the Express
Connection Editor Help system.
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Defining a connection file for an Express Server 6 connection

Use the following steps to define an Express Server 6 connection.

Step Action

1 Use the Express Connection Editor to define a new .XCF file.

The instructions for defining a connection are located in the Express
Connection Editor Help system.

2 Choose the Define  button.

3 Enter the connection file name and description of your choice.

4 Choose Express Server 6.x as the Express version.

5 In the Server String box, enter the name of the server machine on which
Express Server 6 is installed in the Host Name box.

6 Choose ncalrpc (for a Windows NT machine) or ora_ro_tcp (for a Unix
machine) as the Transport.

7

IF Express Server 6 is installed
on . . .

THEN . . .

a Windows NT machine and you
want to connect to any instance
other than the default instance,

specify the UUID. You do not
have to specify the UUID if you
want to connect to the default
instance.

a Unix machine, specify the end point. Also, in the
Authentication Type box, choose
Host (Server Login) .

8 Save the new .XCF file.
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Setting up to run Administrator, client applications, and Express Server 6
on the same Windows NT machine

When Administrator or a client application is installed on the same
Windows NT server as Express Server 6, use the following procedure to
define a connection file.

Step Action

1 Use the Express Connection Editor to define a new .XCF file.

If you do not know how to define a new .XCF file, refer to “Defining
Connections” in the Express Connection Editor Help system.

2 Choose the Define  button.

3 Enter the connection file name and description of your choice.

4 Choose Express Server 6.x as the Express version.

5 Choose ncalpc  as the transport protocol.

6 Save the new .XCF file.

Making the Oracle Express Client support files available

To run Administrator or the client applications with Express Server 6, you
must make the Oracle Express Client support files available on the Express
Server 6 machine. You can use the existing XPDDDATA.DB and other
application database files that already exist on the Express Server 6
machine.

If you start Administrator and cannot connect to Express Server 6, check
the server machine to make sure the files are available.
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Procedure: Making the Oracle Express Client support files available for
Express Server 6

Perform the following steps to make sure the Oracle Express Client support
files are available.

Step Action

1 Make sure the Oracle Express Client support files are in the directory in
which you expect them to be on the machine on which Express is installed,
for example, an \oec620 subdirectory. The files have the following names:

XADEMO.DB
XPADMIN.DB
XPDDCODE.DB
XPDDDATA.DB
XPDB.DB

2 Make sure the database file path of your directory (for example, oec620)
matches the ExpressServerDBPath configuration setting on the Express
Server 6 machine. If this setting is not correct, then neither Administrator nor
the client applications will be able to run.

To specify the database file path, use the Express Server Configuration
Manager. Select Edit Configuration Settings, choose Next , and select the
File I/O tab. Change the Server DBPath entry, then choose Set.

3 Be sure the permissions on the Oracle Express Client support files are set to
read-only.

4 Stop and restart the Express 6 service so that the new Server DBPath
setting will take effect.

If an Administrator or client application user attempts to connect to Express
Server 6 using security, Administrator or the client application will first
look for the location of the Oracle Express Client support files in the path
that is set up for the account being used. If an Administrator or client
application user attempts to connect to Express Server 6 without using
security, then the default user ID is used. If that user ID has a path set up,
Administrator or the client application will use this as its “home” directory.
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Related information

Search for the following topics in the Express Connection Editor Help
system:

“Defining Connections”
“Editing Existing Connections”
“Managing Connections to Relational Databases”

Step 5: Determining Security for an
Express Server 6 Connection
Introduction

Express Server 6 provides security support. General information about
setting up to use the security options is described in this topic.

Setting up security options

To set up the security options, specify Host (Domain Login) or Domain in
the Authentication Type box of the Express Connection Editor, then specify
a level in the Security Level box. The specifications you make determine:

� The kind of authentication (domain, host, or none)

� If you specify domain authentication (Windows NT only), the level at
which to prompt for authentication

� If you specify host authentication (Unix or Windows NT), whether to
perform domain or machine login

When you run Administrator and the client applications and attempt to use
an Express Server 6 connection that requires authentication, you will be
prompted for authentication. The values you enter for domain name and
user ID are stored in the Windows system registry.

The specifications you should make depend on whether Express is installed
on Windows NT or Unix, as discussed in the following topics.
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Security support for Express Server 6 on Unix

For Express Server 6, there are three levels of authentication you can
specify in the Express Connection Editor: domain, host, and none.

Host authentication should be used when Express is installed on a Unix
machine.  See “Security support: Using host authentication” for detailed
information.

Alternatively, you can specify no authentication.

Security support for Express Server 6 on Windows NT

For Express Server 6, there are three levels of authentication you can
specify in the Express Connection Editor: domain, host, and none.

Domain authentication is the preferred way of authenticating clients for
Windows NT Server and also for Express Server 6. It is highly secure and
provides different levels of authentication. Express Server 6 can set a
minimum level of authentication for all its clients. If you want to use
domain authentication, you must first meet the following requirements:

� The client and the server must be on the Microsoft network

� The user must have a domain account within the same domain that the
server machine is on

Host authentication should be used when the client machine is not on the
Microsoft network. See “Security support: Using host authentication” later
in this topic for detailed information.

Alternatively, you can specify no authentication. In this case,
unauthenticated clients will assume a default NT identity, which is read
from the NT server registry.

Security support: Using host authentication

You should use host authentication when:

� Express is installed on a Unix machine

� Express is installed on an NT machine, and the client machine is not on
the Microsoft network
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Host authentication provides only one level of authentication. However, it
can provide two different kinds of logins:

� Domain login — Use when the server machine is within the domain
and the user has a domain account

� Server machine login — Use when the server machine is not in the
domain (or if there is no domain account) and the user has a server
machine account

Step 6: Setting .INI File Options
Overview of setting .INI file options

You specify most connection information in the Express Connection Editor
and that information is stored in the connection files.

However, some information is stored in the Administrator and client
application .INI files in four options — ServerPrompt, ServerDefault,
Iconized, and ConnectToExpress, as described in this topic.

The ServerPrompt option

The ServerPrompt option specifies whether to prompt, with the Connect
dialog box, for the Express connection to make. You specify this option in
the [Express] section of the .INI file. It is also set automatically by the
Show this dialog on startup box in the Connect dialog box.

The valid settings are shown in the following table.

Setting Description

0 Specifies not to prompt for the Express connection to make. If the
ServerDefault option is not set, the Connect dialog box will be displayed
regardless of the ServerPrompt setting. (Default)

-1 Specifies to prompt for the Express connection to make.
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The ServerDefault option

The ServerDefault option specifies the name of the default Express
connection to make. You specify this name using the connection file name
without its extension in the [Express] section of the .INI file. You will
usually specify a setting for this option when the ServerPrompt option is set
to 0.

The ServerDefault option is also set automatically when you select the
Save Settings box in the Connect dialog box. The selected settings are used
as the default connection the next time a connection is made or when the
Connect dialog box is displayed. If the Connect dialog box is not displayed,
then an attempt is made to establish a connection using the default settings.

The ConnectToExpress option

The ConnectToExpress option specifies whether to connect to Express
automatically when a client application starts. Setting up a client
application to not connect to Express automatically on start up decreases
the application’s startup time. You specify this option in the [Options]
section of the client application .INI file. You cannot set up Administrator
to start without automatically attempting to connect to Express.

The valid settings are shown in the following table.

Setting Description

0 Specifies that the client application should not connect automatically to
Express.

1 Specifies that the client application should connect automatically to
Express.

2 (or when
this
setting is
omitted)

Specifies that the client application should connect to Express on
demand; that is, when the client application needs to access Express,
such as for opening a database.
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Using the Connections
How users can connect to and disconnect from Express

Once you have configured Express connections, users can use menu items
to connect and disconnect Administrator and the client applications to
Express while they are running.

Oracle Express Objects developers can write Express Basic code to
program connection and disconnection as part of an application they are
developing.

Express Spreadsheet Add-In users cannot manually disconnect from
Express

If your users’ client application is the Express Spreadsheet Add-In, be
aware that it cannot disconnect from Express. The Express Spreadsheet
Add-In connects on an attempt to open a database. For information, see
your Express Spreadsheet Add-In documentation.

Using connection menu options

When Administrator is connected to Express, the File menu contains the
Disconnect item. When you choose this menu item, all databases that are
connected through Administrator are closed. When Administrator is not
connected to Express, the File menu contains the Connect item.

When Oracle Express Objects or Express Analyzer is connected to Express,
the Database menu contains the Disconnect From Express item. When
this menu item is chosen, all databases that are connected through the
Express Client product are closed. This requires that any projects or
briefings that contain views or dimension list boxes that reference those
databases be closed. Only then is the connection to Express broken.

When an Express Client product is not connected to Express, the Database
menu contains the Connect To Express item.

In Express Client products, the Attach Database option on the Database
menu is available even if there is no Express connection. When this menu
item is chosen, an attempt is made to connect to Express.
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Using Express Basic for connections

In Oracle Express Objects and Oracle Express Analyzer, the connection to
Express is managed by the Express object. In Oracle Express Objects,
developers can use Express Basic to set the properties and to call the
methods of the Express object to manipulate the connection to Express at
runtime.

For information, see the Oracle Express Objects User’s Guide and Help
system.

Using multiple versions of Administrator

If you have more than one version of Administrator that you want to use,
each version of Administrator must attach the versions of the Oracle
Express Client support files that are associated with it.

To do so, add a setting to each connection file that you plan to use. Edit
your .XCF file. In the Express section of the .XCF file, add the option
SYSTEMDBPATH and the location of the Oracle Express Client support
files that are associated with the version of Administrator with which you
plan to use this particular .XCF file.

For example, suppose you are using two versions of Administrator:
Administrator 6.2 and Administrator 2.1. Suppose you want to connect
each version of Administrator to two different versions of Express Server 6
that are installed on the same remote machine. Make an .XCF file for each
Server connection. Now, suppose the Oracle Express Client support files
that are associated with Administrator 6.2 are located in the following
directory path.

C:\orant\olap\oes620\service\oec620

To ensure that Administrator 6.2 can find the correct support files when it
connects to Express, add the following line to the Express section of the
.XCF file that specifies that connection.

SystemDBPath=C:\orant\olap\oes620\service\oec620
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Suppose the Oracle Express Client support files that are associated with
Administrator 2.1 are located in the following directory path.

C:\orant\olap\oes620\service\oec210

To ensure that Administrator 2.1 can find the correct support files when it
connects to Express, add the following line to the Express section of the
.XCF file that specifies that connection.

SystemDBPath=C:\orant\olap\oes620\service\oec210
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Chapter 4

The Administrator Environment

Overview
Introduction

This chapter describes how to start and exit Express Administrator and its
environment.

In this chapter

� Starting and Exiting Administrator

� Understanding the Main Window

� Menus

� Toolbar

� Database Browser

� Setting Administrator Options

� Searching for Objects

� Using the Selector

� Property Inspector

� Using the Property Inspector

� Using Popup Menus

� Getting Information While You Work
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Starting and Exiting Administrator
Installing Administrator

Use the setup program to install Administrator.

For more information, refer to Appendix A, “Installing Administrator.”

Starting Administrator

To start Administrator, double-click on the Administrator program icon.

Depending on how Administrator is set up, you might be prompted to select
a connection. You must create a connection (.XCF) file to allow a
connection to Express; it will not work, otherwise. See Chapter 3 for
information on how to connect to Express.

Exiting Administrator

To exit Administrator, in the main window choose Exit  from the File menu.
When you exit, Administrator will terminate its connection to Express.

Understanding the Main Window
The Administrator main window

Once Administrator starts, you see the main window. It generally does not
display database information until you create or open a database.

The Administrator main window provides access to the tools and
information you use to create and configure databases. It contains a menu
bar, a toolbar, the Database Browser, and a status bar. The Database
Browser shows user-visible objects by default. You can also display the
Property Inspector in the main window, and you can use the right mouse
button to display popup menus.
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Figure: The Administrator main window

The following figure shows the Administrator main window with the
Express XADEMO database open and the Database Browser and the
Property Inspector displayed.
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Menus
Overview

The menu bar on the Administrator main window gives you access to
several menus.

Menu Used to Accomplish These Tasks

File � Create, open, save, and close databases

� Connect to and disconnect from Express

� Import and export data

� Import and export Express data

� Convert application databases

� Print the contents of the Database Browser

� Exit Administrator

Edit � Define, modify, copy, rename, and delete Express objects

� Add values to dimensions and create and modify hierarchies

Tools � Modify properties of open Express databases

� Start the Database Wizard to create an Express database

� Start the Rollup Wizard to roll up data over hierarchical
dimensions

� Select a current SQL connection

� Start and display the Oracle Express Relational Access
Administrator

� Set Administrator options

Run � Write and execute Express commands

� Execute a program

� Schedule program execution

� Monitor scheduled batch jobs

View � Specify whether Administrator displays the Database
Browser showing all objects, or filtering criteria results

Window � Arrange the layout of the Database Browser and the
Inspector

� Arrange a minimized Database Browser and Inspector

Help � Access Administrator and Express Language Help systems
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Related information

If you need more information about a menu as you work in Administrator,
search for the following topics in the Administrator Help system:

“Edit Menu”
“File Menu”
“Help Menu”
“Run Menu”
“Tools Menu”
“View Menu”
“Window Menu”

Toolbar
Overview

The buttons on the Administrator toolbar provide shortcuts for frequently
used actions. The following table shows each button on the toolbar and its
action.

Button Purpose Menu Equivalent

Create a new database Choose New from the File menu

Open an existing database Choose Open  from the File menu

Close an existing database Choose Close  from the File menu

Save changes to an
existing database

Choose Save from the File menu

Save changes to all
databases

Choose Save All  from the File menu

Connect to Express Choose Connect  from the File menu

Disconnect from Express Choose Disconnect  from the File menu

Copy a database object Choose Copy  from the Edit menu

Rename a database object Choose Rename  from the Edit menu
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Button Purpose Menu Equivalent

Delete a database object Choose Delete  from the Edit menu

Display the Property
Inspector

Choose Property Inspector  from the Tools
menu

Display the Filter Database
Objects dialog box

Choose Filter  from the View menu

Display the Express
Command window

Choose Express Command  from the Run
menu

Define a dimension Choose Dimension  from the Define
submenu of the Edit menu

Define a variable Choose Variable  from the Define submenu of
the Edit menu

Define a relation Choose Relation  from the Define submenu of
the Edit menu

Define a formula Choose Formula  from the Define submenu of
the Edit menu

Define a program Choose Program  from the Define submenu
of the Edit menu

Display the Edit Dimension
Values dialog box

Choose Values  from the Edit menu

Display the Database
wizard

Choose Database Wizard  from the Tools
menu

Display the Rollup wizard Choose Rollup Wizard  from the Tools menu

Display the SQL
Connections dialog box

Choose Relational Connections  from the
Tools menu

Display the Help system
contents screen

Choose Contents  from the Help menu

Related information

For detailed information about these buttons and the dialog boxes they
display, search the Administrator Help system for the topic “Main
Toolbar.”
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Database Browser
Definition of the Database Browser

The Database Browser displays the names of the currently open databases
and their objects.

Types of display

You can display the Database Browser in one of three states. It can show all
objects, only user-visible objects, or the results of a filtering operation. Use
the View menu to specify which state is currently shown.

With any state, the Database Browser displays objects that are defined in all
open databases, arranged according to object type.
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Figure: All objects are displayed in the Database Browser

The following figure shows the Database Browser displaying all objects in
the Express XADEMO database.

How to display different levels of detail

The plus and minus signs next to the object types let you control how much
detail you see in the Database Browser:

� Click on the plus sign next to an object type to display all database
objects of that type.

� Click on the minus sign to display only the object type and not the
individual objects.
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Setting Administrator Options
Overview

You can set various Administrator options through the Administrator
Options dialog box. To open the Administrator Options dialog box, choose
Options from the Tools menu.

There are five tabs in the Administrator Options dialog box. This topic
describes each of the tabs and explains which options are available in each
tab.
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The General tab

In the General tab in the Administrator Options dialog box, you can specify
a system shutdown program. A system shutdown program is a program that
runs every time an Express Client product closes. Such a program might
disconnect users from a remote system or reverse the operations of a system
preprocessor, for example.

You can also use the General tab to specify whether you want to display the
status bar in the main window.

The following figure shows the General tab.
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The Format tab

Through the Format tab in the Administrator Options dialog box, you can
specify the basic format for displaying numeric data in Administrator. You
can choose whether to display leading zeroes, which characters to use for
the thousands and decimal separators, and how many decimal places to
show. In addition, you can specify the format for positive and negative
numeric values and currency values.

The following figure shows the Format tab.
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The Relational tab

The Relational tab in the Administrator Options dialog box allows you to
specify options for relational databases. You can specify the maximum
number of records of data to fetch from the relational database. You can
also specify what value to put in the cell of an Express object when the
corresponding value in the relational table does not exist (the NA value
setting).

The following figure shows the Relational tab.



Setting Administrator Options

79

The Toolbar tab

In the Toolbar tab in the Administrator Options dialog box, you can specify
options that are related to the toolbar in the Administrator main window.
You can specify whether or not the toolbar is displayed, whether to show
text for each button on the toolbar, and the position of the toolbar on the
screen. You can also customize the toolbar by specifying which buttons
appear on the toolbar and setting the order in which they are displayed.

The following figure shows the Toolbar tab.
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Procedure: Customizing the Toolbar

The following procedure describes how to customize the main window
toolbar.

Step Action

1 From the Tools menu, choose Options  to display the Administrator Options
dialog box.

2 Select the Toolbar tab.

3 In the Toolbar tab, choose Customize .

4

IF . . . THEN . . .

you want to add one or more
buttons to the toolbar,

select the buttons you want to
add in the Available Buttons box
and choose Add .

you want to remove one or more
buttons from the toolbar,

select the buttons you want to
remove in the Toolbar Buttons
box and choose Remove .

you want to reset the toolbar to
the default (all buttons displayed),

choose Reset .

you want to change the order in
which the buttons are displayed
from left to right,

select a button in the Toolbar
Buttons box and choose either
Move Up  to move the button up
one position in the display order
or Move Down  to move the
button down one position in the
display order.

5 When you have finished, choose Close  to save any changes and close the
Customize Toolbar dialog box.
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The DB Browser tab

Through the DB Browser tab in the Administrator Options dialog box, you
can specify options that are related to the Database Browser. You can
specify whether to show only names, only descriptions, or both names and
descriptions for all objects. You can specify whether to display all metadata
or only standard metadata (dimensions, hierarchies, parent-child
relationships, and long and short labels) for all objects. Selecting Show
object designated as not user visible causes the Database Browser to
display objects that are not normally visible to users.

The following figure shows the DB Browser tab.



Chapter 4  The Administrator Environment

82

Searching for Objects
Purpose of searching for objects

If you are working with one or more databases that contain many objects,
you might lose track of particular objects. If this happens, you can search
for the objects in one or more databases.

Searching for user-visible objects is especially helpful when viewing lists
of the dimensions and the measures with which client application users will
work.

The criteria you can use

You can search using various criteria, including the following:

� Whether the object is dimensioned by a certain object

� What the object’s type is (dimension, variable, and so on)

� What the object’s data type is (Decimal, Text, and so on)

� Whether the object’s name contains certain characters

� Whether the object is referenced by another object

You enter these criteria in the Filter Database Objects dialog box. The
search results are displayed in the Database Browser.
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Figure: Filter Database Objects dialog box

The following figure shows the Filter Database Objects dialog box.

Viewing the results of the search

Once you specify the criteria, the results of your search are displayed in the
Database Browser.

You can switch between viewing all objects in the Database Browser and
viewing the results of your search by choosing Standard view and Filter
Results from the View menu.

The following operations affect the display of the Database Browser:

� Whenever you choose Filter Results, Administrator executes a search
using the most recently specified search criteria.

� Whenever you perform a database operation (such as opening or
closing database files), Administrator disables the Filter Results menu
item, and you must define the search criteria again.
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� Whenever you exit  and re-enter Administrator, the Database Browser
displays the standard view.

Related information

For more information on searching for objects, search for the following
topics in the Administrator Help system:

“Filter Database Objects Dialog Box”
“Searching for Database Objects”

Using the Selector
Definition of the Selector

The Selector is a set of tools that allows you to create a saved selection for
a dimension and to limit the data that is displayed in the Data tab of the
Modify Formula, Modify Relation, and Modify Variable dialog boxes. The
Data tab of these dialog boxes displays the first 2,500 values of each
dimension. If you want to see a particular selection of data, you must first
limit the dimension values in the Selector.

How to display the Selector

You can display the Selector by choosing Selector in the Data Tab of the
Modify Formula, Modify Relation, and Modify Variable dialog boxes or
by choosing Create in the Saved Selections tab of the Modify Dimension
dialog box.
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Figure: The Selector

You use the Selector to select a set of dimension values as a saved selection
or to be viewed on the Data tab of a Modify Object dialog box. The
following figure shows the Selector for the Budget variable in the
XADEMO database.
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Selector tools

The buttons on the Selector toolbar provide shortcuts for you to select a set
of dimension values. The following table shows each tool and its function.

Button Function

All tool — Selects or deselects all values of a dimension or dimension
hierarchy.

List tool — Selects or deselects values from the list of values in a
dimension.

Match tool — Selects dimension values that contain a specified string of
characters.

Level tool — Selects or deselects dimension values at one or more levels
of a hierarchy.

Family tool — Selects or deselects dimension values based on a family
relationship with a particular dimension value.

Attribute tool — Selects or deselects a group of dimension values that
have a common attribute such as color or size.

Exception tool — Selects or deselects dimension values based on
comparison of measure values to another value or values.

Top/Bottom tool — Selects or deselects the largest or smallest data values
in a given measure.

Range tool — Selects or deselects a range of time periods.

Saved Selection tool — Selects or deselects dimension values in a saved
selection.

Sort tool — Sorts dimension values using criteria you specify.

Related information

For more information about using the Selector, search for the following
topics in the Administrator Help system:

“Selector Dialog Box”
“Using the Selector”
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 Property Inspector
Definition of the Property Inspector

The Property Inspector displays the properties of a database or database
object. A property specifies an attribute of a database or an object.

Common use of the Property Inspector

You can use the Property Inspector to change the settings of many
properties. You set some properties in dialog boxes when you create or
modify objects. Some properties are read-only in the Property Inspector.

You cannot set read-only properties; Administrator sets their values.

Purpose of the Property Inspector tabs

There are three tabs in the Property Inspector:

� The Properties tab shows the current settings of the object’s properties.

� The Advanced tab shows information about objects that are stored in
the database. The Advanced tab shows statistics for variables and
dimensions. For other Express objects, the Advanced tab is dimmed.

� The Language tab displays the selected languages for the database. The
setting in the Language tab sets the status of the database language
dimension so that you can enter, for example, Spanish descriptions for
your saved selections. The Language tab shows the language for the
database. For other Express objects the Language tab is dimmed.
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Displaying the Property Inspector

To display the Property Inspector, either:

� From the Tools menu, choose Property Inspector.

or

� Click on the Property Inspector button on the toolbar.

or

� Select the item in the Database Browser, click the right mouse button,
and from the popup menu, choose Property Inspector.

Using the Property Inspector
Displaying an object’s properties in the Property Inspector

With the Property Inspector open, select an object in the Database Browser.
The properties of the selected object appear in the Property Inspector.

Figure: Displaying a dimension’s properties

The following figure shows the Property Inspector displaying some of the
properties of the Geography dimension.
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Property Inspector buttons

The Property Inspector has a three-button toolbar. The following table
shows each button and its function.

Button Function

Closes the Property Inspector

Displays the Modify Object dialog box for the currently selected object

Displays Help for the Property Inspector

How to display read-only statistics

When you inspect dimensions or variables, the Advanced tab shows
read-only statistics about the selected object. When you click on the
Advanced tab, Administrator calculates these statistics. On a large
dimension or variable, this calculation may take some time.

Figure: The read-only statistics of the Geography dimension

The following figure shows statistics for the Geography dimension.
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Related information

For more information, search for the topic about the property you want to
set or for the following topics in the Administrator Help system:

“Editing Programs and Models”
“Modifying Dimensions”
“Modifying Formulas”
“Modifying Relations”
“Modifying Variables”
“Property Inspector”
“Setting Object Properties”

Using Popup Menus
Context sensitive menu

The right mouse button popup menu is context sensitive. It includes
different items depending on whether you select an item in the Database
Browser, or place the cursor in the application window outside the
Database Browser. When you select an item in the Database Browser, the
items on the menu change depending on your selection.

Getting Information While You Work
Overview

When you are working in Administrator, there are various ways to get
assistance for tasks you want to perform.

The Help system

You can access the Help system in the following ways:

� Help menu — From the Help menu on the main menu bar, choose
Contents, Search For Help On, or Express Language.
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� F1 key — View Help for the current item by pressing the F1 key. This is
called context-sensitive Help. For example, when you press F1 in a
dialog box, you see the Help topic that describes that particular dialog
box.

The Help menu items

The following table describes the items on the Help menu.

IF you choose . . . THEN you see . . .

Contents, the main contents screen of the Administrator Help
system.

Search For Help On, the Index tab of the Administrator Help system, from
which you can search for topics on which you need
help.

Express Language, the main contents screen of the Express Language
(version 6.0) Help system.

The Glossary button

The Help System also has a glossary that you can access from the Glossary
button at the top of the Help window.

The status bar

The status bar at the bottom of the main window displays useful
information, which varies depending on your task.

The mouse pointer

The appearance of the mouse pointer changes, depending on the task you
are doing. Some mouse pointers are standard in Windows; for example,
when you see the “wait” pointer, which is shaped like an hourglass, you
know the system is busy and you must wait for it to finish before you can
continue.
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Chapter 5

Planning Your Database

Overview
Introduction

This chapter describes the issues you need to address in planning your
database to assure that you can create it efficiently and that the database
uses computer resources efficiently.

In this chapter

� How Do Users Need to View the Data?

� What Are the Data Sources?

� Identifying the Data

� Organizing the Data

� Organizing the Dimensions

� Starting with a Relational Database

� Example: A Relational Database

� The Sample Express Database

� Think About Performance Now

� Getting Data into an Express Database
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How Do Users Need to View the Data?
What you should find out

Your first step in planning an Express database is to find out what your
users need. Once you find out who your users are, ask them:

� What data they want to analyze

� What types of queries they want to make on the data

� At what level of detail they need to view this data

Get detailed information

When you ask your users about their needs, get as many details as possible.
For example, how do they want to see the data displayed when they view
it?

Suppose your users want to view sales data for a product. You learn that
they want to see the data displayed for all regions for the last six months.
Do they want to see the products listed vertically, regions listed
horizontally, and one month’s data on a page? Or do they want to view
products listed vertically, months listed horizontally, and one region’s data
on a page?

The more information you can gather about your users’ needs, the easier it
will be to plan an effective database.

Example: Possible user needs

The following table shows an example of information about users’ needs.

User Need

All users Want to project sales of different categories of products in
different regions

Sales managers Want to know the volume of sales generated by each
employee, as well as employee salary and hire date

Distribution
managers

Want to compare sales volume in different stores at the
regional level

Financial planner Wants to compare budget and actual expenses



What Are the Data Sources?

95

What Are the Data Sources?
Overview

Your Express database’s data will probably reside in one or more locations,
and you will have to retrieve it into the Express database. Most likely, the
data will exist either in a relational database or in a file.

If the data exists in a relational database, your job is to define an Express
database and the Express objects to which the data in the relational
database will map. You will then set up a SQL connection and perform
tasks to enable the data to be fetched from the relational database into the
Express database.

If the data exists in a file, your job is to define an Express database and the
Express objects that will hold the data. You will then use Administrator to
generate a data loader program and run that program to read the data from
the file into the Express database. If your data file is in the format required
by the Data Wizard, you can use the Data Wizard to perform all of these
tasks quickly and easily.

Regardless of where the data currently resides, you should first look at
existing data and figure out how that data maps to your users’ needs.

What do your users really want?

Compare the data you have with the way in which your users need to view
it.

Suppose your data source provides sales data for every day of the week. It
may be unlikely that any of your users need to view daily sales data.
Instead, a manager may need to view sales data that is organized by week
or by month. On the other hand, an executive may need to view the same
data that is organized by quarter or by year.

This means you need to create a structure to accommodate the way in
which the data is currently structured, such as sales data that has been
recorded on a daily basis. You then need to plan how to accommodate the
higher-level needs of your users.
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How can you structure data to meet your users’ needs?

When you plan the structure for the data, think in terms of hierarchies.
What is the lowest level of data you have — meaning, what is the most
detailed level of data? How can that data be grouped into a higher level?
Can those groups be grouped into even higher levels?

For example, suppose the data source you will be using consists of sales
data that is recorded on a daily basis. You can group that daily data (the
most detailed level) into weekly data. The weekly data can be grouped into
monthly data. The monthly data can be grouped into quarterly data. The
quarterly data can be grouped into yearly data (the least detailed level),
whether your business operates on a calendar year or a fiscal year.

Therefore, plan a hierarchy with levels of day, week, month, quarter, and
year. You will begin with data at the lowest level of the hierarchy, and your
job will be to aggregate that data into the higher levels of the hierarchy.

Think in terms of hierarchies for most, if not all, of the different ways you
need to organize your data. For example, if data is organized by products,
begin with the lowest data level you have for products. Suppose you have
data for products ranging from tents to snowshoes. Find out how your users
expect those products to be grouped. Tents might belong to a Camping
product group, and snowshoes might belong to a Sporting Equipment
product group. Or tents might belong to a Summer product group, and
snowshoes might belong to a Winter product group.

Example: Mapping data to users’ needs

Suppose your distribution managers want to compare sales volume in
different stores at the regional level.

What does that mean? You have sales data for each store, but how do you
map this data to the way in which the distribution managers want to view it
in an Express database?

Because your users want to view data at a regional level, think in terms of
geography. There may be several stores in each city. Those cities may be
grouped by state, and those states may be grouped into geographical
regions. This is an example of when you should consult with your users and
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find out the structure they need to view. If they don’t need information at a
state level, you may need to structure stores into cities and cities into
regions.

Identifying the Data
Identify and name every category of data

Typically, data is numeric. Look at the data in your relational database or
file, and determine how many categories of data you have and how to
identify that data.

For example, you might have sales data, which is usually decimal, such as
the dollar amount of products that were sold. You might have integer data
that identifies how many items of a product were sold — or the “units”
sold. If the data is financial data, you may identify categories of “budget”
(decimal data that represents departmental budgets) and “actual expenses”
(decimal data that represents the money actually spent by those
departments).

Example: Identifying data categories

In the following table, the data categories are shown in bold text.

User Need

All users Want to project sales  of different categories of products in
different regions

Sales managers Want to know the volume of sales  generated by each
employee, as well as employee salary  and hire date

Distribution
managers

Want to compare sales  volume in different stores at the
regional level

Financial planner Wants to compare budget  and actual expenses

Data is held by variables

In an Express database, data is held by variables. Once you have identified
your categories of data and named them, you can plan your variables.
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For example, if you have sales data, plan on defining a variable named
SALES. If you have budget data, plan on defining a variable named
BUDGET. Once you identify your data, you have identified your variables.

Plan first, define later

One of the reasons for planning a database is to map out the most efficient
way to build it.

Because variables are dimensioned, you must define all of the dimensions
before you can define the variables. In other words, you cannot include a
dimension in a variable’s definition until that dimension actually exists.

Therefore, you can look at the data and decide which variables you need to
define. You can then look at the way in which your users need to have the
data organized, and determine which dimensions you need and what their
dimension values will be. Finally, you will define all of those dimensions,
and then define the variables.

Organizing the Data
Use dimensions to organize your data

In an Express database, variables hold the data, and that data is organized
by dimensions.

For example, suppose your data is sales data. That data will be held in a
variable named SALES. Suppose your users want to view sales data for all
products in different geographic regions for the past six months. The
dimensions that organize the SALES variable would be PRODUCT,
GEOGRAPHY, and TIME.

Definition: Data cube

An Express data cube refers to the same group of dimensions in exactly the
same order (from fastest-varying to slowest-varying). For example, suppose
you have two variables: SALES and PROJECTED SALES. If each variable
is dimensioned by PRODUCT, GEOGRAPHY, and TIME, then those
variables share the same data cube. However, if PROJECTED SALES is
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dimensioned by TIME, PRODUCT, and GEOGRAPHY, the variables have
different data cubes because the dimensions are organized in a different
order.

When you define a variable, you specify its dimensions and the exact order
of those dimensions. You can define several different variables that have
the same dimensions in the same order. Even though those variables
contain different data, they are considered to share the same data cube —
they share the same organization of data.

A star schema is a relational database structure that often organizes a data
warehouse. A unique star schema in relational technology resembles a
unique data cube in multidimensional technology.

Decide how many cubes you have

When you plan your database, it is a good practice to determine how many
variables will have the same dimensions in the same order. Those variables
will all share the same data cube.

If variables have the same dimensions, you should put the dimensions in
the same order (from fastest-varying to slowest-varying) for each variable
whenever possible. In this way, you will keep the number of data cubes to a
minimum.
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Example: Determining the dimensions

The following table shows an example of information about users’ needs
and how their needs map to Express variables and dimensions. The
dimensions are shown in their recommended order, from fastest varying to
slowest varying.

User Need Dimensions Required

All users Want to project sales of different categories
of products in different regions

GEOGRAPHY
PRODUCT
TIME

Sales
managers

Want to know the volume of sales generated
by each employee, as well as employee
salary, hire date, and at what store each
employee works

EMPLOYEE
TIME

Distribution
managers

Want to compare sales volume in different
stores at the regional level

GEOGRAPHY
PRODUCT
TIME

Financial
planner

Wants to compare budget and actual
expenses for each division

TIME
LINE
DIVISION
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Example: Determining all Express objects

The following table provides a summary of the Express objects that are
created from the sample user needs.

Express Object Who Needs It

Sales variable, dimensioned by
geography, product, and time (SALES)

All users, distribution managers

Employee sales variable, dimensioned by
employee and time (EMP_SALES)

Sales managers

Budget variable, dimensioned by time,
line, and division (BUDGET)

Financial planner

Actual expenses variable, dimensioned by
time, line, and division (ACTUAL)

Financial planner

Employee’s salary variable, dimensioned
by employee and time (SALARY)

Sales managers

Employee’s hire date variable,
dimensioned by employee (HIRE)

Sales managers

Geography dimension (GEOG) SALES variable

Product dimension (PROD) SALES variable

Time dimension (TIME) SALES, EMP_SALES, BUDGET, and
ACTUAL variables

Employee dimension (EMPLOYEE) EMP_SALES, SALARY, and HIRE
variables

Line item dimension (LINE) BUDGET and ACTUAL variables

Division of products dimension (DIVISION) BUDGET and ACTUAL variables

Relation of the employee and geography,
whose values include the store where
each employee works
(EMP_GEOGRAPHY)

Sales managers

There is one relation in the above table: EMP_GEOGRAPHY. A relation is
an Express object that you define in order to establish a relationship
between two dimensions.

Once you have defined both dimensions and assigned dimension values to
them, you can associate a dimension value from one dimension with a
dimension value of the other dimension. This is how you assign an
attribute. An attribute is a fact about a dimension value. If your dimension
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has a hierarchy, attributes usually apply to only the lowest level of that
hierarchy.

Now, compare the Express objects with the original user needs, as shown in
the following table, in which the data categories are shown in bold text.

User Need

All users Want to project sales  of different categories of products in
different regions

Sales managers Want to know the volume of sales  generated by each
employee, as well as employee salary  and hire date

Distribution
managers

Want to compare sales  volume in different stores at the
regional level

Financial planner Wants to compare budget and actual expenses

Organizing the Dimensions
Figure out each dimension’s hierarchy

It is likely that most, and possibly all, of the dimensions you define will
have hierarchies. Before you define each dimension, figure out every level
of its hierarchy and how each level will aggregate into the next.

For example, a sales variable may be organized by geography, product, and
time dimensions. Determine the hierarchy for each dimension.

What is the sales data source in terms of geography? Suppose the data has
been entered for every store in a city. The lowest level of your geography
dimension would be the Store level. At what levels do your users need to
view geographical information? Do some users need to view data at the city
level? Do others need to view it at a regional level? The way in which they
need to view geographical data will determine the levels of the hierarchy.

Think about the hierarchy for each dimension in the same way. Look at the
data source to determine the lowest level of that dimension’s hierarchy.
Then use the information about how your users need to view the data to
determine the levels of the hierarchy.
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Do you need multiple hierarchies?

It is possible to have more than one hierarchy for the same dimension.

A dimension has dimension values, which are usually text data types. For
example, suppose you have a GEOGRAPHY dimension whose data source
specifies data for the Store level. The dimension values that represent
individual stores could be STAR, STOP&SHOP, PURITY, and so on.
Suppose those stores aggregate to a City level. The dimension would also
have dimension values for every city, such as BOSTON, DENVER, and
SEATTLE. If those cities aggregate into regions, you will need dimension
values for every region, such as EAST, CENTRAL, and WEST. If the
regions aggregate into a final value, you will need a dimension value such
as TOTALUSA.

Suppose you have users who need geographical information, but they have
different needs in how that data is aggregated. For example, some users
may need data for the United States that groups all states into regions of
east, midwest, and west. Other users may need data that groups all states
into regions of north and south. You can use the same dimension to meet all
of your users’ needs. However, you need to create a different hierarchy for
different ways of aggregation.

The dimension will contain the dimension values that are needed by each
hierarchy. For example one hierarchy will need EAST, MIDWEST, and
WEST dimension values; the other hierarchy will need NORTH and
SOUTH dimension values. You will create all of these dimension values in
the same geography dimension. You will then create each hierarchy, in
which you will specify which dimension values to use and how they relate
to each other. Some values may not be mapped for various hierarchies,
because those values are not used.

Define the dimensions first, then define the variables

Define your dimensions first. Furthermore, add dimension values to each
dimension, and define one or more hierarchies, if you need them.

Once your dimensions are set up, you can then define your variables.
Remember that it is not possible to define a variable until its dimensions
exist.
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Starting with a Relational Database
A sample relational database

Suppose you come from a relational database world, and this is your first
exposure to multidimensional databases.

It may be helpful to look at a sample relational database. The following
topics show how you can take a data structure that you already understand
(tables) and translate that structure into an Express database.

How relational database terms map to Express terms

The primary-key and foreign-key relationships in a database reveal strong
associations between tables. These associations are likely to become
dimensions in an Express database.

In terms of a star schema, the star centers (or fact tables) are variables. The
radiating star points are dimensions.

Know your relational database

Acquire a diagram of the relational database that identifies the table names,
the relations between tables, the primary and foreign key columns, and the
column names.

Know your data

You need to decide exactly what information you want to fetch into your
Express database:

� Identify the variables that you want to create in your Express database.
Locate the table and column names where this information resides in
the relational database. Also note the exact data type of each column.
Keep in mind that most data variables contain numeric data that
typically appears in the body of a report.

� Identify the dimensions you need in order to define the variables.
Locate the table and column names where this information resides in
the relational database. Also note the exact data type of each column.
The key columns in a relational database serve the same function as the
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dimensions in an Express database. Dimension values typically appear
as labels that identify the rows and columns of a report.

Data selection and retrieval in Express is quicker when dimension
values are short. Therefore, if codes are available in the relational
database, use them for dimension values. Store the longer descriptive
labels in metadata objects that are automatically generated by
Administrator for every variable.

� Find out at which levels the data is stored in the relational database. If
the data needs to be aggregated to the desired level of detail, decide
whether you want SQL or Express to perform the aggregation.
Generally, you should use SQL to perform simple aggregations, using
the GROUP BY clause of a SELECT statement.

Define Express database objects

Define the database objects, such as dimensions and variables, in your
Express database.

Fastest- and slowest-varying dimensions

When defining a variable or formula, you must decide which dimensions
you want to be the fastest and slowest varying. This is an important
decision, since it will affect the ongoing performance of the database. See
the topic “Dimension order matters: From fastest- to slowest-varying
dimension” for more information.

When defining a variable, specify the fastest-varying dimension first and
the slowest-varying dimension last.

Optimized for loading

Databases that are updated frequently are often optimized for loading data.
If this is your goal, you should define Express variables so that the order of
the dimensions reflects the way the data is stored in the relational tables.

Optimized for use

Some databases are optimized for data analysis and reporting. For this type
of database, the variable should be defined so that the dimension order
reflects the way most users are going to view the data most of the time. In a
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typical report, the values of the fastest-varying dimension should identify
the columns, and the values of the next fastest-varying dimension should
identify the rows. The values of the other dimensions identify individual
pages.

Example: A Relational Database
Determining how to map information from a relational database

Suppose you have a sample relational database that contains corporate data
for a fictitious electronics company. It has four tables: Stores, Products,
Shipments, and Shipments_Detail.

To determine how to map the information from your relational database to
an Express database, begin by examining the normalized, logical view of
your relational database. Trace primary-key and foreign-key relationships
to determine which Express dimensions you need to define, as well as their
hierarchies.

Stores table

The Stores table has a row for each retail outlet. The STORE_ID column is
the primary key and uniquely identifies each store.

The following table shows sample data from three columns of the Stores
table.

SQL> select store_id, store_name, city from stores;

STORE_ID STORE_NAME            CITY
-------- --------------------- ------------
G4       Sears                 Boston
G5       Cambridge Sound       Cambridge
G6       New England Stereo    Boston
G7       Tweeter               Burlington
G8       Tweeter               Nashua
            .
            .
            .
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Products table

The Products table contains a row with information about each product.
The PROD_ID column is the primary key and uniquely identifies each
product.

SQL> select * from products;

PROD_ID    PROD_NAME              SUGGESTED_PRICE
---------- ---------------------- ---------------
P9         CD Player                       248.95
P10        Receiver                        298.95
P11        Amplifier                       189.95
P12        Cassette Deck                   159.95
P15        Color TV                        499.95
P16        B & W TV                         74.95
P17        Portable TV                     169.95
P19        Standard VCR                    179.95
P20        Stereo VCR                      289.95
P22        VHS Camcorders                  599.95
P23        8MM Camcorders                  799.95
            .
            .
            .

Shipments table

The Shipments table contains a row for each purchase order. The
ORDER_NO column is the primary key.

The STORE_ID column is a foreign key and contains store identification
numbers listed in the STORE_ID column of the Stores table. The
STORE_ID columns of the Shipments and Stores tables create a
relationship between the two tables.
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The same store identification numbers can appear in numerous rows, once
for each order placed by a particular retail outlet. In the following sample of
data from the Shipments table, store G16 appears twice.

SQL> select * from shipments;

ORDER_NO     STORE_ID CUST_PO         TIMESTAMP
------------ -------- -------------   ---------
OR25         G6       2FD963718       12-MAR-96
OR26         G20      2243-3122-05    12-MAR-96
OR27         G21      379711          12-MAR-96
OR28         G11      2332628347      12-MAR-96
OR29         G13      786219190       19-MAR-96
OR30         G16      163222          19-MAR-96
OR31         G19      41311A          26-MAR-96
OR32         G12      CED43567        26-MAR-96
OR33         G16      166884          26-MAR-96
            .
            .
            .

Shipments_Detail table

The Shipments_Detail table identifies the quantity and type of items
ordered.

The primary key is composed of two columns, ORDER_NO and
PROD_ID.

The ORDER_NO column is also a foreign key containing values from the
ORDER_NO column of the Shipments table. The ORDER_NO columns of
the Shipments and Shipments_Detail tables create a relationship between
these two tables.
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The PROD_ID column is also a foreign key containing values from the
PROD_ID column of the Products table. The PROD_ID columns of the
Products and Shipments_Detail tables create a relationship between these
two tables.

SQL> select * from shipments_detail where units < 100;

ORDER_NO     PROD_ID    UNITS      SELLING_PRICE
------------ ---------- ---------- -------------
OR51         P10        54         14528.97
OR51         P11        73         12479.71
OR51         P12        76         10940.58
OR51         P19        59          9555.35
OR51         P23        83         59756.27
OR51         P24        55         32172.52
OR52         P9         76         17028.18
OR52         P11        74         12650.67
OR52         P17        84         12848.22
OR52         P22        53         28617.62
OR53         P10        69         18564.79
             .
             .
             .

Diagram of the relational database

Following is a diagram of the database. The primary keys are shaded and
the relationships between tables are identified by arrows between them.
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The Sample Express Database
Introduction

You can use the tables shown in the previous topic to create an Express
data variable named V.UNITS. It is dimensioned by geography, product,
and time dimensions, which are named GEOG, PROD, and TIME,
respectively.

Since the relational tables provide codes for both stores and products, the
Geography and Product dimensions use these codes as their dimension
values. The full names for the stores and products are stored in metadata
objects so that they are available for labeling the data in reports, but they
are not used for storing and selecting data.

In the relational database, the order number is critically important for
tracking individual sales. However, it is not an important factor from the
standpoint of analytical processing. This information is not retrieved into
the Express database.

Geography dimension

The values for GEOG, the geography dimension, are fetched from the
STORE_ID column of the Stores table. The GEOG dimension contains
identification numbers for all the stores, since the numbers are obtained
from a primary key. A report of the first five values in GEOG is shown
below.

GEOG
--------------
G11
G12
G13
G14
G15

Product dimension

The product dimension, PROD, also acquires its values from a primary key
to get a complete list of all products. The product values are fetched from
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the PROD_ID column of the Products table. A report of the first eight
values in PROD is shown below.

PROD
--------------
P10
P11
P12
P15
P16
P17
P19
P20

Time dimension

Time dimension values are fetched from the TIMESTAMP column of the
Shipments table. A report of the first eight values in TIME is shown below.

TIME
--------------
W6.95
W7.95
W8.95
W9.95
W10.95
W11.95
W12.95
W13.95

Notice that, as an example, the date values from the relational table were
converted to a weekly format when they were brought into the TIME
dimension in the Express database.

V.UNITS variable

The number of items sold is fetched from the UNITS column of the
Shipments_Detail table and stored in a variable named V.UNITS. This
variable is dimensioned by GEOG, PROD, and TIME.
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Summary of sample Express objects

The following table provides a summary of the Express objects that are
created from the sample relational database.

Express Object Column to Which It Maps

Geography dimension (GEOG) STORE_ID column of Stores table

Product dimension (PROD) PROD_ID column of Products table

Time dimension (TIME) TIMESTAMP column of Shipments table

Units variable, dimensioned by
geography, product, and time (V.UNITS)

UNITS column of Shipments_Detail table

Geography labels metadata object
(G0.longlabel), which is automatically
generated by Administrator

STORE_NAME column of Stores table

Product labels metadata object
(P0.longlabel), which is automatically
generated by Administrator

PROD_NAME column of Products table

Think About Performance Now
Why this matters

The way in which you define Express objects, especially variables, will
affect the efficiency and performance of your database.

For example, if you take some basic steps to design your variables well, it
can minimize the time it takes to load data and aggregate that data
throughout your dimension’s hierarchies.

Dimension order matters: From fastest- to slowest-varying dimension

When you define a variable, you specify the dimensions that will organize
its data. Furthermore, you specify the dimensions in a specific order.

The first dimension you specify is the fastest-varying dimension, which is
the one whose values vary first in an Express command or function that
loops over the dimensions of the expression.
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The last dimension you specify is the slowest-varying dimension, which is
the dimension whose values vary least.

For example, suppose you have a variable dimensioned by MONTH (the
fastest-varying dimension) and CITY (the slowest-varying dimension).
When you or your users view the variable, you will see the data for all
months for the first city before you see any data for the second city.

Dimension order matters because it determines the default way in which
data is displayed, and it plays a role in performance issues.

Defining sparse variables

It is likely that you will not have data to fill up an entire data cube. For
example, suppose you have a data cube of Geography, Product, and Time
dimensions. Some of your products may be seasonal, and therefore will
have sales data for only a few months out of the year. Or your products may
be regional — for example, you may sell snowshoes in Alaska but not in
Florida. As a result, your data will be sparse, meaning there are large areas
of your data cube for which a variable will have no data.

Having sparse data can slow down performance and make your database
larger than necessary. However, if you identify a variable as likely to have
sparse data, you can maximize performance and reduce database size.

Unless you know your data is dense, meaning the data cube will be full or
nearly full of data, a good practice is to specify all but the fastest-varying
(the first) dimension as sparse dimensions.

Consider using formulas

A formula is an Express object that you define in a database. You should
consider defining formulas for calculations that are used frequently and that
involve frequently updated data. You should also define formulas for
retrieving data from a relational database. Formulas are calculated at the
time they are used, and the resulting values are not stored in the database.

You can store a single expression in a formula. If you need to use multiple
expressions for a calculation, consider writing an Express program or
model.
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Consider writing Express programs

Suppose you are writing an application that requires a stored procedure.
You can define an Express program in Administrator, then define a formula
that calls that program.

You can use this strategy when you have to perform a complicated analysis
that requires multiple expressions instead of a single expression that can be
put into a formula. In this case, you can put multiple lines of code in a
program. Instead of entering an expression in a formula, enter the program
name or write a program call command, if you need to pass arguments.

Getting Data into an Express Database
Decide what method you want to use

You can use one of the following methods to put data in an Express
database, after you have defined it and its objects:

� Import data from one or more text files

� Make a SQL connection to a relational database, where the data resides

� Make a RAM connection to a relational database, where the data
resides

� Enter the data by hand

First, create the database and Express objects

Before you can put data into an Express database, you must define it and its
objects. You can then put data into those objects. You can add a variety of
data, including numeric data for variables, text data for dimension values,
and text data for labels that describe variables. You can also add hierarchy
information, meaning information about assigning a parent dimension value
to a child dimension value.

You can use the Database Wizard to define an Express database. Therefore,
you do not have to create the objects first — the Database Wizard will
prompt you to specify the objects you want and then create them for you. If
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you plan to load data from files, and those files are already in a format that
is required by the wizard, you can use the wizard to load the data, as well.

Alternatively, you can use the Database Wizard to perform some of its
tasks but not all. For example, you can use it just to create a new database
and its Express objects without loading data. You may want to do this, for
example, if you plan to set up a SQL connection and do not need to load
data, or if your data files are in a format that cannot be used by the wizard.

If you do not want to use the wizard, you can define the database and
Express objects by using Administrator dialog boxes.

Typically, you will load data only in the lowest level of a hierarchy. Once
you have loaded data, you can use the Rollup Wizard to aggregate that data
throughout all levels of the hierarchy.

It is a good idea to use the wizards whenever possible. They will guide you
through creating an Express database quickly and efficiently.

Loading data from files

If your data files are not in the format that is required by the Database
Wizard, you will import data from your data files. By using the Import data
dialog boxes, you can specify how you want the data to be loaded, then
Administrator will generate a data loading program.

You can run the program immediately to load the data, or schedule the
program to run at a later time.

Once you have loaded data into your Express database, you must roll it up
to all levels of all hierarchies. To do this, use the Rollup Wizard to create a
rollup program. Just as with the data loader program, you can run the
program immediately to load data, or schedule it to run at a later time.

Suppose you expect to update the data at the lowest level in your database
on a weekly basis. You can generate a data loader program, then schedule it
to run on a weekly basis. You can then generate a rollup program and
schedule it to be executed immediately after the data loader program has
completed. By using this technique, you can keep the data in your database
accurate and up-to-date.
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Using SQL to connect to a relational database

First, make sure Express Server is set up for SQL support. The system
administrator of the server machine on which Express Server is installed
will probably be responsible for setting up SQL support.

If you use Personal Express 6, you must set up your own SQL support.

In Administrator, you create a formula to map the data between the SQL
database and Express. As part of mapping the data, you can customize the
SQL data fetching by preparing a selection preprocessor script. Once you
have mapped the data, it then becomes available for display in tables and
graphs in Express Client applications.

You must then prepare code in the Pre-Attach Program and Post-Attach
Program properties of the database that contains the formula.

See Chapter 16 for details.

Using Relational Access Manager to connect to a relational database

Instead of using Administrator, you or someone else can use Relational
Access Administrator to build a database in Express. You cannot make a
Relational Access Manager connection from Administrator.

Your client application users will use connection (.XCF) files (created by
the Express Connection Editor) to make a Relational Access Manager
connection to the Express database, which retrieves information from the
relational database.

If your responsibilities include using Relational Access Administrator, you
can add settings to the XADMIN.INI file that will allow you to start
Relational Access Administrator from the Administrator menu.

For details about creating .XCF files and enabling the Relational Access
Administrator menu item, see Chapter 17.
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Entering data manually

You can use Administrator dialog boxes (for example, the Data tab of the
Modify a Variable dialog box) to add or modify data to an Express database
manually.

Most of the time, it is highly unlikely you will do this, simply due to the
enormous amount of data. However, you may find it worthwhile to build a
prototype while you are in the process of planning your database. You may
want to try defining a variety of variables and dimensions until you find the
best solution. In this case, it may be worthwhile to enter small amounts of
sample data so that you can see how it will be displayed and work with it.
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Chapter 6

Using the Database Wizard

Overview
Introduction

This chapter describes how to use the Database Wizard to create a new
Express database or modify an existing Express database. The chapter also
describes the requirements for the text files that you use to supply data to
the wizard.

In this chapter

� About the Database Wizard

� Understanding Database Wizard Text Files

� Sample Text Files

� Getting Started

� Identifying the Structure of Your Database

� Working with Dimensions

� Reading the Database Data File

� Modifying an Existing Database
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About the Database Wizard
Overview

The Database Wizard provides a simplified, step-by-step method for
creating a new Express database or modifying an existing Express database.
You can use the wizard to create a finished Express database, or you can
use the wizard to create a database as a “starting point” that you can further
modify and develop using other Administrator features.

What the Database Wizard allows you to do

Using the Database Wizard, you can define the dimensions, variables, and
hierarchies for an Express database. You can include descriptive text labels
for the values in dimensions, create new “parent” levels for hierarchies that
have multiple top-level values, specify the description for a hierarchy and
for the levels in the hierarchy, specify the order of dimensions, define
dimensions as dense or sparse when defining new variables, and modify
data as it is being read into the database.

Data input files for the Database Wizard

When you use the Database Wizard, you must supply input to the wizard in
the form of text files. Before you use the wizard, you must ensure that you
have the necessary types of files, and that they meet requirements for use
with the wizard.

What the rest of this chapter contains

The next topic describes the requirements for the data input (text) files.
Following the file requirements, there is a description of a set of sample
text files. After the sample text file descriptions, most of the remaining
topics are part of an example scenario that shows how to create a new
Express database with the wizard, using the sample text files as data input
files. Finally, there is a brief description of how modifying an existing
database differs from creating a new database.
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Understanding Database Wizard Text
Files
Formats for text files

There are two possible formats for the text files used to supply data to the
Database Wizard: character-delimited files and fixed-width files.

Character-delimited files

Character-delimited files use specific characters as delimiters for the fields
in each row. There are two types of delimiters: field delimiters and text
delimiters. Field delimiters serve as separators for the different fields in
each row, while text delimiters indicate that the values inside them are text
(rather than numerical) data. Both the field delimiter and the text delimiter
must consist of only one character.

The following example shows an excerpt from file that uses commas (,) as
field delimiters and double quotes (") as text delimiters.

"BOSTON","TOTALPROD","APR97",3721.87,1496.05
"BOSTON","TOTALPROD","MAY97",4963.56,1932.23
"BOSTON","AUDIO","JAN96",2123.54,1042.64
"BOSTON","AUDIO","FEB96",2341.56,1097.73

Fixed-width files

Fixed-width files do not use characters as delimiters for the fields in each
row. In a fixed-width file, each field occupies a definite, fixed width that is
the same for every row in the file. Because of this consistency from one
row to another in the data file, fixed-width files do not need to use
delimiters.

The following example shows an excerpt from a fixed-width file.

BOSTON    TOTALPROD   APR97  3721.87  1496.05
BOSTON    TOTALPROD   MAY97  4963.56  1932.23
BOSTON    AUDIO       JAN96  2123.54  1042.64
BOSTON    AUDIO       FEB96  2341.56  1097.73
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Types of text files

There are two basic types of text files that are used with the Database
Wizard: database data files and dimension data files.

Database data files

A database data file contains both information about the dimensions in the
database and actual data related to the variables in the database. There must
be one database data file for each database that you create or modify, and
you can specify only one database data file for each invocation of the
wizard. If you need to use more than one database data file, you must use
multiple passes through the wizard, specifying a different database data file
each time.

Contents of database data files

Database data files contain two types of data values: dimension values and
variables.

Field structure of database data files

The dimensions and variables can be listed in any order in the rows in a
database data file, as long as the following requirements are met:

� As viewed from left to right, the fields representing the dimensions
must appear first, followed by the fields representing the variables.

� The order of dimensions and variables must be the same for every row
in a given database data file.

Example: Database data file

The following example shows an excerpt from a character-delimited
database data file.

"BOSTON","TOTALPROD","APR97",3721.87,1496.05
"BOSTON","TOTALPROD","MAY97",4963.56,1932.23
"BOSTON","AUDIO","JAN96",2123.54,1042.64
"BOSTON","AUDIO","FEB96",2341.56,1097.73

In the first row in this example, BOSTON is a dimension value in the
Geography dimension, TOTALPROD is a dimension value in the Product
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dimension, and APR97 is a dimension value in the Time dimension. The
values 3721.97  and 1496.05  are values for the variables SALES and
COST respectively. The values in the subsequent rows in the file pertain to
the same dimensions and variables.

Dimension data files

A dimension data file contains information about the values in a specific
dimension.

Dimension data files are optional. If you have labels or hierarchical
(parentage) information associated with the dimension values in a given
dimension, you need to use a dimension data file to include that
information in your Express database.

There must be one dimension data file for each dimension for which you
want to include labels or hierarchical information. If you do not have labels
or a hierarchical structure for a dimension, there is no need to use a
dimension data file for that dimension.

Contents of dimension data files

Each row in a dimension file may contain four types of data values:

� Dimension value — A value in the dimension to which the file
pertains.

� Parent value — The value that is the parent of the dimension value.
Additional parents (beyond the immediate parent of the dimension
value) may be included as well.

� Short label — A label that provides a short text description for the
dimension value or a parent value.

� Long label — A label that provides a long text description for the
dimension value or a parent value.

Field structure of dimension data files

The rules for field structure are as follows:

� The fields for the dimension value and any parent values in each row
must be ordered so that there is a progression in order from the
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dimension value to the highest parent value (if only one parent value
appears in each row, then the order is simply from the dimension value
to the parent value).

Thus, if the dimension value is the left-most value, the sequence from
left to right is from the dimension value to the highest parent value. If
the dimension value is the right-most value, then the sequence from left
to right is from the highest parent value to the dimension value.

� Labels are optional. There can be short labels, long labels, or both for
any or all values (dimension values and parent values) in the file.

The only rule for labels is that any labels that apply to a given value
must appear immediately to the right of that value. If there are both
short and long labels for a value, it does not matter which label appears
first (that is, which label is on the left and which is on the right), as long
as the labels are immediately to the right of the value to which they
pertain, without any other fields in between.

� The field structure must be the same for every row in the file.

Example: Dimension data files with one parent per row

The following example shows an excerpt from a character-delimited
dimension file for the Time dimension, in which the left-most field in each
row represents the dimension value.

"JAN97","Jan97","January 1997","Q1.97"
"FEB97","Feb97","February 1997","Q1.97
"MAR97","Mar97","March 1997","Q1.97"

The first field (farthest to the left) in each row is the dimension value, the
second field is the short label for the dimension value, the third field is the
long label for the dimension value, and the last field is the parent of the
dimension value. Thus, in the first row, JAN97 is the dimension value,
Jan97  is the short label for JAN97, January 1997  is the long label for
JAN97, and Q1.97  is the parent value for JAN97.

The same information could also be structured so that the parent value is
the left-most field in each row, as shown in the following example.

"Q1.97","JAN97","Jan97","January 1997"
"Q1.97","FEB97","Feb97","February 1997"
"Q1.97","MAR97","Mar97","March 1997"
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Example: Dimension data files with multiple parents per row

The following example shows an excerpt from a dimension file in which
each row contains multiple parent values.

"JAN97","Jan97","January 1997","Q1.97","1997"
"FEB97","Feb97","February 1997","Q1.97”,"1997"
"MAR97","Mar97","March 1997","Q1.97","1997"

In this case, the fourth field contains the immediate parent of the dimension
value in the first field, and the fifth field contains the parent of the value in
the fourth field. Thus, in the first row, Q1.97  is the parent of JAN97, and
1997  is the parent of Q1.97 .

The same information could also be structured so that the highest parent
value appears as the left-most field, as shown in the following example.

"1997","Q1.97","JAN97","Jan97","January 1997"
"1997","Q1.97","FEB97","Feb97","February 1997"
"1997","Q1.97","MAR97","Mar97","March 1997"

Note: Labels for parent values

Although no labels for parent values are shown in the preceding examples,
there could also be labels for any or all of the parent values. Labels for a
parent value would appear immediately to the right of the parent value.

Sample Text Files
Introduction

This topic describes two sample text files, a database data file and a
dimension data file, that are suitable for use as input data files for the
Database Wizard. The usage examples later in this chapter use these sample
files to demonstrate the various steps in the Database Wizard.

Sample database data file

The sample database data file is the sampdata.txt  file. The data in the
sampdata.txt  file represents the sales and costs data for a worldwide
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chain of electronics stores. The following figure shows excerpts from the
sampdata.txt  file.

"WORLD","TOTALPROD","TOTALCHANNEL","1996"118247100.00,2490243.00
"WORLD","TOTALPROD","TOTALCHANNEL","Q1.96"26084850.00,560379.50
"WORLD","TOTALPROD","TOTALCHANNEL","JAN96"8614830.00,185754.80
"WORLD","TOTALPROD","TOTALCHANNEL","FEB96"8657406.00,186761.70
"WORLD","TOTALPROD","TOTALCHANNEL","MAR96"8812612.00,187863.00
"WORLD","TOTALPROD","TOTALCHANNEL","Q2.96"30468050.00,649004.50
"WORLD","TOTALPROD","TOTALCHANNEL","APR96"8859808.00,188850.80
"WORLD","TOTALPROD","TOTALCHANNEL","MAY96"10792100.00,228981.90
"WORLD","TOTALPROD","TOTALCHANNEL","JUN96"10816140.00,231171.70
"WORLD","TOTALPROD","TOTALCHANNEL","Q3.96"27781700.00,582693.10
"WORLD","TOTALPROD","TOTALCHANNEL","JUL96"9103562.00,192927.50
"WORLD","TOTALPROD","TOTALCHANNEL","AUG96"9189346.00,194497.80
"WORLD","TOTALPROD","TOTALCHANNEL","SEP96"9488794.00,195267.80
"WORLD","TOTALPROD","TOTALCHANNEL","Q4.96"33912510.00,698166.00
"WORLD","TOTALPROD","TOTALCHANNEL","OCT96"9177290.00,196300.30
"WORLD","TOTALPROD","TOTALCHANNEL","NOV96"11772360.00,249126.80
"WORLD","TOTALPROD","TOTALCHANNEL","DEC96"12962860.00,252739.00
.
.
.
"TORONTO","CDPLAYER","CATALOG","Q1.96"46443.04,91.40
"TORONTO","CDPLAYER","CATALOG","JAN96"15179.64,29.89
"TORONTO","CDPLAYER","CATALOG","FEB96"16179.24,31.82
"TORONTO","CDPLAYER","CATALOG","MAR96"15084.16,29.69
"TORONTO","CDPLAYER","CATALOG","Q2.96"45361.54,89.22
"TORONTO","CDPLAYER","CATALOG","APR96"14225.12,27.98
"TORONTO","CDPLAYER","CATALOG","MAY96"16037.70,31.55
"TORONTO","CDPLAYER","CATALOG","JUN96"15098.72,29.69
.
.
.

Each row in the file consists of six fields (columns) that are separated by
commas (,) . Thus, this is a character-delimited file. Quotations marks (")
serve as text separators.

In each row, reading from left to right, the fields contain the following data:

� Field 1: A value in the Geography dimension

� Field 2: A value in the Product dimension

� Field 3: A value in the Channel dimension

� Field 4: A value in the Time dimension

� Field 5: A value for the variable Sales

� Field 6: A value for the variable Costs
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Sample dimension data file

The samptime.txt  file is a dimension data file for the Time dimension.
The samptime.txt  file is a fixed-width file. No characters are used as
separators between the fields in the file; instead, each field has a set, fixed
width that is the same in every row.

The following figure shows the samptime.txt  file.

JAN96           Jan96           January 1996              Q1.96
FEB96           Feb96           February 1996             Q1.96
MAR96           Mar96           March 1996                Q1.96
APR96           Apr96           April 1996                Q2.96
MAY96           May96           May 1996                  Q2.96
JUN96           Jun96           June 1996                 Q2.96
JUL96           Jul96           July 1996                 Q3.96
AUG96           Aug96           August 1996               Q3.96
SEP96           Sep96           September 1996            Q3.96
OCT96           Oct96           October 1996              Q4.96
NOV96           Nov96           November 1996             Q4.96
DEC96           Dec96           December 1996             Q4.96
JAN97           Jan97           January 1997              Q1.97
FEB97           Feb97           February 1997             Q1.97
MAR97           Mar97           March 1997                Q1.97
APR97           Apr97           April 1997                Q2.97
MAY97           May97           May 1997                  Q2.97
Q1.96           Q1.96           Quarter 1, 1996           1996
Q2.96           Q2.96           Quarter 2, 1996           1996
Q3.96           Q3.96           Quarter 3, 1996           1996
Q4.96           Q4.96           Quarter 4, 1996           1996
Q1.97           Q1.97           Quarter 1, 1997           1997
Q2.97           Q2.97           Quarter 2, 1997           1997
1996            1996            1996
1997            1997            1997

In each row, reading from left to right, the fields structure is as follows:

� Field 1: A dimension value in the Time dimension

� Field 2: The short label for the value in Field 1

� Field 3: The long label for the value in Field 1

� Field 4: The parent value for the dimension value in Field 1
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Getting Started
Introduction

The next several topics show how you can use the Database Wizard to
create a database, using the sampdata.txt  and samptime.txt  data files
(discussed in the preceding topic) as examples.

Navigating through the wizard

Each step in the wizard contains the following controls:

� Cancel — Cancels (closes) the wizard.

� Help — Displays the Help topic associated with the current step.

� Back — Displays the previous step.

� Next — Displays the next step. After you have completed your work in
each step, choose Next to proceed to the next step.

� Finish — Completes your work and closes the wizard. Finish is
available only in the last step of the wizard.

Do you have to open a database before starting the wizard?

You can have one or more databases open before starting the wizard,
although you can also start the wizard without any databases open.
However, if you want to modify an existing database, you must open that
database before starting the wizard.

Starting the Database Wizard

After you have started Administrator, you can start the Database Wizard by
choosing Database Wizard from the Tools menu or by clicking on the
Database Wizard button ( )on the toolbar.

Introductory screen

The Introduction step is the first step in the Database Wizard. This step
simply provides brief introductory text about the wizard. If you want to,
you can choose to skip this step on subsequent invocations of the wizard.
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The following figure shows the Introduction step.

Note: If you have one or more databases open when you choose Next, the
wizard displays the Create New Database or Modify Existing One step. If
you do not have any databases open, the wizard goes directly to the Specify
Database Name and Location step.
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Choosing to create a new database

Assuming that you have one or more databases open before starting the
wizard, the next step is Create New Database or Modify Existing One.

In this example scenario, you want to create a new database, so you select
the Create a new Express database option, as shown in the following
figure.

Specifying the name and location of the database

The next task is to use the Specify Database Name and Location step to
specify the name and location for the database that you want to create. The
wizard provides a default name for the database. You can keep the default
name or type in one of your own choosing.
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Assume that you want to name the database TESTDB, and that you want to
create this database in the f:\users\gbsamp  directory. The following
figure shows how the Specify Database Name and Location step should
look.

Identifying the Structure of Your
Database
Introduction

At this point, you have started the wizard, chosen to create a new Express
database, and provided the name and location of the database that you want
to create. Now, you are ready to specify the database data file that you want
to use and to identify the database objects for your database.
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Specifying the database data file

The next step is to specify which file you want to use as the database data
file. In the Specify Import Data File step, specify the name of the database
data file in the Import file box. You can use the Browse button to locate the
directory containing the file.

You must specify whether the file is a character-delimited file or a fixed-
width file by  choosing the appropriate option.  In this case, the sample
database data file (sampdata.txt ) is a character-delimited file.

In addition, you can choose which rows are the first row and the last row
that the wizard is to read from the database data file. This can be useful if
there are rows at the beginning or the end of the file that do not represent
data that you want to be part of your Express database (header information,
for example). You can use the arrow buttons to select choices for the first
and last rows to read, or you can type in the appropriate row numbers. In
this example, the sampdata.txt  file does not contain any extraneous
information, so you want to read the entire file.

The Preview box shows the structure of the database data file you have
specified in the Import file box by displaying the first 50 rows of the file.
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The following figure shows how the Specify Import Data File step should
appear after you have made your selections for the sampdata.txt  file.

Specifying delimiters

For character-delimited files, you need to specify the characters that serve
as field delimiters and text delimiters in the file. In the Specify Delimiters
step, you can specify the field and text delimiters.

Choose the appropriate delimiters in the Field Delimiters and Text
Delimiters boxes. If none of the choices in the Field Delimiters box match
the character that is used as a field delimiter in your file, choose Other in
the Field Delimiters box and type the appropriate character in the box that
appears at the right. The same applies for text delimiters.

The Preview box shows how the wizard has interpreted the field structure
of the first 50 rows of your file, based on the character and text delimiters
that you have specified.
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The sampdata.txt  file is a character-delimited file that uses commas (,)
as field delimiters. Double-quotes (") are used as text delimiters in the file.
The following figure shows how the Specify Delimiters step should appear
after you have made your selections for the sampdata.txt  file.

Specifying field information

Now that you have identified the field structure of the database data file,
you need to specify what each field represents. In the Specify Field
Information for Database Data File step, the Field Information box displays
the field structure for the first 50 rows of your file. The Field Information
box also displays four rows (A, B, C, and D) that you use to specify
information about each field, as follows:

� Row A — Use row A to specify the name of the database object that
the field represents.

� Row B — Use row B to specify the type of database object that the
field represents. The choices are Dimension, Variable, or Ignore
(Skip). Choose Ignore (Skip) if the field represents data that you do
not want to include in the Express database.
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� Row C — Use row C to specify the data type for the object that the
field represents. If you have specified a dimension in row B, the choices
are Text, ID, Day, Week, and Month. If you have specified a variable,
the choices are Boolean, Date, Decimal, ID, Integer, Short decimal,
Short integer, and Text.

� Row D —  Use row D if you want to specify any additional load
parameters for the data in the field, allowing you to modify data as it is
being read. Click on the Properties button to display the Dimension
Properties dialog box or the Variable Properties dialog box, depending
on the type of object that the field represents.

By default, the wizard assigns an object type in row B for each field. Be
sure to check whether the object type that the wizard assigns is correct;
change the object type if necessary.

Note: The Field Information box may not display all of the fields at one
time. If necessary, scroll all the way through the fields (from left to right) to
ensure that the correct information is specified for each field.



Chapter 6  Using the Database Wizard

136

The following figure shows how the Field Information box in the Specify
Field Information for Database Data File step should appear after you have
specified the field information for the sampdata.txt  file.

The preceding figure shows field information for only the first three fields
in this example. By scrolling to the right, you could display the fourth, fifth,
and sixth fields. The fourth field would be for the Time dimension, with an
object type of Dimension, and a data type of Text. The fifth field would be
for the Sales variable, with an object type of Variable, and a data type of
Decimal. The sixth field would be for the Costs variable, and would also
have an object type of Variable and a data type of Decimal.

Checking the database objects you specified

After the Specify Field Information for Database Data File step, the next
step in the wizard is the Object Summary step. The Object Summary step
lists the dimensions and variables that you have specified. If the
Dimensions box and the Variables box list the correct dimensions and
variables, simply click Next to proceed to the next step. However, if
something is not correct, click Back to return to the Specify Field
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Information for Database Data File step, and then correct the information in
that step as necessary.

The following figure shows how the Object Summary step should appear
for the sampdata.txt  file.

Working with Dimensions
Introduction

The next tasks that you have to perform are related to the dimensions in the
database that you are creating, and to any dimension data files that are
associated with these dimensions.

Specifying dimension order and sparsity

The Specify Dimension Order and Sparsity step allows you to specify the
order of the dimensions and to define any or all of the dimensions as sparse.
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Use the Dense box to list any dimensions that are dense, and use the Sparse
box to list any dimensions that are sparse. By default, all dimensions are
listed in the Dense box. To specify a dimension as sparse, select the
dimension in the Dense box and choose the Add button ( ) to move
the dimension to the Sparse box. You can select and move multiple
dimensions at one time. To return one or more dimensions to the Dense
box, select the dimension or dimensions in the Sparse box and choose the
Remove button ( ).

You can set the order of the dimensions in both the Dense and Sparse boxes
by selecting a dimension and choosing Move Up or Move Down to change
the position of that dimension in the dimension order. The dimension at the
top of the list is the fastest-varying dimension; the dimension at the bottom
of the list is the slowest-varying dimension.

For further information about order and sparsity for dimensions, see
Chapter 13.
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In the case of the TESTDB database, all the dimensions are dense, and the
default dimension order is correct, so no changes need to be made in the
Specify Dimension Order and Sparsity step. The following figure shows
this step for the TESTDB database.

Specifying which dimensions use dimension data files

If you plan to use dimension data files for any dimensions, you need to
specify the dimensions for which there are dimension data files. You do
this  through the Specify Dimensions Using Import Data Files step. Use the
check boxes next to the dimension names to select the dimensions for
which there are data files.
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In the case of the TESTDB database, the only dimension data file is the
samptime.txt  file for the Time dimension. The following figure shows
how the Specify Dimensions Using Import Data Files step should appear.

Steps related to dimension data files

For each dimension that you have selected in the Specify Dimensions
Using Import Data Files step, the database wizard displays a series of steps.
The exact steps that are displayed depend on various factors, such as the
type of file used, whether you are creating a new database updating an
existing one, and certain characteristics of the data.

If you have selected multiple dimensions in the Specify Dimensions Using
Import Data Files step, the wizard displays the entire series of steps that are
appropriate for a given dimension before proceeding to the steps for the
next dimension.
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The following table shows the sequence of steps for each dimension. The
steps are listed from top to bottom in the order in which they appear.

Database Wizard Step Description

Specify Import Data File In this step, you specify the dimension data file for the
dimension.

Specify Delimiters
or
Specify Column Breaks

The step displayed depends on whether the dimension
data file is a character-delimited file or a fixed-width file.
For a character-delimited file, you specify the delimiters;
for a fixed-width file, you specify the column breaks.

Specify Field
Information for
Dimension Data File

In this step, you provide information about the fields in
each row in the dimension data file.

Create New Hierarchy
or Modify Existing One

Displayed only if you are updating an existing database
and there is an existing hierarchy that contains one or
more values. Specify whether you want to create a new
hierarchy or make updates to an existing hierarchy.

Specify Data Input
Parameters

In this step, you specify various options related to the data
reading operation for the dimension data file.

Import Data In this step, you import the data from the dimension data
file.

Specify New Parent
Value

Displayed only If the wizard detects that the top level in the
hierarchy contains more than one value. If you wish, you
can specify a new value as a top-level value for the
hierarchy

Specify Hierarchy and
Level Descriptions

Displayed only If there is no existing hierarchy in the
dimension (as in creating a new database or adding a new
dimension to an existing database). If you wish, you can
specify a descriptive name for a hierarchy, as well as
descriptive names for the levels in that hierarchy.

Specifying a dimension data file

The first step in the sequence for a dimension that uses a dimension data
file is the Specify Import Data File step.

In our example, the dimension data file for the Time dimension is the
samptime.txt  file, which is a fixed-width file. Thus, you must choose
Fixed-Width  in the File fields box.
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The following figure shows how the Specify Import Data File step should
appear for the samptime.txt  dimension data file.

Specifying information about field structure

After you have specified the dimension data file for a given dimension, you
must provide information about the way that the fields in the file are
structured.

Because you chose Fixed-Width  for the samptime.txt  file in the
preceding step, the next step in the sequence for the samptime.txt  file is
the Specify Column Breaks step. To specify a column break, place the
mouse pointer at a position in the Preview of file box where you want to
indicate a column break, and click on that position. Repeat this operation,
scrolling to the right if necessary, until you have specified all of the column
breaks in the file.
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The following figure shows how the Specify Column Breaks step should
appear for the samptime.txt  dimension data file. The figure shows the
mouse pointer at the position where you click to indicate the column break
between the first and second columns.

Specifying field information

The third step in the sequence for each dimension data file is the Specify
Field Information for Dimension Data File step. In this step, you specify
information about the fields in each row in the dimension data file.

The field information box displays the field structure for the first 50 rows of
the dimension data file. The field information box also displays two rows
(A and B) that you use to specify the following information about each
field:

� Row A — Use row A to specify the type of database object that the
field represents. The choices are Values, Short labels, Long labels,
Parents, or Ignore (Skip). Choose Ignore (Skip) if the field represents
data that you do not want to include in the Express database.
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� Row B — Use row B if you want to specify any additional load
parameters for the data in the field, allowing you to modify data as it is
being read. Click on the Properties button to display the Dimension
Properties dialog box or the Variable Properties dialog box, depending
on the type of object that the field represents.

Note: The Field Information box may not display all of the fields at one
time. If necessary, be sure to scroll all the way through the fields (from left
to right), to be sure that you have specified the correct information for all of
them.

The following figure shows how the Field Information box in the Specify
Field Information for Dimension Data File step should appear after you
have specified the field information for the samptime.txt  file.

Specifying data input parameters

Before you actually read the data from the dimension data file, you can
specify various parameters related to the data reading operation.
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The Specify Data Input Parameters step allows you to specify the program
that is used to load the data, along with an optional text description of the
program. You can also specify optional log files that store information
about the data reading process and about any rejected records. Finally, you
can indicate how often you want the wizard to save changes to the
database, specify the acceptable limit for the number of errors in the data
reading operation, and specify further options using the Advanced button.

In the case of the samptime.txt  file, all of the default values are
appropriate. The following figure shows the Specify Data Input Parameters
step for the samptime.txt  file.

Importing data from the database data file

You are now ready to read the data from the dimension data file using the
Import Data step. Simply click on the Read Data button to import the data.
After the wizard has read the data from the database data file, the results of
the data reading operation are displayed in the Results box.
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The following figure shows the Import Data step after the wizard has
completed reading the data from the samptime.txt  file.

Specifying a new parent value

Because there are multiple values at the top hierarchical level in the
samptime.txt  file, the wizard displays the Specify New Parent Value
step, in which you can specify a new value as a parent for the existing top-
level values.

The wizard provides a default name for the new value, TOTAL_dimension,
where dimension is the name of the dimension in which the hierarchy
exists. You can specify a different name for the value if you choose.

In the case of the samptime.txt  file, there are two values that are at the
top level in the file, 1996 and 1997. Assume that you want to create a new
value named ALLYEARS that serves as the parent of those two values.
ALLYEARS will represent the aggregated total of all data for 1996 and
1997.
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The following figure shows how the Specify New Parent Value step would
appear for the Standard hierarchy in the Time dimension in the TESTDB
database, with the default name TOTAL_Time replaced by ALLYEARS.

Specifying hierarchy and level descriptions

The last step in the sequence related to the samptime.txt  file is the
Specify Hierarchy and Level Descriptions step.

The wizard supplies a default description for the hierarchy (Standard), as
well as default descriptions (L1, L2, etc.) for the levels in the hierarchy.
You can specify different descriptions if you wish.

For the Time dimension in the TESTDB database, assume that you want to
use “Standard” as the description for the hierarchy, but you want to change
the descriptions for the levels to ALLYEARS, YEAR, QUARTER, and
MONTH. The following figure shows how the Specify Hierarchy and Level
Descriptions step should appear in this case.
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The following figure shows this step for the Standard hierarchy in the Time
dimension.

Reading the Database Data File
Introduction

At this point, you have specified the structure for the database and have
read the data from any dimension data files. You are now ready to read the
data from the database data file, which completes your work in the
Database Wizard.

Specifying data input parameters

As with the dimension data files, you have the opportunity to specify
various parameters related to the data reading operation for the database
data file. You use the Specify Data Input Parameters step (the same step as
displayed for dimension data files) to specify these parameters.
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Importing data

You are now ready to read the data from the database data file using the
Import Data step. This is the same step that was used to import data from
the dimension data files. Simply click on the Read Data button to import
the data. After the wizard has read the data from the database data file, the
results of the data reading operation are displayed in the Results box.

Finished!

You have now completed your work in the Database Wizard. The Finished!
step indicates the status of the data reading operation and lists any data
loader programs that the wizard used. The following figure shows the
Finished! step for the TESTDB database.
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Modifying an Existing Database
Introduction

You can use the Database Wizard to modify an existing Express database.
When you modify an existing database, most of the steps are the same as
those used in creating a new database, although there are a few differences.
This topic describes how the process for modifying an existing database
differs from the process for creating a new database when using the
Database Wizard.

Selecting the database you want to modify

If you select Modify an existing Express database in the Create New
Database or Modify Existing One step, the next step that the wizard
displays is the Select Database step. In the Select Database step, you select
the database that you want to modify.

The following figure shows an example of the Select Database step.
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 Specifying order and sparsity

When you modify an existing database, you specify a database data file,
just as you do when creating a new database. If the database data file that
you are using to modify the database contains new variables — that is,
variables that do not currently exist in the database — Administrator
displays the Specify Dimension Order and Sparsity step. However, if there
are no new variables, Administrator does not display the Specify
Dimension Order and Sparsity step.

Creating a new hierarchy or modifying an existing one

If you are using a dimension data file for a dimension in an existing
database, and there are currently one or more hierarchies in that dimension
that contain values, the wizard displays the Create New Hierarchy or
Modify Existing One step. In this step, you can specify whether to place the
values that you want to read from the dimension data file in an existing
hierarchy or in a new hierarchy.

If the values are to be part of an existing hierarchy, you can select the
hierarchy that you want to use. If the values are to be part of a new
hierarchy, you can type in the name for the new hierarchy.
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The following figure shows an example of the Create New Hierarchy or
Modify Existing One step.
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Chapter 7

Creating a Database Manually

Overview
Introduction

This chapter tells you how to create an Express database without the
Database Wizard.

In this chapter

� Overview of Creating an Express Database Without the Database
Wizard

� Stage 1: Defining the Database

� Stage 2: Defining the Dimensions

� Stage 3: Adding Values to Dimensions and Creating Hierarchies

� Stage 4: Defining the Variables

� Stage 5: Method 1 — Importing Data into Variables

� Stage 5: Method 2 — Manually Adding Data to the Variables

� Stage 6: Rolling Up Data with and Without the Rollup Wizard

� Stage 7: Defining Other Database Objects

� Maintaining Hierarchies

� Working with Valuesets

� Working with Models
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Overview of Creating an Express
Database Without the Database Wizard
Process: Creating a new database

When you create a new database without the Database Wizard, you will
perform most or all of the following tasks.

Stage Description

1 Define the database.

2 Define the dimensions.

3 Add values to the dimensions you define and create hierarchies for the
dimensions.

4 Define the variables.

5 Method 1: Import data into the variables.

or

Method 2: Add data manually to the variables.

6 Roll up the data in all variables that have one or more hierarchical
dimensions

7 Define any other database objects you wish to create.
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Stage 1: Defining the Database
Procedure: Defining a new database

Use the following procedure to define a new database.

Step Action

1 From the File menu, choose New.  The Create a New Express Database
dialog box appears.

2 In the Database Name box, type a base file name of up to eight characters.

Do not include a period (.) as one of the eight characters in the file name.
Administrator adds the .DB extension to the file name.

3 The database will be created in the directory that is specified in the Directory
box. Choose Browse  to see the Select Database Directory dialog box, if
you want to select a different directory or a different drive or server.

4 In the Database Identifier box, type a two-character database identifier. The
database identifier must be unique. The first character must be a letter. The
second character can be a letter or a number.

5 In the Database Description box, type a database description using any
combination of upper- and lowercase characters.

6 Choose OK. The new database will be listed in the Database Browser.

Figure: The Create a New Express Database dialog box

In the following figure, the new database will be created in the directory
C:\ORAWIN95\OLAP\EAD620 by default.
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Stage 2: Defining the Dimensions
Overview

Once you have defined a database and decided what dimensions and
variables you need to create, your next step is to define those objects.

First, you should define all of the dimensions that you need.

Defining dimensions

You must define dimensions before you can define measures (variables,
formulas, and relations). Remember that a dimension is a list of values that
provides an index to your data. Dimension values let you identify your data
and select subsets of data with which to work. Some typical dimensions
you might create are time, product, market, and region dimensions. For
more information about dimensions, refer to Chapter 1.

Procedure: Defining a dimension

Use the following procedure to define a dimension. You create hierarchies
for dimensions when you add values to the dimension.

Step Action

1 From the Edit menu, choose Define.

2 From the submenu, choose Dimension to display the Define a Dimension
dialog box.

3 In the Name box, type a valid Express object name for the new dimension.

The name must consist of 1 to 16 characters. For information about naming
restrictions, see the entry for the DEFINE command in the Express
Language Help system.

4 In the Database box, select the database in which you want to define the
new dimension.
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Step Action

5 In the General tab, select a data type in the Type box. You can select Text,
ID, Integer, Day, Week, Month, Quarter, Year, Conjoint,  or Composite.

IF you select . . . THEN . . .

Text,  and dimension
values will have varying
numbers of characters,

select varying  in the Width box.

Text,  and all dimension
values will have about
the same number of
characters,

select the maximum number of
characters for a dimension value in the
Width box. Longer values will be
truncated. Defining a fixed width
improves the efficiency of your
database.

Conjoint or Composite, make certain that all the base
dimensions you will need to define the
conjoint dimension or composite are
listed in the Available list.

Select each base dimension from the
Available list, beginning with the
fastest-varying dimension. Then choose
the right arrow button to add the
dimension to the Selected list, or just
double-click on the dimension.

Conjoint, select the algorithm you want Express to
use for loading and accessing the values
of the conjoint dimension. You can
select BTree , Hash , or No Hash .

Important:  Oracle Corporation
recommends that you use composite
dimensions rather than conjoint
dimensions for building a new database.
Composite dimensions are self-
maintaining.

Composite, select the algorithm you want Express to
use for loading and accessing the values
of the composite. You can select BTree
or Hash .

6 In the Dimension Identifier box, type a three-character dimension identifier.
The first character must be a letter. The second and third characters can be
letters or numbers.
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Step Action

7 In the Labels tab, type a descriptive name for the dimension in the
Comments box.

For example, the comments for the TIME dimension might be Time Period.
In Express Client products, the comments appear in the Database Browser
and in the Selector.

8 In the Short Description box, type a short name for the dimension, using any
combination of upper- and lowercase letters, numbers, and periods.

For example, the short name for the TIME dimension might be Time. In
Express Client products, the short name appears in tables, graphs, and the
Dimension Bar.

9 In the Description box, type a description for the dimension.

The description can include spaces and provides internal documentation for
the dimension. In Express Client products, the Description appears in the
Object Inspector.

10 In the Short Description (Plural) and Description (Plural) boxes, type the
plural forms of the names.

For example, if the description is Time Period, the plural name is Time
Periods. Express Client products use these names when displaying scripts
in the Selector.

11 Choose Define  to define the dimension and to create the supporting
database objects.

12 Choose Close  when you have finished defining dimensions.

The importance of metadata

Additional database objects, called metadata, are automatically created to
support hierarchical dimensions.

If you use a client application that is provided by Express, that client
application will use the metadata. Additionally, if you use Administrator
with Oracle Express Web Agent, it also uses the metadata. Therefore, be
sure to create any hierarchical dimensions with Administrator and not with
Express commands.
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Stage 3: Adding Values to Dimensions
and Creating Hierarchies
Overview

After defining a dimension, you must provide values for it — you cannot
add data to a variable or other measure until its dimensions have values.
You can add values to a dimension by importing data from an external
source or by typing in the values manually.

This topic describes a procedure for entering values manually for text ID,
integer, date, and conjoint dimensions. Express automatically adds values
to a composite when you add values to the dimensions that the composite
comprises.

Chapter 9 describes how to import data.

The values you add to a hierarchical dimension

After defining a dimension, add all dimension values to it. For example,
suppose you define a GEOGRAPHY dimension with four levels: cities,
countries and regions, continents, and world. The values you add would
include all city names, all country and regional names, all continent names,
and a single WORLD value. You create a hierarchy from the dimension
and its values while you are adding the values to the dimension.

Procedure: Adding values to a text, ID, integer, conjoint, or date dimension

Use the following procedure to add values to a text, ID, integer, date or
conjoint dimension and create a hierarchy.

Step Action

1 From the Database Browser, select a dimension, and from the right mouse
popup menu choose Edit Values  to display the Edit Dimension Values
dialog box.
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Step Action

2 From the main toolbar of the dialog box, choose Options ( )  to display
the Dimension Value Editor Options dialog box. Your selections in the
Dimension Value Editor Options dialog box control the display of dimension
values.

IF . . . THEN . . .

you want the text or ID dimension
values to be displayed in
uppercase letters regardless of
how you enter them,

select Make text dimension
values uppercase when
adding  and choose OK.

you want the text or ID dimension
values to be displayed in the case
you enter them,

clear Make text dimension
values uppercase when
adding  and choose OK.

you want the text you type in the
Value box of the Add Values
dialog box to be displayed,

select Dimension Values .

you want the text you type in the
Short Label box of the Add Values
dialog box to be displayed,

select Short Labels .

you want the text you type in the
Long Label box of the Add Values
dialog box to be displayed,

select Long Labels .

3

IF . . . THEN . . .

you want to add values to the
dimension list displayed in the
Available box,

go to step 4.

you want to add values to the
dimension hierarchy displayed in
the Hierarchy box,

go to step 5.
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Step Action

4 From the Available box toolbar, choose Add Values (  ). Depending on
the data type of the dimension, you will be prompted to enter different
information in the Add Values dialog box.

IF . . . THEN. . .

the data type
is Text or ID,

type values in the appropriate boxes, select an
option to specify where the dimension value is to
be inserted, then choose Add. If you specified a
maximum width when you defined the
dimension, you cannot exceed that width when
entering values.

the data type
is Integer,

type the number of values you wish to add,
select an option to specify where the values are
to be added, and choose Add.

the data type
is Date, and
this is the first
time you are
adding time
periods,

type the first value in the First Time Period box,
type the number of time periods you want to add
in the Number of Periods box, then choose Add.

the data type
is Date, and
this is not the
first time you
are adding
time periods,

type the number of time periods you want to add
in the Number of Periods box, select where you
want the time periods to be added, and choose
Add.

the data type
is Conjoint,

type a value for each dimension of the conjoint
plus a short label and a long label, select a
position for the value in the dimension hierarchy,
and choose Add . For nested conjoint
dimensions, you must type values in conjoint
notation; for example
<‘Product1’,’Geography1’>. For non-nested
conjoint dimensions, you must not use conjoint
notation.

The dimension values will appear in the Available box. To have the long or
short name of the value displayed in the box, make a selection in the
Dimension Value Editor Options dialog box.

When you are done adding values, choose Close  to return to the Edit
Dimension Values dialog box.
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Step Action

5 From the Hierarchy box toolbar, choose Add Values (  ). Depending on
the data type of the dimension, you will be prompted to enter different
information in the Add Values dialog box.

IF . . . THEN . . .

the data type is
Text or ID,

type values in the appropriate boxes, select an
option to specify where the dimension value is to
be inserted, then choose Add. If you specified a
maximum width when you defined the
dimension, you cannot exceed that width when
entering values.

the data type is
Integer,

type the number of values you wish to add,
select an option to specify where the values are
to be added, and choose Add.

the data type is
Date, and this is
the first time you
are adding time
periods,

type the first value in the First Time Period box,
type the number of time periods you want to add
in the Number of Periods box, then choose Add.

the data type is
Date, and this is
not the first time
you are adding
time periods,

type the number of time periods you want to add
in the Number of Periods box, select where you
want the time periods to be added, and choose
Add.

the data type is
Conjoint,

type a value for each dimension of the conjoint
plus a short label and a long label, select a
position for the value in the dimension hierarchy,
and choose Add . For nested conjoint
dimensions, you must type values in conjoint
notation; for example <‘Product1’,’Geography1’>.
For non-nested conjoint dimensions, you must
not use conjoint notation.

The dimension values will appear in the place you selected in the Hierarchy
box. To have the long or short name of the value displayed in the box, make
a selection in the Dimension Value Editor Options dialog box.

When you are done adding values, choose Close  to return to the Edit
Dimension Values dialog box.

6 When you are finished making changes to the dimension, choose Close.

If the dimension is hierarchical, the level and order information about the
values you have entered is automatically calculated.
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Related information

For further information, see the following:

� Refer to the DEFINE DIMENSION command in the Express Language
Help system for more information about data types and defining
dimensions.

� For more information about assigning parent values to child values and
about calculating hierarchies, search for the following topics in the
Administrator Help system:

“Adding Dimension Values”
“Defining Hierarchies”

Stage 4: Defining the Variables
Procedure: Defining a new variable

Use the following procedure to define a new variable.

Step Action

1 Define all dimensions that are required by the variable, if you have not done
so already.

2 From the Edit menu, choose Define.

3 From the submenu, choose Variable  to display the Define a Variable dialog
box.

4 In the Name box, type in a valid Express object name for the new variable.

5 In the Database box, select the database in which you want to define the
new variable.

6 In the General tab, select a data type in the Type box. You can select
Boolean, Date, Decimal, ID, Integer, Short decimal, Short integer, or
Text.
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Step Action

7 In the Available box, select the dimension that you wish to be the
fastest-varying dimension.

IF . . . THEN . . .

the dimension is a sparse
dimension,

choose (  ) next to the
Sparse box to add the dimension
to the Sparse box.

the dimension is not a sparse
dimension,

choose (  ) next to the
Dense box to add the dimension
to the Dense box.

Note:  For detailed information about working with sparse data, see Chapter
13.

8 Repeat step 7 for each of the variable’s dimensions, ending with the
slowest-varying dimension.

9 For text variables only, perform the following steps:

IF . . . THEN . . .

you want to restrict the number of
bytes of storage for each value of
the variable,

select or type a value in the
Width box. A longer value will be
truncated to this width.

do not want to restrict the number
of bytes of storage for each value
of the variable,

leave the default value (Varying ).

10 Decide whether to select the Temporary  box, as follows:

IF . . . THEN . . .

you want the data to be
discarded at the end of every
session,

select the Temporary  box.

you want to store the data from
one session to the next,

do not select the Temporary  box.

The variable definition is saved whether or not you select the Temporary
box.

11 In the Labels tab, type a description for the variable in the Description box.
The description can include spaces and provides internal documentation. In
Express Client products, it appears in the Object Inspector. You can change
all of the names at any time by editing the variable.
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Step Action

12 Type a short name for the variable in the Short Description box, using any
combination of upper- and lowercase letters. For example, the name for the
V_SALES variable might be Sales. Express Client products display the short
name in tables, graphs, and the Dimension Bar.

13 Type a description in the Comments box. If the short name is Sales, the
description might be Sales Dollars. In Express Client products, the
description appears in the Database Browser and in the Selector.

14 In the Format tab, you can specify the formatting for a variable with numeric
data.

IF . . . THEN . . .

you want to specify the formatting
for a variable with numeric data,

clear the Use Default  box and
enter values in the Format and
Display Type boxes.

you want to use global values
and not specify the formatting for
a variable with numeric data,

select the Use Default  box.

15 Choose Define .

16 When you are through defining variables, choose Close .

Stage 5: Method 1— Importing Data
into Variables
Overview

Once you have created a variable, you can add data to that variable. You
can either enter data values manually or import data. This topic describes
how to import data.

Adding data to a variable with hierarchical dimensions

If your variable has one or more hierarchical dimensions, in most cases,
you will probably add data to your variable for the lowest level of the
hierarchy. In order to total that data for all other levels of the hierarchy, you
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must roll up that data as described in the topic, “Stage 6: Rolling Up Data
with and Without the Rollup Wizard.”

Importing ASCII data

You can import data from two types of ASCII files:

� Structured files contain records whose fields are delimited by
characters. Text fields are identified by quotes. Numbers are identified
by spaces or commas.

� Ruled files contain records whose fields have a fixed length. Each field
occupies a certain number of columns in the file (one column being one
character or space).
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Procedure: Importing ASCII data into a variable

Use the following procedure to add ASCII data to a variable by importing
ASCII data values.

Step Action

1 Create Express objects to store the data, as described in this chapter and
the Help system.

2 From the File menu, choose Import.

3 From the submenu, choose Text  to display the Import Text dialog box.

4 Use the Import Text dialog box to create a data loader program to read in
the data. You must specify the following information:

� The file from which you want to import data

� Whether the file has character-delimited fields or fixed-length fields

� If the file has character-delimited fields, the characters that are used as
delimiters

� The Express object in which the data in a field will be stored

When you specify a file from which to import data, the fields and sample text
for the first record are displayed in the Import Text dialog box. You can
display this information for any record by selecting a new record number.

To specify the Express object in which a field’s data will be stored, drag the
object from the Database Browser and drop it on a row in the File Layout
box. The Dimension or Data Properties dialog box will be displayed, in
which you can modify the data to be imported. You can double-click on an
object in the row to redisplay a Properties dialog box.

When you return to the Import Text dialog box and save the information you
have specified, Administrator creates a data loader program.

5 Execute the data loader program. You will be prompted to do this when
Administrator creates the data loader program, or you can execute it
separately. The program appears under Programs in the Database Browser.
You can run the program at any time. Select the program in the Database
Browser, and choose Execute from the right mouse popup menu. This
displays the Execute Data Loader Program dialog box. To run the program,
choose Execute.

Using data loader programs

You do not have to load all fields in a source file with the same data loader
program. You can read the same file several times, reading in different
information each time.
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Related information

For further information, see the following:

� See Chapter 9 for details about importing data into a variable.

� For more information about importing ASCII data and data reader
programs, see the Express Language Programming Guide.

� To see detailed instructions for importing ASCII data, search for the
following topics in the Administrator Help system:

“Data Properties (Boolean) Dialog Box”
“Data Properties (Numeric) Dialog Box”
“Data Properties (Text) Dialog Box”
“Dimension Properties (Integer) Dialog Box”
“Dimension Properties (Text) Dialog Box”
“Execute Data Loader Program Dialog Box”
“Import Text Dialog Box”

� See Chapter 13 for information about using the = and FILEREAD
commands to assign data to a variable.

Stage 5: Method 2 — Manually Adding
Data to the Variables
Overview

Once you have created a variable, you can add data to that variable. You
can either enter data values manually or import data. This topic describes
how to enter data manually.

Adding data to a variable with hierarchical dimensions

If your variable has one or more hierarchical dimensions, in most cases,
you will probably add data to your variable for the lowest level of the
hierarchy.
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In order to total that data for all other levels of the hierarchy, you must roll
up that data, as described in the topic “Stage 6: Rolling Up Data with and
Without the Rollup Wizard.”

Procedure: Entering data values manually

Use the following procedure to add data to a variable by entering data
values manually.

Step Action

1 Double-click on the variable in the Database Browser to display the Modify
Variable dialog box.

2 To edit the data, select the Data tab, click on the field you want to edit, and
enter a new value.

3 To specify formatting for numeric data, select the Format tab, and enter
appropriate values.

4 To define data-driven formatting formulas for a variable, select the Data
Driven Format tab, and enter appropriate values.

5 Choose Close  to return to the Main Window.

Viewing the data in a variable

If you want to view a small portion of the variable’s data, choose Selector
in the Data tab to open the Selector and set status for the variable’s
dimensions. Setting status allows you to limit the portion of the variable’s
data that you will view. After you have set status, you can use the scrollbars
to see the full two-dimensional slice of data. To see additional pages of
data, select different values for the other dimensions in the Dimension list
boxes. You can enter new values or edit a value by double-clicking on it.

You can also rotate the data display by switching the position of the
dimensions. For example, if the display shows time periods down the first
column and line items on separate pages, you can switch them so that line
items appear down the first column and time periods appear on separate
pages. Just click on the dimension name and drag it onto another dimension
name. You can also drag the dimension values in the table. The dimensions
will switch positions.
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To change the width of the columns, click the right mouse button. Then
choose Column Width  to display the Column Width dialog box. Type in
new values for the width of the columns.

Related information

For further information, see the following:

� See Chapter 13 for information about using the = and FILEREAD
commands to assign data to a variable.

� For information on how to use the Selector, see the Help system.

Stage 6: Rolling Up Data with and
Without the Rollup Wizard
Overview

Each variable you define is likely to be dimensioned by one or more
hierarchical dimensions.

After you have defined a variable with hierarchical dimensions, the most
efficient approach to adding data to that variable is to load data into the
lowest level of the hierarchy and then roll up that data to all levels of the
hierarchy. You can roll up data using the Rollup Wizard or by entering an
Express command in the Express Command window.

Guidelines for using the Rollup Wizard or the Express Command window

Oracle Corporation recommends that you use the Rollup Wizard to roll up
data except when there are conjoint dimensions in the database. The Rollup
Wizard will roll up data over conjoint dimensions, but it is more likely that
you will want to roll up data over the dimensions that compose the conjoint
dimensions. If you want to keep conjoint dimensions in the database, you
will need to use the ROLLUP command in the Express Command window.

You can change conjoint dimensions to composites with the CHGDFN
command. You will then need to rewrite any load, calculation, and output
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programs. Oracle Corporation recommends that you use composites instead
of conjoint dimensions for new databases.

Related information

See Appendix B for information about using the CHGDFN command to
change a conjoint dimension to a composite dimension.

Procedure: Using the Rollup Wizard to roll up data for all levels of the
hierarchy

The following procedure describes how to use the Rollup Wizard to roll up
data.

Step Action

1 From the Tools menu, choose Rollup Wizard  to invoke the Rollup Wizard.

2 Follow the instructions for each step in the Rollup Wizard. Detailed Help is
available for each step.
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Procedure: Writing an Express program to roll up data for all levels of the
hierarchy

The following procedure describes how to get the name of the relation for
your hierarchical dimension and how to use the ROLLUP command.

Step Action

1 From the Run menu, choose Express Command  to display the Express
Command window.

2 In the Command window of the Express Command window, type the SHOW
command with the OBJ function using the following syntax.
show obj(property 'PARENTREL' 'dimension-name')

For example, to get the parent relation name of the GEOGRAPHY

dimension, you would type the following command, then choose Run  (
)to execute the command.
show obj(property 'PARENTREL' 'GEOGRAPHY')

The result of the above command will be in the form X.PARENT where X is
“g0.parent.”

3 In the Command window, type the ROLLUP command using the following
syntax.
rollup variable-name over dimension-name using
relation-name

So, for example, to roll up the SALES variable, you would type the following
command.
rollup sales over geography using g0.parent

4 Choose Run  to execute the command.
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Figure: Using the ROLLUP command

The following figure shows a sample ROLLUP command in the Express
Command dialog box.

Confirming the ROLLUP results

If you open the Modify Variable dialog box for the variable and look at the
Data tab, you will see that data has been rolled up for every parent
dimension value.

Important: Rolling up data with multiple hierarchies

Data is rolled up for one hierarchy at a time. If two or more hierarchies
share the same dimension values at any level other than the lowest level
and the data rolls up differently into a dimension value that is shared by
multiple hierarchies, the data created by the previous rollups is overwritten
by the data created by the last hierarchy that is rolled up. If you know that
such a conflict exists among hierarchies, you must have only a single
hierarchy in status when performing a rollup.

The Rollup Wizard warns you of conflicts among hierarchies. If you want
to find out if there is a conflict, start the Rollup Wizard, but do not run the
program.
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When you should roll up the data in a variable

Whenever you add values to an existing hierarchical dimension, or you
change or add data to your variable, you must roll up that data. You should
also recalculate the hierarchy if you have added new dimension values.

Related information

See Chapter 10 for more detailed information about hierarchical
dimensions, especially in regard to configuring your database.

Stage 7: Defining Other Database
Objects
Overview

Although dimensions and variables are the essential database objects that
you must define, you can also define formulas, models, programs, relations,
and valuesets.

The importance of using formulas

You should consider using formulas whenever possible. Formulas calculate
temporary data that you do not need to store permanently in your database.

Example: Using formulas

Suppose your database has a variable named UNITS that has an integer
data type and is dimensioned by MONTH, PRODUCT, and DISTRICT.
This variable stores data about the number of units of every product that is
sold each month in each district.

Another variable, PRICE, has a decimal data type and is dimensioned by
MONTH and PRODUCT. This variable stores data about the price of each
product, which changes from month to month.

Now, suppose you want to determine sales information about each product.
To do so, you can define the formula SALES, whose data is simply the



Stage 7: Defining Other Database Objects

175

product of UNITS multiplied by PRICE. Define the formula with the same
dimensions (and in the same order) as UNITS and PRICE. In the Equation
box in the Define a Formula dialog box, enter the following equation.

UNITS * PRICE

SALES, as a formula, calculates values whenever they are needed.
Therefore, any changes you make to the data in UNITS or PRICE will
cause the data in the SALES formula to be recalculated automatically.

You could alternatively define a variable and set it equal to UNITS times
PRICE. Variables, however, must be recalculated using the Express
Command dialog box or a program.

DEFINE SALES VARIABLE DECIMAL <MONTH PRODUCT DISTRICT>
SALES = UNITS * PRICE

Alternatives for creating time dimensions

If you are creating time dimensions, you can use Express commands
instead of the Administrator interface to take advantage of some special
features Express offers.

Keep in mind that the time dimensions you create with Administrator are
the dimensions expected by the Express SpreadSheet Add-In and other
Express Client products. For example, if you create time dimensions using
Express commands, your users may not be able to take advantages of such
features as drilling down in their client applications.

However, if you find you need to create time dimensions other than the
ones available in Administrator, refer to the DEFINE DIMENSION
command in the Express Language Help system for more information.
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Related information

For information about defining these Express database objects, search for
the following topics in the Administrator Help system:

“Defining Formulas”
“Defining Models”
“Defining Programs”
“Defining Relations”
“Defining Valuesets”

Maintaining Hierarchies
Overview

It is most efficient to create hierarchies when you add values to dimensions.
The following procedures describe how to modify the structure of an
existing hierarchy, create additional hierarchies, copy an existing hierarchy,
or edit an existing hierarchy.

Procedure: Modifying hierarchical structure

You can modify the structure of a hierarchy using standard drag-and-drop
techniques in the Edit Dimension Values dialog box.
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Use the following procedure to modify the structure of a hierarchy.

Step Action

1 From the Database Browser, select a dimension, and from the right mouse
popup menu choose Edit Values  to display the Edit Dimension Values
dialog box.

2 From the hierarchy list, select a hierarchy.

Note:  Administrator will not open a circular hierarchy. A circular hierarchy is
one in which a dimension value is specified to be a descendant of itself.
When you select a circular hierarchy, a warning message is displayed
asking if you want Administrator to fix the problem. If you choose Yes,
Administrator will take the dimension value that is specified to be a
descendant of itself, move it to the top of the hierarchy, and display the
modified hierarchy in the Hierarchy box.

3 Insert items into the hierarchy by moving them from the Available box to the
Hierarchy box. Remove items from the hierarchy by moving them from the
Hierarchy box to the Available box.

4 Select and move items within the Hierarchy box and from the Available box
to the Hierarchy box to create the hierarchy you want.

Notes:  When you move an item and its child items, the new hierarchy is
displayed with the child items collapsed within the parent item.

To move an item from the Hierarchy box to the Available box, you must use

Remove Values (  ) and not drag-and-drop.

5 When you finish making changes to the hierarchy, choose Close.

6 Roll up the data over the new hierarchy.
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Procedure: Creating additional hierarchies

A configured database is not limited to one hierarchy for each dimension.
Use the following procedure to create an additional hierarchy for a
dimension.

Step Action

1 In the Database Browser, select the dimension for which you want to create
an additional hierarchy.

2 From the right mouse popup menu, choose Edit Values  to display the Edit
Dimension Values dialog box.

3 From the main toolbar of the Edit Dimension Values dialog box toolbar,

choose Add Hierarchy  (  ) to display the Add Hierarchy dialog box.

4 Type a name and description for the new hierarchy and choose OK.
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Procedure: Copying an existing hierarchy

Use the following procedure to copy an existing hierarchy for a dimension.
Copying a hierarchy copies its whole content: parent-child relationships,
levels, and order. Once you have copied the hierarchy you can edit it in the
Edit Dimension Values dialog box. You can rename the hierarchy in the
Rename Hierarchy dialog box and rename hierarchy levels in the Rename
Hierarchy Levels dialog box. In the Edit Dimension Values dialog box, you
can add or remove levels from the hierarchy.

Step Action

1 In the Database Browser, select the dimension for which you want to copy
an existing hierarchy.

2 From the right mouse popup menu, choose Edit Values  to display the Edit
Dimension Values dialog box.

3 From the hierarchy list, select the hierarchy you want to copy.

Note:  Administrator will not let you copy a circular hierarchy. A circular
hierarchy is one in which a dimension value is specified to be a descendant
of itself. You must first modify the hierarchy to remove the circularity.

4 From the main toolbar of the Edit Dimension Values dialog box toolbar,

choose Copy Hierarchy  (  ) to display the Copy Hierarchy From
Hierarchy dialog box.

5 Type a new name and description for the hierarchy you want to create,
select the hierarchy you want to copy from the list, and choose OK.

Important: Rolling up data

When you create an additional hierarchy or modify an existing hierarchy,
you must roll up the data over all levels of the hierarchy.



Chapter 7  Creating a Database Manually

180

Procedure: Renaming a hierarchy

Use the following procedure to rename a hierarchy.

Step Action

1 In the Database Browser, select the dimension that contains the hierarchy
you want to rename.

2 From the right mouse popup menu, choose Edit Values  to display the Edit
Dimension Values dialog box.

3 From the hierarchy list, select the hierarchy you want to rename.

Note: Administrator will not open a circular hierarchy. A circular hierarchy is
one in which a dimension value is specified to be a descendant of itself.
When you select a circular hierarchy, a warning message is displayed
asking if you want Administrator to fix the problem. If you choose Yes,
Administrator will take the dimension value that is specified to be a
descendant of itself, move it to the top of the hierarchy, and display the
modified hierarchy in the Hierarchy box.

4 From the main toolbar of the Edit Dimension Values dialog box, choose

Rename Hierarchy  (  ) to display the Rename Hierarchy dialog box.

5 Type a new name for the hierarchy in the New Hierarchy Description box,
and choose OK. The new name will appear in the Database Browser.

For more detailed information, search the Help system for the topic
“Renaming Hierarchies.”
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Procedure: Renaming hierarchy levels

Use the following procedure to rename hierarchy levels.

Step Action

1 In the Database Browser, select the dimension that contains the hierarchy
whose level descriptions you want to rename.

2 From the right mouse popup menu, choose Edit Values  to display the Edit
Dimension Values dialog box.

3 From the hierarchy list, select the hierarchy whose level descriptions you
want to rename.

Note: Administrator will not open a circular hierarchy. A circular hierarchy is
one in which a dimension value is specified to be a descendant of itself.
When you select a circular hierarchy, a warning message is displayed
asking if you want Administrator to fix the problem. If you choose Yes,
Administrator will take the dimension value that is specified to be a
descendant of itself, move it to the top of the hierarchy, and display the
modified hierarchy in the Hierarchy box.

4 From the main toolbar of the Edit Dimension Values dialog box, choose

Rename Hierarchy Levels  (  ) to display the Rename Hierarchy Levels
dialog box.

5 From the Level Description column, select the level description you want to
rename, and press F2 to enter edit mode.

6 Choose OK when you have finished renaming the level descriptions.

For more detailed information, search the Help system for the topic
“Renaming Hierarchy Levels.”

Working with Valuesets
Definition of a valueset

A valueset is an Express object that contains a list of dimension values for a
particular dimension.

The values in a valueset can be saved across Express Server sessions. You
can limit a dimension to the values that are stored in a valueset for that
dimension.
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Creating a valueset

First, you define a valueset.

You then use the LIMIT command in the Express Command dialog box to
assign values from the dimension to the valueset.

Procedure: Defining a valueset

Use the following procedure to define a valueset.

Step Action

1 From the Edit menu, choose Define.

2 From the submenu, choose Valueset  to display the Define a Valueset
dialog box.

3 Specify the appropriate settings in the dialog box.

4 Choose Define.

5 Choose Close.
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Assigning dimension values to a valueset

When you first define a valueset, its value is NULL; that is, it holds no
dimension values. You must then use the following procedure to assign
dimension values to the valueset.

Step Action

1 From the Run menu, choose Express Command  to display the Express
Command dialog box.

2 In the dialog box, use LIMIT commands to set the status of the valueset’s
dimension.

The dimension values that are in status are automatically assigned to the
valueset.

For example, suppose you want to limit the MONTH dimension to the even-
numbered months of 1997. After creating a valueset named EVEN97, you
would assign dimension values to the valueset with the following
commands.
define even97 valueset month
limit even97 to 'FEB97' 'APR97 'JUN97 'AUG97' -
'OCT97' 'DEC97'

3 When you have finished editing, choose Close.

Using a valueset

Once you have created a valueset, you can use it with Express commands
in programs. For example, you can use the LIMIT command to limit the
status of a dimension to a valueset.

You must choose Standard View from the View menu in Administrator to
see valuesets that are listed in the Database Browser.

Related information

For further information, see the following:

� For information on defining valuesets, search the Administrator Help
system for the topic “Defining Valuesets.”

� See the Express Language Help system for information about using the
LIMIT command. Chapter 12 also gives a brief discussion of some
common Express commands you can use, including the LIMIT
command.
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Working with Models
Definition of a model

A model is an Express object that contains a set of interrelated equations.

Purpose of a model

Models let you store and solve a set of interrelated equations. The equations
can be based on the values of variables or dimensions.

For example, you can define a financial model with equations based on the
values of a line item dimension. The equations in the model can use input
data for some line items, such as revenue and expenses, to calculate other
line items, such as net income and return on sales.

Related information

For information on defining, editing, compiling, and executing models,
search for the following topics in the Administrator Help system:

“Defining Models”
“Edit Menu Bar”
“Edit Window”
“Editing Programs and Models”
“Executing Programs and Models”
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Chapter 8

Working with Databases

Overview
Introduction

This chapter describes some of the basic database operations that you
typically need to perform.

In this chapter

� Opening a Database

� Setting Properties for a Database

� Saving Changes in a Database

� Closing a Database

� Converting an Application Database

� Ensuring That the Client Application Can Find Your Databases

� Working with Database Languages

� Defining System Shutdown Programs
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Opening a Database
Overview

You can open an Express database using Administrator. Once you have
opened the database, its contents appear in the Database Browser. There is
no limit to the number of databases that can be open at the same time.

The Open Database dialog box

You use the Open Database dialog box to open a database in Administrator.
The following figure shows an example of the Open Database dialog box.

Read/write or read-only access

Administrator allows you to open a database with either read/write or read-
only access (unless you do not have read/write access). By default,
databases are opened with read/write access. If you want to open a database
with read-only access, select the Open as read-only option in the Open
Database dialog box. If you open a database with read-only access,
Administrator displays a warning that no changes will be saved upon exit.
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Procedure: Opening a database

Use the following procedure to open a database.

Step Action

1 Click on the Open Database button or choose Open  from the File menu to
display the Open Database dialog box.

2 Select the database you wish to open.

IF . . . THEN . . .

the database is located on a
different drive and directory from
the current one,

select the correct drive and
directory in the appropriate
boxes.

the database is located on a
different server from the one to
which you are currently
connected,

you must first disconnect from the
current server, then connect to
the server on which the database
is located. (From the File menu,
choose Disconnect , then choose
Connect  to use the Connect
dialog box.) After you have
connected to a different server,
you can then display the Open
Database dialog box and select
the correct drive and directory in
the Look In box.

The Open Database dialog box only allows you to switch drives and
directories for the current server.

3 Select the database from the list, or type its name in the File Name box.

If the database does not have a .DB file name extension, you can either
type in the extension, such as .EXP, or select All Files  in the Files of Type
box.

4 If you want to open the database with read-only access, choose Open as
read-only;  otherwise, do not select this option.

5 Choose Open.

6 If the database is protected by a password, you are prompted to enter the
password.
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Note: Database sharing on multiple servers

Two separate instances of Express Server can have the same database open
simultaneously only if the database file is flagged as read-only at the
operating system level.

Setting Properties for a Database
Definition of database properties

You can specify how a client application handles a given database by
specifying the database properties in Administrator. The properties of a
database are a group of characteristics such as the path name, the access
mode (read-only or read/write), and whether the database should be hidden
from the client application user.

Viewing and setting properties

To view and set properties for a database, first select the database in the
Database Browser, then choose Property Inspector from the Tools menu
to open the Property Inspector. The following figure shows an example of
the Property Inspector as it might appear when the selected object in the
Database Browser is a database.
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Database properties available in the Property Inspector

The following table describes the database properties that are listed in the
Property Inspector.

Property Description

Attach Order The database’s place in the attach order (relevant only if the
database will be opened automatically)

AutoAttach Whether the database should be attached (opened)
automatically when the client application starts

DatabaseID The database identifier for the database that is currently
selected in the Database Browser.

Database Name The name of the database that is currently selected in the
Database Browser

Description A phrase describing the database

Extendsize The size of the increment by which Administrator extends the
component files of the database

Filesize The maximum size of each component file (main and
extension files) for the database

Language Dimension The dimension that holds the names of all the languages that
the client application can use with the database

PathName The full path name of the directory in which the database file
resides, including the file name

Pre-Attach Program The name of an Express program that the client application
runs before opening the database

Pre-Detach Program The name of an Express program that the client application
runs before closing the database

Post-Attach Program The name of an Express program that the client application
runs after opening the database

Post-Detach Program The name of an Express program that the client application
runs after closing the database

ReadOnly Whether a user can open the database as read-only or
read/write

User Data Whether the database and its contents are visible to the user
in the client application
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See the Administrator Help system for more information about each
property.

Saving Changes in a Database
Overview

You can save changes to any database that has been opened with read/write
access.

Saving changes to a single database

To save changes to a given database, select the name of the database (or
select an object within that database) in the Database Browser and choose
Save dbname from the File menu, where dbname is the name of the
database.

Saving changes to all open databases

If you want to save all of the changes you have made in all open databases,
you can choose Save All from the File menu.

Closing a Database
Overview

After you have finished working with a database, you can close the
database. Once a database is closed, it no longer appears in the Database
Browser.

How to close a database

To close a database, choose Close from the File menu.

If you have more than one database open, Administrator displays the Close
Databases dialog box. To close one or more databases, select the database
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or databases that you want to close, then choose OK.  The following figure
shows an example of the Close Databases dialog box.

Saving changes before closing a database

Before you close a database, save any changes you have made, unless you
do not want to save the work you have done. If you do not save your
changes before attempting to close a database, Administrator issues a
prompt that asks if you want to save the changes to the database before
closing it. Answer Yes to the prompt if you want to save your changes;
answer No if you want to close the database without saving changes.

Important: Conflicting object names in different databases

Be sure to close a database before trying to open another one with the same
object names. If you try to open a database that contains an object with the
same name as an object in an already open database, a warning message
appears, informing you of the conflict in object names. If you choose to
ignore the warning and open the database anyway, you can create
unanticipated interactions between the objects, because Administrator
might load objects from the wrong database.

Converting an Application Database
Converting other application databases

If you have a database that has been set up for one of the following Oracle
applications, you can convert it for use with Express Client products:

� Oracle Express/EIS, release 4.5 or later
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� Oracle Financial Analyzer, release 4.6 or later

� Oracle Sales Analyzer, release 1.3 or later

Important: Upgrade the database before you convert it

To convert a database that has been set up for one of the above
applications, you must first upgrade it, as described in Appendix C,
“Upgrading from Express 5.” After you have upgraded the database to
Express 6, you can then use Administrator to convert it.

Administrator understands the data structures these applications use for
handling such things as labels and hierarchies, so it can make conversion
adjustments in your database to allow the Express Client Data Dictionary to
understand them as well.

Backing up the database before you convert it

When you convert a database, Administrator makes some additions to it;
however, those additions do not affect your ability to use the database with
its original application, as long as the application works with Express 6.
Nevertheless, it is always a good idea to back up your database before
converting it.

If you plan to convert a database that has been used with an earlier release
of Express (prior to 6.0) that predates the release an Express Client product
uses, you must take special precautions. After you convert a database for
Express Client products, you cannot use it with an earlier release of
Express. Therefore, do not convert the database directly. Make a copy of
the database, and convert the copy for use with Express 6. Save the original
database for use with the earlier release of Express.

Guidelines for converting Oracle Sales Analyzer databases

When using Administrator to convert Oracle Sales Analyzer databases, use
the following guidelines:

� Convert slice databases only. Do not try to convert any other type of
Oracle Sales Analyzer database.

� Convert only one slice database at a time.
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� If you want to convert an Oracle Sales Analyzer slice database that has
not been upgraded to Express 5 (that is, one used with Oracle Sales
Analyzer release 1.5 or earlier), make a copy of the database before
converting it. Convert the copy and continue to use the original version
with your Oracle Sales Analyzer application.

� You can use saved selections from your personal database if you
specify the name of your personal database during the conversion
process.

� If you created saved selections as scripts in Oracle Sales Analyzer and
you want to use these saved selections in Express Client products, then
you must do the following:

� Set the User Data property to NO for DSCODE.DB.

� Set the Pre-Attach Program property of the slice database to a
program that opens DSCODE.DB.

� Set the Post-Detach Program property of the slice database to a
program that closes DSCODE.DB.

Performing the conversion

To convert a database, choose Convert from the File menu to display the
Convert Application Databases dialog box. Specify the application for
which you want to convert the database, as well as the complete path names
of the databases you are converting (as appropriate for the application).
Then, choose Convert to perform the conversion.
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The following figure shows an example of the Convert Application
Databases dialog box.

Effects of conversion

As you begin the conversion process, you specify the names of related
databases, such as the data and catalog databases. You do not have to have
the databases open. However, if the database is opened prior to the
conversion, Administrator leaves the database open after the conversion.

Administrator does not rename databases during conversion; rather, it
retains their original names.

Related Information

For information on the procedure for converting databases, search for the
following topic in the Help system:

“Converting Application Databases”
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Ensuring That the Client Application
Can Find Your Databases
Configuring a database for automatic opening

You can use Administrator to configure data and application databases so
that the client application opens them automatically. You do this by setting
the AutoAttach property to Yes. If you set this property, then you must
ensure that the client application can find the database.

Definition of data databases

The data databases are the Express databases you create and to which you
add data.

How a client application locates data databases

When the client application starts, it checks the Data Dictionary to see if
any data databases are configured to be opened automatically. (When you
start a project or query, the application also checks for any databases that
are part of that project or query.) If there is such a database, the client
application attempts to open the database by searching the following
locations in the indicated order:

 1. The directory from which the database was opened when the project or
query was last saved.

 2. The directory (optionally) that is specified by the DBA in the database’s
Path property when the DBA configured the database. If the client
application finds the database in the specified directory, it opens the
database and runs pre-attach and post-attach programs, if any are
specified.

How a client application locates the application databases

The application databases are XPDB.DB, XPDDCODE.DB,
XPDDDATA.DB, and XPADMIN.DB. See “Databases You Should Know
About” in Chapter 3 for a brief description of these databases.



Chapter 8  Working with Databases

196

If Administrator or a client application cannot find the application
databases, it will not be able to connect to Express Server. The client
application and Administrator locate XPDB.DB, XPDDCODE.DB,
XPDDDATA.DB, and XPADMIN.DB by searching the following locations
in the indicated order:

 1. The current working directory of Express Server.

 2. The paths that are specified in the ExpressServerDBPath setting in the
server configuration on the Express Server machine. This means that all
of the application databases must be located in a directory that is
included in the ExpressServerDBPath setting, which your system
administrator specifies using Configuration Manager. You should
coordinate with your system administrator to find out or request which
paths are specified in the ExpressServerDBPath setting. You should
also ask your system administrator for information about other server
settings that are related to directories.

Security issues

It is possible for several Express Server services to run on the same server.
A service can be set up with security, so that it requires client users to
identify themselves. In this case, you must edit your configuration file so
that Administrator can connect to Express Server. The same edits must also
be made to the configuration file used by any client application that
attempts to connect to Express Server. See Chapter 3 for more information.

If an Administrator or client application user connects to Express Server
using security, Administrator or the client application will first look for the
location of the application databases in the path setup for the account that is
used. If an Administrator or client application user connects to Express
Server without using security, the default user ID is used. If that user ID has
a path setup, Administrator or the client application will use this as its
“home” directory.
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Working with Database Languages
Database languages

Administrator creates a language dimension for each open database. The
default name of the language dimension is _XX_LANGDIM, where XX is
the database identifier. By default, the dimension has a value (ENU).

You can add additional values for any other languages in the client
application. As you configure dimensions and measures, you will find that
several of their supporting data structures are dimensioned by the language
dimension, so you can specify different values for different languages.

Specifying the Database language

To specify a language for a database, select the database in the Database
Browser, then choose Property Inspector from the Tools menu. Select the
Language tab in the Property Inspector. The Language tab allows you to
add and delete database languages and specify the current database
language. When you add or delete languages, Administrator modifies the
values in the language dimension.
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The following figure shows an example of the Langauge tab in the Property
Inspector.

Using a different dimension as the language dimension

Under certain conditions, you can specify a different dimension to serve as
the language dimension:

� If you are just beginning to work with a database, you can specify
another dimension. It must be a TEXT or ID dimension, and it must
reside in the database with which you are working.

� If you are working with a database that has been at least partially
configured by Administrator, avoid specifying another dimension.
Doing so may produce unexpected results.

Note: Deleting a value from the language dimension

Deleting a value from the language dimension can have serious
consequences. Several data structures that are used by the Data Dictionary
are dimensioned by the language dimension, and information (such as level
and hierarchy descriptions) is kept in those data structures. When you
delete a value from the language dimension, you delete all the information
for it in all relevant data structures.
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The current database language

You can specify the current language for each database through the
Langauge tab of the Property Inspector. The current language values can be
the codes for specific languages, such as ENU for U.S. English.

If you specify a current language, this value overrides the language
specified in the WIN.INI file (for Windows 3.1 or Windows 95) or the
Registry (for Windows NT).

Specifying the Windows Default language

You can also specify Windows Default for the current language. If you
specify this value, the client application uses the language that is specified
in the WIN.INI file or Registry.

If your users want to use the client application with the language from their
own WIN.INI files or Registry, set the current language for each database
to Windows Default.

Adding database languages

Whenever you add languages, ensure that you are using the correct
operating system code for that language (for example, “ENU” for English
as spoken in the United States). You can check the international section of
your WIN.INI file or the Registry to check the operating system code.

As part of the process of installing languages, you can provide descriptive
labels in the new language for dimensions, variables, formulas, and other
objects. See Chapter 11 for further information about labels and about
setting properties of a dimension.

Related information

For more information on languages, search for the following topic in the
Administrator Help system:

“Installing Additional Languages”
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Defining System Shutdown Programs
Overview

You can develop a program that the client application will run
automatically every time it closes. You might want to run a program that
disconnects the user from a remote system, reverses the operations of a
system preprocessor, or does other similar activities.

Specifying a shutdown program

The system has only one shutdown program. You must ensure that the
database that contains the shutdown program is open, so that the client
application can find the program when it is ready to shut down. You can
name the program anything you like.

Use the General tab in the Administrator Options dialog box to specify
which program to use as the shutdown program.

Related information

For more information on system shutdown programs, search for the
following topics in the Administrator Help system:

“Defining Programs”
“Editing Programs and Models”
“Specifying a System Shutdown Program”
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Chapter 9

Importing and Exporting Data

Overview
Introduction

This chapter describes how to import data from various sources, what to do
after you have loaded data into your database, and how to export data from
your database.

In this chapter

� The Data You Can Import

� Importing Data from a Text File

� Importing Data from a Relational Database

� Importing Data from an EIF File

� Importing Data from a Discoverer File

� Importing Hierarchy Information

� Using the Data Loader Program

� Rolling Up Data Using the Rollup Wizard

� Exporting Data to an EIF File
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The Data You Can Import
Overview

Once you have created a database and defined the dimensions, variables,
and other Express objects that provide structure for your data, you can load
the data into the database from a file.

However, there are a variety of ways in which you can import data into an
Express database, depending on the source data.

The data sources from which you can import data into your database

You can import data from:

� Structured or ruled ASCII files (PRN or TXT files)

� Relational databases (SQL data source)

� Express Interchange Format (EIF) files

� Discoverer (DCS) files
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The steps you take to import each type of data

The tasks you need to perform depend on the type of data you want to
import and where that data resides.

IF you want to import . . . THEN . . .

data from ASCII (PRN or TXT) files, define an Express database, define the
Express objects for each type of data you
want to import, generate a data loader
program, and run the data loader
program to import the data.

SQL data from a relational database, define an Express database, define the
Express objects for each type of data you
want to import, generate a data loader
program, and run the data loader
program to import the data.

data and Express objects from an EIF
file,

define an Express database and use
Administrator dialog boxes to import the
data and Express objects. (You do not
have to define Express objects before
you begin the import.)

data from a Discoverer file, use Administrator dialog boxes to import
the data. (You do not have to define an
Express database or objects before you
begin the import.)

Other topics in this chapter describe in detail the steps you take to import
each type of data.

The importance of understanding the structure of the data

Before importing data from any source, you must know the structure of the
data in the source file.

Once you understand the structure of the data, you can then decide which
dimensions, variables, relations, and other Express objects you need to
define. These objects will store the data properly in the Express database.

Example: What to do before you load data from a file

In most cases, before you load data, you will define a new database, then
define the database objects in which the data will be stored. You will
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usually load text dimension values into dimensions and decimal or integer
data into variables.

For example, suppose the following is a row of information from a
structured ASCII file that you wish to load into a new database that you
have created:

"JAN98 ","TENTS     ","TOTUS   " 1429, 20156.50

The quotes and commas are delimiters. Therefore, the values are for five
different objects. The text values (JAN98, TENTS, and TOTUS) are
dimension values. The numeric values (1429 and 20156.50) are data values.

In this example, assume that 1429 is the number of tents sold in the United
States in the month of January 1998. Also, assume that 20156.50 is the
dollar value of all tents sold in the United States in the month of January
1998.

With this information, determine the Express database object that you need
to define for each value in the row, as shown in the following table.

IF the value in the file is . . . THEN the Express object you should define is . . .

JAN98, a dimension named MONTH.

TENTS, a dimension named PRODUCT.

TOTUS (Total United States), a dimension named GEOGRAPHY.

1429, a variable named UNITS.

20156.50, a variable named SALES.

Therefore, before you can load the data from the file, you must define the
following Express database objects:

� Three text dimensions (MONTH, PRODUCT, and GEOGRAPHY)

� One integer variable (UNITS)

� One decimal variable (SALES)

After you have defined these database objects, you can then import the
data.
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After you import the data

After importing data, configure the database as described in Chapter 11.

If any of your dimensions have one or more hierarchies, then you must roll
up the data to all the levels of the hierarchy for which values have not been
loaded.

Typically, you will load data only at the lowest level of the hierarchy, then
use a rollup program to aggregate that data for each level of the hierarchy.
Use the Rollup Wizard to generate a rollup program, which you can either
run immediately or schedule to run at a later time.

Be aware that, if a dimension has more than one hierarchy, the data in the
database might be accurate for only the last hierarchy that was rolled up if
there is any conflict between hierarchies. See the Help topics for the Rollup
Wizard for details.

Importing Data from a Text File
Understanding the types of text files

You can import data from two types of text files:

� Structured files contain records whose fields are delimited by
characters. Text fields are typically identified by quotes. Numbers are
typically identified by spaces or commas.

� Ruled files contain records whose fields have a fixed length. Each field
occupies a certain number of columns in the file (one column being one
character or space).



Chapter 9  Importing and Exporting Data

206

Procedure: Importing ASCII data

When you import ASCII data, you use the following basic steps.

Step Action

1 Define Express objects to store the data (as described in Chapter 6, Chapter
7, and the Administrator Help system).

2 From the File menu, choose Import .

3 From the submenu, choose Text  to display the Import Text dialog box.

4 Use the Import Text dialog box to create a data loader program that will read
in the data.

5 Execute the data loader program.
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Procedure: Creating a data loader program

Use the following procedure to create a data loader program.

Step Action

1 From the Import Text dialog box, specify the file from which you want to
import data in the Data File box.

You may use the Browse  button to specify the file.

2 Specify whether the file has character-delimited fields or fixed-length fields
in the File Type box.

3 If the file has character-delimited fields, text must be enclosed in text
delimiters. Specify the characters that are used as delimiters in the
Delimiters box.

4 Specify the Express object in which the data in a field will be stored.

To do so, drag the object from the Database Browser and drop it on a row of
the File Layout box. The Dimension or Data Properties dialog box will be
displayed, in which you can modify the data to be imported.

5 When you have made modifications, if any, to the data to be imported,
choose OK in the Dimension or Data Properties dialog box.

6 Map the other fields to Express objects.

7 When you return to the Import Text dialog box, choose Save to display the
Save Data Loader dialog box.

8 In the Save Data Loader dialog box, type in the name you want to assign to
the data loader program.

9 Select the database in which you want to store the program.

10 Choose OK.

11 You will be prompted to run the data loader program. If you choose Yes,
then you will see the Execute Data Loader Program dialog box, which you
can use to execute your program. If you choose No, then the data loader
program is saved and will be listed under Programs in the Database
Browser.

See “Using the Data Loader Program” in this chapter for more information.

Loading dimension values and data from one or more files

You must load all of the values for all of your dimensions before you load
the data for other objects, such as variables.
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How many data loader programs you need depends on where your data is
located.

IF the dimension values and
the data are located in . . .

THEN . . .

different files, create one data loader program to load the
dimension values, then create another data loader
program to load the data.

the same file, create just one data loader program.

If you create one data loader program, it will be executed in two passes by
default. The first pass loads the dimension values, and the second pass
loads the data.

Displaying information for different records

When you specify a file from which to import data, the fields and sample
text for the first record are displayed in the Import Text dialog box. You
can display this information for any record by specifying a new record
number.

Related information

� For more information about importing ASCII data and data reader
programs, see the Express Language Programming Guide.

� To see detailed instructions for importing ASCII data, search for the
following topics in the Administrator Help system:

“Data Properties (Boolean) Dialog Box”
“Data Properties (Numeric) Dialog Box”
“Data Properties (Text) Dialog Box”
“Dimension Properties (Integer) Dialog Box”
“Dimension Properties (Text) Dialog Box”
“Import Text Data Dialog Box”
“Importing Text Data”
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Importing Data from a Relational
Database
Before you import data

You can import data from a SQL data source into an Express database.
Make sure your system administrator has installed the appropriate SQL
support on the machine on which Express Server is installed. For Personal
Express 6, you must have SQL support installed on your PC.

In addition, you must set up an ODBC data source on the PC on which
Administrator is installed. See Chapter 16 for information about setting up
an ODBC data source.

Procedure: Importing data from a relational database

When you import data from a relational database, you use the following
basic steps.

Step Action

1 Create Express objects to store the data (as described in Chapter 6,
Chapter 7, and the Administrator Help system).

2 From the File menu, choose Import .

3 From the submenu, choose Relational  to display the Import Relational Data
dialog box.

4 Use the Import Relational Data dialog box to create a data loader program.

5 Execute the data loader program.
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Procedure: Creating a data loader program

Use the following procedure to create a data loader program.

Step Action

1 From the Import Relational Data dialog box, select a current connection from
those listed.

2 Choose OK to return to the Import Relational Data dialog box.

3 Specify the SQL table from which to import data in the Table Name box.

4 Specify the Express object in which the data in a field will be stored.

To do so, drag the object from the Database Browser and drop it on a row of
the File Layout box. The Dimension or Data Properties dialog box will be
displayed, in which you can modify the data to be imported.

5 Specify the last data row to read into the database.

6 Choose Save to display the Save Data Loader dialog box.

7 In the Save Data Loader dialog box, type the name you want to assign to the
data loader program.

8 Select the database in which you want to store the program.

9 Choose OK.

10 You will be prompted to run the data loader program. If you choose Yes, you
will see the Execute Data Loader Program dialog box, which you can use to
execute your program. If you choose No, the data loader program is saved
and will be listed under Programs in the Database Browser.

See “Using the Data Loader Program” in this chapter for more information.

Related information

To find detailed instructions for importing data from a relational database,
search for the following topics in the Administrator Help system:

“Import Relational Data Dialog Box”
“Importing Data from Relational Databases”
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Importing Data from an EIF File
Definition: EIF file

An EIF file is an Express Interchange Format file. When you export data
from an Express database, an EIF file is generated to store that data. See
“Exporting Data to an EIF File” in this chapter for more information.

Once the data is in the EIF file, you can import the data into a target
database.

When you import data from an EIF file, you do not have to create the
Express database objects to store the information, as you do with data from
other sources. When you import the data, the Express database objects that
store the data are automatically imported.

Alternatively, you can import the data into an existing Express database.

Procedure: Importing EIF data

When you import EIF data and definitions into a database, you follow these
basic steps.

Step Action

1 In the Database Browser, select the target database, which will hold the
imported data. Alternatively, you can create a new database, then select it in
the Database Browser.

2 From the File menu, choose Import .

3 From the submenu, choose EIF to display the Import an EIF File dialog box.

4 Specify the file from which you want to read data and definitions.

5 Select the source database objects that you want to import. You do not have
to import all objects in one import operation.

Important: Object names should not exist in more than one opened
database

Make sure that no other opened database has the same object names as the
ones to be imported. For example, you cannot export objects from one
database to an EIF file, open or create a second database, and then import
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that EIF file into the second database while the first database is still opened.
If you attempt to do so, all the objects will be imported back into the first
database, because the same object names should not exist in more than one
opened database.

Guidelines for importing database objects

If the target database already contains definitions of the objects into which
you want to import data, the object definitions in the target database must
match the definitions in the source database from which the EIF file was
created, in both name and data type. Each time you import EIF data, you
can append new dimension values, read in only values that match the
dimension values already in the target database, or replace existing values
with imported values.

Related information

To see complete directions for importing EIF data, search for the following
topics in the Administrator Help system:

“Import an EIF File Dialog Box”
“Importing EIF Files”

Importing Data from a Discoverer File
Definition: DCS file

A file with an extension of “DCS” is a Discoverer file. When you export
data from a Discoverer report to Express, a DCS file is generated to store
that data.

In order to import data from a DCS file, you or someone else must first
create a DCS file. This task is performed with Discoverer, not with
Administrator.

You do not have to create an Express database or Express database objects
to store the information, as you do with data from some other sources.
When you import the data, you can specify that a new Express database and
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Express database objects will be automatically generated. Alternatively,
you can import the data into an existing Express database.

Once you have created or obtained a DCS file, you can import the data into
Express.

Procedure: Importing Discoverer data into an existing database

To import Discoverer data into a database that already exists, follow these
basic steps.

Step Action

1 Open an existing database.

2 From the File menu, choose Import.

3 From the submenu, choose Discoverer to display the Import a Discoverer
File dialog box.

4 Choose Browse  to display the Select a Discoverer File dialog box.

5 Select the name of the Discoverer file that you want to import. You may have
to change drives and directories first.

6 Choose Open  to open the Discoverer file.

The Select a Discoverer File dialog box is closed, and you are returned to
the Import a Discoverer File dialog box, where the name of the file you
selected is now displayed.

7 Make sure that Update Open Database  is selected.

8 If the database into which you want to import the Discoverer data is not
already listed in the Select Open Database box, select it from the drop-down
menu.

9 Choose OK to import the Discoverer data into the selected database.
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Procedure: Importing Discoverer data into a new database

To import Discoverer data into a new database, follow these basic steps.

Step Action

1 From the File menu, choose Import.

2 Choose Discoverer to display the Import a Discoverer File dialog box.

3 Choose Browse  to display the Select a Discoverer File dialog box.

4 Select the name of the Discoverer file that you want to import. You may have
to change drives and directories first.

5 Choose Open  to open the Discoverer file.

The Select a Discoverer File dialog box is closed, and you are returned to
the Import a Discoverer File dialog box, where the name of the file you
selected is now displayed.

6 Select Create New Database .

7 Choose OK to display the Create a New Express Database dialog box.

8 Specify the drive, directory, and name of the database in which the data and
data structures from the Discoverer file will be stored as Express objects
and their associated data.

9 Choose OK to create the new database.

The database name and data structures are displayed in the Database
Browser.

Related information

To see detailed instructions for importing Discoverer files, search for the
following topics in the Administrator Help system:

“Import a Discoverer File Dialog Box”
“Importing Data from Discoverer Files”
“Select a Discoverer File Dialog Box”
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Importing Hierarchy Information
What is hierarchy information?

Hierarchy information is information about one or more existing hierarchies
for the values that you want to import into an Express dimension. You may
have files that include information such as hierarchy names, labels for each
level of the hierarchy, and the name of the parent for each dimension value.

You can import hierarchy information in the same way that you import
dimension values and variable data. But you need to be able to identify the
hierarchy information that exists in the file that you want to import, then
identify the Express objects that will hold that information.

Identifying the Express objects that hold hierarchy information

When you define a dimension, Administrator automatically generates
metadata to support any hierarchies that you might want to create for that
dimension. The metadata is a group of Express database objects that store
information about the dimension.

In the Database Browser, click on the drill symbol (+) next to a dimension.
The Express objects that are listed below the dimension are the standard
metadata for that dimension.
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The following table describes the standard metadata.

Metadata Name
Express

Object Type Purpose

XnXnn.HIERDIM Dimension Identifies the hierarchies that are defined for
a dimension. HIERDIM stores the name of
every hierarchy.

XnXnn.LONGLABEL Variable Stores the long label for each dimension
value.

XnXnn.PARENT Relation Stores the name of the parent value of each
dimension value. If the dimension has
multiple hierarchies, the parent-child
information for every hierarchy is stored in
this object.

XnXnn.SHORTLABEL Variable Stores the short label for each dimension
value.

Understanding the metadata prefix

The metadata prefix, XnXnn, is the database identifier and the dimension
identifier. Only databases that are created with Administrator 6.2 have
prefixes.

When you define a new database, you may specify the database identifier in
the Database Identifier box in the Create a New Database dialog box.
Likewise, when you define a new dimension, you may specify the
dimension identifier in the Dimension Identifier box in the Define a
Dimension dialog box.

For example, if the name of the dimension is GEOGRAPHY and its
dimension identifier is G12, and the database identifier is AZ, the name of
the metadata object XnXnn.SHORTLABEL is AZG12.SHORTLABEL.

Identifying other useful Express metadata objects

The standard metadata objects that are listed under each dimension name in
the Database Browser are not the only metadata that exist. They are the
most commonly used.

It may be useful for you to know about and understand many of the other
metadata objects. To display the names of all metadata in the Database
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Browser, select Options from the Tools menu to display the Administrator
Options dialog box. In the DB Browser tab, select Show all metadata, then
choose OK  to exit the dialog box. All metadata for every dimension will
now be available in the Database Browser.

The following table describes the metadata that you may find useful to
know about.

Metadata Name
Express

Object Type Purpose

XnXnn.ANCESTORS Formula Calculates the ancestors of each dimension
value, using the information you provided in
the PARENT relation. Do not alter this
formula.

XnXnn.CHILDREN Formula Calculates the children of each dimension
value, using the information you provided in
the PARENT relation. Do not alter this
formula.

XnXnn.DEPTH Formula Calculates the number of levels each
dimension value is from the root (that is, the
most aggregate value). Do not alter this
formula.

XnXnn.DRILLICON Formula Calculates whether each dimension value
can be drilled up, drilled down, or not drilled.
Do not alter this formula.

XnXnn.HIERDESC Variable Contains descriptions of a dimension's
hierarchies. You can import descriptions into
this variable.

XnXnn.LEVELDEPTH Variable Identifies the number of levels each level in
a hierarchy is from the most aggregate level.
It is maintained when you calculate the
dimension hierarchy. Do not edit this
variable manually.

XnXnn.LEVELDESC Variable Stores descriptions for the hierarchy levels.
You can import descriptions into this
variable.

XnXnn.LEVELDIM Dimension Contains a value for each hierarchy level (for
example, in the form L1, L2, L3, and so
forth). These values are automatically
calculated by Administrator but can be
renamed.

XnXnn.LEVELHLIST Variable Contains a temporary list of levels as
needed by the Selector.
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Metadata Name
Express

Object Type Purpose

XnXnn.LEVELHREL Valueset A list of dimension values that identifies the
levels associated with the current hierarchy.
This valueset sets the status of the
LEVELDIM dimension. Do not alter this
valueset.

XnXnn.LEVELREL Relation Identifies the level (L1, L2, L3, and so on) for
each dimension value. Its values are
assigned when the dimension hierarchy is
calculated. Do not alter this relation
manually.

XnXnn.ORDER Variable Contains integers that identify the order in
which you want sibling dimension values to
appear in tables and graphs in Express
Client products.

XnXnn.ORDERVSET Valueset A hierarchical list of dimension values. This
valueset reorders the values of a dimension.
It is maintained when you calculate the
dimension hierarchy. Do not alter this
valueset.

Do I need a separate data loader program to import hierarchy information?

In order to import hierarchy information, you will generate a data loader
program.

IF the hierarchy information exists . . . THEN . . .

in the same file as the dimension values, you can generate one data loader
program to import both the dimension
values and the hierarchy information.

in its own file, you have to generate a separate data
loader program just to import hierarchy
information.

Mapping Express metadata objects to hierarchy information in a file

You map Express metadata to the hierarchy information that you want to
import in the same way that you map Express dimensions and objects to the
data that you want to import. You do this in the Import Text dialog box
when you are making specifications before you generate a data loader
program.
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See “Procedure: Creating a data loader program” in this chapter for details.

What if I do not have a file with hierarchy information?

If you do not have hierarchy information that you can import, you can
define one or more hierarchies for a dimension by using Administrator’s
Edit Dimension dialog boxes. In this case, you do not have to be concerned
about metadata. When you use Administrator dialog boxes to define your
hierarchies, the information you specify is automatically saved in the
metadata that is associated with that dimension.

Related information

For information about defining your own hierarchies instead of importing
hierarchy information, search for the following topic in the Administrator
Help system:

“Maintain Hierarchy Dialog Box”
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Using the Data Loader Program
Procedure: Executing the data loader program

Use the following procedure to execute a data loader program, once you
have generated one.

Step Action

1 You can display the Execute Data Loader Program dialog box in one of the
following ways.

IF you have . . . THEN . . .

just saved the data loader
program you have created in the
Save Data Loader dialog box,

choose Yes when you are
prompted to run the data loader
program.

previously created a data loader
program,

select the name of your data
loader program in the Database
Browser, and choose Execute
from the Run menu or the right
mouse menu.

2 Make any modifications you wish in the Execute Data Loader Program
dialog box that is displayed.

3 To run the program, choose Execute .

Loading partial information from a source file

You do not have to load all the fields in a source file (for ASCII data) or a
data source (for relational data) with the same data loader program. You
can read the same file or data source several times, reading in different
information each time.

Using a data loader program to import complex files

You can use one data loader program to import complex source files (for
ASCII data) or to import from a complex data source (for relational data).
For example, suppose one file or table contains all the information for a
dimension, including hierarchy information that is stored in a relation.
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By default, a data reader program is executed in two passes. The data
reader’s first pass reads all the dimension and relation columns in the file.
The values in the relation columns are appended to the related dimension;
they are not used to populate the relation. The data reader's second pass
reads all data values, including data that is associated with relations.

Related information

To see detailed instructions for using the data loader program, search for
the following topics in the Administrator Help system:

“Execute Data Loader Program Dialog Box”
“Import Text Dialog Box”
“Importing ASCII Data”

Rolling Up Data Using the Rollup
Wizard
What does “rolling up data” mean?

Once you have defined a new database and its objects, your next step is to
load dimension values (for each dimension) and data (for each variable).

Typically, you will load data only for the lowest level of each hierarchical
dimension of the variable, for example, cities and days.

You will then aggregate or “roll up” the data so that Express will calculate
the total sums for each hierarchical level, for example, regions, countries,
weeks, months, and years. In other words, you have to tell Express to do
the math for you.

Different ways to roll up data

Although you can use ROLLUP and other Express commands to perform
rollups, it is more likely that you will generate a Rollup program.

Administrator provides a Rollup Wizard that prompts you to make
decisions about how you want to roll up your data, then automatically
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generates a Rollup program for you. You can choose to run the Rollup
program immediately, schedule it to run at a later time, or save it for later
use. You may also decide to schedule a Rollup program to run after a data
loader program has executed successfully.

Starting the Rollup Wizard

From the Tools menu, choose Rollup Wizard  to start the wizard.

The Rollup Wizard provides Help for every step, if you need it.

The Help topics also provide examples and advice for the choices you can
make to ensure the best performance.

Exporting Data to an EIF File
Purpose of exporting data to EIF files

Exporting data to an EIF file allows you to copy data and object definitions
from one Express database to another.

Controlling which data you export to an EIF file

The status of the database objects determines which values are exported to
the EIF file.

If you want to export all dimension values in all of the dimensions that you
have chosen to export, then select Export All Values in the Export to an
EIF File dialog box.

Otherwise, select Export Selected Values, then choose the Selector
button, which displays the Selector. The Selector lists all the dimensions
that you have specified to be exported. When you select a dimension name
in the Selector, its dimension values that are currently in status are listed in
the Area Selection Values box.

To get more information about the currently selected dimension, select the
List icon, which displays the List dialog box. All of the dimension values
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are listed in the Available Areas box. Only those dimension values that are
currently in status are listed in the Selected Areas box.

To change which values are in status, you can either move values from one
list box to another in the List dialog box, or use other tools in the Selector
to set the status of your choice. For detailed information, see the Help
topics for the Selector and its tools.

If you want to export objects that are associated with the dimensions you
have selected to export, select Include Metadata. Metadata includes
Express objects such as labels, valuesets, hierarchies, levels, and parent
relations. If you do not select Include Metadata, only the dimension
values and definitions associated with each dimension will be exported.

Procedure: Exporting data to an EIF file

When you export data to an EIF file, you use the following steps.

Step Action

1 In the Database Browser, make sure the only database that is currently
opened is the database that contains the data you want to export.

2 From the File menu, choose Export to display the Export to an EIF File
dialog box.

3 Specify a file name for the exported data.

4 Specify the objects you want to export (for example, by using drag and
drop).

5 If you want to export only some of a dimension’s values, select Export
Selected Values , then choose Selector . Use the Selector tools to specify
the dimension values you want to export for each dimension. Choose OK to
close the Selector and return to the Export to an EIF File dialog box.

6 Choose OK.

Using Express commands to export data to an EIF file

Instead of using the Export to an EIF File dialog box, you can enter Express
commands in the Express Command window to export EIF files. This gives
you the ability, for example, to export data by writing a program instead of
using Administrator. Refer to the EXPORT (EIF File) command in the
Express Language Help system.
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Related information

� To find detailed instructions for exporting data to an EIF file, search for
the following topics in the Administrator Help system:

“Export to an EIF File Dialog Box”
“Exporting to EIF Files”

� To find detailed instructions for using the Selector, search for the
following topics when the Selector is displayed:

“Selector Dialog Box”
“Using the Selector”
“Using Selector Tools”
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Chapter 10

Maintaining a Database

Overview
Introduction

This chapter describes the steps you can take to maintain your database.

In this chapter

� Updating Your Data

� Scheduling Data Loads and Rollups

� Rolling Up Data Selectively

� Copying, Renaming, and Deleting Objects

� Copying and Deleting Hierarchies

Updating Your Data
Adding new data to your database

Once you have designed and built a database, added data to that database,
and rolled up the data, your users can connect to the database and use it.

However, in most cases, you will have to keep the data up to date on a
regular basis. Typically, you will import data only at the lowest level of a
hierarchy. This means that after loading new data, you will then need to roll
it up.
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This chapter describes the most efficient approach you can take to make
sure the data is recent and accurate.

Maintaining your data loader programs

If you use a data loader program to import data into your database, you may
or may not be able to use the same data loader program to add new data to
your database.

You can use the same data loader program if you can meet all of the
following conditions:

� The name of the file in which new data is provided is always the same.

� The format (number of columns or delimiters) of the file in which new
data is provided is always the same.

� The location of the file in which new data is provided is always the
same.

� No objects in the database have been added, deleted, changed, or
renamed.

� No hierarchies in the database have been added, deleted, or changed.

� The database itself has not been renamed.

As long as all of the above conditions are met, you can use the same data
loader program every time you need to update the database. You can
schedule the data loader program to run at specific intervals of time or on a
particular date at a particular time. In other words, as long as the new data
is put in a file with a format, name, and location that never change, you can
automate the data loading process. Once you schedule your data loader
program to run, your database will automatically be updated on whatever
basis you specify.

On the other hand, as soon as you make a change to the structure of the
database or the file from which new data is imported, you should generate a
new data loader program. Otherwise, the data may be loaded incorrectly.
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Maintaining your rollup programs

In most cases, you will generate a rollup program, schedule it to run
immediately after the data loader program finishes executing, and you will
not have to think about rolling up data again.

However, if you make any of the following changes to the database itself,
you will need to generate a new rollup program:

� Adding, deleting, changing, or renaming database objects

� Adding, deleting, or changing hierarchies

� Renaming the database itself

Making maintenance easy

As long as you do not make any changes to the database objects or
hierarchies in your database, you can use the following steps to automate
the process of updating the data in the database.

Step Action

1 Make sure that whoever is responsible for providing new data understands
that the file in which the new data resides must always have the same
format, the same file name, and be placed in the same location.

2 Find out when the new data file is updated so that you can schedule your
data loader and rollup programs to run after the new data file is updated.

3 Generate a data loader program that imports data from the file in which new
data resides.

4 Generate a rollup program that will roll up the new data.

5 Schedule the data loader program to run after the new data file has been
updated. You can schedule the data loader program to run on a regular
basis, for example, at the same time and day on a weekly basis.

6 Schedule the rollup program to run immediately after the data loader
program finishes executing. This will ensure that the data in your database
is always accurate.
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Scheduling Data Loads and Rollups
Scheduling programs to run as batch jobs

You can schedule a data loader program to run, then schedule a rollup
program to run as soon as the data loader program is completed.

In other words, you can schedule one batch job to load new data, followed
immediately by another batch job that rolls up that new data. By using this
strategy, the data in your database will always be accurate.

Using the Scheduler

The Scheduler is an Administrator tool that lets you schedule a program to
run at the time and day of your choice. To display the Scheduler, choose
Schedule from the Run menu. The Schedule the Program dialog box is
displayed. For details about using this dialog box, click on its Help button.

The Scheduler lets you run a program immediately, at the time (including
the month, date, and year) that you specify, or after running another
program.

You can run the program on a regular basis. The Scheduler lets you specify
how often the program will run in measures of minutes, hours, days, weeks,
or months.

You can also specify the time and date after which the program should no
longer run.

Monitoring batch jobs

It is possible that more than one instance of Express Server can be running
on a remote machine at the same time. You can monitor all of the batch
jobs that are scheduled to run on the instance of Express Server to which
Administrator is currently connected.

To display the Monitor Batch Jobs dialog box, choose Monitor  from the
Run menu. For details about using this dialog box, click on its Help button.
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All batch jobs are displayed in the task list in the Monitor Batch Jobs dialog
box. The task list displays the name of each program that is scheduled to
run, the name of the user who scheduled it, the status of the batch job that is
associated with that program, and the program’s type (for example,
Dataread, Rollup, or Command). “Dataread” refers to a data loader
program that was generated by using one of the import dialog boxes or the
Database Wizard. “Rollup” refers to a program that was generated by using
the Rollup Wizard. Any program that was written by a user will be listed as
a Command program.

You should monitor your data loader and rollup programs to make sure
they execute without any problems. A data loader or rollup program may
fail to run if you have made changes to database objects or hierarchies, or if
there is a problem with the file from which the data loader program imports
data.

Scheduling and monitoring available for Express Server only

You can schedule and monitor programs to run on Express Server.

If you use Administrator with Personal Express 6, it is not possible to
schedule or monitor programs.

Related information

For more information on scheduling programs to run as batch jobs and
monitoring batch jobs, search for the following topics in the Administrator
Help system:

“Monitor Batch Jobs dialog box”
“Monitoring Batch Jobs”
“Program Settings dialog box”
“Schedule the Program dialog box”
“Scheduling Programs to Run”
“View Log dialog box”
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Rolling Up Data Selectively
What does it mean to roll up data selectively?

Typically, you will generate one rollup program for the purpose of rolling
up new data whenever new data is added to your database. In most cases,
the rollup program will roll up all the data. However, it is possible to roll up
just a portion of the database.

The Rollup Wizard lets you generate programs that will roll up only the
data that you specify. For example, if you add new data that will affect just
one variable in the database, you can generate a rollup program that will
roll up data for just that variable, leaving the data for all other variables
unchanged.

For dimensions that have more than one hierarchy, you can generate a
rollup program that rolls up data for only the hierarchy that you specify.

In addition, you can specify that a rollup will begin at a specific level of a
hierarchy. In this case, only the data at that level will be rolled up. Any data
that exists in levels below the level you specify will remain unchanged.

Furthermore, you can specify that the data that is associated with certain
dimension values will be rolled up. You do so by selecting the dimension
values in the Rollup Wizard whose associated data has changed and needs
to be rolled up again. Only the data of the ancestors of the selected
dimension values will be rolled up. All other data will remain unchanged.
The ancestors’ data will be calculated using the data of all of their
respective siblings and children, not just the selected ones.

Generating a new rollup program

In order to roll up data selectively, you generate a new rollup program and
execute it. The Rollup Wizard and the Scheduler make this a quick and
easy task.

Every step in the Rollup Wizard provides a detailed Help topic. As you use
the Rollup Wizard to make specifications for a rollup program that will roll
up data selectively, click on the Help button in each step.
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The Introduction step of the Rollup Wizard provides a step-by-step
example of making specifications for a program that will roll up data
selectively.

The Choose Values to Roll Up step provides a Help topic with detailed
information about how to specify that a rollup should be executed for a
specific hierarchy, begin at a specific hierarchy level, or roll up data that is
associated with certain dimension values.

When it is advantageous to roll up data selectively

It is a good idea to generate a new rollup program that will roll up data
selectively when time is an issue. If the rollup program you normally use
takes a long time to execute, and you do not want to invest that time when
only a small portion of data needs to be rolled up, you can probably
generate and execute a new rollup program in a much smaller amount of
time.

You may want to roll up data selectively when:

� A small change has been made to the data in your database (for
example, the data that is associated with a single Month in the TIME
dimension has changed)

� A change has been made to a level other than the lowest level of a
hierarchy

� A change has been made that will affect only one or some of the
variables in your database

Why you may not need to roll up data selectively

In some cases, it may not be worth the effort to generate a new rollup
program to roll up data selectively.

If time is not an issue, there is no reason to generate a new rollup program.
Even if a very small change is made, you can use the rollup program that
you normally use to roll up data. This is true as long as your rollup program
either rolls up all the data in your database or you are certain that it will
include whatever data has been changed.
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In addition, if you use the Scheduler to schedule your rollup program to run
on a day and at a time when users do not need to access the database, there
is no reason to generate a new rollup program.

Copying, Renaming, and Deleting
Objects
Copying objects

Once you have defined an object, you might want to define another object
that is similar to the first, but with minor differences. You can copy the first
object and use it as the basis for the second one. You can then edit the
second object to include the appropriate differences.

You can copy programs, formulas, and so forth, as a starting point for
defining new database objects.

How much of the object is copied depends on the type of object.

Express object What gets copied

Formula Its definition, labels, and equation (EQ)

Program Its definition, labels, and the text of the program

Model Its definition, labels, and the text of the model

Time dimension Its definition, labels, and the value name format (VNF)

Any other object Its definition and labels

Renaming objects

After defining an object, you might want to give the object another name.
You can change the name of variables, dimensions, and so forth.

Administrator changes all references to a renamed object that are included
in the definition of other objects. For example, if you rename the PROD
dimension to PRODUCTS, all variables dimensioned by PROD will be
changed automatically so that they are dimensioned by PRODUCTS.
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If a database object is referenced by one or more formulas, Administrator
will automatically adjust those formulas so that the new database object
name replaces the old database object name. Any saved selections that were
created by using the Selector will also be adjusted automatically.

After you rename the object, a message is displayed that lists the names of
the database objects in which references to the object you renamed have
automatically been renamed.

Programs and models are not automatically adjusted. Administrator
searches all programs and models in the database for the name of the
database object that you want to rename. If Administrator finds any
occurrences of the name in other objects, a warning message is displayed
before the Rename dialog box is displayed. The warning message lists the
names of all the programs and models that reference the database object. If
you choose to proceed and rename that object, you should then edit every
program and model that was listed in the warning message. You will need
to manually change every occurrence of the database object name in
programs and models.

Deleting objects

You might find that you no longer need an object and want to delete it. You
can delete variables, dimensions, and so forth.

You cannot delete a dimension that is used to define a variable, formula, or
other object. You must first delete the objects that are dimensioned by that
dimension.

You must manually edit any references to the deleted object in programs,
models, saved selections, and so forth.

You cannot rename or delete metadata objects

You cannot rename or delete the metadata objects that are automatically
created by Administrator to support dimension hierarchies. If you attempt
to do so, a warning message is displayed.

See “How to identify metadata objects” if you are unsure how to recognize
a metadata object.
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How to identify metadata objects

You can identify a metadata object by its prefix. The metadata prefix,
XnXnn, is the database identifier and the dimension identifier. When you
define a new database, you specify the database identifier in the Database
Identifier box in the Create a New Database dialog box. Likewise, when
you define a new dimension, you specify the dimension identifier in the
Dimension Identifier box in the Define a Dimension dialog box.

For example, if the name of the dimension is GEOGRAPHY, its dimension
identifier is G12, and the database identifier is AZ, the name of the
metadata object XnXnn.SHORTLABEL is AZG12.SHORTLABEL.

Regenerate your data loading and rollup programs

You will need to generate new data loading programs after adding new
objects, copying and modifying existing objects, or deleting objects.
Otherwise, the next time you load new data into the database, that data may
load incorrectly.

Related information

For more information on copying, renaming, and deleting objects, search
for the following topics in the Administrator Help system:

“Copying Database Objects”
“Renaming Database Objects”
“Deleting Database Objects”

Copying and Deleting Hierarchies
Copying hierarchies

You can copy an existing hierarchy and then modify its structure. This can
give you a quicker and easier way to define a new hierarchy, instead of
adding a new hierarchy.
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You can copy a hierarchy that has already been defined for a dimension.
Copying a hierarchy copies its whole contents: parent-child relationships,
levels, and order.

When to delete a hierarchy

Delete a hierarchy only if you are sure you have no further use for it.

Think carefully before you delete a hierarchy. When you delete it, all the
data structures, such as the parent relation and description variables, are
modified to delete any information that applied to the hierarchy, as well as
saved selections.

Regenerate your data loading and rollup programs

It will be necessary to generate new data loading programs after adding
new hierarchies, copying and modifying existing hierarchies, or deleting
hierarchies. Otherwise, the next time you load new data into the database,
that data may load incorrectly.

Related information

For more information on copying and deleting hierarchies, search for the
following topics in the Administrator Help system:

“Copying Hierarchies”
“Deleting Hierarchies”
“Modifying Hierarchy Structure”
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Chapter 11

Configuring Dimensions and
Measures

Overview
Introduction

This chapter describes how to use Administrator to configure dimensions
and measures to enhance performance in your database and client
application.

In this chapter

� Setting Properties of a Dimension

� Defining a Dimension’s Selections

� Displaying Descriptions for Dimension Values

� Hiding Dimensions and Measures

� Working with Measures

� Setting Properties of a Measure

� Managing Data-Driven Formatting

� Setting Number Formats
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Setting Properties of a Dimension
Definition of dimension properties

The properties of a dimension are a group of its characteristics, such as the
dimension’s description and labels.

Why you should set dimension properties

You can specify the way the client application will handle a given
dimension by specifying its properties.

The values that you set as you define and modify dimensions in
Administrator are stored in the properties. You can view and specify some
dimension properties in the Property Inspector.

Dimension properties displayed on the Inspector Properties tab

The following table lists the dimension properties available on the
Properties tab of the Inspector.

Property Description

# Dimension Values The number of values in the dimension (read-only).

DataType The data type of the dimension, such as Text (read-only).

Database The name of the database to which the dimension belongs
(read-only).

Description A singular, long form of the dimension name used in the
Selector, a tool in Express Client applications. You can
specify a plural description using the DescriptionPlural
property.

DescriptionExp An Express expression that evaluates to a text value. When
you enter this expression, the client application evaluates it
and places the result in the Description property.

DescriptionPlural A plural, long form of the dimension name used in the
Selector.

DescriptionPluralExp An Express expression that evaluates to a text value. When
you enter this expression, the client application evaluates it
and uses the result to display plural descriptions.
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Property Description

Dimension ID An identification code that Administrator assigns to the
dimension (read-only).

DimensionType Indicates whether the dimension has a time data type. The
value 1 indicates the dimension has a time data type; the
value 0 indicates that it does not.

Dimensioned By For conjoint dimensions, the names of the other base
dimensions (read-only).

Drill Direction Specifies the order in which hierarchical dimension values are
displayed. The value 1 specifies that the parent value is
displayed above the child values; the value 0 specifies that
the child values are displayed above the parent value.

IsAttribute A Boolean expression indicating whether a conjoint
dimension is treated as an attribute in the Selector.

LD The long description for the dimension.

LongLabelVar The name of the variable that holds the long labels for the
dimension’s values. The default name is XN.LONGLABEL.

Name The Express name for the object (read-only).

MDBSource The name of an Express Server counterpart to an object in
another remote Express database. Used for remote data.

ObjectType The object’s type — in this case, dimension (read-only).

ShortLabelVar The name of the variable that holds the short labels for the
dimension’s values. The default name is XN.SHORTLABEL.

ShortName A singular, short form of the dimension name used in the
Express Client products’ tables, graphs, and the Selector if
there is no description.

ShortNameExp An Express expression that evaluates to a text value. When
you enter this expression, the client application evaluates it
and places the result in the ShortName property.

ShortNamePlural A plural, short form of the dimension name used in the
Express Client products’ tables, graphs, and the Selector if
there is no plural description.

ShortNamePluralExp An Express expression that evaluates to a text value. When
you enter this expression, the client application evaluates it
and uses the result to display short plural names.
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Property Description

UserVisible Whether to make this dimension available to client application
users. When you set this property, it will take effect only in the
Express Client products.

Width The width of the object. Applies only to text dimensions
(read-only).

How you can use the Inspector Properties dimension properties

You can use the information specified by these properties to improve the
response time of very large dimensions and variables and to decide whether
to optimize them.

The name expression properties (DescriptionExp, DescriptionPluralExp,
ShortNameExp, and ShortNamePluralExp) are used when you have more
than one name for the same dimension value. For example, you might want
to set the name expression properties if your database includes more than
one language, so that you can provide a different set of dimension names
for each language.

Dimension properties displayed on the Inspector Advanced tab

The following table lists the advanced object properties, which are read-
only.

Property Description

Disk Size (bytes) The total number of bytes needed to store the object.

In Order A boolean expression indicating whether the logical order of
the values of an Express object’s underlying dimensions
matches the physical order in the database file. True
indicates that the logical order matches the physical order.

Number Active Cells The number of active value cells.

Number Deleted
Cells

The number of deleted value cells.

Number Segments The number of segments associated with any object that has
more than one dimension. Express uses segments internally
to keep track of the physical storage of the object’s values.
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How you can use the Inspector Advanced dimension properties

You can use the advanced properties to measure the efficiency of
dimensions and variables.

These properties are read-only. See the OBJ function in the Express
Language Help for more information on these properties.

Procedure: Setting properties for a dimension

The following procedure describes how to set properties for a dimension
using the Inspector.

Step Action

1 In the Database Browser, select the dimension whose properties you want
to set.

2 From the Tools menu, choose Property  Inspector  to display the Property
Inspector.

3 Click on the value in the Value column for the property you want to set.

This selects the current value.

Note:  Dimmed properties are read-only.

4 Type in a new value.

Your property choices are saved as soon as you move to a new value.

Related information

For information about setting properties for a dimension, search for the
following topics in the Administrator Help system:

“Modifying Dimensions”
“Setting Object Properties”
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Defining a Dimension’s Selections
Definition of a saved selection

When client application users display the Selector to choose the data to
display in the client application, they often find that they are choosing the
same group of dimension values again and again. As part of the
configuration of a database, you can save such a group of dimension values
as a saved selection.

Where the saved selections are displayed

The selections you save in Administrator will be available in the Express
Client application’s Selector.

The Selector recognizes these saved selections and lets users choose them.
Client application users can also save their own selections.

Types of saved selections

The two types of saved selections static and dynamic. The setting of the
selection depends on its type:

� The setting of a value selection is a multiline list of dimension values.
A value selection is static; if you delete one of the values that is listed,
or if you add a dimension value that should be included, you must
change the list yourself.

� The setting of a dynamic selection is a script that Express creates when
you define the saved selection. The values that the script selects from
one time you use the script to another. For example, if you select values
of the PRODUCT dimension based on SALES, the actual values in the
selection will differ based on the sales values.

If one or more hierarchies are associated with the dimension

If the dimension has one or more hierarchies associated with it, you might
want the selected values limited to only the values that belong to the
hierarchy. You might also want the values sorted according to the order
associated with the hierarchy.
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Procedure: Defining saved selections

The following procedure describes how to define a saved selection.

Step Action

1 In the Database Browser, select the dimension whose selected values you
want to save and choose Modify  from the Edit menu to display the Modify
Dimension dialog box.

2 In the Selections tab, choose Create  to display the Selector dialog box.

3 Make sure the current dimension value selection is the one you want to
save, or select the values you want.

4 In the Selector dialog box, choose Library .

Note:  If the Selector dialog box does not have a Library button, change the
Selector option to allow access to the library (see the Help topic “Controlling
Access to the Saved Selection Library).

5 In the Selections box, click on <Current Selection> .

6 In the Selection Library dialog box, choose Save.

7 In the Save Selection dialog box, review the information displayed to confirm
that it describes the selection you want to save.

8 In the Save Selection As box, select New.

9 In the Name box, type a unique name for the saved selection.

Note: To avoid naming conflicts for those who might use the saved
selection, use a convention that ensures that your name is unique. For
example, you might want to include your initials or the date in the name
(Top10_SBR_2298).

10 In the Description box, type a description for the Selection.

11 Select Dynamic  or Static  as follows:

IF . . . THEN . . .

you want the saved selection to
be evaluated from the selection
criteria each time that you use it,

select Dynamic .

you want to always select the
exact dimension values included
in the selection at the time the
selection is saved,

select Static .
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Step Action

12 Choose OK.

13 In the Selection Library dialog box choose Close  to return to the Selector
dialog box; then choose OK to return to the Main window.

Related information

For more information on saved selections, search for the following topics in
the Administrator Help system:

“Defining Saved Selections”
“Deleting Saved Selections”
“Selector Dialog Box”

Displaying Descriptions for Dimension
Values
Overview

In a database, you might have a relation that contains data for your client
application users to view. If users can create a table for that relation
(Express Spreadsheet Add-In users cannot create tables), they will see the
dimension values displayed exactly as they are stored in the dimension.
You might want to display the values in a different way, such as by
showing their long labels.

Procedure: Changing the way dimension values are displayed

Use the following procedure to display dimension values in a different way.

Step Action

1 Create a formula that displays the values in the desired form.

2 Make the formula user-visible.

3 Hide the original relation.
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Figure: Changing the default display of short labels for dimension values

Suppose you have a dimension called PRODUCT, whose values are
PANTS, SHIRTS, and HATS. You have a dimension called COLOR,
whose values are RED, GREEN, and BLUE. You also have a relation
called Prod.Color between the two dimensions. In the relation, PRODUCT
is the related dimension (or data type) of the relation and COLOR is the
dimension of the relation.

In Administrator, if you defined Prod.Color in a database and did not hide
it, an Express Client product user could display the relation in a table such
as the following.

However, you might prefer that users see the long label for each color,
instead of the actual dimension values, as shown in the next figure.

You must create a formula that displays the long labels, so Express Client
product users can create a table with that formula.
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Procedure: Changing the default display of short labels for dimension
values

The following procedure describes how to change the default of displaying
short labels so that long labels are displayed instead.

Step Action

1 Define the COLOR dimension.

2 Define the PRODUCT dimension.

3 Define the Prod.color relation and hide it using the Property Inspector.

4 Define a text formula called Prod.cf and dimension it by COLOR.

5 In the equation for Prod.cf, include the name of the formula that stores the
long labels for the values of the PRODUCT dimension. For example, if the
formula for the long labels is called P3.LONGLABELF, the equation for the
Prod.cf formula would be the following.

p3.longlabelf(product prod.color)

Hiding Dimensions and Measures
Preventing your users from seeing certain dimensions or measures

If you want to hide dimensions or measures from users, you can use
Administrator to do this. Later, if you change your mind, you can use
Administrator to show them again.

If the client application is the Express Spreadsheet Add-In

Note that if your users use the Express Spreadsheet Add-In as the client,
you can hide only measures.

By default, the Measures list in the Express Spreadsheet Add-In’s Express
Wizard displays the user-visible measures in your database. You can
prevent any measure from being displayed in the Measures list.
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Procedure: Hiding a dimension or measure

Use the following procedure to prevent a dimension or measure from being
displayed in your user’s client application.

Step Action

1 In the Database Browser, select the dimension or measure you want to hide
and choose Property Inspector  from the Tools menu to display the
Property Inspector.

2 For the UserVisible property, select False .

Related information

For more information on hiding measures, search for the following topic in
the Administrator Help system: “Setting Object Properties.”

Working with Measures
Definition of measures

Measures are stored in your Express database as formulas, relations, and
variables.

A formula is an expression that you name and define.

A relation describes a correspondence between the values of two or more
dimensions. A relation can have more than one dimension, but the values of
the relation must be values from the related dimension.

A variable is an array whose cells hold individual data values.

The information you specify for measures

When you set up measures with Administrator, you specify:

� Whether the client application should give users access to the measures

� How the measure names will be displayed

� For numeric measures, how their data will be formatted
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Whether a given measure is stored as a formula, as a relation, or as a
variable makes no difference in the steps you take in configuring it for the
client application.

Related information

See Chapter 1 for more information about measures. See Chapter 8 for
information on importing data into measures. See Chapter 7 for an
overview of creating and using hierarchies.

Setting Properties of a Measure
Definition of measure properties

The properties of a measure include characteristics such as the measure’s
description and labels.

Why you should set measure properties

You can specify the way the client application will handle a given measure
by specifying its properties.

The values that you set as you define and modify measures in
Administrator are stored in the properties. You can view and specify some
measure properties in the Property Inspector.

Measure properties displayed on the Inspector Properties tab

The following table lists the properties for measures.

Property Description

Compiled For formulas only, Information about the compilation status of a
formula (read-only).

DataType The data type of the measure, such as TEXT (read-only).

Database The name of the database to which the measure belongs
(read-only).

Description A long form of the measure name used in the client application.
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Property Description

DescriptionExp For formulas and variables, an Express expression that evaluates
to a text value. When you enter this expression as a property,
Administrator evaluates it and places the result in the Description
property.

Dimension
Dependency

For formulas only, a program or list of Express commands you
use to adjust the status of base dimensions of a formula that uses
time-series functions (such as LAG or LEAD), the QUAL function,
or a QDR (qualified data reference). The Express commands will
most likely be LIMIT commands. You only have to set this
property when the database has been built from a Relational
Access Administrator project.

Dimensioned By The names of the dimensions by which the measure is
dimensioned (read-only).

FormatFormula Identifies the default data-driven formatting formula specified for
an variable, relation, or formula (read-only).

IsAttribute For relations only, a boolean expression indicating whether a
relation is treated as an attribute in the Selector.

LD The long description for the measure.

MDBSource The name of an Express Server counterpart to an object in
another remote Express database.

Measure
Dependency

For formulas only, a list of any SQL-based measures that are
referenced by ampersands in the formula’s expression. You only
have to set this property when the database has been built from a
Relational Access Administrator project.

ObjectType The object’s type — in this case, formula, relation, or variable
(read-only).

ShortName A short form of the measure name used in the Express Client
products’ tables, graphs, and the Selector if there is no
description.

ShortNameExp An Express expression that evaluates to a text value. When you
enter this expression as a property, Administrator evaluates it and
places the result in the ShortName property.

Sparse
Dimensions

For relations and variables, the list of sparse dimensions.

StorageType For relations and variables, the storage type, either Temporary, or
Permanent (indicated by a blank setting). (Read-only.)
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Property Description

UserVisible Whether to make this measure available to client application
users.

Width The width of the object. Applies only to dimensioned text, integer,
and boolean variables (read-only).

Advanced properties

Formulas and relations have no advanced properties.

Variables have the same advanced properties that dimensions have, with
one addition: variables have the NA Pages property, which shows how
many pages of NA information the variable has.

Variable properties displayed on the Advanced Properties tab

The following table describes the advanced properties of variables.

Property Description

Disk Size (bytes) The total number of bytes needed to store the object.

In Order A boolean expression indicating whether the logical order of
the values of an Express object’s underlying dimensions
matches the physical order in the database file. True
indicates that the logical order matches the physical order.

NA Pages The number of pages of NA information the variable has.

Number Active Cells The number of active value cells.

Number Deleted
Cells

The number of deleted value cells.

Number Segments The number of segments associated with any object that has
more than one dimension. Express uses segments internally
to keep track of the physical storage of the object’s values.
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Name properties

The name properties specify the words to be used when the client
application displays the measure name. You can specify a short name and a
description, and name expressions for the measure in the following
properties:

Description
DescriptionExp
ShortName
ShortNameExp

If you are satisfied with specifying a single description and short name, you
can leave the DescriptionExp and ShortNameExp properties blank.
However, if your database includes more than one language, you might
want to use the name expressions to provide a different set of measure
names for each language.

Related information

For more information on descriptions, search for the following topics in the
Administrator Help system:

“Installing Additional Languages”
“Setting Object Properties”

Managing Data-Driven Formatting
Purpose of data-driven formatting

In the Express Client products, you can create tables that contain data from
formulas, relations, and variables. You can specify that the data in each cell
of a table be formatted in a certain way, based on the value of the data.

Creating a data-driven formatting formula

To make these specifications, you create a data-driven formatting formula
for a measure. The formula must have the same dimensions or a subset of
the dimensions of the measure for which it specifies formatting.
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You can easily create data-driven formatting formulas, and you can even
create multiple formulas that can be shared across measures with the same
dimensionality. You can specify one formula as the default one, but client
application users can choose any formula you provide.

Users can see the formula names and explanations in the Data-Driven
Format tab of the Modify Variable, Modify Relation, and Modify Formula
dialog boxes.

If the client application is the Express Spreadsheet Add-In

If the client application is the Express Spreadsheet Add-In, any data-driven
formatting formula you create in Administrator will not have an effect in
spreadsheets.

Related information

For more information on data-driven formatting formulas, search for the
following topics in the Administrator Help system:

“Defining a Data-Driven Formatting Formula”
“Entering Code for a Data-Driven Formatting Formula”

Setting Number Formats
Overview

The number format specifications you make when you define or edit a
measure apply to that one measure. For example, if you change the number
of decimal places from two to three, the change affects only the measure
that you are editing.

If you want to make such a change for all the measures that the client
application displays, you can change the default setting for the system.

If the client application is the Express Spreadsheet Add-In

If the client application is the Express Spreadsheet Add-In, any number
formatting you specify in Administrator will not take effect in spreadsheets.
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Setting the defaults

When calculating the number format string for a given measure,
Administrator uses the current number format specifications. If you do not
specify a value, the corresponding default value is used.

Thus, you can change a number format characteristic for all measures in the
system by changing the default setting and ensuring that the corresponding
setting is blank for all measures.

Making a system-wide change

Because the number format string for a given measure is stored in the
measure’s database, only the strings for measures in opened databases can
be recalculated. Therefore, to make a system-wide change, open all
possible databases before changing the default values.

If there are two databases with conflicting definitions (for example, two
measures named SALES), open only one of the databases before changing
the default values. Later, you can open the other database and explicitly
recalculate its number format strings.

Client application users can override the defaults you set

The Express Client product users can also set the format of numbers. If you
set number formatting in Administrator, users can override the formatting
in tables but not in graphs. For information on the precedence of number
formatting in the client application, see the user’s guide for the application.
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Procedure: Setting number format defaults

You can use the following procedure to set number format defaults.

Step Action

1 Open the databases that have measures, but that do not have conflicts in
definitions (for example, objects with the same name).

2 From the Tools menu, choose Options  to display the Options dialog box.

3 Select the Format tab.

4 Set the values as you want the defaults to appear.

5 When the settings are correct, choose OK.

Administrator automatically calculates the number format string for all the
measures in all the opened databases.

8 If you have not opened some databases because they have conflicting
definitions, update their defaults with the following steps.

Step Action

1 Close the currently opened databases that have conflicts.

2 Open the databases that need to have their defaults
updated.

3 Repeat Steps 2 through 5.

Procedure: Causing a particular measure to use the default number format
settings

If you have edited the number formatting for a particular measure, and then
decide that you want to remove your edits and use the default settings, use
the following procedure.

Step Action

1 Display the measure in the appropriate Modify dialog box.

2 Select the Format tab.

3 Choose Use Default Settings.
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Chapter 12

Express Commands and
Programs

Overview
Introduction

This chapter describes how to use Express commands and programs to
manipulate your data after creating your database.

In this chapter

� Executing Express Commands

� The Express Command Window

� Working with Valuesets

� Working with Programs

� Creating a Program

� Compiling and Executing a Program

� Debugging a Program

� Defining System Shutdown Programs

� Changing Dimension Status

� Using LIMIT to Change Dimension Status

� Using XP_SLLIMIT to Set Dimension Status

� Using STATUS to Check the Current Status
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Executing Express Commands
Overview

You can use certain Express commands to perform a variety of database
management tasks. This section describes a few of those commands and
suggests when you are likely to use them. The following procedure explains
how to execute commands in Administrator.

Procedure: Executing an Express command in Administrator

Use the following procedure to execute an Express command from within
Administrator.

Step Action

1 From the Run menu, choose Express Command .

The Express Command Window is displayed.

2 Enter an Express command in the Command box.

3 To run the command, press Enter or choose the Run ( )button.

If the command produces any output, that output is displayed in the
Response tab of the lower window.
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The Express Command Window
Figure: Express Command Window

The following figure shows two commands that have been entered in the
Command box and the resulting output. When you enter a command in the
Command box, both the command and its results (if any) are displayed in
the Response box.
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Express Command Window buttons

The following buttons in the Express Command Window provide shortcuts
for frequently used actions.

Button Purpose

Multi-command Editor —  Toggles the Command box between being
displayed as a single-command editor and being displayed as a multi-
command editor.

Run  — Executes the command(s) that have been typed in the Command
box or executes the command(s) that are currently selected in the
Command Log box.

Clear  — Clears the Command box.

Copy  — Copies the commands that are currently in the Command Log box.

Print  — Prints the contents of the Response box or the Command Log box.

You can execute actions for one box at a time. For example, use the buttons
in the Command box to toggle between editors, execute commands in the
Command box, or clear the Command box. Use the buttons at the bottom of
the Express Command Window to execute actions for either the Response
box or the Command Log box, whichever one is currently displayed.

Entering and executing Express commands

The Express Command Window contains two panes.

The upper pane is the Command box, in which you enter Express
commands. You can use the Command box as a single-command editor or
a multi-command editor. Use the Multi-command editor button to toggle
between these two editor modes. Click on the down arrow in the Command
box to display and select from the command history list.

The lower pane has two tabs: Response and Command Log. You can toggle
between the Response box and the Command Log box by clicking on their
respective tabs.

Express displays any output in the Response box.
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The Command Log box displays every command that has been executed in
the order in which it was executed. You can select multiple commands in
the Command Log and execute them by clicking on the Run () button.
Alternatively, you can copy and paste them into the Command box, where
you can edit or rearrange the order of the commands by using standard
clipboard operations.

You can resize the Command box by moving the separator between the
upper and lower panes. If you use the Command box as a multi-command
editor, it is a good idea to resize the box in order to see multiple lines of
commands. If you do not resize the Command box, you will only see one
line at a time.

You can execute most Express commands from Administrator. To get
information about any command you have typed, position the cursor at the
beginning, end, or inside the name of the command in the Command box,
the Response box, or the Command Log box. If you then press F1 or click
on the Help button, Help for that command is displayed.

Commands you should not execute

Do not use local Express commands such as GET, LOG, PAUSE, TRACE,
or WATCH.

Do not use the Express OUTFILE command, which does not work from the
Express Command Window.

Do not use Express commands that require user input.

Do not use Express commands to open or close databases or perform
operations on objects such as defining, copying, deleting, and renaming;
your actions will not be reflected in the Database Browser. Also, you will
be defeating the purpose of Administrator’s ease of use. Instead, use
Administrator’s menus and dialog boxes to perform these tasks.
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Related information

For more information on executing Express commands, search for the
following topics in the Administrator Help system:

“Executing Express Commands”
“Express Command Window”

Working with Valuesets
Definition of a valueset

A valueset is an Express object that contains a list of dimension values for a
particular dimension. You use valuesets to set the status of a dimension
quickly. To do so, limit a dimension to the values stored in a valueset for
that dimension.

The values in a valueset can be saved across Express Server sessions.

Creating a valueset

First, you define a valueset.

You then use the LIMIT command in the Express Command Window to
assign values from the dimension to the valueset.

Procedure: Defining a valueset

Use the following procedure to define a valueset.

Step Action

1 From the Edit menu, choose Define.

2 Choose Valueset  to display the Define a Valueset dialog box.

3 Specify the appropriate settings in the dialog box.

Refer to the "Defining Valuesets" Help topic for detailed information.

4 Choose Define.

5 Choose Close.
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Assigning dimension values to a valueset

When you first define a valueset, it has no values initially. You must use
the following procedure to assign dimension values to the valueset.

Step Action

1 From the Run menu, choose Express Command  to display the Express
Command Window.

2 In the Command box, use LIMIT commands to set the status of the valueset.

The dimension values in the status are automatically assigned to the
valueset.

For example, suppose your database has a dimension named MONTH that
has dimension values ranging from JAN97 to DEC97. Now suppose you
want to limit the MONTH dimension to the even-numbered months of 1996.
After creating a valueset named EVEN96 in which you have specified the
dimension as MONTH, you would assign dimension values to the valueset
with the following command.

limit even96 to 'FEB96' 'APR96' 'JUN96' 'AUG96' 'OCT96' 'DEC96'

3 When you have finished, close the Express Command Window.

Using a valueset

Once you have created a valueset, you can use it with Express commands
in programs. For example, you can use the LIMIT command to limit the
status of a dimension to a valueset.

Related information

For further information, see the following:

� For information on defining valuesets, search for the following topic in
the Administrator Help system:

“Defining Valuesets”

� See the Express Language Help for information about using the LIMIT
command.
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Working with Programs
Definition of a program

A program is a stored procedure that acts on Express data or external data.

A program, like a dimension or a variable, is a database object. The data
loader programs described in Chapter 9 are examples.

Purpose of a program

Programs let you store sequences of commands that manipulate your data.
Some commands, which can only be used in programs, enable you to loop
over sets of data.

Using a program instead of a formula

If you need to use a very complex calculation, you might want to define it
in a program rather than as a formula.

If you define a program that uses a RETURN command to return a value,
you can use the program as a function wherever you would use an
expression or a formula. (An expression is one or more data values, which
you use as an argument in commands or functions. See the Glossary in the
Express Language Help for a detailed definition of “expression.”)

Creating a Program
Overview

The first step in creating a program is to define the program object.

After defining an Express program object, you can attach the programming
code by editing the object. You edit programs using the Editor within
Administrator. When you use this window, the menu bar in the Main
Window changes so that it has five menus — File, Edit, Tools, Window,
and Help.
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You can display context-sensitive Help for the Editor by clicking on the
Help icon. You can also print from the Editor by clicking on the Print icon.
See “Express Command Window buttons” for illustrations and explanations
of all the icon buttons in the Editor.

Procedure: Defining a program

Use the following procedure to define a program.

Step Action

1 From the Edit menu, choose Define.

2 Choose Program  to display the Define a Program dialog box.

3 In the Name box, type in a valid Express object name for your program.

4 In the Comments box on the Label tab, type in a long description for the
program.

The long description will be displayed in the Database Browser. It is not
displayed to client application users.

5 In the Return Type box on the General tab, specify the return value of the
program.

IF the program . . . THEN . . .

will have a return value, specify its data type.

will not have a return value, use the default type of None.

6 In the Database box, select the database where you want to create the
program.

7 Choose Define  to create the program object definition.

The name of the program will appear in the Database Browser under the
heading Programs. The program object does not yet have any code
associated with it. To enter the code, you must edit the program.

8 Choose Close  to return to the Main Window.
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Procedure: Editing a Program

After you have defined a program, use the following procedure to add code
to the program.

Step Action

1 Select the program in the Database Browser.

2 Choose Modify  from the Edit menu.

Alternatively, you can click on the Editor icon in the Main Window.

3 Enter the programming code in the Edit Window.

You can use standard Windows editing techniques to cut, copy, paste, find,
and replace text, using commands from the Edit menu.

4 If you wish, you can save your changes periodically to the Express database
by choosing Save from the File menu.

Note: Do not use “END”

Do not end the program with “END.” Administrator does not require
“END”, and including it will cause unexpected results.

Tip: Structuring your program

Avoid writing large programs. Instead, structure the program into separate,
smaller parts.

Related information

For further information, see the following:

� Refer to the DEFINE PROGRAM command in the Express Language
Help system for more information about defining programs.

� Refer to the Express Language Programming Guide for information
about program contents.

� For information on defining and editing programs, search for the
following topics in the Administrator Help system:

“Defining Programs”
“Edit Menu Bar”
“Edit Window”
“Editing Programs and Models”
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Compiling and Executing a Program
Compiling your program from the Edit Window

Once you have edited your program, you can compile it without leaving the
editing environment.

To compile a program, from the Tools menu, choose Compile.

The Compile command saves and compiles the code in the Edit Window.

Fixing compilation errors

If your program does not compile successfully in the Edit Window, you see
error messages in the Compilation Errors dialog box. You can then fix
compilation errors.

Procedure: Fixing compilation errors

Use the following procedure to fix compilation errors in your program.

Step Action

1 Modify your code in the Edit Window.

2 When you are ready to recompile your changes, choose Compile  again
from the Tools menu.
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Procedure: Executing a program

Once you have successfully compiled your program, you can then execute
your program.

Step Action

1 Run the program.

IF the Edit Window . . . THEN . . .

Is open, Choose Run  from the Tools
menu.

Is not open, Doubleclick on the program name
in the Database Browser.
(Alternatively, click on the
program name, then click the
right mouse button to display the
popup menu, and choose Run .)

The Express Command Window is displayed.

2 Click on the Run ( ) button.

Your program is executed. If your program produces output, that output is
displayed in the Response box.

3 Close the Express Command Window.

4 When you are through working with your program in the Edit Window,
choose Close  from the File menu.

Related information

For information on compiling and executing programs, search for the
following topic in the Administrator Help system:

“Executing Programs and Models”

Debugging a Program
Overview

If you find that you need more powerful debugging tools (e.g., so that you
can step through your program), you can debug your program by using
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Express commands in the Express Command Window in combination with
a text editor outside of Administrator.

Debugging with Express commands and a text editor

In the Express Command Window, you can set the PRGTRACE and
ECHOPROMPT options to YES, then execute the DBGOUTFILE
command. This creates a log of your program’s execution, including error
messages.

Outside of Administrator, you can examine the debugging file with a text
editor. You can then edit your program and compile it again in
Administrator.

For more information, see the DBGOUTFILE command in the Express
Language Help system and the debugging section in the Express Language
Programming Guide.

Related information

See the Express Language Programming Guide for more information about
writing and debugging programs.

Defining System Shutdown Programs
Overview

You can develop a program that the client application will run
automatically every time it closes. You might want to run a program that
disconnects the user from a remote system, reverses the operations of a
system preprocessor, or does other similar activities.

The system has only one shutdown program. You must ensure that the
database containing the shutdown program is attached so that the client
application can find the program when it is ready to shut down. You can
name the program anything you like. You use the Administrator Options
dialog box to specify which program to use as the shutdown program.
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Procedure: Specifying the shutdown program

Use the following procedure to specify which program you want to be used
as the system shutdown program.

Step Action

1 Choose Options  from the Tools menu.

This displays the Administrator Options dialog box.

2 In the General tab, enter the name of the program you want to specify as the
shutdown program in the System Shutdown Program box.

3 Choose OK.

Related information

For more information on system shutdown programs, search for the
following topics in the Administrator Help system:

“Defining Programs”
“Editing Programs and Models”
“Post-Attach Program property”
“Pre-Attach Program property”
“Specifying a System Shutdown Program”

Changing Dimension Status
Definition: The status of a dimension

The status of a dimension is a list of some, all, or none of that dimension’s
values.

How to change the status of a dimension

There are three different ways to change the status of a dimension: by using
the Selector tool, LIMIT commands, or the XP_SLLIMIT program. You
change the status of a dimension when you want to look at or work with a
subset of the dimension’s values.
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Most often, you will probably use the Selector. When you are performing
tasks in which you are likely to need to change a dimension’s status, it
should be easy and obvious how to display the Selector. For example,
several dialog boxes have a Selector button. Use the Help topics for the
Selector and its associated tools to learn how to use it.

This chapter describes how to use LIMIT commands and XP_SLLIMIT.

Related information

When you use the Selector, the way in which you display will depend on
the task you perform. For more information about using the Selector, search
for the following topics in the Administrator Help system:

“Modifying Variables”
“Modifying Dimensions”
“Modifying Relations”
“Modifying Formulas”
“Defining Saved Selections”

Using LIMIT to Change Dimension
Status
Example: Using LIMIT to change the status of a dimension

You can view part of your data in the Express Command Window by
changing the status of dimensions.

Suppose your database has a SALES variable. This variable contains sales
data stored by month for the past five years, but you only want to look at
the sales for the past six months.
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You can use the LIMIT command to change the status of the MONTH
dimension to include only the last 6 months, rather than all 60 dimension
values. If you then execute a REPORT command, the sales data for the last
six months only is displayed in the Express Command Window.

limit month to last 6
report sales

You can also limit the dimension to a single value or a range of values by
specifying the actual dimension values.

limit month to 'JAN97' to 'JUN97'

Resetting the status of one dimension

When you wish to set the status of a dimension back to all of its values, you
can use the LIMIT command with the ALL keyword. For example, you can
use the following command to set the status of the MONTH dimension
back to all of its values.

limit month to all

Resetting the status of all dimensions

When you want to set the status of all dimensions to all of their values, you
can use the ALLSTAT command. To do so, enter allstat  in the
Command box of the Express Command Window.

Limiting dimensions to view an object’s data

If you want to view a specific portion of an object’s data in Administrator,
you can set the status of its dimensions to the number of values you wish to
see.

For example, suppose you display the Modify Variable dialog box. You
can use the LIMIT command to limit that variable’s dimensions in order to
specify the number of values you want to view.

An easier way to accomplish the same task is to use the Selector tool. In the
Modify Variable dialog box, choose Selector to display the Selector. For
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details about using the Selector, choose Help in the Selector or its
associated dialog boxes.

Limiting dimensions when defining Express objects

In addition to editing variables or formulas, you may want to use LIMIT to
set dimension status when you define relations, saved selections, and
valuesets.

Limiting dimensions before exporting Express objects

If you want to export only certain values of dimensions, use the LIMIT
command to set the status of those dimensions before you export them.

An easier way to accomplish the same task is to use the Selector tool. When
you export Express database objects, you choose Export  from the File
menu, which displays the Export to an EIF File dialog box. In its
Dimension Options box, choose Select to display the Selector. For details
about using the Selector to specify only those values you want to export,
choose Help in the Selector or its associated dialog boxes.

Using XP_SLLIMIT to Set Dimension
Status
What is XP_SLLIMIT?

XP_SLLIMIT is a program that resides in the XPDDCODE database. To
use XP_SLLIMIT, you must have the XPDDCODE and XPDDDATA
databases opened. Administrator does this for you automatically.

XP_SLLIMIT has built-in knowledge of Administrator metadata. It allows
you to use all of the metadata structures that support hierarchical
dimensions, without knowing the names of the database objects or the
relationships among them that provide this support.
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When do I use XP_SLLIMIT?

You can use either LIMIT commands or XP_SLLIMIT to set dimension
status when you define saved selections for an Express database.

When you define saved selections for a Relational Access Manager
database, you must use XP_SLLIMIT instead of LIMIT to set dimension
status.

In fact, using XP_SLLIMIT is the preferred method for setting dimension
status when you define saved selections for any database. Using
XP_SLLIMIT is much easier than writing LIMIT commands.

Why you should create saved selections

When client application users display the Selector to choose the data to
display in the client application, they often find that they are choosing the
same group of dimension values again and again. As part of the
configuration of a database, you can save such a group of dimension values
as a saved selection. The Selector recognizes these saved selections and lets
users choose them. Client application users can also save their own
selections.

The selections you save in Administrator will be available in the client
application’s Selector. Client application users cannot modify or delete the
saved selections that you create.

How do I use XP_SLLIMIT?

There is a standalone Help system that details how to use XP_SLLIMIT.
The file that contains the XP_SLLIMIT Help system (xpsllim.hlp) is
supplied on the Express Client and Express Server CDs.
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Related information

For more detailed information on saved selections, search for the following
topics in the Administrator Help system:

“Defining Saved Selections”
“Deleting Saved Selections”

Using STATUS to Check the Current
Status
The STATUS command

When you use the STATUS command with a dimension name, it displays
the current status for that dimension.

Dimension status does not have to be made up of consecutive values. You
can specify more than one range in a LIMIT command or you can add or
remove values from the current status list.

An alternative way to check the current status of a dimension is to use the
List tool in the Selector.

Example: Adding values to the current status

The following commands show the current status of MONTH (using the
STATUS command), and then add six months to the current status with the
ADD keyword in the LIMIT command.

Suppose the status of the MONTH dimension is currently limited to the
first six months of 1995. If you execute the following command, it displays
the current status of that dimension.

status month

The current status of MONTH is:
JAN95 TO JUN95
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The following commands add values to the current status and use the
STATUS command to verify the results.

limit month add 'JAN97' to 'JUN97'
status month

The current status of MONTH is:
JAN95 TO JUN95, JAN97 TO JUN97

Reducing the current status

You can also reduce the current status with the KEEP keyword. KEEP,
REMOVE, and ADD operate differently from TO:

� TO operates on all the values of the dimension, regardless of its status.
If you have five years of sales data from 1993 to 1997, the command
LIMIT  MONTH TO FIRST  6 gives the first six months of 1993,
regardless of the current status of MONTH.

� KEEP, REMOVE, and ADD operate on the current status. If the current
status is all the months of 1997, the command LIMIT  MONTH KEEP
FIRST  6 gives the first six months of 1997.

One example of when you may need to use LIMIT in this way is when you
map SQL data to an Express database. You will use a selection
preprocessor script (as described in detail in the Administrator Help
system). In that script, you can include any valid Express command or
program name, but it is likely you will use LIMIT commands with the
ADD keyword.

Example: Reducing the current status

Suppose you first check the status of MONTH, which produces the
following results.

status month

The current status of MONTH is:
JAN97 TO DEC97
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If you limit the dimension and check its status, the STATUS command
shows the status is now limited to the dimension’s first six values.

limit month to first 6
status month

The current status of MONTH is:
JAN93 TO JUN93

Use the following commands to limit the status to the first 6 months of
1997.

limit month to year 'YR97'
limit month keep first 6
status month

The current status of MONTH is:
JAN97 TO JUN97

Related information

Refer to the LIMIT command in the Express Language Help system for
more details about using this command.
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Chapter 13

Sparse Data

Overview
Introduction

This chapter gives you tips on setting up Express databases that contain
sparse data.

In this chapter

� What You Should Know About Sparsity

� Data with Controlled Sparsity

� Data with Random Sparsity

� What Are Sparse Variables?

� What are Composites?

� Sharing Composites

� Multiple Composites

� Single-Dimension Composites

� Creating and Using Named Composites

� Naming Composites

� Working with Composites

� Database Design Tips

� Assigning Data to Sparse Variables

� Assigning Data to a Variable with the = Command
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� Specifying an Alternative Evaluation Behavior of the = Command

� Assigning Data to a Variable with the FILEREAD Command

� Using CHGDFN SEGWIDTH for Execution Efficiency

� Determining and Specifying Segment Size

� Deleting Composite Dimension Values

� Using the Selector with Sparse Variables

� Performing Miscellaneous Tasks

What You Should Know About Sparsity
What is sparse data?

When you first define a variable, its values are NA (not available) by
default. An NA value means that the cell (a single data value in the data
cube) either does not currently have a value assigned to it or that a
calculation produced an NA result. Even if cells have NA values, these
values can occupy disk space, depending on how the variable has been
defined. This can result in a variable with a large number of NA values that
requires a lot of disk space, which can result in poor performance.

If a variable has a large number of NA values, its data is called sparse data.

The NA values may be scattered throughout a variable, usually because
some combinations of dimension values never have any data. This is often
a result of the nature of your business; for example a product is never sold
in a certain region.

How Express handles NA values

By default, Express stores all NA cells unless an entire page of data is made
up of NA values.
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Types of sparse data

You can reduce the size of your database by reducing the size of the
variables in which data is sparse. Sparse data comes in two varieties:

� Controlled (or structural) sparsity

� Random sparsity

Data with Controlled Sparsity
Definition: Controlled sparsity

Controlled sparsity means that a range of values of one or more dimensions
has no data.

This is often a result of the way you design your database.

Example: Controlled sparsity

For example, suppose you define a new variable called
PROJECTED_SALES.

Notice in the following figure that this definition specifies TIME as the
fastest-varying dimension, because TIME was the first dimension selected
and was added to the Dense box of the Define a Variable dialog box.
PRODUCT is the second-fastest varying dimension, and DISTRICT is the
slowest-varying dimension.

Now suppose there are no values for the last three months. The cells exist
because these months exist as TIME dimension values, but all the cell
values are NA, as shown in “Figure: All NA values are saved to disk.” All
of these NA values will be saved to disk.
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Figure: All NA values are saved to disk

Because there are no values for the last three months all the cell values are
NA and will be saved to disk.

Saving disk space with controlled sparsity

You can save disk space for data with controlled sparsity by the way you
define variables. For example, when you use the Define a Variable dialog
box to define the PROJECTED_SALES variable, as shown in “Figure: The
sparse dimension is specified as the slowest-varying dimension,” TIME is
the last dimension selected.
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Figure: The sparse dimension is specified as the slowest-varying dimension

The following figure shows the definition of the a variable named
PROJECTED_SALES where the sparse dimension (TIME) has been
specified as the slowest-varying dimension, which means TIME is the last
dimension in the dimension list.
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Figure: NA values are not saved to disk

In the following figure, NA values are grouped on a page and will not be
saved to disk.

The consequences of making the sparse dimension the last dimension

If you add the sparse dimension as the last, or slowest-varying, dimension
in the Dense box, the NA values are grouped together on one or more data
pages. Express Server does not store pages that contain only NA values, so
you save space in the database.

This method saves disk space, but can cause inefficient processing if other
variables have the same dimensions specified in a different order or if
accessing this data causes more pages to be retrieved. The topic entitled
“How Data is Stored” describes how this works. In using these techniques,
you must decide which you would rather optimize, processing or storage.
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Data with Random Sparsity
Definition: Random sparsity

Random sparsity means that NA values are scattered throughout a variable,
usually because some combinations of dimension values never have any
data.

This is often a result of the nature of your business.

Example: Random sparsity

Suppose a district sells only certain products and never has data for other
products. Other districts might sell some of those products and other ones
as well.

“Figure: A random pattern of NA values” shows the values of a variable
with sparse data and its dimensions. It uses a variable named SALES,
which is dimensioned by TIME, PRODUCT, and DISTRICT.

Figure: A random pattern of NA values

The following report of SALES shows a random pattern of NA values.

           ---------------------SALES------------------

                   JAN97      FEB97      MAR97      APR97      MAY97     JUN97
              ---------- ---------- ---------- ---------- ---------- ---------
BOSTON:
  COFFEE       31,462.80  58,343.75  54,158.84  45,459.55  63,727.98  52,232.05
  SUGAR        45,633.38  66,960.37  51,201.41  41,119.10  66,985.30  34,103.41
  GRITS               NA         NA         NA         NA         NA       NA
  GRANOLA      38,353.49  44,890.01  32,705.20  59,889.76  26,695.59  25,807.17

ATLANTA:
  COFFEE       62,373.42  37,698.17  39,944.58  42,854.71  31,815.47  26,659.09
  SUGAR               NA         NA         NA         NA         NA        NA
  GRITS        55,075.33  64,352.74  36,571.66  31,048.07  28,430.80  69,612.45
  GRANOLA             NA         NA         NA         NA         NA        NA

CHICAGO:
  COFFEE       28,302.61  31,301.34  53,122.95  32,510.59  50,884.83  33,123.26
  SUGAR        43,460.88  22,743.96  45,991.54  39,841.34  25,657.83  50,375.86
  GRITS               NA         NA         NA         NA         NA         NA
  GRANOLA             NA         NA         NA         NA         NA         NA
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How to eliminate NA values

To eliminate the NA values from data with random sparsity and make the
variable smaller, you can set sparsity when you define a variable such as
SALES. When you do this, you are defining a sparse variable.

What Are Sparse Variables?
Definition: Sparse variable

A sparse variable is a variable that you define as sparse along one or more
of its dimensions. In other words, at the time you define a variable, you
should determine which of its dimensions (or combination of dimensions)
are likely to result in sparse data, and identify those dimensions by adding
them to the Sparse box in the Define a Variable dialog box. When you add
one or more dimensions to the Sparse box, you tell Express to create a
composite.

Procedure: Defining sparse variables

Use the following procedure to define a sparse variable.

Step Action

1 From the Edit menu, choose Define.

2 From the submenu, choose Variable  to display the Define a Variable dialog
box.

3 Specify information such as the name, data type, and database of the
variable.

4 In the Available box, select the fastest varying non-sparse dimension and
choose (  ) next to the Dense box to add the dimension. Repeat this
step for each of the non-sparse dimensions, ending with the slowest-
varying.

5 In the Available box, select the fastest varying sparse dimension and
choose (  ) next to the Sparse box to add the dimension. Repeat this
step for each of the sparse dimensions, ending with the slowest-varying.

6 Choose Define  to define the variable.
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What Are Composites?
Definition: Composite

A composite is an Express object that identifies which combinations of
values of several dimensions actually exist in the data. Variables that use a
composite only make room for those combinations. This potentially saves
enormous amounts of space.

How a composite is created

You do not have to create a composite. When you define a variable in
which you have added a dimension to the Sparse box, Express
automatically creates an internal structure called an unnamed composite to
help process the sparse variable efficiently.

If you need to name a composite, you can do so. By default, when you
define two or more variables with the same sparse dimensions in the same
order, they share the same composite. You can override this.

Why is it important to use composites?

Careful and appropriate use of composites most often results in:

� Reduced database size

� Increased density of non-NA cells per data page

� Reduced paging demands

� Improved performance

If you do not use composites, it is possible that a small amount of data will
be stored on a data page that contains mostly NA values. If there are many
pages like this, Express reads different data pages constantly, resulting in
poor performance.

Important: Limit on composite values

Express Server 6.2 allows no more than 45 million distinct values per
composite. Earlier releases of Express Server allow no more than 45
million total composite values in a database.
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Example: When Express will create a composite

If you sell products in some but not all districts, your data will be sparse
along the PRODUCT and DISTRICT dimensions. Therefore, when you
define variables and add PRODUCT and DISTRICT to the Sparse box,
Express creates a composite so that dimension values are created only for
those values that have data (for example,
< ‘SPORTSWEAR’ ‘BOSTON’ >).

Controlling the access method that will be used by a new composite

By default, composites are created using the BTREE method for loading
and accessing values.

Use the SPARSEINDEX option in the Express Command window to
control which access method of is used by a new unnamed composite.
Acceptable values are HASH and BTREE. See the entry for
SPARSEINDEX in the Express Language Help system.

Composites and defining variables

You can define:

� Two or more variables that share the same composite

� A variable with more than one composite

� A variable with a single-dimension composite

Converting conjoint dimensions to composites

If you have used a version prior to Express Server 6.0, you may have
defined conjoint dimensions in your Express database. You can convert
conjoint dimensions to composites, and vice versa. See Appendix B for
more information.
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Sharing Composites
Overview

When you define two or more variables with the same sparse dimensions in
the same order, they share the same composite.

Unless the variables differ significantly in their sparsity pattern, this is the
most efficient approach.

When variables should not share the same composite

In some cases, you may have two variables that are sparse along the same
dimensions, but have a significantly different pattern of sparsity. To handle
sparsity more efficiently in this situation, you should create a named
composite to use when you define the second variable. See the topic
“Creating Named Composites” later in this chapter.

Procedure: Defining variables that share the same composite

The following procedure gives an overview of how to define two or more
variables that will share the same composite.

Step Action

1 Open the Define a Variable dialog box.

2 For each variable you define, add the same dimensions to the Sparse box in
the same order.

Example: Defining two variables that will share the same composite

Suppose you have already defined a SALES variable that has the
PRODUCT, DISTRICT, and TIME dimensions, and the PRODUCT and
DISTRICT dimensions are sparse.

Now, suppose you plan to define a UNIT_SALES variable with the same
dimensions as SALES. You know that UNIT_SALES will be sparse along
the same dimensions as SALES, and will have the same sparsity pattern as
SALES. For example, neither SALES nor UNIT_SALES will have values
for GRITS in BOSTON.
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When you define UNIT_SALES, you would add the TIME dimension to
the Dense box and the PRODUCT and DISTRICT dimensions to the
Sparse box in that order. SALES and UNIT_SALES now share the same
composite.

You can also copy the definition of SALES by selecting sales in the
Database Browser and choosing Copy from the Edit menu.

Figure: Definition of a second variable to share the same composite

The following figure shows the settings in the Define a Variable box to
define the UNIT_SALES variable so that it will share the same composite
with the SALES variable.
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Multiple Composites
Overview

You may define a variable that has multiple composites by dimensioning it
by named composites that you have previously defined.

Example: Why a variable might have more than one composite

Suppose you define a UNITS variable with the TIME, PRODUCT,
GEOGRAPHY, CHANNEL, and AREA dimensions.

You know that the variable will be sparse along all the dimensions except
TIME. You could define the variable with one composite by selecting
PRODUCT, GEOGRAPHY, CHANNEL, and AREA, and adding them to
the Sparse box in the Define a Variable dialog box.

However, if you have already defined a PROD_GEO composite with base
dimensions PRODUCT and GEOGRAPHY, and a CHANNEL_AREA
composite with base dimensions CHANNEL and AREA, it is more
efficient to define the variable using the two composites that already exist.

To do this, you select PROD_GEO and CHANNEL_AREA and add them
to the Sparse box in the Define a Variable dialog box.

Procedure: Defining a variable with multiple composites

The following procedure gives an overview of how to define a variable that
has two or more composites.

Step Action

1 In the Define a Variable dialog box for each variable you define, select the
composites you want to include from the Available box.

2 Choose (  ) next to the Sparse box to add the composites to the
Sparse box.

3 Choose Define  to define the variable.
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Figure: Defining a variable with multiple composites

The following figure shows the CHANNEL_AREA and PROD_GEO
composites selected in the Sparse box of the Define a Variable dialog box.
Choosing the Define button will define the UNITS variable.

Single-Dimension Composites
Definition: Single-dimension composite

When you set sparsity on just one dimension in a variable definition,
Express creates a single-dimension composite.
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When to use single dimension-composites

It is a good idea to use single-dimension composites when a variable will
share the same dimensions as some other variables, but for a particular
single dimension, the variable will only have data for some of that
dimension’s values.

Example: When to use single dimension composites

Suppose you have already defined a variable called ACTUAL with the
dimensions TIME, DIVISION, and LINE. ACTUAL has no NA values.
You need to define a variable called BUDGET, which requires much less
detail than ACTUAL. For example, BUDGET only needs 10 percent of the
LINE dimension values, while ACTUAL needs all of them.

If you define BUDGET without setting sparsity, all of the LINE dimension
values are present for every TIME and DIVISION, but 90 percent of the
LINE dimension cells will have NA values.

To handle sparse data in this case, set sparsity on the LINE dimension only
when you define BUDGET.
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Figure: Sparsity is set on a single dimension

In the following figure, the Sparse dimensions box in the Define a Variable
dialog box shows that sparsity has been set only on the LINE dimension,
which means Express will automatically create a single-dimension
composite when the variable is defined.

Creating and Using Named
Composites
Overview

When you have two variables that are sparse along the same dimensions
but have a significantly different pattern of sparsity, it is more efficient to
create a named composite to use when defining the second variable.
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For example, two variables may be sparse along the PRODUCT and AREA
dimensions, but there may be many dimension value combinations where
one variable has data and the other does not.

Suppose you have two variables named SALES and PROJECTED_SALES.
These variables could have a significant difference in sparsity for many
reasons. Some products and districts may have been discontinued, other
products and areas may be added in the future, or some products will no
longer be sold in certain areas or will be offered for the first time in certain
areas.

You refer to a named composite by the name you gave it in its definition.

A named and an unnamed composite with identical base dimensions are
different composites, and they can have different dimension value
combinations.

Using a named composite in the variable’s dimension list tells Express that
the base dimensions of the named composite are sparse dimensions on this
variable, and that this composite will only be shared with other variables
using the same named composite.
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Procedure: Creating a named composite

The following procedure describes how to create a named composite.

Step Action

1 From the Edit menu, choose Define.

2 From the submenu, choose Dimension  to display the Define a Dimension
dialog box.

3 In the Database box, select the database in which you want to define the
new composite.

4 In the Name box, type a valid Express object name for the new composite.

The name must consist of 1 to 16 characters. For information about naming
restrictions, see the entry for the DEFINE command in the Express
Language Help.

5 In the General tab, select Composite  in the Type box.

6 Select each base dimension from the Available list, beginning with the
fastest-varying dimension. Then choose(  ) to add the dimension to
the Selected list or just double-click on the dimension.

7 Select the algorithm you want Express to use for loading and accessing the
values of the composite in the Options box. You can select BTree, Hash.

8 In the Labels tab, type a descriptive name for the composite in the
Comments box.

9 Type a short name for the composite in the Short Description box, using any
combination of upper- and lowercase letters.

10 Type a description for the composite in the Description box.

The description can include spaces and provides internal documentation for
the dimension. In Express Client products, the Description appears in the
Object Inspector.

11 Type the plural forms of the names in the Short Description (Plural) and
Description (Plural) boxes.

12 Choose Define  to define the composite and to create the supporting
database objects.

13 Choose Close  when you have finished defining composites.
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Figure: Defining a composite

The following figure shows the Define a Dimension dialog box set up to
define a composite.
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Procedure: Creating a variable that uses a named composite

Use the following procedure to create a variable that uses a named
composite.

Step Action

1 Define all the composites and dimensions required by the variable if you
have not done so already.

2 From the Edit menu, choose Define.

3 From the submenu, choose Variable  to display the Define a Variable dialog
box.

4 In the Name box, type a valid Express object name for the new variable.

5 In the Database box, select the database in which you want to define the
new variable.

6 In the General tab, select a data type in the Type box. You can select
Boolean, Date, Decimal, ID, Integer, Short decimal, Short integer,  or
Text.

7 In the Available box, select the dimension or composite that you wish to be
the fastest varying dimension or composite and choose (  ) to add the
composite to the Dense box.

8 Repeat step 7 for each of the variable’s dimensions or composites.

9 Decide whether to select the Temporary  box, as follows:

IF . . . THEN . . .

you want the data to be
discarded at the end of every
session,

select the Temporary  box.

you want to store the data from
one session to the next,

do not select the Temporary  box.

10 In the Labels tab, type a description for the variable in the Description box.
The description can include spaces and provides internal documentation. In
Express Client products, it appears in the Object Inspector.

11 Type a short name for the variable in the Short Description box, using any
combination of upper- and lowercase letters. Express Client products
display the short name in tables, graphs, and the Dimension Bar.

12 Type a description in the Comments box. In Express Client products, the
description appears in the Database Browser and the Selector.
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Step Action

13 In the Format tab, you can specify the formatting for a variable with numeric
data.

IF . . . THEN . . .

you want to specify the formatting
for a variable with numeric data,

deselect the Use Default  box,
and enter values in the Format
and Display Type boxes.

you want to use global values
and not specify the formatting for
a variable with numeric data,

select the Use Default  box.

14 Choose Define to create the variable.

15 When you are through creating variables, choose Close.
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Figure: Creating a variable using a named composite

The following figure shows the Define a Variable dialog box in which the
sparse variable EXPENSE is created using the composite
PRODUCT_AREA and the dimension TIME.

Related information

For more information about named composites, see the DEFINE
COMPOSITE command in the Express Language Help system.
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Naming Composites
Overview

You can name an unnamed composite. To do so, use the RENAME
command in the Express Command window.

You can also change the name of a named composite and change a named
composite to an unnamed composite.

The RENAME syntax

The syntax for naming a composite with the RENAME command is as
follows.

RENAME SPARSE <dims> composite_name

The syntax is explained below.

� SPARSE indicates that the following dimensions are sparse.

� dims is the list of dimensions in your composite.

� composite-name is the name of your composite.

Procedure: Naming an unnamed composite

Use the following procedure to name an unnamed composite.

Step Action

1 From the Run menu, choose Express Command  to display the Express
Command window.

2 Enter a RENAME command in the Command box, using the following
syntax.
RENAME SPARSE <dims> composite_name

3 Choose (  ) to execute the command.

4 Close the database and reopen it to see the composite displayed in the
Database Browser.
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Example: Naming an unnamed composite

Suppose a variable has already been defined in which sparsity has been set
on the PRODUCT and AREA dimensions.

The following command assigns the name PRODUCT_AREA to the
variable’s previously unnamed composite.

rename sparse <product area> product_area

Procedure: Changing the name of a named composite

You can change the name of a named composite using the Rename dialog
box.

The following procedure describes how to change the name of a named
composite.

Step Action

1 From the Database Browser, select the named composite, and from the
right mouse popup menu, choose Rename  to display the Rename dialog
box.

2 Type a new name for the composite in the Enter new object name box and
choose OK.

Procedure: Changing a named composite to an unnamed composite

You can change a named composite to an unnamed composite if the
composite has no properties or permission restrictions and if there is at least
one object dimensioned by it. All composites defined in Adminstrator have
the property ‘USERDATA’ so you must delete this property before you can
change a named composite to an unnamed composite.

In addition, there cannot be more than one unnamed composite with the
same dimensions in the same order in the database.

Use the following syntax in the Express Command window to change a
named composite to an unnamed composite.

CONSIDER composite-name
PROPERTY DELETE ALL
RENAME composite-name SPARSE
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Working with Composites
Procedure: Copying the definition of a named composite

You can copy the definition of a named composite using the Copy
Definition dialog box.

The following procedure describes how to copy the definition of a named
composite.

Step Action

1 From the Database Browser, select the named composite and from the right
mouse popup menu, choose Copy  to display the Copy Definition dialog box.

2 Type a new name for the copied composite definition in the Enter new
object name box, and choose OK.

Getting a list of all named composites in a database

The COMPOSITE “choice” argument of the DATABASE function returns
a list of all named composites in a database. See the entry DATABASE
function in the Express Language Help system.

Getting information about named composites

The Property Inspector displays information about certain database object
properties. The OBJ function returns information about database objects.
You can use the Property Inspector and the OBJ function to get information
about named composites and to get information on variables with
composites.
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The following table shows a subset of Property Inspector properties for a
composite and the information displayed for the property.

Property Information Displayed

Data Type For a composite, the name of the composite and the
names of the dimensions in the composite

Dimensioned by For a composite, the names of the dimensions in the
composite

Object Type For a composite, COMPOSITE

The following table show a subset of OBJ choices that you might want to
use.

Choice
Data Type
of Result Information Returned

DFNDIMS TEXT For a composite or a variable, a multiline text value
containing the name(s) of the dimensions and
composites in the dimension list used to define an
object.

DIMS TEXT For a composite or a variable, a multiline text value
containing the name(s) of an object's dimensions. For
composites, it returns a multiline text value listing the
base dimensions of the composite. For variables, it
returns a multiline text value containing the name(s)
of the base dimensions of the variable.

NUMDFNDIMS INTEGER For a composite or a variable, the number of
dimensions or composites in the dimension list used
to define an object. For this count, each composite
counts as one, and the dimensions within the
composite's dimension list are not counted.

NUMDIMS INTEGER For a composite or a variable, the number of
dimensions of a dimensioned object. For all types of
dimensions, NUMDIMS returns 1. For a composite, it
returns the number of base dimensions.

SPARSE TEXT For a composite or a variable, a multiline text value
listing the named or unnamed composites used in the
definition of an object.
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Related information

See DATABASE and OBJ in the Express Language Help system for
detailed information about these functions.

Database Design Tips
When you define sparse variables

To ensure good performance, you should consider taking the following
steps any time you define a sparse variable.

� Create only one composite in any variable you define.

� Consider adding the fastest-varying dimension to the Dense box (not
part of a composite), and putting all other dimensions into a single
composite by adding them to the Sparse box. You may keep more than
one dimension dense. The dimension you choose to keep dense will
depend on your application.

� Use CHGDFN with the SEGWIDTH keyword to control the size of a
variable’s segment before you assign any data to the variable. Express
provides default segment widths, but you might get better results by
using CHGDFN with the SEGWIDTH keyword. The number of
segments in a variable affects the performance of data loading and data
accessing. The topic entitled “What You Should Know About
Segments” describes segments and how you can control their size.

Assigning Data to Sparse Variables
How to assign data to sparse variables

You can assigndata to sparse variables in a number of ways. You can:

� Edit variables and add data manually.

� Import data.

� Use the = command to assign the value of an expression to your sparse
variable.
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� Use the FILEREAD command to read data from a file into your sparse
variable.

� Use the SQL command with the FETCH keyword to fetch data from a
relational database into your sparse variable.

Express adds any needed composite values when you add data

No matter which method you use to assign data to a sparse variable,
Express will automatically add composite values as needed to create any
missing target cells that are being assigned non-NA values.

Assigning Data to a Variable with the =
Command
Definitions: Target variable and source expression

When you use the = command to assign data to a variable, the variable
appears on the left side of the = sign, and is called the target variable.

The data you are assigning to the variable appears on the right side of the =
sign, and is called the source expression.

Example: Assigning data to a variable

Suppose you assign data to the SPARSE_SALES variable. Express
attempts to assign values from the source expression into the target variable
for all the combinations of products and markets that are in status.

The following command assigns data to the sparse variable
SPARSE_SALES from the SALES variable, automatically adding values to
the composite used by SPARSE_SALES as needed.

sparse_sales = sales
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Express adds any needed composite values when you add data

When you assign data to a sparse variable with the = command, Express
automatically adds composite values as needed to create new data cells for
non-NA data.

If there is no existing data cell in the target variable for a particular
combination of product and market, and the source expression has data for
that combination, Express adds the missing dimension value combination to
the composite, thus creating the missing cell. It then sets the cell to the
value in the source expression.

Express always assigns data correctly, regardless of the sparsity of the
target variable or the source expression. For example, the target variable
might be a sparse variable while the source is a regular variable. Or the
source might be a sparse variable and the target might be a regular variable.
Or both target and source might be sparse variables; they could have the
same composite, or different composites. Express will handle each case
appropriately.

If the source expression is sparse, and Express tries to find a value for a
dimension value combination that does not exist in the source expression, it
will consider that the source expression has an NA at that dimension value
combination.

Specifying An Alternative Evaluation
Behavior of the = Command
The default evaluation behavior of the = command

When assigning data to sparse variables, Express evaluates the source
expression for every combination of the dimension values in status for the
target variable, including combinations of the sparse dimensions for which
the target variable currently has no cells. If the source expression is not NA
for those combinations where the target currently has no cells, Express will
create new cells and assign the data into them.
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Express gives you the ability to specify a different evaluation behavior.
You can alter the default evaluation behavior of the = command so that
Express evaluates the source expression only for those combinations of the
dimension values in status for which the target variable currently has cells.

Use alternative syntax for the = command

Since the composite of the sparse dimensions is how Express keeps track of
which combinations of the sparse dimensions have data cells, you use the
following syntax to specify this different evaluation behavior.

name = expression ACROSS composite

The syntax is explained below.

� name is the sparse variable. It is the target where data will be assigned
and stored.

� expression is the source expression that holds the data that will be
assigned to the target variable.

� ACROSS is the keyword that indicates that you want to alter the default
evaluation behavior and cause Express to evaluate the composite of the
target variable.

� composite is the composite for the sparse dimensions on the target
variable.

Named versus unnamed composites

If the variable was defined with a named composite, specify the name of
the composite in the alternative syntax for the = command. If the variable
was defined with an unnamed composite, use the following syntax to refer
to the unnamed composite.

SPARSE<dims>

In this syntax, dims is the list of the base dimensions of the composite.
These are the dimensions you indicated as sparse when you defined the
variable by adding them to the Sparse box in the Define a Variable dialog
box.
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Example: Specifying the alternative evaluation behavior

For example, to have Express assign data from SALES only into existing
data cells of SPARSE_SALES, whose associated dimension values are in
status, use the following command.

sparse_sales = sales across sparse<product market>

The ACROSS keyword

The ACROSS keyword is particularly helpful if the source expression is a
single value. If there are no limits on the dimensions of SPARSE_SALES,
then an assignment command like the following will create cells for every
combination of dimension values, because there are no cases where the
source expression is NA.

sparse_sales = 0

This defeats the purpose of a sparse variable.

In contrast, the following command will set only existing cells of
SPARSE_SALES to 0.

sparse_sales = 0 across sparse<product market>

Assigning Data to a Variable with the
FILEREAD Command
Overview

When reading data into a sparse variable (that is, one defined with a
composite in its dimension list), FILEREAD automatically creates any
missing target cells that are being assigned non-NA values. This process
also adds to the composite all the dimension value combinations that
correspond to those new cells.

Alternatively, you can use the FILEREAD command to explicitly add
values to the composite for your sparse variable before reading in the data.
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See the FILEREAD entry in the Express Language Help system for more
information.

The FILEREAD syntax

As shown in the following example, the syntax for the FILEREAD
command is the same for a sparse variable as it would be for a regular
variable.

fileread unit append w 8 product append w 8 market-
   w 10 sparse_sales

How to make storage more efficient

As with any method of assigning data to sparse variables, you can use the
CHGDFN command with the SEGWIDTH keyword before assigning data
to make the storage more efficient. See the topic entitled “Using CHGDFN
SEGWIDTH for Execution Efficiency.”

Using CHGDFN SEGWIDTH for
Execution Efficiency
Definition: Segment

A segment is a portion of the total number of values a variable holds.

How segments affect performance

The number of segments in a variable affects the performance of data
loading and data accessing. Too many segments (thousands to millions) can
degrade performance.

Use the CHGDFN command with the SEGWIDTH keyword to specify the
size of a variable’s segments.

When to use CHGDFN SEGWIDTH

It can be a good strategy to use the CHGDFN command to ensure good
performance for a sparse variable before that variable contains any data.
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You can use CHGDFN SEGWIDTH to ensure good performance for any
variable.

You can reduce the number of segments if you let Express know how many
values you expect the composite for the variable will have once all the data
has been assigned.

Express provides default segment widths, which in many cases ensure good
performance. However, it is still a good strategy to use CHGDFN so that
you can specify the segment widths you want.

The CHGDFN syntax

Use the following syntax for CHGDFN.

CHGDFN varname SEGWIDTH length-dim1 length-dim2 ...

The syntax is explained below.

� Varname is the name of a variable whose segment size you want to
specify.

� SEGWIDTH indicates that the following numbers will be used to
specify the size of a variable’s segments.

� Length-dim1 is the number of values for the dimension or composite in
the first position of the dimension list of the variable’s definition (the
fastest-varying dimension or composite), length-dim2 is the number of
values for the dimension or composite in the second position in the
dimension list, and so on.

Specify the segment width as the maximum number of values per segment
for each dimension or composite on the variable.

The CHGDFN command will affect the segment size not only for the
variable whose segment size you want to specify, but also for any other
variable that has a dimension list identical to the dimension list for that
variable. This means that if you have a number of sparse variables with
identical dimension lists, a single CHGDFN command will set up an
efficient segment size for the whole group of variables.
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If data has already been assigned to the variable whose segment size you
want to specify, or any other variable with an identical dimension list,
several segments have already been created. The CHGDFN command
cannot get rid of those existing segments. It can, however, reduce the
number of segments that are created after you execute the CHGDFN
command. You can change the segment width of a variable at any time to
further optimize the number of segments.

Determining and Specifying Segment
Size
Determining segment size

If you are not sure what your segment size should be, use the maximum
anticipated number of values for each dimension or composite as the length
arguments to SEGWIDTH. Then only one segment will be created for the
variable.

You must execute the CHGDFN command before any data is assigned to a
variable in order to have just one data segment for that variable.

Example: Determining and specifying segment size

Suppose you have a variable SPARSE_UNITS with an unnamed composite
at the end of its dimension list. The following is the definition of the
SPARSE_UNITS variable.

define sparse_units variable integer <month
sparse<district product>>



Determining and Specifying Segment Size

311

Now suppose you would like this variable to have only one segment.
SPARSE_UNITS’s dimension list includes the TIME dimension and an
unnamed composite of the DISTRICT and PRODUCT dimensions
(SPARSE<DISTRICT PRODUCT>). If you expect eventually to have data
for 90,000 combinations of DISTRICT and PRODUCT, and the TIME
dimension to have 120 values, you can make the segments for
SPARSE_UNITS that size by using the following command.

chgdfn sparse_units segwidth 120 90000

When you may want to have more than one segment per variable

If you are an experienced Express user and your database has large
variables, you may want to have more than one segment per variable. You
can specify segment sizes for those variables that best suit their application.

Sometimes, having more than one segment can improve performance. If
you want your variable to have more than one segment, it is generally a
good idea to keep the number of segments small.

Finding out how many segments an object already has

You can use OBJ(NUMSEGS) to find out if you have too many segments
for objects that have a particular dimension set. For example, to find out the
number of segments for the variable SALES, enter the following commands
in the Express Command window.

show obj(numsegs ‘sales’)

If you have previously set the segment size for a particular dimension set,
you can check on the size by executing a command with the following
syntax.

CHGDFN variable-name SEGWIDTH
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When you use the SEGWIDTH keyword with no length arguments,
Express produces an error message that includes the current length-dim
value for each dimension in the dimension set for variable-name. For
example to find out the length-dim value for each dimension in the
dimension set for the variable SALES, enter the following command in the
Express Command window.

SHOW OBJ(SEGWIDTH ALL ‘f.sales’)

What to do if an object has too many segments

If you find that an object has too many segments, you can reduce the
number of segments. See the CHGDFN command and the OBJ function in
the Express Language Help system for details.

Alternative methods for ensuring efficient segment size

There are some alternative methods for ensuring efficient segment size. If
you are using the FILEREAD command to assign data into your sparse
variable, you can use the FILEREAD command to explicitly add values to
the composite for your sparse variable before reading in the data. See the
FILEREAD command in the Express Language Help system for more
information.

In some situations, you might want to use the MAINTAIN command to
explicitly add values to the composite before assigning data. See the
MAINTAIN command in the Express Language Help system for more
information.

Deleting Composite Dimension Values
Overview

If you need to delete composite values, use the MAINTAIN command with
the DELETE keyword. You can delete one or more specified values of the
composite, or you can delete related groups of composite values.



Deleting Composite Dimension Values

313

The MAINTAIN syntax

The syntax for deleting one or more specified values from a composite is as
follows.

MAINTAIN composite DELETE valuelist

The syntax is explained below.

� Composite can be either a named or unnamed composite. To refer to a
named composite, use its name. To refer to an unnamed composite, use
the keyword SPARSE followed by the dimensions of the composite
enclosed by angle brackets.

� DELETE is the keyword that indicates the following values will be
deleted from the composite.

� Valuelist is a list of composite values. You refer to an individual
composite value the same way you refer to values of a conjoint
dimension: by enclosing the values of the composite’s base dimensions
in angle brackets.

Example: Deleting dimension values from a composite

Suppose you have an unnamed composite with the base dimensions of
PRODUCT and DISTRICT. To delete the value <‘SNOWSHOES’
‘ATLANTA’> from that composite, you would use the following
command.

maintain sparse<product district> delete <'SNOWSHOES'-
'ATLANTA'>

Example: Deleting related groups of composite values

You can also use the MAINTAIN command to delete related groups of
composite values by using the following syntax.

MAINTAIN composite DELETE basedim basevaluelist

The syntax is explained below.

� Composite can be either a named or unnamed composite. To refer to a
named composite, use its name. To refer to an unnamed composite, use
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the keyword SPARSE followed by the dimensions of the composite
enclosed by angle brackets.

� DELETE is the keyword that indicates the following values will be
deleted from the composite.

� Basedim is one of the base dimensions of the composite.

� Basevaluelist is a list of one or more values of the specified base
dimension.

For example, suppose you no longer need any of the data related to the
product SNOWSHOES in any of the sparse variables sharing the unnamed
composite with the base dimensions of PRODUCT and DISTRICT. To
delete all the composite values that contain SNOWSHOES as their product
dimension value, use the following command.

maintain sparse<product district> delete product- 
'SNOWSHOES'

The above command will remove all the composite values that contain
SNOWSHOES. It does not remove SNOWSHOES from the PRODUCT
dimension.

Example: Deleting a value from the dimension and from the composite

You can delete a dimension value from one of the base dimensions of a
composite by using the Edit Dimension Values dialog box or by using the
MAINTAIN command directly on that base dimension. This will also
delete values associated with that dimension value from the composite.

For example, suppose your company drops SNOWSHOES entirely from its
product line. Therefore, you need to remove SNOWSHOES from the
PRODUCT dimension as well as from the composite. To do this, use the
MAINTAIN command directly on the PRODUCT dimension, as shown in
the following command.

maintain product delete 'SNOWSHOES'

The above command not only removes SNOWSHOES from the
PRODUCT dimension, but it also automatically removes any composite
values associated with SNOWSHOES from any named or unnamed
composites that have PRODUCT as a base dimension.
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Using the Selector with Sparse
Variables
Setting the status for dimensions of sparse variables

You use the Selector to set status for the dimensions of a sparse variable in
the same way you would if the variable were not sparse.

Composites are not dimensions, and therefore do not have any independent
status. The values of a composite that are “in status” are determined by the
status of the base dimensions of the composite. In general, when Express
functions and commands deal with objects defined with composites, the
default behavior is to treat those objects as if no SPARSE keyword or
named composite had been used when the object was defined.

Displaying data in a report

When you use the REPORT command with a sparse variable, Express’s
default behavior is to evaluate all the combinations of the values of the
composite’s base dimensions that are in status. Any combinations that do
not exist in the composite display NA for their associated data.

Example: Displaying data in a report

Suppose you want to look at SPARSE_SALES for sales in Boston from
January 98 to March 98. First, use the Selector to set the status of
DISTRICT to ‘BOSTON’ and the status of TIME to ‘JAN98,’ ‘FEB98,’
and ‘MAR98.’ The composite on DISTRICT and PRODUCT only has
values for <‘CANOES’ ‘BOSTON’> and <‘SPORTSWEAR’ ‘BOSTON’>.

Use the following command to produce a report for SPARSE_SALES.

report SPARSE_SALES
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The preceding command will produce the following output.

DISTRICT: BOSTON
              -----------SPARSE_SALES----------
               -------------TIME--------------
PRODUCT          JAN98      FEB98      MAR98
-------------- ---------- ---------- ----------
TENTS                  NA         NA         NA
CANOES             66,014     76,084     91,748
RACQUETS               NA         NA         NA
SPORTSWEAR         53,195     58,913     62,798
FOOTWEAR               NA         NA         NA

Example: Overriding the default REPORT behavior

You can override the default REPORT behavior shown in “Example:
Displaying data in a report” by specifying the composite of your sparse
variable in an ACROSS, DOWN, or GROUP phrase. Besides changing the
format of a report, specifying a composite in an ACROSS, DOWN or
GROUP phrase in a REPORT command changes what is shown in the
report. When you use such a phrase, the report will show only those
combinations of dimension values which both exist in the composite and
are in status.

For example, to report the SPARSE_SALES variable broken out by its
composite, with the values of the composite going down the report, use the
following command.

report down sparse<product district> SPARSE_SALES

Because the composite only has values for the <‘CANOES’ ‘BOSTON’>
and <‘SPORTSWEAR’ ‘BOSTON’> combinations, the above command
would produce the following output.

                      ----------SPARSE_SALES-----------
                      -------------TIME--------------
 PRODUCT    DISTRICT    JAN98      FEB98      MAR98
---------- ---------- ---------- ---------- ----------
CANOES     BOSTON         66,014     76,084     91,748
SPORTSWEAR BOSTON         53,195     58,913     62,798

See the REPORT command in the Express Language Help system for more
information.
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Performing Miscellaneous Tasks
Overview

Variables and other objects that are defined with composites generally
behave like variables dimensioned by simple dimensions.

The following topics describe miscellaneous tasks you may need to perform
and additional information you may need to know when using composites
or sparse variables.

Rolling up data for hierarchical dimensions

Using the Rollup Wizard or the ROLLUP command calculates totals for a
hierarchy of dimension values where each level of the hierarchical
dimension is an aggregation of the level below it. If you are rolling up a
sparse variable, a hierarchical dimension can be a sparse dimension of the
variable. Express will automatically create any missing cells of the sparse
variable needed to store the calculated totals.

Chapter 7 gives an overview of creating and using hierarchical dimensions,
including information about using the Rollup Wizard and the ROLLUP
command. See the ROLLUP command in the Express Language Help
system for more information.

Models

You can use a sparse variable as a solution variable when solving a model.
Express will automatically create any missing cells in the sparse variable
needed to store the result of equations executed when solving the model.

See the MODEL command in the Express Language Help system for more
information on models. Also, refer to the Express Language Programming
Guide for information about creating and using models.
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Chapter 14

Performance Issues

Overview
Introduction

This chapter describes steps you can take to assure good performance from
your Express database.

In this chapter

� Warning Signs of Poor Performance

� How Data Is Stored

� Saving Calculated Data

� Planning for a Smaller Database

� Keeping Your Database Efficient

� Conserving Memory While Running Express Server

� What Is a Multifile Database?

� Saving a Database in Two or More Files

� What You Should Know About Segments

� Data Loading Tips

� Scheduling Programs

� Performance Tips for Express
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Warning Signs of Poor Performance
Overview

This topic describes the indication of performance you want to see and how
to look for signs of poor performance, especially when you are executing
rollups of the data in your database.

The tools you use

The performance tools you use depend on the platform on which Express
Server is installed, as shown in the following table.

IF Express Server 6 is
installed on . . .

THEN to get information about and tune the
performance of Express Server 6, you use. . .

AIX, the Express Session Manager and the native AIX
performance tools.

Solaris, the Express Session Manager and the native Solaris
performance tools.

NT, the Microsoft Windows NT performance monitor and
other NT tools.

The ideal

In an ideal world, the goal during rollups is for your server machine’s CPU
to run at 100 percent of utilization. It may not be possible to achieve 100
percent utilization — if possible, the CPU should run at or near 100 percent
(for example, between 95 and 100 percent). You should look at the Express
Server process and see what percentage of the CPU’s resources (memory,
paging, disk, and so on) are being utilized. If the CPU is not running near
100 percent, you should take action to improve the performance of your
database.

What you want to avoid during rollups is a lot of paging at the operating
system level and at the Express level. Express Server may be one of many
processes that is running on a server machine, and if the resources allotted
to the Express Server process are used up, then paging occurs at the
operating system level. In addition, Express Server has its own paging
buffer. If Express runs out of data pages, paging occurs at the Express level.
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The ideal situation for good rollup performance is that no paging should
occur at either the operating system level or the Express level. The next
best situation is that paging occurs at the Express level only. (To ensure the
latter, you may need to increase the size of the Express cache.)

First, determine whether the CPU is running near 100 percent.

How do I determine if the CPU is running near 100 percent on a Unix
machine?

If Express Server 6 runs on Unix, then you can use the perfmeter
command (Solaris only), the top  command, or any other performance
monitoring tool that is offered by the vendor or that is in the public domain
to determine at what percentage the CPU is running when you execute a
rollup program.

Be aware that on a multiple-CPU system, the way in which the percentage
is represented depends on the operating system. Many operating systems
will display the percentage as a sum of the CPUs. In this case, you cannot
get information about any individual CPU; instead, the results reflect the
overall system performance. For example, if you have six CPUs running at
about 90 percent each, the results would be about 540 percent.

However, some operating systems will display the percentage ranging from
0 to 100 percent, regardless of whether the machine has one CPU or
multiple CPUs.

Therefore, it is critical that you understand how your operating system
reports CPU usage. For example, suppose you determine that the CPU is
running at 90 percent. On an operating system on which the CPU usage can
only range from 0 to 100 percent, 90 percent is a good percentage. But on
an operating system on which the CPU usage can range from 0 to 600
percent, 90 percent indicates that you need to take steps to improve
performance.
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How do I determine if the CPU is running near 100 percent on an NT
machine?

If Express Server 6 runs on NT, use the NT performance monitor to
determine at what percentage the CPU is running when you execute a
rollup program.

The information about using the NT performance monitor is intended for
single-CPU systems only. On a multiple-CPU system, you cannot get
information about any individual CPU; instead, the results reflect the
overall system performance. Do not attempt to determine at what
percentage a CPU on a multiple-CPU system is running, because the results
are likely to be a sum of the CPUs (for example, two CPUs running at 50
percent would show a result of the system’s CPUs running at 100 percent).

In the NT performance monitor, you will select an object, one or more
counters, and an instance. You will then display a graph.

Select Process as your object, select %ProcessingTime as your counter,
and select Express Server as your instance. The graph you then display
will show the activity of the %ProcessingTime counter, ranging from 0 to
100 percent. The %ProcessingTime counter should be running between 95
and 100 percent. If it is, this indicates there is probably no paging occurring
at all, at either the operating system level or the Express level, which is
what you want.

You may find it helpful to display other counters, including
%CommittedBytesInUse, PageFaults/Second, FileReadOperations/Second,
and FileWriteOperations/Second. See the Help system for the Express
Server Configuration Manager for more information. Next, consider the
warning signs of poor performance.

Warning signs

The following warning signs indicate poor performance.

� The server machine’s CPU is not running near 100 percent.

� Performing rollups takes longer than expected.

� You notice a dramatic difference in the paging behavior of your
operating system.
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Investigating the warning signs

On the server machine on which Express Server is installed, check CPU
utilization and paging behavior.

If you are executing a rollup for the first time, you can estimate how long
the rollup will take by executing limited versions of that rollup. For
example, you might limit the slowest-varying dimension to its first value (at
the lowest level of values, if the dimension is hierarchical), execute a
rollup, then limit the slowest-varying dimension to its first five values (at
the lowest level of values, if hierarchical), execute another rollup, and so
on. You can use the amount of time each rollup takes to extrapolate how
long a complete rollup will take. Limiting the status of the slowest-varying
dimension will best predict overall performance. If the rollup takes
significantly longer than your estimate, it may be a warning sign of poor
performance.

How Data Is Stored
Definition: Page of data

A page is a block of data.

How Express uses pages

Data in a multidimensional variable is sorted in the order of the dimensions.

Data for each value of the first dimension is stored in order in a page of
data before data is stored.

When Express Server retrieves data from a variable, it reads a page of data
from disk. If you define a variable with its dimensions in the order a user is
likely to display the data, then Express Server can retrieve the data most
efficiently by getting many values from the same page, thereby reading
fewer pages.
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Figure: How data is stored

The following figure gives an example of how data is stored for a variable
named UNIT.

  D1P1M1 D1P1M2 D1P1M3 D1P1M4 D1P1M5 D1P1M6 D1P1M7 D1P1M8 D1P1M9 ... D1P1Mnn
  D1P2M1 D1P2M2 D1P2M3 D1P2M4 D1P2M5 D1P2M6 D1P2M7 D1P2M8 D1P2M9 ... D1P2Mnn
  D1P3M1 D1P3M2 D1P3M3 D1P3M4 D1P3M5 D1P3M6 D1P3M7 D1P3M8 D1P3M9 ... D1P3Mnn
  D2P1M1 D2P1M2 D2P1M3 D2P1M4 D2P1M5 D2P1M6 D2P1M7 D2P1M8 D2P1M9 ... D2P1Mnn
  D2P2M1 D2P2M2 D2P2M3 D2P2M4 D2P2M5 D2P2M6 D2P2M7 D2P2M8 D2P2M9 ... D2P2Mnn

Explanation of figure: How data is stored

UNITS is a variable with an integer data type that is dimensioned by
MONTH, PRODUCT, and DISTRICT.

The data is described with a code in which D means DISTRICT, which is
the slowest-varying dimension; P means PRODUCT; and M means
MONTH, which is the fastest-varying dimension. In the list, the code
D1P1M1 means the UNITS value for the first district, first product, and
first month. All the months for the first product and district are stored in
order; followed by the months for the second product of the first district,
and so on.

How layout affects processing time

If you define a variable so that your users use the default layout with the
variable’s first dimension across the columns of tables or spreadsheets in
client applications, then Express Server can retrieve groups of consecutive
values from each page of data.

For UNITS in “Explanation of figure: How data is stored,” a client
application can retrieve a group of month values before calculating where
to find the next data. This does not mean users should never use a different
layout; it just takes more processing time.

How to ensure good processing speed when you define objects

If you have data variables or formulas that share the same dimensionality,
you should define these variables or formulas in the same dimension order,
with the fastest-varying dimension first. The data is retrieved the same way
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for each variable, thus increasing processing speed. This is a good first step
toward optimization.

Saving Calculated Data
Saving frequently used calculations in variables

The second recommendation for efficient use of processing time is to save
frequently used calculations in variables. This, of course, increases the size
of your database. However, if you save a calculation, all you have to do is
retrieve it, rather than recalculate it.

You can perform this task using Express commands.

Example: Saving frequently used calculations in variables

Suppose the variable SALES is simply the product of UNITS multiplied by
PRICE. You could define a formula that is calculated every time you refer
to SALES.

DEFINE SALES FORMULA UNITS * PRICE

However, you could alternatively define a variable and set it equal to
UNITS times PRICE.

DEFINE SALES VARIABLE DECIMAL <MONTH PRODUCT DISTRICT>
SALES = UNITS * PRICE

This variable does add to the size of your database, but it avoids the need to
recalculate SALES again unless, of course, you have to correct some of
your data. SALES, as a formula, is self-correcting.

Planning for a Smaller Database
Definition: Cell

A cell is a single data value of an expression.
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In a dimensioned expression, a cell is identified by one value from each of
the dimensions of the expression. For example, if you have a variable with
the dimensions MONTH, PRODUCT, and DISTRICT, each combination of
a month, a product, and a district identifies a separate cell of that variable.

Definition: NA values

NA means that the cell has either never had a value assigned to it or that a
calculation produced an NA result.

When you first define a variable or relation, its values are all NA by
default.

Options for saving disk space

If you have data in each variable for every combination of dimension
values, with no NA values, consider the following options for saving disk
space:

� If some of your variable data is derived from other data, you can save
space by defining a formula to calculate the data instead of storing it.

� If you define a variable to store interim calculations, make it a
temporary variable by selecting Temporary in the Storage box when
you define a variable. Search for “Define a Variable Dialog Box” in the
Administrator Help system for more information.

Procedure: Defining a formula

Use the following procedure to define a formula.

Step Action

1 Choose Define from the Edit menu.

2 Choose Formula  from the submenu to display the Define a Formula dialog
box.

3 Specify the formula’s name and dimensions.

You can also specify the formula’s data type, although it is not required.

4 In the Equation box, type the formula, for example:

units * price

5 Choose Define  to define the formula.
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When you should define formulas

If you do not use the calculated data very often, the savings in disk storage
can outweigh the cost of CPU time to repeatedly calculate the formula.

You should use formulas whether or not you need to conserve disk space if
you make frequent corrections to your data. A formula ensures that the
derived data is as current as the newly corrected data.

Temporary variables

Temporary variables are for data that is needed only in the current client
application session; the actual data does not get stored in the database.

Temporary variables only have a definition in the database file; they do not
contain any associated data. When you close the database in which any
temporary variables are defined, their values are lost.

Related information

For further information, see the following:

� For more details about defining a formula, search for “Defining
Formulas” in the Administrator Help system.

� For more information on managing variables with many NA values,
which can take up a lot of disk space, refer to Chapter 13.

Keeping Your Database Efficient
What happens when you make changes to your dimensions

Frequent maintenance of a dimension, such as adding, deleting, or
reordering its values, can affect the efficiency of your application.

This is because when you maintain a dimension, the physical order of its
values (the order in which they are actually stored) can become different
from the logical order (the order in which the values appear when you use
your database), making data retrieval less efficient. In addition, when you
delete values from a dimension, Express Server marks those values as
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deleted, but the space they occupied is unusable. Although the dimension
values no longer appear in your dimension, Express Server cannot use this
“dead” space for other purposes.

This eventual “disorganization” of a dimension that receives frequent
maintenance can slow down processing in your application because it
affects not only the dimension itself, but also any object that depends on it:
composites, variables, or relations that are dimensioned by it or related to it.

How to fix the problem

You can eliminate the dead space created by dimension maintenance and
bring the physical order and logical order of a dimension back into
correspondence.

If you want to use disk space efficiently, then you can consider rebuilding
your database. When you rebuild the database, your database takes up less
space on your disk.

While rebuilding a database will reduce the disk space required, the process
can take a long time if your database is large. In addition, compiled
program code that is saved in your database will be discarded during the
process. This means that after you rebuild the database, you may want to
recompile all the programs in the database (which is easily done with the
ALLCOMPILE command).

Procedure: Rebuilding a database

The following procedure describes how to rebuild a database named
MARKET.

Step Action

1 From the Run menu, choose Express Command  to display the Express
Command window.

2 If you have more than one database attached, enter and execute the
following command in the Express Command window to ensure that all
subsequent commands you enter will affect the MARKET database.

database attach market first
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Step Action

3 Set the status of all dimensions to ALL. To do so, enter and execute the
following commands in the Express Command window.

limit name to all
allstat

4 Export all the database objects to an Express Interchange Format (EIF) file.

From the File menu, choose Export to display the Export to an EIF File
dialog box, in which you specify a file name for the exported data (for
example, MARKET.EIF), then specify the objects you want to export.

5 Rename the file for the database you are rebuilding.

You probably will not need the file again, but you should not delete it until
you know that you have successfully imported everything in it. By renaming
the database, you can keep the old database as long as you want, while
using the original database name for the rebuilt database.

Since you cannot rename a database in Administrator, you must rename the
database at the system level. (Your system administrator might have to do
this.) For example, if your database is named MARKET, you can rename it
OLDMARK.

6 Create a new database with the original name of the database you just
renamed.

From the File menu, choose New to display the Create a New Express
Database dialog box, and enter the original database name (for example,
MARKET).

7 In the new MARKET database, import all the database objects you
previously exported to an EIF file.

From the File menu, choose Import .

8 From the submenu, choose EIF to display the Import from an EIF File dialog
box, in which you specify the file from which you want to read data and
definitions (for example, MARKET.EIF), then specify the source database
objects you want to import.

9 Examine your MARKET database to make sure all the objects and data are
there.

10 Enter and execute the ALLCOMPILE command in the Express Command
window.

This command compiles all of the programs you have just imported.
Importing and exporting do not transfer compiled programs, just program
text.

11 Delete the old database (OLDMARK) or copy it to a tape or CD and keep it
as a backup.
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Keep in mind that for a large database, this procedure can take a
considerable amount of time to perform.

Tip: EIF files make good backup files

Because EIF files are smaller than database files, they are an excellent way
to keep backups of Express Server databases.

Conserving Memory While Running
Express Server
When to conserve memory

Conserving memory is only a concern if a server is running other programs
in addition to Express Server.

Determining the best memory allocation for your system

Your system administrator decides how much memory each job on the
Express Server system needs. It may take some fine-tuning to arrive at the
best memory allocation for that system. You do not want to use too much
memory because that would take system resources away from other jobs.
On the other hand, if you have too little memory, you will not have enough
room for all the definitions and data that are contained in a large database.
Express Server will have to page data and code in and out frequently, which
increases the number of times it has to read the disk. Too much paging
slows Express Server down because it takes longer to retrieve data.

The suggestions in this topic are only for cases where databases are very
large or application code is very complex.

How Express uses memory

Express Server divides its available memory into two sections:

� Permanent memory: for object definitions

� Temporary memory: for program code, data, and computations
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When you start an Express Server session, Express Server reads the
definition of each object that you use and stores it in permanent memory.

Temporary memory is used for processing commands and storing current
data and program code. Processing complex commands and recursive
formulas requires more memory.

As you use more objects, the amount of memory that is used increases. Its
size never decreases; memory can be reused but not returned to the
temporary-memory region.

What to do if you run out of memory

If you run out of memory while processing a complex command or
expression, you can separate the task into several simpler commands.

If you see messages that indicate that the system is out of memory, then
you can try the following suggestions.

When you design your database

The following recommendations are decisions you make when you design
your database. They really are the same as the recommendations for making
a small database file. To minimize the amount of memory needed to run
Express Server:

� Use temporary variables. Their definitions take less space.

� Use composites by setting sparsity when you define variables.
Composites reduce the size of variables with sparse data both on disk
and in memory.

� Do not define more objects than necessary. Each object definition takes
up memory. Definitions for temporary variables and relations take up
less room than other definitions.
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When you write a program

The following recommendations have to do with the way you write
application programs. You do not necessarily have to worry about them
unless you see warning messages. If you write programs, you can also:

� Minimize the use of recursive formulas. Each iteration of the formula
takes up memory.

� Break up deeply nested character string expressions.

� Write a program that uses the ROW command, but reduce its
complexity. Processing the ROW command takes a lot of memory.

Some of these recommendations seem contrary. For example, composites
create three new objects: a new dimension and a relation to each of the
original dimensions. However, the savings in the number of data cells can
outweigh the size of the extra definitions. You have to select priorities that
are applicable to your system and optimize your database for those
conditions.

What Is a Multifile Database?
Overview

Ordinarily, an Express Server database is contained in a single file.

However, a database can be a multifile database; that is, it can span several
files.

A multifile database is spread over a main file and extension files.

Definition: Main file

The main file of any given database is created automatically when Express
creates that database.

As you add and configure database objects, Express Server adds to the
main file until it reaches the maximum size you specified for it with the
FILESIZE argument or until the current disk becomes full.
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Definition: Extension file

When the main file reaches its maximum size or when the current disk
becomes full, Express creates a database extension file.

Specifying where the extension files should be created

The files of a multifile database can be located in separate qualifying
locations. A qualifying location is a disk, volume, file system, pathway, or
device-and-directory (depending on your system) that has some space for
more files. This way, you can create a database that is larger than any
single location.

When the extension file reaches the maximum size or fills its location,
Express Server creates another extension file, and so on. If the end of the
list is reached and there are still qualifying locations, Express Server returns
to the beginning and goes through the list again until it saves the whole
database or uses up all the space everywhere in the list and signals an error.

You can identify the location where Express should create any database
extension files by setting the text option DBEXTENDPATH. The value of
DBEXTENDPATH overrides the Express Configuration Manager setting
for ExtensionFilePath. For more information, see the entries for
DATABASE and DBEXTENDPATH in the Express Language Help
system.

How are the main file and the extension files named?

The file name of the main database file and all extension files is the
database name you specified when you created the database. For the file
type of the main file, “.DB” is automatically appended to the name you
specify.

For the extension files, file types that contain numbers are automatically
appended. The first extension file is assigned a file type that contains the
number “001” and subsequent extension files are assigned file types
containing the numbers “002,” “003,” “004,” and so on.

Extension file names must always match the main file name, and extension
file types must never be changed. Be aware that if you delete or change so
much as one file, the entire database will be corrupted.
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Saving a Database in Two or More
Files
Procedure: Creating a multifile database

The following procedure gives an overview of creating a multifile database.

Step Action

1 Create a new database.

Step Action

1 From the File menu, choose New. The Create a New
Express Database dialog box appears.

2 In the Database Name box, type in a base file name of up to
eight characters.

3 The database will be created in the directory that is
specified in the dialog box. Choose Browse  to see the
Browse dialog box if you want to select a different directory
or a different drive or server.

4 Choose OK. The new database will be listed in the
Database Browser.

2 From the Run menu, choose Express Command  to display the Express
Command window.

3 Enter a DATABASE FILESIZE command in the Express Command window
to specify the maximum size of the main file and any extension files, such as
the following.

database filesize 32m

Using the DATABASE FILESIZE command

Using the FILESIZE keyword with the DATABASE command indicates
that you want Express Server to create an extension file when the current
file reaches the specified size. If you just specify a number after the
keyword, then the size is evaluated in bytes. If you specify “K,” “M,” or
“G” after the number, then the size is evaluated in kilobytes, megabytes, or
gigabytes.
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If you want to change the file size of an existing database

If you want to change the maximum file size, then you can use the
DATABASE FILESIZE command at any time. The new file size will not
change the size of existing files, but it will affect the size of a file that is
currently being filled and the size of all subsequent extension files.

When the database will be read-only

If Express Server finds even one of a database’s extension files in a read-
only location, then it treats the entire database as read-only.

Consequences of deleting one or more files

If you delete even one of a multifile database’s extension files, then
Express will no longer be able to open the database and the whole database
will be inaccessible.

On the other hand, if you delete a multifile database, then remember to
delete all of its extension files.

Getting the names of all the files in a multifile database

You can use the DATABASE function with the “pathname” choice to list
all the files that make up the multifile database. For example, to list the file
names and directory paths for the current database, enter and execute the
following command in the Express Command window.

show database(pathname)

When you execute this command, the file names and path names of the
current database will be displayed in the Express Command window. For
more information, search for the DATABASE function in the Express
Language Help system or Reference Manual.
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What You Should Know About
Segments
How does Express store and access data?

To increase the efficiency of loading data into variables, Express stores data
in segments. A segment is a block of disk space that is allocated for the
storage of a particular variable. Each segment contains data for a specific
range of dimension values.

When a user requests data from an Express database, Express moves the
required data from disk into memory. However, most Express databases
contain variables that are too large to fit into memory all at once.

Therefore, Express divides each storage segment on disk into chunks of
four kilobytes (4k) each, which are called pages. Each segment starts with a
new page. When a user requests a set of data, Express brings into memory
only the pages that contain the required data.

What is the default number of segments?

By default, the number of segments that a variable uses for storage depends
on the sequence in which you maintain the dimensions of the variable and
add data to the variable, as the following table shows.

IF you . . . THEN Express . . .

add all your dimension
values before you load
data into a variable,

loads all the data into a single segment.

interweave the addition
of dimension values
and the loading of data,

may create a new segment each time you add more
dimension values. New segments are always created for
new dimension values of all but the slowest-varying
dimension.

If you repeatedly add dimension values and then data for any but the
slowest-varying dimension of a variable, your variables may end up with a
great many segments — perhaps as many as hundreds of thousands of
segments.
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The proliferation of segments can be especially pronounced if you define a
sparse variable that has a composite in any position except the slowest-
varying (last) position.

What is the optimal number of segments?

As a general rule, overall performance is best if all the data for a variable is
stored in a single segment. Sometimes there are exceptions, and you must
decide how many segments your variable should have based on your
patterns of loading and accessing data.

If you access a variable whose data is stored in a large number of segments,
the performance of your application may be very slow, for two reasons:

� Express spends a lot of time on I/O operations because the data that you
need may be spread over a great many separate pages.

� Express spends a lot of time determining the segment and page location
of data that is spread out over a great many segments.

How to specify segment size

You should use the CHGDFN command with the SEGWIDTH keyword to
specify the size of a variable’s segments. Generally, it is a good idea to
have one segment in a variable. A good rule of thumb is to determine the
total number of values a variable will hold, then make the size of the
variable’s segment slightly larger than that total number to make sure only
one segment will be created.

Using the CHGDFN command will affect the segment size not only for the
variable with which you use it, but also for any other variable that has an
identical dimension list. This means that if you have a number of sparse
variables with identical dimension lists, a single CHGDFN command will
set up an efficient segment size for the whole group of variables.

Proper use of this command will ensure good performance for any variable,
whether it is sparse or not. However, it is more important to use CHGDFN
SEGWIDTH on any variable in which the composite is not the slowest-
varying dimension.



Chapter 14  Performance Issues

338

To execute this command from Administrator, select Express Command
from the Run menu, then enter the CHGDFN command with the
SEGWIDTH keyword in the Express Command window that is displayed.

When to specify segment size

Express provides default segments. In most cases, you will not have to
specify segment size, because using the default segments will often result
in good performance.

However, in some cases, you can improve performance by specifying the
segment size. It is a good idea to specify segment size for every variable
you define in order to ensure the best possible performance.

You should use CHGDFN SEGWIDTH before you assign any data to the
variable to ensure one segment per variable.

If data has already been assigned to a variable (or any variable with the
same composite), then several segments may have already been created.
The CHGDFN command cannot get rid of those existing segments. It can,
however, reduce the number of segments that are created after you execute
the CHGDFN command. You can change the segment width of a variable
at any time to further optimize the number of segments.

Related information

See Chapter 13 for more detailed information and examples. For details
about using CHGDFN SEGWIDTH, see the CHGDFN entry in the Express
Language Help system or Reference Manual.
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Data Loading Tips
How to load data efficiently

This section describes the following steps you can take before you load
data into a variable, so that you can load data as efficiently as possible:

� Load the dimension values first

� Check the order of your data

� Check for circularity

Loading dimension values first

Be sure to load all of the values into your dimensions before you load any
data into your variables.

Checking the order of data

For the best performance during a data load, the order of the dimension
values must match the order of the data that is intended for those dimension
values in your input file. If they do not match, sort your data so that it will
load in the order in which the dimension values are defined.

Checking for circularity of hierarchies

Before you load any data (or, alternatively, just after populating
hierarchies), you should check to be sure that there is no circularity in your
hierarchies. In other words, you must make sure that no dimension value is
its own parent. If a hierarchy is circular, either directly or indirectly, then
ROLLUP will loop indefinitely.

Express provides a program called HIERCHECK in the EXPRESS.DB
database that you can use to check for circularity. Refer to the
HIERCHECK topic in the Express Language Help system or Reference
Manual for information about using the HIERCHECK program to check for
circularity.

The Rollup Wizard includes a test for circularity. Therefore, as long as you
use the Rollup Wizard, the issue of checking for circularity will be
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addressed. If you write your own Rollup program or execute ROLLUP
commands, you must check for circularity yourself.

Scheduling Programs
Scheduling programs to run as batch jobs

You can schedule any program that has been created in an Express database
to run as a batch job on a remote machine.

For example, you can schedule a data loader program to run, then schedule
a rollup program to run as soon as the data loader program is completed. In
other words, you can schedule one batch job to load new data, followed
immediately by another batch job that rolls up that new data. By using this
strategy, the data in your database will always be accurate.

Using the Scheduler

The Scheduler is an Administrator tool that lets you schedule a program to
run at the time and day of your choice. To display the Scheduler, choose
Schedule from the Run menu. The Schedule Program dialog box is
displayed. For details about using this dialog box, click on its Help button.

The Scheduler lets you run a program immediately, at the time (including
the month, date, and year) that you specify, or after running another
program.

You can run the program on a regular basis. The Scheduler lets you specify
how often the program will run in measures of minutes, hours, days, weeks,
or months.

You can also specify the time and date at which the program should no
longer run.

Monitoring all batch jobs associated with the Express Server instance

It is possible that more than one instance of Express Server can be running
on a remote machine at the same time. You can monitor all of the batch
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jobs that are scheduled to run on the instance of Express Server to which
Administrator is currently attached.

To display the Monitor Batch Jobs dialog box, choose Monitor  from the
Run menu. For details about using this dialog box, click on its Help button.

All batch jobs are displayed in the task list in the Monitor Batch Jobs dialog
box. The task list displays the name of each program that is scheduled to
run, the name of the user who scheduled it, the status of the batch job that is
associated with that program, and the program’s type (Dataread, Rollup, or
Command). Dataread is a program that was generated by using the Import
Text dialog box. Rollup is a program that was generated by using the
Rollup Wizard. Any program that was written by a user will be listed as
Command.

You can stop a program that is currently running, and restart from the
beginning the execution of a program that has been stopped. When a
program has run successfully and will not be run again, delete its associated
batch job from the task list.

Performance Tips for Express
Overview

This topic describes the steps you can take toward ensuring good
performance after you have designed a good database, loaded data
efficiently, and written an effective Rollup program.

Changing the size of the Express cache

You can increase or decrease the size of the Express cache. You may want
to do so for the following reasons:

� If there is no operating system paging but there is Express paging, then
you can increase the Express cache size.

� If there is both operating system paging and Express paging, then you
should decrease the Express cache size.
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� Check the NT performance monitor. If you notice a lot of page faults,
then you may need to decrease the size of the Express cache. You need
to consider the demands that are made by any other applications that are
running on your NT server, and try to balance them with Express.

To change the size of the Express cache, change the value of the
PageBufferCount parameter in the Express Server Configuration Manager.
There are no hard-and-fast recommendations — try changing the size until
you see a good improvement in performance.

To change the value of the PageBufferCount parameter, select the Paging
tab in Configuration Manager. In the Settings list, notice the
PageBufferCount parameter. This parameter controls the number of page
buffers in the cache.

On Unix, the default value of PageBufferCount is half of physical memory
divided by 4,096 bytes.

On NT, the default value of PageBufferCount depends on the amount of
physical memory you have:

� If you have less than 128MB of physical memory, then the default
value is half of physical memory divided by 4,096 bytes.

� If you have a minimum of 128MB of physical memory, then the default
value is three-quarters of physical memory divided by 4,096 bytes.

To check this value, look at the file OESEvent.log  in your install
directory, or use the Event Viewer in the NT Event Log. On Unix, the
default location of the file OESEvent.log  is
$OLAP_HOME/oes620/log .

Adjusting paging behavior

Eventually, the Express cache may run out of pages. When this happens,
Express Server will remove the least-recently used page from the cache to
make room for the currently needed page.

Two parameters in the NT server configuration tool control this behavior.
The value of the FreePageLowCount parameter specifies at what page
count Express Server starts discarding the least-recently used pages, and the
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FreePageHighCount parameter specifies at what page count Express Server
stops.

If Express is installed on NT, then you can check the process time from the
NT performance monitor. Look for spikes in the graph when you are
executing a rollup program. Spiking may be an indication that the rollup
program is frequently stopping at the number that is specified by
FreePageHighCount. This is a result of the values of these parameters being
set too low.

The solution is to raise the values of both the FreePageLowCount and the
FreePageHighCount parameters. You can do this with Configuration
Manager. If you have more than 128MB of physical memory, then it is
generally a good idea to increase the values of both the FreePageLowCount
and the FreePageHighCount parameters.

If Express is installed on a single-CPU machine, then set
FreePageLowCount to 100 and set FreePageHighCount to 250.

If Express is installed on a multiple-CPU machine, then the default settings
will be displayed as “NA” in the Configuration Manager. Instead of using a
page count as the setting for each parameter, the percentage of the physical
memory that is associated with the page buffers is used as the setting on a
multiple-CPU machine. The default setting for FreePageLowCount is 2
percent, and the default setting for FreePageHighCount is 15 percent. There
are no recommendations for changing these parameters on a multiple-CPU
machine — try changing the size until you see an improvement in
performance.

Improving the time required for data loading and updates

When you write your rollup program, a good strategy is to execute an
UPDATE command after every ROLLUP, solve, or assign (=) command.
This section describes a strategy for improving the time it takes to execute
UPDATE commands. This strategy can also improve the time it takes to
perform data loading. You can use this strategy if your machine has at least
two processors.

The ModifiedPageWriterSleep parameter in the NT server configuration
tool controls the behavior of the input/output thread.
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The ModifiedPageWriterSleep parameter determines how often the
input/output thread wakes up and checks to see if any pages can be written
out. The default setting for the ModifiedPageWriterSleep parameter is 0.

The input/output thread runs at a lower priority than other threads. The
input/output thread will run only if there are available CPU cycles. Because
you will gain the most benefit when the CPU is idle, it is unlikely that
changing the default value of ModifiedPageWriterSleep on a
single-processor machine will be helpful.

The ModifiedPageCount parameter determines the number of pages you
wish to keep in a modified state. The default setting is 0.

When the number of pages that have been modified and are not actively
being used is greater than the value of ModifiedPageCount, the input/output
thread will write out pages until they once again equal that value. As with
the ModifiedPageWriterSleep parameter, it can be worthwhile to
experiment with changing this value to improve performance.

Preventing file fragmentation

It may be a good idea to take steps that will prevent file fragmentation,
especially if you know your database will be large (such as a multigigabyte
database).

Taking the following steps will either prevent file fragmentation from
happening or keep fragmentation to a minimum:

� Use the disk analysis tools or commands that are available for your
platform to perform disk defragmentation before you perform any task
that will cause the database to grow in size, such as loading data.

� Change the default size by which database files are incremented to at
least 1MB for every data database (the Express databases that you or
someone else defined). To do so, use the DATABASE command with
the EXTENDSIZE keyword. If you know that your database will be
very large and that using a lot of disk space is not an issue, then you
might want to change the default increment size to a much larger value
than 1MB. Refer to the entry for the DATABASE command in the
Express Language Help system or Reference Manual for more
information about using the EXTENDSIZE keyword.
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� Put any temporary files on a different disk than the disk on which the
main database file resides. This will minimize competitive
fragmentation.
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Chapter 15

Controlling Access to a
Database

Overview
Introduction

This chapter discusses issues that are related to controlling access to a
database.

In this chapter

� Using Database Passwords

� Levels of Database Security

� The PERMIT Command

� Establishing Permission Conditions

� Typical Permission Cases

� Assigning Permission to a Dimension

� Designing a Database Security Application

Using Database Passwords
Introduction

You can create a password for a database to limit access to the database.
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Procedure: Creating a password for a database

You can use the following procedure to assign a password to a database.

Step Action

1 From the Run menu, choose Express Command  to display the Express
Command window.

2 Issue the DATABASE command to ensure that the database is the top
attached database, as in the following example (where dbname is the name
of the database):

database attach dbname first

3 Issue the DATABASE command to assign a password for the database, as
in the following example:

database password xxx

4 Choose the run button ( ) to issue the command.

Related information

For details, refer to the DATABASE command entry in the Express
Language Help system.

Levels of Database Security
Overview

This topic describes the different levels of security at which you can control
access to an Express database. You can use the Express commands that are
described in this topic in Administrator, or you can use them in a program.
If you have used previous versions of Express, then you may already have
programs that use these commands.

Controlling access to your database

You can create security applications that control access to your database by
using database permission programs, the PERMITERROR option, and the
PERMIT and PERMITRESET commands.
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You can define a PERMIT_READ or PERMIT_WRITE program that will
run when the database is opened for either read-only or read/write access.

Your database permission programs can contain PERMIT commands and
values for permission conditions. PERMIT commands assign different
types of access permission to objects in your database, depending on the
permission conditions that you establish. You could set up your permission
conditions to test for a class of database users.

Operating system access rights

In some cases, you can specify read or write access to database files within
the operating system.

If you can establish or restrict database access through the operating system
and you do not need to establish access rights to objects within the
database, then you might not need to use the security mechanisms in
Express Server.

Database password

If you have established a password for a database with the DATABASE
PASSWORD command, Express Server checks for that password before
opening the database.

However, if a database permission program appropriate to the mode (read-
only or read/write) exists within the database, Express Server passes the
password as an argument to the database permission program instead of
validating it against the stored database password.

Database permission programs

In each database, you can create database permission programs called
PERMIT_READ and PERMIT_WRITE. These programs must be
user-defined Boolean functions. When you open a database with read-only
access, Express runs the PERMIT_READ program, if it finds one in the
database. When you open a database with read/write access, Express runs a
program called PERMIT_WRITE, if it finds one in the database.
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When a database permission program runs, it must return YES in order for
the database to be opened. Database permission programs run before an
AUTOGO program.

Within the database permission programs, you can use PERMIT commands
to establish access conditions for objects in the database. You can also
specify values for the variables that you will use in the permission
conditions for PERMIT commands in the database. These variables might
represent passwords or user IDs. You can protect the PERMIT_READ and
PERMIT_WRITE programs themselves with PERMIT commands.

Related information

See the following topic, “The PERMIT Command,” for further information
on the PERMIT_READ and PERMIT_WRITE programs. Also, refer to the
entry for the PERMIT command in the Express Language Help system.

The PERMIT Command
Purpose of the PERMIT command

The PERMIT command lets you control access to database objects.

With PERMIT, you can grant or deny read-only and read/write access for
objects and for values of dimensions and dimensioned objects. You can
also use PERMIT to grant or deny permission to maintain dimensions and
to change permission for objects.

You can apply up to four PERMIT commands to an object: one each for
read, write, maintain, and permit permission. Before issuing a PERMIT
command, you must use the CONSIDER command on that object.

Reevaluating object permission

You can use the PERMITRESET command to cause Express to reevaluate
object permission. See the PERMITRESET entry in the Express Language
Help system for detailed information.
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Controlling how Express handles attempted violations of permission

You can use the PERMITERROR option to control how Express handles
attempted violations of permission. See the PERMITERROR entry in the
Express Language Help system for detailed information.

Getting information about the user identity

The SYSINFO function can provide information about the user ID under
which an Express session is running, as well as the groups to which the user
ID of the session belongs. You can use the values that are returned by
SYSINFO(USER) and SYSINFO(GROUP) with PERMIT commands to
create security mechanisms within Express.

If the user ID is a domain account on Windows NT, SYSINFO(USER)
returns the domain and the user ID, and SYSINFO(GROUP) returns the
domain and the group name.

Related information

For complete descriptions of PERMIT, PERMITRESET, PERMITERROR,
and SYSINFO, see the Express Language Help system.

Establishing Permission Conditions
Permission conditions are Boolean expressions

The conditions for granting read, write, maintain, or permit permission to a
database object consist of one or more Boolean expressions. These
expressions can be dimensioned or undimensioned.

The permission condition as a single Boolean value

The permission condition consists of a single Boolean value in the
following cases:

� When you are assigning permission to an object without dimensionality

� When you are assigning permission to all the values of a dimensioned
object
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� Whenever you are issuing PERMIT MAINTAIN or PERMIT PERMIT
commands

Example: The permission condition as a single Boolean value

The following commands allow the program MYPROG to be run or edited
as long as the Boolean variable MYBOOL is set to YES. When MYBOOL
is NO, MYPROG can be run but not edited.

define mybool variable boolean
define myprog program
permit write when mybool eq yes

If MYBOOL is set to YES, the following commands make the PRODUCT
dimension available for maintenance (maintenance would not be possible if
MYBOOL is set to NO).

consider product
permit maintain when mybool eq yes

Dimensioned permission conditions

With dimensioned permission conditions, you can assign read or write
permission to individual values and to slices of values within dimensioned
objects.

Example: Dimensioned permission conditions

For a SALES variable that is dimensioned by MONTH, PRODUCT, and
DISTRICT, you might have three dimensioned permission conditions in the
form of three variables as shown in the following example.

MONTH_BOOL <MONTH> PROD_BOOL <PRODUCT> DISTRICT_BOOL <DISTRICT>
------------------ ------------------- ------------------------
JAN98        NO  TENTS      YES      BOSTON       NO
FEB98        YES  CANOES     YES      ATLANTA      NO
MAR98        NO  RACQUETS   NO       CHICAGO      YES
.           .     .          .        .            .
.           .     .          .        .            .
.           .     .          .        .            .

If the YES values in this example are the only YES values in the
permission conditions, then the following PERMIT command provides
read/write access to SALES data for TENTS and CANOES sold in
CHICAGO in FEB98. In the absence of a PERMIT READ command for
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SALES, Express Server provides read-only permission for all the other
values of SALES.

permit write when district_bool by prod_bool by month_bool

Preventing access to a variable value

If you want to prevent access to one particular sales figure, then you can
create a Boolean variable and use it in a PERMIT command.

Example: Preventing access to a variable value

The following example shows how you could prevent access to the value
for racquets in Boston in March of 1997. In this example, SALES_BOOL is
a Boolean variable that is dimensioned by MONTH, PRODUCT, and
DISTRICT.

define sales_bool boolean <month product district>
sales_bool = yes
limit month to 'MAR97'
limit product to 'RACQUETS'
limit district to 'BOSTON'
sales_bool = no
consider sales
permit read when sales_bool

Assigning permission to a dimensioned variable

The PERMIT command is designed to handle certain typical cases with as
little coding as possible. Of the five cases illustrated in the following topic,
“Typical Permission Conditions,” four can be specified with a single
PERMIT command, and one requires two PERMIT commands. This
concise syntax is possible because of the permission defaults that are
associated with the PERMIT command.

When you target a dimensioned variable for read or write permission, a
single PERMIT command can grant or deny the other permission by
default. Unless you explicitly override this default behavior with another
PERMIT command, the following rules apply:

� When you deny read permission, write permission is denied for those
values by default.
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� When you grant read permission, write permission is granted for those
values by default.

� When you grant or deny write permission, read permission is granted
for all values by default.

Granting write permission to values that do not have read permission

It is possible to grant write permission to a slice of a dimensioned variable
to which you have not granted read permission. This means that these
values can be modified but not viewed.

To create this situation, you need to specify both a PERMIT READ and a
PERMIT WRITE command for the variable, and some or all of the values
that are targeted for write permission must not also be targeted for read
permission.

Typical Permission Cases
Introduction

The typical permission cases that are described in this topic use a two-
dimensional variable called MYVAR. The figures identify the areas of the
data where the permission conditions apply. Each case identifies the
appropriate syntax of the PERMIT command.
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Case 1: Full read permission and restricted write permission

The following figure illustrates full read permission and restricted write
permission.

      MYVAR
¸¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¹
·  READ          ·
·                ·
·    ¸¶¶¶¶¶¶¶¶¶¶¶½
·    ·           ·
·    ·   WRITE   ·
º¶¶¶¶¿¶¶¶¶¶¶¶¶¶¶¶»

PERMIT WRITE WHEN -
   dimensioned_permission_conditions

Case 2: Restricted read and write permission

The following figure illustrates restricted read and write permission where
the areas for read and write permission are the same.

      MYVAR
¸¶¶¶¶¾¶¶¶¶¶¶¶¶¶¶¶¹
·    ·           ·
·    ·  READ/    ·
·    ·  WRITE    ·
·    ·           ·
·    ·           ·
º¶¶¶¶¿¶¶¶¶¶¶¶¶¶¶¶»

PERMIT READ WHEN -
   dimensioned_permission_conditions
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Case 3: Restricted read permission

The following figure illustrates restricted read permission with a subset of
that area having write permission.

      MYVAR
¸¶¶¶¶¾¶¶¶¶¶¶¶¶¶¶¶¹
·    ·           ·
·    ·  READ     ·
·    · ¸¶¶¶¶¶¶¶¶¶½
·    · ·         ·
·    · ·  WRITE  ·
º¶¶¶¶¿¶¿¶¶¶¶¶¶¶¶¶»

PERMIT READ WHEN -
   dimensioned_permission_conditions_1
PERMIT WRITE WHEN -
   dimensioned_permission_conditions_2

Case 4: Read-only permission

The following figure illustrates read-only permission for the whole object.

      MYVAR
¸¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¹
·                ·
·     READ       ·
·                ·
·                ·
·                ·
º¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶»

PERMIT WRITE WHEN NO
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Case 5: Permission denied

The following figure illustrates denial of permission to access the object
under any circumstances.

      MYVAR
¸¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¹
·                ·
·                ·
·   NO ACCESS    ·
·                ·
·                ·
º¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶¶»

PERMIT READ WHEN NO

Assigning Permission to a Dimension
Overview

This topic describes how to assign read or write permission to a dimension
through the use of the PERMIT READ and PERMIT WRITE commands.

How you can assign permission to a dimension

You can grant read or write permission to dimensions. You can use a
dimensioned permission condition to target dimension values, or you can
use a single-cell permission condition to target the whole dimension.

Dimension values that satisfy the permission conditions for a PERMIT
READ command constitute the default status of a dimension. Therefore,
the permission shown below effectively removes all MONTH values for the
years prior to 1996 from your database.

describe month

DEFINE MONTH DIMENSION MONTH
LD MONTH
PERMIT READ WHEN month gt 'DEC96'
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If you issue an ALLSTAT command, and then display a report, you only
see values of MONTH starting with January 1997. All variables
dimensioned by MONTH are affected by this restriction, and maintenance
of the MONTH dimension is not allowed, even if a PERMIT MAINTAIN
command exists for MONTH.

Write permission is meaningful for dimensions as a means of providing
write access to dimensioned objects. In order for write permission
associated with a dimension to apply to objects dimensioned by it, there
must be at least one PERMIT command associated the dimensioned object.

Consider, in addition to the read permission described above, the following
write permission for MONTH.

describe month

DEFINE MONTH DIMENSION MONTH
LD Month
PERMIT READ WHEN month gt 'DEC96'
PERMIT WRITE WHEN month gt 'DEC97'

If the SALES variable has the following permission associated with it, then
you can view sales figures for the BOSTON and CHICAGO districts in
1997 and 1998, but you can only modify those values for the BOSTON
district in 1998.

describe sales

DEFINE SALES VARIABLE DECIMAL <MONTH PRODUCT DISTRICT>
LD Sales Revenue
PERMIT READ WHEN district eq 'BOSTON' or district eq 'CHICAGO'
PERMIT WRITE WHEN district eq 'BOSTON'

Designing a Database Security
Application
Overview

This topic explains how to design a database security application using the
PERMIT_READ and PERMIT_WRITE programs.
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Database permission programs

The database permission programs PERMIT_READ and PERMIT_WRITE
allow you to establish the permission conditions for a database and have
them take effect when the database is opened. The permission that is
associated with database objects is not in effect within the database
permission programs. Your database permission programs must first
generate explicit PERMIT or PERMITRESET commands if you want
permission to be evaluated when you reference database objects within
these programs.

Debugging tip

When debugging a PERMIT_WRITE program, it is a good idea to
temporarily rename it to PERMIT_READ. This allows you to test your
program logic within the context of a DATABASE ATTACH command.
However, if the program fails, you can still open the database with
read/write access and edit your database permission program. Once you
have tested it, you can rename it back to PERMIT_WRITE.

Designing a database security application

A typical approach to designing a database security application would be to
first check for the identity of the user who is opening the database. Your
program could then determine if the user is the DBA, and if so, would grant
the authority to modify the permission structure for the database. If the user
is not the DBA, the program could then determine what authority level this
particular user should have.

Consider that the following objects exist for security purposes in your
database.

describe dba

DEFINE DBA VARIABLE BOOLEAN
LD If yes, permission can be modified
PERMIT WRITE WHEN DBA
PERMIT PERMIT WHEN DBA

describe userid

DEFINE USERID VARIABLE TEXT
LD Identification code of user of the database
PERMIT WRITE WHEN DBA
PERMIT PERMIT WHEN DBA
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describe user

DEFINE USER DIMENSION TEXT
LD Valid Users of the Database
PERMIT MAINTAIN WHEN DBA
PERMIT PERMIT WHEN DBA

report user

BCD
RMS
OPL
WSM

describe authority

DEFINE AUTHORITY DIMENSION TEXT
LD Authority Classification for Users
PERMIT MAINTAIN WHEN DBA
PERMIT PERMIT WHEN DBA

report authority

CLASS1
CLASS2

describe authority_user

DEFINE AUTHORITY_USER RELATION AUTHORITY <USER>
LD Users with their Permission Classifications
PERMIT WRITE WHEN DBA
PERMIT PERMIT WHEN DBA

report authority_user

               AUTHORITY
USER             _USER
------------   -----------
BCD            CLASS1
RMS            CLASS2
OPL            CLASS2
WSM            CLASS2

describe salespermission

DEFINE SALESPERSMISSION VARIABLE BOOLEAN <DISTRICT AUTHORITY>
LD Accessible sales district values per authority classification
PERMIT WRITE WHEN DBA
PERMIT PERMIT WHEN DBA

report salespermission

-----------------SALESPERMISSION----------------------
--------------------DISTRICT--------------------------
AUTHORITY    BOSTON  ATLANTA  CHICAGO  DALLAS  DENVER  SEATTLE
---------    ------  -------  -------  ------  ------  -------
CLASS1        YES      YES      YES       YES    YES     YES
CLASS2        YES      NO       NO        NO     NO      NO
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Now you can use the security structures that are shown above to limit
access to the SALES variable. Additional Boolean variables similar to
SALESPERMISSION could be defined for use in PERMIT commands for
other variables.

dsc sales

DEFINE SALES VARIABLE DECIMAL <MONTH PRODUCT DISTRICT>
LD Sales Revenue
PERMIT READ WHEN SALESPERMISSION
PERMIT PERMIT WHEN DBA

Following is a description of a PERMIT_WRITE program for this database.
The PERMIT_WRITE program determines who is using the database and
what type of access authority that user has. This sample program illustrates
a simplified approach to implementing a security structure for a database.
You could implement more elaborate security checking, for example, by
passing a password that is associated with a user ID to the following
program and testing to see if its value is “XYZ.”

DEFINE PERMIT_WRITE PROGRAM BOOLEAN
PERMIT READ WHEN DBA
PERMIT PERMIT WHEN DBA
PROGRAM
arg _userid text
dba = no
userid = _userid
if userid eq 'XYZ'
   then goto isdba
   else do
        if isvalue (user,userid)
           then do
                consider authority
                permit read when authority eq -
                                authority_user(user userid)
           doend
           else goto notvalid
   doend
return yes
isdba:
   dba = yes
   return yes
notvalid:
   show 'Not a valid identification code.'
   return no
END

Express Server runs this PERMIT_WRITE program before opening the
database. Express Server opens the database with read/write access if and
only if the PERMIT_WRITE program returns YES.
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If the user is the DBA, then the permission structures within the database
can be modified. When a user accesses the SALES variable, the permission
that is established in the PERMIT_WRITE program goes into effect. The
DBA and the Class 1 user can see and modify all SALES values. A Class 2
user can see and modify all SALES values for BOSTON only.
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Chapter 16

Configuring for SQL
Connections

Overview
Introduction

This chapter describes how to set up for connecting to relational databases
to perform dynamic SQL reach-through.

In this chapter

� Setting Up Administrator for SQL Connections

� Setting Up an ODBC Data Source

� Considerations for SQL Connections

� Setting Up a Database for SQL Connections

� Setting Up Formulas for SQL Reach-Through

� Preparing Code That Connects to the SQL Database

� Using Two Administrator Programs for SQL Connections

� Sample Programs for Connecting to SQL Databases
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Setting Up Administrator for SQL
Connections
Overview

To connect to a relational database, the following must happen:

� Administrator makes a 32-bit ODBC connection (via SQL*Net or
another communications interface) to the relational database.

� Administrator makes a SNAPI connection to Express.

� Express makes an OCI (for Oracle databases only) or ODBC
connection (via SQL*Net or another communications interface) to the
relational database.

The kind of connection Express should make to a relational database
depends on the version of Express and the platform on which it runs, as
shown in the following table.

Connection Type

Express Server 6 (Unix) connects to an Oracle database OCI

Express Server 6 (Windows NT) connects to an Oracle
database

OCI (preferred) or
ODBC

Express Server 6 (Windows NT) connects to a non-Oracle
database

ODBC

Personal Express 6 connects to an Oracle database OCI (preferred) or
ODBC

Personal Express 6 connects to a non-Oracle database ODBC

Issues

There are two issues that you, as the DBA, should address:

� You must set up a 32-bit ODBC data source on the computer on which
Administrator is installed so that Administrator can connect to the
relational database.
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� You must set up your Express database so that your users can access
data in a relational database. You do this by using programs that are
provided with Administrator. These programs are described in detail in
this chapter.

Required compliance levels of ODBC drivers

The ODBC driver that is installed on the same computer as Administrator
must meet Administrator’s minimum required compliance levels, as shown
in the following table.

Area of ODBC standards Minimum required compliance

ODBC API Level 2

ODBC SQL grammar and data types Core

If your ODBC driver does not meet these minimum required compliance
levels, Administrator will lose functionality and might not work at all.

All OLAP products, including Administrator and Express, are developed
and tested using Oracle and Intersolv ODBC drivers because they offer a
high level of conformance with ODBC standards.

Setting Up an ODBC Data Source
Overview

You must set up a 32-bit ODBC data source on the same machine on which
Administrator is installed before you can perform SQL reach-through. If
Express Server 6 uses an ODBC connection, a 32-bit ODBC data source
must also be defined on the server machine on which Express Server 6 is
installed. In this case, the two ODBC data sources must be identical.

On Windows 95 or Windows NT, you use the Microsoft ODBC
Administrator program to define data sources. You can double-click on the
ODBC icon in the Windows Control Panel program group to use the
Microsoft ODBC Administrator program.
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Setting up an ODBC data source (Personal Express 6)

If you use Administrator with Personal Express 6, and both are installed on
the same computer, set up one 32-bit ODBC data source.

Procedure: Setting up an ODBC data source (Express Server 6)

If you use Administrator with Express Server 6, use the following
procedure to set up an ODBC data source for Administrator.

Step Action

1 Check with your system administrator to make sure Express Server 6 is fully
configured for SQL support, either OCI or ODBC.

2 Perform any further actions, as follows:

IF Express Server 6 is set up
for an . . .

THEN . . .

OCI connection, you need do nothing more.

ODBC connection, on the computer where you have
installed Administrator, set up a
32-bit ODBC data source that is
identical to the 32-bit data source
that has been defined on the
server machine on which Express
Server 6 is installed.

If Administrator is installed on the same Windows NT server as
Express Server 6

If Administrator is installed on the same Windows NT server machine as
Express Server 6, then you only need to define one 32-bit ODBC data
source. Check with your system administrator to make sure Express Server
is fully configured for SQL support and that a 32-bit ODBC data source has
already been set up on the machine.

Setting up a system data source on a Windows NT server

If you set up a 32-bit ODBC data source on a Windows NT server, Oracle
Corporation recommends that you set up a system data source instead of a
user data source. A system data source on a Windows NT server is
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available to all users, regardless of the user ID that is used to establish the
connection.

Procedure: Setting up a system data source on a Windows NT server

Use the following procedure to set up a system data source on a Windows
NT server.

Step Action

1 Choose the System DSN tab or button in the Data Sources dialog box.

This displays the System Data Sources dialog box.

2 Add a system data source in the System Data Sources dialog box.

Considerations for SQL Connections
If you want to access an Oracle database

In order for Administrator to communicate with an Oracle relational
database, a SQL*Net connection must be set up on both of the following:

� The computer on which Express is installed (regardless of whether
Express uses OCI or ODBC)

� The computer on which Administrator is installed

You must install 32-bit SQL*Net Version 2.2 or later on the same computer
as Administrator.

If you want to access a non-Oracle database

If you want to access data in a non-Oracle relational database, you should
check that product’s communications interface documentation for
compatibility issues.

An alternative to SQL reach-through

An alternative to SQL reach-through is Relational Access Manager, which
allows Express applications to access data in a relational database
management system. Refer to Chapter 17 for details.
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Setting Up a Database for SQL
Connections
Introduction

Once you have set up a 32-bit ODBC data source on the computer on
which Administrator is installed, you can set up an Express database so that
its users can access the data in a relational database.

Overview: Setting up an Express database for SQL reach-through

To set up an Express database for SQL reach-through, you must perform
the following steps.

Step Action

1 Set up formulas in your Express database for SQL reach-through.

2 Prepare the code that connects to the SQL database.

3 Use the programs provided with Administrator to make the connection.

These steps are described in detail in the following topics.

Setting Up Formulas for SQL
Reach-Through
Giving your users the ability to get data from a relational database

If Express Server is set up for SQL support, you can connect to SQL
databases. These connections provide dynamic SQL reach-through that
enables you to set up Express formulas that fetch data from a relational
database as client application users request the data.

You can have one active SQL connection

You can maintain several SQL connections, but only one can be activated
at a time.
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Mapping the data between the SQL database and Express

After making a connection, you use a formula to map the data between the
SQL database and Express. As part of mapping the data, you can customize
the fetching of SQL data by preparing a selection preprocessor script.

What your users will need from you

When client application users work with the formulas that fetch SQL data,
they will use the SQL connections. If users need user names and passwords
to access the SQL databases, you should either provide the names and
passwords or prompt for them in the pre-attach processor program of the
databases that contain the formulas.

Related information

For more information on SQL reach-through, search for the following
topics in the Administrator Help system:

“Connecting to SQL”
“Mapping SQL Data”
“Preparing a Selection Preprocessor Script”

Preparing Code That Connects to the
SQL Database
What you must do before users can get data from a relational database

To allow users to request data to be fetched from a relational database, you
must:

� Prepare code that connects to the SQL database

� Include this code in the Pre-Attach Program and Post-Attach Program
properties of the database that contains the SQL reach-through formulas

You can decide whether to display, in the client application, the SQL Login
dialog box that prompts users for their IDs and passwords for connecting to
SQL databases.
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Temporary variables let client applications communicate with your code

To understand what to include in a connection program, you must
understand the temporary variables that allow the client application to
communicate with the code in your connection programs. These variables
are stored in XPDDCODE.DB and are described in “Table: Temporary
variables for SQL connections.”

This table’s Function column shows the numeric values to which the
XP_SQLACTION and XP_SQLSTATUS variables can be set. Rather than
using the actual numeric values, you can use qualified data references
(QDRs) to make your code more readable. A QDR is a way of limiting one
or more dimensions to a single value, using the Express language. For
example, the following expression refers to Sales values for only Toronto
and only VCRs.

F.SALES(GEOGRAPHY 'TORONTO' PRODUCT 'VCR')

Example: Setting up variables with dimension values used as constants

To set the variables with dimension values used as constants, you use a
QDR with two objects from XPDDCODE.DB. One is a text dimension
called XP_DEF. The other object is a variable called XP_VAL, which is
dimensioned by XP_DEF.

Suppose you want to set the XP_SQLACTION variable to tell your client
application to connect to the SQL database. You can enter one of the
following lines of code. The two lines accomplish the same task.

xp_sqlaction = 1

or

xp_sqlaction = xp_val(xp_def 'XP_ACTLOGIN')
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Table: Temporary variables for SQL connections

The temporary variables in the following table allow the client application
to communicate with the code in your connection programs.

Variable Data
Type

Function

XP_SQLACTION INTEGER Tells your connection code or the client
application what action to take. You set the
value of this variable. Possible values are:

0 = Do nothing (XP_ACTNONE).
1 = Connect to the SQL database
      (XP_ACTLOGIN).
2 = Give the user a message (XP_ACTMSG).
3 = Detach the current database
      (XP_ACTDETACH).
4 = Detach the database and give the user a
      message (XP_ACTDETACHMSG).

XP_SQLLOGINMSG TEXT Holds the text of an informational message to
display in the SQL Login dialog box. The text
can contain up to 38 characters.

XP_SQLMESSAGE TEXT Holds the text of an informational message to
display in a dialog box after the connection
process.

XP_SQLPASSWOR
D

TEXT Holds the user’s password to access the
relational database.

XP_SQLSTATUS INTEGER Tells your connection code or the client
application the state of the connection process.
The client application sets the value of this
variable. Possible values are:

0 = Everything is proceeding normally
      (XP_STSOK).
1 = There is already a connection
      (XP_STSCONNECTED).
2 = The user canceled the SQL Login dialog box
      (XP_STSCANCEL).

XP_SQLUSERNAME TEXT Holds the user ID to access the relational
database.
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Understanding the sequence of events

When client application users open a database manually or when it is
opened automatically and that database is meant to connect to an SQL
source, the following sequence of events occurs:

 1. The client application initializes the XP_SQLUSERNAME,
XP_SQLPASSWORD, XP_SQLLOGINMSG, XP_SQLSTATUS, and
XP_SQLACTION variables to NA or 0.

 2. The client application runs the program that is specified in the
database’s Pre-Attach Program property. If you want the client
application to display the SQL Login dialog box and if you want to
display a message in that dialog box, then enter the following
commands in the pre-attach program.

  
  xp_sqlaction = xp_val (xp_def 'XP_SQLLOGIN')
  xp_sqlloginmsg = 'Connect to SQL database FRED'

 3. The client application opens the database. If it cannot open the
database, then it skips the following steps.

 4. If the user chooses OK  in the SQL Login dialog box, then the client
application stores the user ID and password in the
XP_SQLUSERNAME and XP_SQLPASSWORD variables. (The user
cannot choose OK  if the user ID field is blank). If the user chooses
Cancel, then the client application sets the XP_SQLSTATUS variable
to 2.

 5. The client application runs the program that is specified in the
database’s Post-Attach Program property. This program should contain
code to accomplish the following:

� Connect to the SQL database.

� Handle nonzero values that are set in the XP_SQLSTATUS
variable, and set the XP_SQLACTION variable appropriately.

� Set a value in the XP_SQLMESSAGE variable to display to the
user (optional).

 6. If the XP_SQLACTION variable is not set to 0, then the client
application takes the appropriate action, based on the variable’s setting.
Such actions might include sending a message to the user or closing the
Express database.
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Using Two Administrator Programs for
SQL Connections
Overview

The topic entitled “Sample Programs for Connecting to SQL Databases”
provides examples of program code that you can use to connect to and
disconnect from SQL databases. These examples call on two programs
provided with Administrator — XP_SQLCNCT and XP_SQLDISCNCT.
Before understanding the example programs, you must understand the
XP_SQLCNCT and XP_SQLDISCNCT programs.

XP_SQLCNCT program

As you begin the process of connecting to a SQL database, you use the
XP_SQLCNCT program. This program returns a Boolean value that
indicates whether the connection was successful. The program takes the
following five arguments:

� ODBC Data Source — The name of the ODBC data source, which is
described earlier in this chapter. If Express uses OCI instead of ODBC
to connect to the relational database, this argument should be an empty
string.

� Relational dbms — The type of the relational database to which you
are connecting, such as Oracle.

� NA — This third argument is always NA.

� User ID — This fourth argument depends on whether the connection is
an ODBC or an OCI connection.

If the connection made from Express is an ODBC connection, this
argument should be the user ID used to make the SQL connection.
However, if the connection made from Express to the data source is an
OCI connection, then the fourth argument to the XP_SQLCNCT
program should be a string in the following form:

userid/password@server_connect_string

where server_connect_string  is the SQL*Net connection string
used to set up the 32-bit ODBC data source.
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For example, if the user ID is “scott,” the password is “tiger,” and the
server connection string is “tns: myserver.world,” the fourth argument
to the XP_SQLCNCT program should be:

scott/tiger@tns:myserver.world

Password — This fifth argument depends on whether the connection is
an ODBC or an OCI connection.

If the connection made from Express is an ODBC connection, this
argument should be the password associated with the user ID. If the
connection made from Express is an OCI connection, the fifth argument
to the XP_SQLCNCT program should be an empty string.

Example: Uses for the XP_SQLCNCT program

The following example lines show uses for the XP_SQLCNCT program.

The first example shows how to make an OCI connection to an Oracle
database using an ODBC data source called “Oracle 7016,” with a
username “scott,” password “tiger,” and the server connect string
“tns:myserver.world.”

call xp_sqlcnct('Oracle 7016', 'ORACLE', na, -
'scott/tiger@tns:myserver.world', '')

The second example makes a connection to a Microsoft Access source that
does not require a user ID or password.

call xp_sqlcnct ('MS Access')

XP_SQLDISCNCT program

When you close a database, you should disconnect from the SQL source.
To do so, you use a program that calls the XP_SQLDISCNCT program.
This program takes only one argument — the name of the ODBC data
source, which is described earlier in this chapter.

If Express uses OCI instead of ODBC to connect to the relational database,
this argument should be an empty string.
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Example: Uses for the XP_SQLDISCNCT program

The following example shows the XP_SQLDISCNCT program being used
to disconnect from an Oracle database using an ODBC data source called
“Oracle 7016.”

call xp_sqldiscnct ('Oracle 7016')

Tips for using the programs

When preparing programs that use XP_SQLCNCT and
XP_SQLDISCNCT, you should keep the following tips in mind:

� When you distribute a query that requires a database using dynamic
SQL reach-through, you must ensure that the end users have the
appropriate ODBC drivers and access to the data source on the Express
Server machine.

� Not all SQL sources require user ID and passwords. The pre-attach
processor of the database will specify whether to display the SQL Login
dialog box, and the temporary variables XP_SQLUSERNAME and
XP_SQLPASSWORD will contain the values that were entered in the
dialog box. You should pass these two variables as the User ID and
Password arguments to the XP_SQLCNCT program.

� You must set up an ODBC data source, because Administrator makes
an ODBC connection to create the dynamic SQL reach-through
formulas to import SQL data. If Express Server 6 uses ODBC, the
ODBC data source that is set up on the computer on which
Administrator is installed must be identical to the ODBC data source on
the server machine.
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Sample Programs for Connecting to
SQL Databases
Example: Pre-attach program for a SQL connection

The following figure provides a sample login program for starting the
connection between a client application session and a SQL database. This
program displays the SQL Login dialog box. This program name would be
set as a database’s Pre-Attach Program property value.

DEFINE SQL.PRE PROGRAM
PROGRAM
" Set the SQL Action to prompt with the SQL Login dialog box
XP_SQLACTION = XP_VAL (XP_DEF 'XP_ACTLOGIN')
XP_SQLLOGINMSG = 'Enter Oracle Userid/password'
END

Example: Post-attach program for a SQL connection

The following figure provides a sample program for continuing to establish
the connection between a client application session and a SQL database that
began with the pre-attach program. This program name would be set as a
database’s Post-Attach Program property value.

DEFINE SQL.POST PROGRAM
PROGRAM
trap on ERROR noprint
pushlevel 'SQL.POST'
push SQLMESSAGES
SQLMESSAGES = YES

" Status is OK, connect to the SQL source
if XP_SQLSTATUS eq XP_VAL (XP_DEF 'XP_STSOK')
then do

" Connect to the SQL source
if XP_SQLCNCT ('Oracle 7016', 'ORACLE', na, -

      XP_SQLUSERNAME, XP_SQLPASSWORD)
      then do
" Connection established, display message for the user
       XP_SQLACTION = XP_VAL (XP_DEF 'XP_ACTMSG')
       XP_SQLMESSAGE = 'Oracle SQL Connection established.'
      doend
      else do
" Connection failed, detach the database and tell the user
  XP_SQLACTION = XP_VAL (XP_DEF 'XP_ACTDETACHMSG')
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  XP_SQLMESSAGE = joinchars ('Connection Failed:  ' -
          sqlerrm)
      doend
doend

" Status is connected, display message for the user
else if XP_SQLSTATUS eq XP_VAL (XP_DEF 'XP_STSCONNECTED')
then do
   XP_SQLACTION = XP_VAL (XP_DEF 'XP_ACTMSG')
   XP_SQLMESSAGE = 'The SQL connection is already made.'
doend
" Status is cancel, detach the database and tell the user
else if XP_SQLSTATUS eq XP_VAL (XP_DEF 'XP_STSCANCEL')
then do
   XP_SQLACTION =  XP_VAL (XP_DEF 'XP_ACTDETACHMSG')
   XP_SQLMESSAGE = 'User canceled from the login dialog.'
doend

DONE:
poplevel 'SQL.POST'
return
ERROR:
XP_SQLACTION =  XP_VAL (XP_DEF 'XP_ACTDETACHMSG')
XP_SQLMESSAGE = joinlines('Postprocessor Error:' errortext)
goto DONE
END

Example: Sample detach program for a SQL connection

The following figure provides a sample program for breaking the
connection between a client application session and a SQL database. This
program name would be set as a database’s Pre-Detach or Post-Detach
Program property value.

DEFINE SQL.DETACH PROGRAM
PROGRAM
" Disconnect form the SQL Source
call XP_SQLDISCNCT ('Oracle 7016')
END
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Chapter 17

Using Relational Access
Manager

Overview
Introduction

This chapter describes how to make Relational Access Manager
connections and how to prepare for the use of formulas with a Relational
Access Manager database.

In this chapter

� Making Relational Access Manager Connections

� Starting Relational Access Administrator from Administrator

� Preparing for the Use of Formulas

� Prefilling the Cache for Use with Formulas

� Examples: Prefilling the Cache for Use with Formulas
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Making Relational Access Manager
Connections
Overview

Relational Access Manager allows Express client applications to access
data that is stored in a relational database management system (RDBMS).

Using Relational Access Administrator, which is the graphical user
interface for Relational Access Manager,  you can build Express databases
that model the data in an RDBMS and access data that is stored in the
RDBMS. To allow Express client applications to connect to these Express
databases, you must provide connection (.XCF) files.

Relational Access Administrator requirements

If you use Relational Access Administrator to build databases in Express,
you should be aware that Relational Access Administrator has the same
ODBC and SQL*Net requirements as Administrator.

You must set up a 32-bit ODBC data source on the computer on which
Relational Access Administrator is installed so that Relational Access
Administrator can connect to the relational database.

On Windows 95 or Windows NT, you use the Microsoft ODBC
Administrator program to define data sources. You can double-click on the
ODBC icon in the Windows Control Panel program group to use the
Microsoft ODBC Administrator program.

If your ODBC driver does not meet these minimum required compliance
levels, Relational Access Administrator will lose functionality and might
not work at all.

In order to communicate with an Oracle relational database, a SQL*Net
connection must be set up on both of the following:

� The computer on which Express is installed (regardless of whether
Express uses OCI or ODBC)

� The computer on which Relational Access Administrator is installed
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You must install 32-bit SQL*Net Version 2.2 or later on the same computer
as Relational Access Administrator.

If you want to access data in a non-ORACLE relational database, you
should check that product’s communications interface documentation for
compatibility issues.

Identifying the master database

When you create connection files, you must know the name and location of
the master database, which is one of the Express databases that is built
using Relational Access Administrator. The master database contains the
formulas needed for retrieving data from an RDBMS.

The name of the master database always begins with the letter “D.” For
example, when you build databases from a Relational Access Administrator
project, you must first specify the name of the data database, and the names
of the other databases are automatically generated, based on the name of
the data database. If the name of that data database is “MYDB,” the name
of the master database that is built from that project is “DMYDB.DB.”

Identifying the code databases

When creating connection files, you also need to know where the
Relational Access Manager code databases have been installed. These
databases are included as part of the Relational Access Manager
installation.

The code databases are READWH.DB, EXTRACSQ.DB, DSCODE.DB,
and DSBUILD.DB. These databases probably reside in a directory such as
C:\ORAWIN95\OLAP\RPMnnn, where nnn represents the release number.
If you do not know where these databases are located, contact the person
who installed Relational Access Manager.
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Procedure: Setting up a connection file

Use the following procedure to set up a connection file for an Express
Server remote configuration that includes Relational Access Manager.

Step Action

1 Start the Express Connection Editor by double-clicking on its associated
icon in the Express Client program group, if you have not already done so.

2 Choose Define  to display the Connection Settings dialog box.

3 Specify the following settings.

Step Action

1 In the Express Version box, select Express Server 6.x .

2 In the Host Name box, enter the name of the computer on
which Express Server is installed.

3 In the Transport box, select the transport protocol of your
choice.

4 If you selected the ncacn_ip_tcp  or other RPC transport
protocol, you can enter a value in the UUID box. In the
UUID box, enter the universal unique identifier that points to
the defined shell script.

If necessary, ask your system administrator to generate this
information for you.

5 If you selected the ora_ro_tcp  transport protocol, you can
enter a value in the Endpoint box. In the Endpoint box, enter
the port number on which the server accepts connection
requests.

6 In the Authentication Type box, specify the appropriate
security settings.

7 In the Relational Data box, check the Relational Access
Manager Connection  box.

8 In the Relational Data box, choose the Direct  button.

4 Choose the Settings  button to display the Relational Access Manager
Connections Settings dialog box.
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Step Action

5 Specify the following settings in the Relational Access Manager
Connections Settings dialog box:

Step Action

1 The Personal Configuration box is deselected by default.
Whether you select or deselect the Personal Configuration
box depends on your users. For details, see the text labeled
“Why you should select or deselect the Personal
Configuration box” that follows this table.

2 In the Master Database box, enter the name of the master
database, if it is not already entered.

Be sure to include the “.db” extension (in lowercase) after
the master database name.

3 In the RDC File box, enter the name of the remote database
configuration file.

This file will have the same name as the master database
plus an .RDC extension. This file is generated on the server
when Relational Access Administrator is used to build the
master database.

6 Make the .XCF file available to your application users, for example, by giving
copies of the .XCF file to users. You can put a read-only copy of the .XCF
file on the LAN, if you want your users to share the same file.

7 Instruct your users to open the Connection Editor, select Set Path , and
enter the file path for the .XCF file in the Paths for Connection (.XCF) Files
dialog box, if it is not already listed.

Why you should select or deselect the Personal Configuration box

The Personal Configuration box in the Relational Access Manager
Connection Settings dialog box is deselected by default. You will be able to
select the Personal Configuration box only if you have specified any setting
other than None in the Authentication box in the Connection Settings
dialog box.

Whether you select or deselect the Personal Configuration box depends on
your users. You should select the Personal Configuration box if your users
also use Oracle Sales Analyzer (hereinafter referred to as “Analyzer”). This
allows users to reuse functionality from Analyzer, such as custom measures
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and scoping. Each of your users must have an account on the appropriate
domain or machine. When a user connects to the database, a personal
database will be created (if it does not already exist) and opened with
read/write access.

However, if your users do not use Analyzer, you should deselect the
Personal Configuration box. This makes a “guest” login possible, so that
users without accounts can connect to the database. If you create the .XCF
file, you, as the DBA, need to know the name and path of the database and
its RDC file, which has the same name as the database but with an .RDC
extension.

If you select the Personal Configuration box, you (or the administrator of
the NT machine from which Express Server is administered) must set up
the User Environment Profile on the NT machine for each of your users.
You must specify a unique path for the user’s personal database in the
Local Path box in the Home directory section of the User Environment
Profile screen in the User Manager (NT). Otherwise, all personal databases
will be defined in the same location — therefore, only one user will be able
to connect to the database at a time, because the personal database is
opened with read/write access.

Related information

See your Relational Access Manager documentation for more information
about Relational Access Manager, Relational Access Administrator, and
building databases.

Starting Relational Access
Administrator from Administrator
The changes you must make to your Administrator .INI file

If your responsibilities include using Relational Access Administrator, you
can take steps that let you start it directly from Administrator.
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If your Administrator .INI file does not already have a [Relational
Access Administrator]  group, add that group name to the file and add
the .INI file settings after that group name.

Then, add the settings that are described in “Relational Access
Administrator .INI file options” to the Relational Access Administrator
group in the Administrator .INI file (XADMIN.INI).

Relational Access Administrator .INI file options

Add the following settings to your Administrator .INI file if you want to be
able to start Relational Access Administrator from Administrator.

Option Description Settings

InUse Specifies whether to
enable the Relational
Access Administrator
item on the Tools menu.
When this menu item is
chosen, Relational Access
Administrator is displayed
in Administrator.

-1 = Show the Relational
Access Administrator
menu item.
0 = Hide the Relational
Access Administrator
menu item. (Default)

ExePath If InUse is set to -1,
specifies the directory path
of the Relational Access
Administrator executable
file.

A string that describes the
directory. (The default is
the directory you enter for
this executable file when
you install Administrator.)

How to start Relational Access Administrator

Once you have added the Relational Access Administrator settings to your
.INI file, you can start Relational Access Administrator from Administrator
by choosing Relational Access Administrator from the Tools menu.

Preparing for the Use of Formulas
Overview

Most of the operations and features in Express Client products (for
example, Oracle Express Objects and Express Analyzer) are fully supported
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for Relational Access Manager databases. However, Express Client
products do not support formulas that involve qualified data references
(QDRs), time-series functions, or ampersands for Relational Access
Manager databases.

This topic describes what you must do to allow users of Express Client
products to use formulas that include QDRs, time-series functions, or
ampersands with a Relational Access Manager database.

How Express Client products access Relational Access Manager data

In order to understand why certain functions are problematic, it is necessary
to understand how Relational Access Manager accesses data from a
relational database.

A Relational Access Manager database contains a cache for each measure.
The cache is normally empty at the beginning of a user’s session and is
gradually filled as the user views data for a measure. Before data can be
displayed in the user’s report or graph, it must be retrieved from the
relational database and stored in the cache.

The values of Express formulas are not stored in the database; they are
calculated from the values of the measures that are specified in their
definitions. To permit accurate calculations, the values of the measures in
the formula definition must be cached before the formula is calculated.

When Express Client products automatically prefill caches

In cases where a formula contains references to Relational Access Manager
measures, the Express Client product is able to parse the formula and
automatically prefill the caches for the Relational Access Manager
measures.

For example, suppose you have two Relational Access Manager measures,
SALES and COSTS. A PROFIT formula is defined in Express as SALES -
COSTS. Because the definition of PROFIT contains references to
Relational Access Manager measures, the Express Client product correctly
prefills the appropriate caches for SALES and COSTS.
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When Express Client products do not prefill the cache

There are other cases, however, where the Express Client product either
cannot determine the cache to prefill or the areas of a cache to prefill. These
cases include formulas that have any of the following:

� QDRs, such as those used in share calculations. A QDR refers to a
single value for one or more dimensions.

� Time-series functions: LAG, LAGABSPCT, LAGDIF, LAGPCT,
LEAD, MOVINGAVERAGE, MOVINGMAX, MOVINGMIN, and
MOVINGTOTAL.

� Ampersands.

Prefilling the Cache for Use with
Formulas
Overview

This topic describes what you can do in Administrator to have the
appropriate cache or cache area prefilled for formulas involving QDRs,
time-series calculations, or ampersands.

Using QDRs in formulas

Sometimes a formula needs to refer to a particular data value by using a
QDR such as SALES(PRODUCT ‘TOTPROD’). Express Client products
do not parse QDRs or automatically cache the numbers for the specified
dimension value.

To instruct the Express Client product to cache the data for the dimension
value, set the formula’s Dimension Dependency property to a LIMIT
command that includes the dimension value. Such a command looks like
the one in the following example.

LIMIT dimension ADD value
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Enabling time-series calculations

A number of Express time-series functions refer to values of the time
dimension that are not included in the current status of the dimension.
These time dimension values are not likely to be cached.

To add these values to the cache, you set the Dimension Dependency
property to a LIMIT command that adds them to the current status of the
time dimension.

Using ampersands in formulas

If a formula contains an ampersand, Express Client products cannot
determine which Relational Access Manager measures the formula depends
on, if any. Ampersands in formulas are not a good idea in general, because
they degrade performance.

In Administrator, if you include ampersands in a formula that refers to a
Relational Access Manager measure, add the Express Client measure
dimension (XP_MEASUREDIM) to the value of the formula’s Measure
Dependency property. For example, if the formula refers to SALES, you
would add SALES to the list of measures in the property value.

What to tell Express Client users

Inform Express Client users that they should avoid using functions that
Express Client products do not support: QDRs, time-series functions, and
ampersands. For Relational Access Manager databases, these problematic
functions are excluded from the function list in the custom measure
interface. In addition, Express Client products warn users if they use one of
these functions or use a problematic syntax.

Summary

Use Administrator to define any formula that requires a QDR, a time-series
function, or an ampersand. This allows you to set the properties that prefill
the cache as necessary.
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Examples: Prefilling the Cache for Use
with Formulas
Example: Prefilling the cache for the QDR

A share calculation such as the following compares sales for a particular
product to total sales.

100 * SALES / SALES(PRODUCT 'TOTPROD')

In order for this formula to return correct results, SALES for the product
value TOTPROD must be cached before the formula is evaluated.

After you define the above share formula in Administrator, set the
formula’s Dimension Dependency property to the following value.

limit product add 'TOTPROD'

This command instructs the Express Client product to add TOTPROD to
the status of PRODUCT before retrieving SALES from the relational
database. Because the Express Client product executes this LIMIT
command before retrieving SALES, the SALES values for TOTPROD are
cached before the share formula is evaluated.

Example: Prefilling the cache for a more complex QDR

A more complex share formula refers to the parent value in a hierarchy,
where the parent varies from product to product.

100 * SALES / SALES(PRODUCT P0.PARENT)

In this case, you must make sure SALES is cached for all parent values.
You should enter the following command as the value of the Dimension
Dependency property.

limit product add charlist( p0.parent )

Example: Prefilling the cache for year-ago and period-ago calculations

Time dimensions in a Relational Access Manager database contain special
structures to support year-ago and period-ago calculations. For example, the
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dimension TIME might be supplied with structures called PRIOR.T and
YRAGO.T. These are relations that hold the period-ago and year-ago
period for each time period. These relations can be used to define lag
formulas such as the following, which returns sales numbers for the time
periods preceding those in status.

DEFINE SALES.LAG1PER FORMULA DECIMAL <TIME PROD GEOG>
EQ if prior.t eq na then na else sales(time prior.t)

After defining this formula, you would set its Dimension Dependency
property to the following value.

limit time add charlist(prior.t)

Example: Prefilling the cache with the appropriate nonhierarchical time
values

The formula LAG(SALES, 6, MONTH)  refers to months preceding those
currently in status. If SALES is not cached for those months before the
formula is evaluated, incorrect data will be returned. Therefore, you must
add the following command as the value of Dimension Dependency.

limit month add poslist charlist(if month gt 6 then na
else convert(month, integer) - 6)
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Appendix A

Administrator Installation

Overview
Introduction

This appendix tells you how to install Administrator and the Express
Connection Editor.

In this appendix

� Software and Hardware Requirements

� Getting Started

� Installing

� Understanding the Installation

� Handling Connections to Express

� Upgrading

� Starting and Exiting

� Removing Products and Utilities

� Reading Documents Online

� Help Systems
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Software and Hardware Requirements
Software Requirements

Your PC must meet the following software requirements:

� Microsoft Windows. This can be Windows 95 or Windows NT version
4.0 or later.

� If you are running a LAN-based version of Windows, then you must
have write access to the Windows system directory.

� Access to Express. This can be any of the following:

� Personal Express 6 on a PC

� Express Server 6

� If you intend to import data from a relational database that complies
with Microsoft’s Open Database Connectivity (ODBC), then you must
have the ODBC support and appropriate ODBC drivers installed. The
Express products and utilities support ODBC version 2.0 or later. See
Chapter 16 or the Express Language Programming Guide for more
information about ODBC.

� If you are using an Express Client product or utility with Express
Server, then you must also install the following:

� SNAPI. Use Oracle Installer (hereinafter referred to as “Installer”)
to install Remote SNAPI. (For more information about installing,
see the topic “Installing” later in this appendix.)

� RPC runtime support. The Express products and utilities support
MS-RPC from Microsoft, which is distributed free of charge.

� TCP/IP support on the client machine.

� ODBC drivers.

Hardware requirements

Your PC must meet the following hardware requirements:

� IBM or compatible PC with at least an Intel Pentium processor running
at 75MHz or greater.
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� 32MB of RAM, plus an additional 8MB of RAM if you are using
Personal Express.

� At least 12MB available on your PC’s hard drive for Administrator
files, and 1MB for Express Connection Editor files. Another 7MB is
required if you install the demonstration database. If you are using
Personal Express, then you will also need at least 5MB for its files and
15MB for client databases.

Getting Started
Overview

This section provides an overview of the steps you take to install and begin
to use Administrator. Some steps are required, while others are optional.

Important: Express Client products require separate installation

If you have purchased any Express Client products and plan to install
Administrator with them, refer to Oracle Express Analyzer Getting Started
or Oracle Express Objects Getting Started for installation instructions for
all products and utilities, including Administrator, instead of this appendix.
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Procedure: Installing Administrator

The following procedure gives an overview of the installation process.

Step Action

1 If you have not already done so, determine where you want your Oracle
home directory to be.

The first time you install an Oracle product, you choose a location for the
home directory. All Oracle products are installed in subdirectories of the
home directory. Each release of a particular product is installed into a
separate subdirectory.

2 Optional. Install the Acrobat reader, as described in “Reading Documents
Online.”

3 Use the Acrobat reader to read the release notes for the product you are
installing.

These notes might contain additional information that you should review
before continuing the installation process. You can locate the release notes
by opening CONTENTS.PDF, which provides access to all online
documents. See the section “Reading Documents Online.”

4 Use Installer to install Administrator.

5 If you are the DBA (or are defining your own Express connections), then use
the Express Connection Editor to define connections to Express. Use the
utility’s online Help for instructions. For more information on Express
connections, see Chapter 3.

Alternatively, you can perform this step later or you can allow Installer to
initialize your connection definitions, as described in the topic “Handling
Connections to Express.”

6 If you plan to import data from a relational database that complies with
ODBC and you have not already installed the ODBC drivers, do so now.

Be sure to install ODBC version 2.0 or later. These drivers are not provided
on the Express CD.

7 Start Administrator to configure existing databases or create new databases.
For information about creating databases, see Chapters 6 and 7. For
information about configuring databases, see Chapter 8.

If you plan to use Relational Access Manager to access a relational
database, then you must first use Relational Access Administrator to create
and build the Express database.

Never make changes to the home directory

  Once you have installed an Oracle product, you should not change the
location of the home directory, nor the names of its subdirectories.
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You should install the Acrobat Reader

 Although this step is optional, Oracle Corporation strongly recommends
that you install Acrobat Reader so you can read and print important
documents, such as release notes. You can also use Acrobat Reader to
read and print the online version of the printed document.

Installing
Each user must install Administrator and the Express Connection Editor
locally

Administrator and the Express Connection Editor can be installed only for a
single user, whether they are installed on a PC or a LAN.

Deciding what to install

In order to use Administrator, you must install Express.

When you run Installer, you choose the products you wish to install from
the Software Asset Manager dialog box. The box on the left lists all the
available products and utilities in alphabetical order. You can select one or
more products and utilities from the list. Installer ensures that they are
installed in the correct order.
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Procedure: Installing Administrator

Use the following procedure to install Administrator from the Express CD.

Step Action

1 Start Microsoft Windows and insert the Express CD into the appropriate
drive.

If inserting the CD into the drive starts Installer, then skip to Step 5.

2 Read README.TXT, which is located in the top level directory on the CD.

This file describes the contents of the CD and tells you what to do.

3 Navigate to the X:\WIN32\INSTALL directory, where X is the letter of your
CD-ROM drive.

4 Run SETUP.EXE (Installer).

5 Select the products and utilities you wish to install from the box on the left
labeled “Products available on path,” where path is the location of the
installation files on the CD.

If you plan to use Administrator with Express Server or Personal Express,
then you can select SNAPI at this time.

If you are using the Relational Access Manager with Personal Express plus
Administrator, then you must install the Relational Access Manager support
files from the CD.

6 Choose Install .

Important:  Do not change the Oracle home directory.

7 Follow the instructions on each of the dialog boxes.

Important:  Do not change the Oracle home directory.

Do not change the Oracle home directory

If you have previously installed any Oracle product, then you already have
an Oracle home directory. Oracle Corporation strongly recommends that
you do not change this directory once it is defined.
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Understanding the Installation
Installation structure

Installer installs all products and utilities into subdirectories of the Oracle
home directory. The products and utilities on the Express Server CD and
the Express Client CD use the 32-bit version of Installer. This version uses
ORANT or ORAWIN95 as the default name for the Oracle home directory.

Under the Oracle home directory, OLAP products are installed in
subdirectories named OLAP\product_identifier. The product identifier is a
concatenation of a directory prefix (listed in the following table) and the
first three digits of the current release number.

For example, Express Administrator release 6.2.0 will be installed in a
directory named EAD620.

When you install a new release whose number has fewer than four digits, it
is placed in an entirely new directory. Release numbers with four or more
digits overwrite the previous installation. For example, release 6.3 would
go into a new directory. However, release 6.2.0.4 would overwrite release
6.2.0.3 because both releases would be installed in directory EAD620.
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The directory prefixes

The directory prefixes are shown in the following table.

Prefix Directory Contents

ead Administrator

ece Express Connection Editor

ecf Express connection files (.XCF)

ecs Shared files, such as the Express Language Help files

oea Express Analyzer

oeo Express Objects

oes Express Server

osn SNAPI

owa Web Agent

owp Web Publisher

pex Personal Express

raa Relational Access Administrator

rpm Relational Access Manager

xsa Express Spreadsheet Add-In

Related information

For more information about installing Express, see the following
documents from the Express documentation set:

� For information about installing Express Server, see the Oracle Express
Server Installation and Configuration Guide.
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� For information about installing Personal Express, see the Personal
Express Installation and Configuration Guide.

Handling Connections to Express
What is the Express Connection Editor?

The Express Connection Editor allows you to define connections to
Express.

What are connection files?

Connection definitions are stored in connection files, which have an
extension of .XCF.

Connection files can reside on your PC or on a LAN. Their various
locations are specified in a file named XCONNECT.INI. Each user must
have a local copy of XCONNECT.INI, although it can be maintained by the
DBA and distributed to users. When you install Administrator, Installer
provides XCONNECT.INI automatically.

Do not move the XCONNECT.INI file

Once Installer has created XCONNECT.INI, you should not move it to a
different directory. Doing so will make it impossible to connect to Express.

How Installer handles Express connections

When you install Administrator, Installer places connection information
files in the \ECFxxx directory. The connection information files include the
following:

� .XCF files — Define Express connections, one in each .XCF file.

� XCONNECT.INI — Specifies the locations of your .XCF files. Such
files may be stored locally or on a LAN.

If you have any existing .XCF files, Installer preserves them in their current
locations. It also locates remote connection definitions in the .INI file from
previous versions of Administrator and uses them to create new .XCF files.
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It creates an .XCF file for each definition, as well as one for Personal
Express. If you do not already have any .XCF files and your .INI file does
not contain connection definitions, then Installer simply creates a default
.XCF file.

After you have installed Administrator, you will be able to connect to
Express. As the DBA, you are likely to create and edit .XCF files, as
described in Chapter 2. Therefore, you will probably need to install the
Express Connection Editor. You do need to have at least one .XCF file
available and to have a local copy of XCONNECT.INI. Both of these are
provided the first time you use Installer.

Managing Express connections

After you have completed the installation, you can manage your site’s
connections in various ways, including the following:

� Each user can manage his or her own connections to Express. To do
this, each user must install and use the Express Connection Editor.

� You, as the DBA, can create and edit all connection files and manage
their locations. The .XCF files can reside in a central location such as a
LAN drive, on a local PC, or both. In this case, you install the Express
Connection Editor and use it to create and edit connection definitions
and to update XCONNECT.INI. You then distribute XCONNECT.INI
to users, who overwrite the copy on their PCs. Users do not need to
install the Express Connection Editor.

� Connection files can be in any directory. For example, your site might
provide some .XCF files on the LAN, while others might be on your
local PC. If this is the case, it must be possible to update the connection
files path in XCONNECT.INI on each PC, since the local directories
may be different. You or the users can do so with the Express
Connection Editor (installed on the local PC), or you can edit the file
directly using a text editor. When the path statement contains multiple
locations, the paths should be separated by semicolons.

Related information

For more information about the Express Connection Editor, see Chapter 2.
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Upgrading
Overview

This topic applies only to installations that use Personal Express.

If you are using Express Server 6, the required databases are installed
automatically.

Installing and upgrading the Data Dictionary database

The Data Dictionary database, XPDDDATA.DB, is installed with Express
Server and Personal Express when you choose to install the Express Client
Support Files. It is always installed in the \OECREL directory with Express
Server and the \PECREL directory with Personal Express, where REL is the
release number (for example, 620).

Installer performs the following tasks when you install Server.

Stage Description

1 Installer searches for a copy of XPDDDATA.DB from a previous installation
of, first, Oracle Express Objects, then of Express Analyzer. Installer
searches only for Express 6.x versions of XPDDDATA.DB, not for Express
5.x or earlier versions.

2 If Installer finds an existing copy of XPDDDATA.DB, it asks if you want to
copy it to the new installation. If you choose Yes, then Installer copies the
existing file to the \OECREL or \PECREL directory. If Installer does not find
an existing copy or if you choose No, then Installer places a new copy of
XPDDDATA.DB in \OECREL or \PECREL.

Installer looks first in \OECREL or \PECREL. If that directory already
contains a copy of XPDDDATA.DB, Installer does not perform any other
searches. That is, once you have installed Administrator and \OECREL or
\PECREL contains a copy of XPDDDATA.DB, Installer will not look for
other copies.

Upgrading XPDDDATA.DB

Oracle Corporation recommends that you use Administrator to upgrade the
XPDDDATA.DB database that was created with earlier releases of Express
6. When you start Administrator, it automatically upgrades
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XPDDDATA.DB. Closing Administrator automatically updates
XPDDDATA.DB. It is easiest to upgrade this file once, using
Administrator, and then distribute the upgraded version to other users.

The procedure for upgrading XPDDDATA.DB created with Express 5 is
described in Appendix C.

For more information about XPDDDATA.DB, see Chapter 3.

Upgrading Express user databases

The Express user databases — databases that contain your data — might
also need to be upgraded. Upgrading is required when a database was
created with an earlier version of Express or when it was created with an
earlier version of Administrator.

In Administrator, when you open a database read/write, its file version is
compared to the file version in Express. If the database needs to be
upgraded, you are asked whether to continue. If the database is an Express
6 database and you choose to continue, Administrator will upgrade the
database.

The procedure for upgrading user databases created with Express 5 is
described in Appendix C.

Starting and Exiting
Procedure: Starting Administrator or the Express Connection Editor

Use the following procedure to start Administrator or the Express
Connection Editor in Windows 95 or Windows NT version 4.0.

Step Action

1 From the Start menu, choose Programs .

2 Choose Oracle OLAP Client .

3 Choose the product or utility name.
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In Windows NT, double-click on the program or utility’s icon in the Oracle
OLAP Client program group.

Procedure: Exiting Administrator

To exit Administrator, from the File menu, choose Exit.

Procedure: Exiting the Express Connection Editor

To exit the Express Connection Editor, choose Close from the Express
Connection Editor dialog box.

Connecting to Express

You cannot run Administrator without connecting to Express. Therefore,
when Administrator starts, it displays a list of available Express
connections. You must choose the one you wish to use. The available
connections are defined by the Express Connection Editor.

Related information

For detailed information, see Chapter 3.

Removing Products and Utilities
Procedure: Removing any product that was installed with Installer

Use the following procedure to remove products and utilities.

Step Action

1 Start Microsoft Windows and insert the Express CD into the appropriate
drive.

2 Navigate to the X:\WIN32\INSTALL directory, where X is the letter of your
CD-ROM drive.

3 Run SETUP.EXE (Installer).

4 Select the products and utilities you wish to remove from the right list box.

5 Choose Remove .
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Restrictions on what you can remove

Installer will remove only files that it installed or knows about. It will not
remove any files that you may have copied or created in that directory. If
the product directory contains files that Installer cannot delete, that
directory will not be removed.

Reading Documents Online
Use Acrobat Reader

Use Acrobat Reader to read documents online. You can install Acrobat
Reader from the Express CD.

Procedure: Installing Acrobat Reader

Use the following procedure to install the Acrobat reader.

Step Action

1 Start Microsoft Windows and insert the Express CD into the appropriate
drive.

2 Run the following command: x:\READER\AR32E301.EXE , where x
identifies your CD-ROM drive.

3 Follow the instructions on your screen. Installation requires approximately
2MB of free space in your \TEMP directory. If the required space is not
available, the installation will terminate with a *0003* error.
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Procedure: Reading a document online

Use the following procedure to read a document online.

Step Action

1 Start Microsoft Windows and insert the Express CD into the appropriate
drive.

2 Start Acrobat Reader.

3 From Acrobat Reader’s File menu, choose Open .

4 Specify X:\DOC\CONTENTS.PDF, where X identifies your CD-ROM drive.
CONTENTS.PDF contains a table of contents for all the documentation on
the CD, from which you can navigate to any of the available documents.

Using Acrobat Reader

Once the file is open in the reader, you can use Acrobat’s navigation
facilities. For information about how to use Acrobat Reader, choose
Acrobat Reader Help from the Help menu.

Help Systems
Administrator Help systems

When you install Administrator, its Help systems, which are shown below,
are installed automatically.

Help System File Names

Administrator Help XADMIN.HLP

Express Language Help Version 6 EXPLANG.HLP

You can access both Help systems from the Administrator Help menu.

The Express Connection Editor Help system

When you install the Express Connection Editor, its Help system, which is
named XCONEDIT.HLP, is installed automatically. You can access this
Help system from the Help button in any Connection Editor dialog box.
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Appendix B

Using Conjoint Dimensions

Overview
Introduction

This appendix describes conjoint dimensions and how you can convert
them into composites, as well as how you can convert composites into
conjoint dimensions.

In this appendix

� What Are Conjoint Dimensions?

� Defining and Maintaining Conjoint Dimensions

� Converting Conjoint Dimensions to Composites

� Converting Composites to Conjoint Dimensions

What Are Conjoint Dimensions?
Definition: Conjoint dimensions

A conjoint dimension is a special type of dimension whose values
correspond to specific combinations of values from one or more other
dimensions called base dimensions. Normally, the conjoint dimension
would only have those combinations of base dimension values for which
you have data.
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Purpose of conjoint dimensions

One way to eliminate NA values and make data variables smaller is to use
conjoint dimensions instead of composites.

Composites give you a quick and easy way to handle sparse variables.
Conjoint dimensions give you finer control in working with sparse
variables, but you will then have to take extra steps to maintain your
conjoint dimensions.

Example: Using conjoint dimensions versus composites

Suppose you want to limit the dimensions of a sparse variable. If that
variable is dimensioned by a composite, you limit the base dimensions of
that composite (such as limiting the PRODUCT dimension to
‘SPORTSWEAR’).

However, if the variable is dimensioned by a conjoint dimension, then you
can limit the actual combinations of the conjoint dimension (such as
<‘SPORTSWEAR’ ‘BOSTON’>). If you find you need this degree of
control, then you might consider using conjoint dimensions instead of
composites. Be aware, though, that you will be sacrificing the ease of use
that composites provide.

How using conjoint dimensions gives you finer control

When you define a conjoint dimension, Express automatically defines
relations between the conjoint dimension and the base dimensions from
which it is derived. Therefore, you can select and retrieve data based on the
base dimension values.

Defining and Maintaining Conjoint
Dimensions
Example: Sparsity in a variable’s data

Suppose you have a variable SALES, which is dimensioned by MONTH,
PRODUCT, and DISTRICT.
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Each district only sells certain products and never has data for other
products. The following report shows the values in the SALES variable.

                  ---------------------SALES------------------

                   JAN98      FEB98      MAR98      APR98      MAY98     JUN98
              ---------- ---------- ---------- ---------- ---------- ---------
BOSTON:
  COFFEE       31,462.80  58,343.75  54,158.84  45,459.55  63,727.98  52,232.05
  SUGAR        45,633.38  66,960.37  51,201.41  41,119.10  66,985.30  34,103.41
  GRITS               NA         NA         NA         NA         NA       NA
  GRANOLA      38,353.49  44,890.01  32,705.20  59,889.76  26,695.59  25,807.17

ATLANTA:
  COFFEE       62,373.42  37,698.17  39,944.58  42,854.71  31,815.47  26,659.09
  SUGAR               NA         NA         NA         NA         NA        NA
  GRITS        55,075.33  64,352.74  36,571.66  31,048.07  28,430.80  69,612.45
  GRANOLA             NA         NA         NA         NA         NA        NA

CHICAGO:
  COFFEE       28,302.61  31,301.34  53,122.95  32,510.59  50,884.83  33,123.26
  SUGAR        43,460.88  22,743.96  45,991.54  39,841.34  25,657.83  50,375.86
  GRITS               NA         NA         NA         NA         NA         NA
  GRANOLA             NA         NA         NA         NA         NA         NA

Example: Defining a conjoint dimension to handle sparsity

To eliminate the NA values and make the data variable smaller, you can
define a conjoint dimension whose values are combinations of the values of
the PRODUCT and DISTRICT dimensions.

For example, define a conjoint dimension named PRODDIST that is
dimensioned by PRODUCT and DISTRICT. You then add combinations of
values to PRODDIST by using Express commands.

Example: Maintaining a conjoint dimension

You maintain the new dimension by adding only those combinations of
product and district values that have data. If you use the MAINTAIN
command, enclose each combination in angle brackets. In this example,
there are only seven combinations that have data.

maintain proddist add <'COFFEE' 'BOSTON'>
<'COFFEE' 'ATLANTA'> <'COFFEE' 'CHICAGO'>
<'SUGAR' 'BOSTON'> <'SUGAR' 'CHICAGO'>
<'GRITS' 'ATLANTA'> <'GRANOLA' 'BOSTON'>
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Example: Defining a variable dimensioned by the conjoint

Now you can define a variable that is dimensioned by PRODDIST for the
sales data. Because a conjoint dimension is automatically related to its
component dimensions, a single assignment statement transfers the non-NA
data to the new variable.

define sales2 variable decimal <month proddist>
sales2 = sales
delete sales
rename sales2 sales

After you assign the values from the original variable to the new one, you
can delete the original variable. You can rename the new variable to the
name of the original variable, if you wish to keep the old name. In the
example above, SALES was converted to SALES2, which has more than 40
percent fewer cells. The original variable, SALES, was deleted, and the
new variable, SALES2, was renamed SALES.

Example: Adding dimension values

You need to build the combinations to be added to the conjoint dimension.
You can use the FILEREAD command to read data from the input file and
add values to the base dimensions and the conjoint dimension.

If you have an input file with product names beginning in column one and
district names beginning in column nine, you can add new values to the
PRODUCT, DISTRICT, and PRODDIST dimensions with the following
FILEREAD command. New values are added first to the base dimensions,
then the combination is added to the conjoint dimension.

fileread unit append proddist = <w 8 append product, w 8 append district>

If the base dimension values already exist, use the following command
instead.

fileread unit append proddist = <w 8 match product, w 8 match district>
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Converting Conjoint Dimensions to
Composites
Why you should convert conjoint dimensions

If you have used a version of Express prior to Express Server 6 or Personal
Express 6, you may have already created conjoint dimensions. You may
want to convert them to composites to take advantage of the ease of use
that composites provide.

Prerequisites for converting

You can convert a conjoint dimension to a named composite. However,
there are several restrictions:

� If an Express object (such as a program or relation) returns a conjoint
dimension value, then you cannot convert that conjoint dimension to a
composite. For example, if your database contains a program whose
return value is a conjoint dimension value, you cannot convert that
conjoint dimension to a composite.

� You cannot convert a NOHASH conjoint dimension. You can,
however, use the CHGDFN command to change the conjoint dimension
to BTREE or HASH, and then you can convert it to a composite.

� If the definition of the conjoint dimension contains both a dimension
and a second conjoint dimension that contains the same dimension in its
definition, then you cannot convert the first conjoint dimension. For
example, suppose the definition of a conjoint dimension named
MYDIM contains a dimension named MONTH and a conjoint
dimension named YOURDIM. The definition of the conjoint dimension
YOURDIM contains the same MONTH dimension. Therefore,
MONTH appears twice in the definition of MYDIM, so MYDIM
cannot be converted to a composite.

� If there are permissions set on a conjoint dimension, then you cannot
convert it to a composite. You can remove the permissions, and then
convert the conjoint dimension to a composite. You can then set
permissions on the base dimensions of the composite, if you wish.
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� The conjoint dimension must have been defined with the DEFINE
command, not with Administrator.

Procedure: Converting a conjoint dimension to a composite

To convert a conjoint dimension to a named composite, use the
COMPOSITE keyword with the CHGDFN command. Use the following
syntax.

chgdfn conjoint-name COMPOSITE

Conjoint-name is the name of the existing conjoint dimension. The
COMPOSITE keyword specifies that you are converting a conjoint
dimension to a composite.

The name of the composite

When you convert a conjoint dimension to a composite, the conjoint name
becomes the name of the composite. In other words, when a conjoint is
converted to a composite, it keeps its name.

Related information

See the entry for CHGDFN in the Express language Help or Reference
Manual for more information about using CHGDFN.

Converting Composites to Conjoint
Dimensions
Overview

If you are willing to take the extra steps to maintain conjoint dimensions in
exchange for finer control, then you can convert composites to conjoint
dimensions. You can convert either a named composite or an unnamed
composite to a conjoint dimension. There are no prerequisites; you can
convert any existing composite to a conjoint dimension.
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If you use the Express Command Window to enter the commands required
for conversion, be sure to close the database then reopen it after the
conversion so that the changes you make at the command level will be
displayed in Administrator.

Procedure: Converting a named composite to a conjoint dimension

To convert a named composite to a conjoint dimension, use the
DIMENSION keyword with the CHGDFN command. Use the following
syntax.

chgdfn composite-name DIMENSION

Composite-name is the name of the existing composite. The DIMENSION
keyword specifies that you are converting a named composite to a conjoint
dimension.

When you convert a composite to a conjoint dimension, it keeps its name.
The composite name becomes the conjoint dimension name.

Procedure: Converting an unnamed composite to a conjoint dimension

Use the following procedure to convert an unnamed composite to a conjoint
dimension.

Step Action

1 Use the RENAME command to change the unnamed composite into a
named composite.

2 Use the CHGDFN command to change the named composite into a conjoint
dimension.

Example: Changing an unnamed composite to a named composite

Suppose an unnamed composite exists in a sparse variable definition as
“sparse<product district>.” To change this unnamed composite to a
composite named PRODDIST, use the following command.

rename sparse<product district> proddist
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Example: Changing a named composite to a conjoint dimension

Suppose you have a composite named PRODDIST. Use the following
command to change PRODDIST into a conjoint dimension.

chgdfn proddist DIMENSION



415

Appendix C

Upgrading from Express 5

Overview
Introduction

This appendix describes how to update Express 5 databases to Express 6.

In this appendix

� Upgrading Express 5 Databases to Express 6

� What to Do After the Upgrade

Upgrading Express 5 Databases to
Express 6
Overview

If you are a previous user of Express, you can upgrade your existing
Express 5 (or earlier) databases to Express 6.

This appendix describes upgrading with the following configurations:

� An Express Client product connected directly to Express Server 5 using
Remote SNAPI.

� An Express Client product connected to Personal Express 5 only, either
on a local PC or a local area network (LAN).
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� An Express Client product connected to Personal Express 5
communicating with Express Server 5 on a remote machine via Express
Communication Architecture (XCA).

The upgrade process

There are two basic parts to the process of upgrading Express 5 databases
to Express 6. The first part of the process is to upgrade the Express 5
XPDDDATA database. The second part is to upgrade the Express 5 user
databases.

Important: Upgrade the Express 5 XPDDDATA database first

You must upgrade the Express 5 XPDDDATA database before you
upgrade any other databases.

Procedure: Upgrading the Express 5 XPDDDATA database

The following procedure explains how to upgrade the Express 5
XPDDDATA database, and shows examples of the appropriate Express
commands (where applicable).

Step Action

1 Start Express 5.

2 Attach the Express 5 version of the XPDDDATA database as read-only.

dtb attach XPDDDATA.DB ro

3 Export the contents of the Express 5 XPDDDATA database to an EIF file.

export all to eif file ' filepath /xpdddata.eif'

4 Detach the Express 5 XPDDDATA database.

dtb detach XPDDDATA.DB

5 Make a backup copy of the Express 6.2 XPDDDATA.DB file (for example,
XPDDDATA.BAK) using the file management procedures that are applicable
for your operating system.

6 Start Administrator 6.2.

7 Open the Express Command Window in Administrator 6.2, and perform
Steps 8 through 15 using the Express Command Window.
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Step Action

8 Generate a database list, and note the path information for the Express 6.2
XPDDDATA database file (XPDDDATA.DB).

dtb list

9 Detach the Express 6.2 XPDDDATA database, which Administrator has
automatically attached.

dtb detach XPDDDATA.DB

10 Attach the Express 6.2 XPDDDATA database as read/write, making sure to
use the file identified by the path information that you obtained in Step 8.

dtb attach pathname \XPDDDATA.DB rw

11 Import the data from the xpdddata.eif file, which contains the Express 5
data, into the XPDDDATA database.

import all from eif file ' filepath /xpdddata.eif'

12 Compile the objects in the XPDDDATA database.

allcompile 1

13 Update the XPDDDATA database.

update

14 Detach the XPDDDATA database.

dtb detach XPDDDATA.DB

15 Attach the updated XPDDDATA database as read-only.

dtb attach XPDDDATA.DB ro

Procedure: Upgrading Express 5 user databases

The following procedure explains how to upgrade Express 5 user databases,
and shows examples of the appropriate Express commands (where
applicable).

Step Action

1 In Express 5, attach (as read-only) a database that you want to upgrade.

dtb attach dbname.db ro

2 Export the data from the Express 5 database to an EIF file.

export all to eif file ' filepath / dbname.eif'

3 Detach the database.

dtb detach dbname.db
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Step Action

4 Rename the database file (for example, dbname.old) to create a backup
copy, using the file management procedures that are applicable for your
operating system.

5 Open the Express Command Window in Administrator 6.2 and perform
Steps 6 through 11 using the Express Command Window.

6 Create a new database file.

dtb create attach dbname.db

Note:  The name of the new file must be the same as the name of the
Express 5 database file that you are upgrading.

7 Set the size by which Express will extend the database component files to
512 K.

dtb extendsize 512K

8 Import the data from the EIF file that contains the Express 5 data into the
new database.

import all from eif file ' filepath/dbname .eif'

9 Compile the objects in the database.

allcompile 1

10 Update the database.

update

11 Detach the database.

dtb detach dbname.db

12 Choose Open  from the File menu and open the database that you have just
created. This constructs the necessary metadata.

13 Choose Save All  from the File menu to save the database and metadata.

14 Choose Close  from the File menu and close the database.

15 Repeat the Steps 1 through 14 for any additional databases that you want to
upgrade.

What to Do After the Upgrade
Ensuring connections for Administrator and client applications

When you move databases (such as XPDDDATA.DB) to the machine on
which Personal Express 6 or Express Server 6 is installed, you can put the
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databases in the directory of your choice. Then, you should use
Configuration Manager to add that directory to the ServerDBPath
configuration setting on the Personal Express 6 machine, or ask your
system administrator to add that directory to the ServerDBPath
configuration setting on the Express Server 6 machine. See Chapter 3 for
information about the steps you take to ensure that Administrator and any
client applications can connect to Express Server or Personal Express 6 and
can locate databases.

Other considerations

When you “upgrade” an existing Express database to Express 6, you are
merely moving it to a new server. You can then take additional steps to take
full advantage of the new features that Express 6 provides.

� You may want to convert your conjoint dimensions to composites so
that Express automatically maintains them. Chapter 13 describes
composites in detail. Appendix B describes the procedure for
converting conjoint dimensions to composites and vice versa.

� Many of the commands in Express 5 are now obsolete. If your Express
5 database has any programs or models, be sure to check the list of
commands that are not supported in Express 6. It is a good idea to
compile every program and model after you import your database into
Express 6; if your program or model contains obsolete commands,
check the error messages that are displayed when you try to compile to
find out which commands are no longer supported. See the appendix in
the Express Language Programming Guide for the list of these
commands.

� You may also want to take advantage of the easier way to create and
manage hierarchical dimensions that Administrator provides, as
described earlier in Chapter 7.
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Appendix D

New Features

Overview
Introduction

This appendix describes new features in Oracle Express Administrator 6.2.

In this appendix

� Database Wizard

� Rollup Wizard

� Hierarchy Editor

� Edit Window

� Express Command Window

� Task Scheduler and Monitor

� Database Search Options

� Database Browser Options

� Selector

� Context Sensitive Right Mouse Menu

� Import from Discoverer Files
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Database Wizard
Overview

The Database Wizard provides a simplified, step-by-step method that
guides you through the process of creating Express databases and loading
data from ASCII files. The Wizard prompts you for information regarding
the location and layout of data files, and any associated files containing
hierarchy information. After collecting this information, the Database
Wizard can automatically create the Express database and load it with data,
or the data load can be scheduled for a later time. The Database Wizard can
also be used to modify existing Express databases.
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Figure: The Database Wizard

The following figure shows the Database Wizard Introduction screen.

What the Database Wizard allows you to do

Using the Database Wizard, you can define the dimensions, variables, and
hierarchies for an Express database. You can include descriptive text labels
for the values in dimensions, create new “parent” levels for hierarchies that
do not currently have a single top-level value, specify the description for a
hierarchy and for the levels in the hierarchy, specify the order of
dimensions, and define dimensions as dense or sparse when defining new
variables.

Related information

For detailed information about using the Database Wizard, see Chapter 6.
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Rollup Wizard
Overview

The Rollup Wizard provides a simplified step-by-step method that guides
you through the process of rolling up your data to summarized levels within
dimension hierarchies.

What the Rollup Wizard allows you to do

Using the Rollup Wizard, you have the option to roll up all data within an
Express database or to select only specific portions of data to roll up. This
flexibility allows you to reaggregate only those variables that have been
modified, rather than reaggregating the entire database. Once the rollup
program is created, you can execute it immediately or schedule it for a later
time. Rollup programs are saved within the Express database, so they can
be reused quickly and easily.
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Figure: Rollup Wizard

The following figure shows the Rollup Wizard Introduction screen.

Related information

For detailed information about rolling up data, see Chapter 10.

Hierarchy Editor
Overview

The Edit Dimension Values dialog box (the hierarchy editor) provides you
with a tool to add dimension values, organize dimension values into
hierarchies, and modify existing hierarchies.
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What the hierarchy editor allows you to do

After you define a dimension, you must provide values for it — you cannot
add data to a variable or other measure until its dimensions have values.
You can add values to a dimension by importing data from an external
source or by typing in the values manually. The hierarchy editor allows you
to add values to a dimension and organize those values into a hierarchy.
The display of hierarchy information can be customized—you can choose
to display dimension values, short labels, or long labels. In the hierarchy
editor, you can rename hierarchies and hierarchy levels, delete hierarchies,
copy a hierarchy, modify the structure of a hierarchy, specify which
hierarchy is the default, and add a hierarchy to a dimension.

Figure: Hierarchy editor

The following figure shows the hierarchy editor with an open hierarchy.

Related information

For information about how to use the hierarchy editor, see Chapter 7.
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Edit Window
Overview

The Edit window provides you with a tool to enter or revise the content of a
program or model. When you invoke the Edit window, the Edit menu bar
replaces the Main menu bar in the main window. You can use the Edit
window toolbar to access the frequently used features of the Edit window.

What the Edit window allows you to do

Express Administrator provides a powerful 4GL editor to create or modify
Express programs and models. The editor supports search and replace
functionality, as well as printing. The 4GL editor also provides context-
sensitive Help, which allows you to highlight any Express Stored Procedure
Language (SPL) command in your code and receive online Help, including
a definition, command syntax, and sample code. You can use the editor to
create you own custom 4GL code, or use it to view or print programs that
are automatically generated by the Express Administrator wizards.
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Figure: Edit window

The following figure shows an Edit window that contains an Express
program.

Related information

For information about using the Edit window to edit Express programs, see
Chapter 12.

Express Command Window
Overview

The Express Command window provides you with a tool for executing
most Express commands from Administrator.

What the Express Command window allows you to do

The Express Command window lets you enter one Express command in the
Command box. You can change the Command box from a single-command
editor to a multiple-command editor. The Command Log box displays a list
of all the commands that have been executed. You can execute commands
from either the Command box or the Command Log box. The Express
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Command window uses a Clipboard that allows you to copy text from
another source and paste it into the Command box or copy text from the
Command box and paste it into another application.

Figure: The Express Command window

The following figure shows the Express Command window.

Related information

For detailed information about using the Express Command window to
execute Express commands, see Chapter 12.

Task Scheduler and Monitor
Overview

The task scheduler allows you to schedule batch jobs via a graphical
interface. The task monitor tracks the status of jobs that have been
submitted to the task scheduler.
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What the task scheduler and monitor allow you to do

You can specify a particular time to run a job, as well as set job
dependencies such as run a job only after a previously scheduled job is
completed. You can also schedule jobs to run on an hourly, daily, weekly,
or monthly recurring basis. Through the monitor, you can display the name,
creator, status, and type of all scheduled jobs. The task monitor allows you
to stop, suspend, restart, delete, or view the log of any scheduled jobs.

Figure: Task scheduler

The following figure shows the task scheduler.

Related information

For detailed information about using the task scheduler and monitor to
schedule and monitor programs, see Chapter 14.
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Database Search Options
Overview

The Filter Database Objects dialog box provides you with a tool to search
for database objects in one or more databases.

What the Filter Database Objects dialog box allows you to do

If you are working with one or more databases that contain many objects,
you might lose track of particular objects. The Filter Database Objects
dialog box allows you to search for those objects using any of the following
criteria:

� Whether the object is dimensioned by a certain object

� What the object’s type is (dimension, variable, and so on)

� What the object’s data type is (Decimal, Text, and so on)

� Whether the object’s name contains certain characters

� Whether the object is referenced by another object
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Figure: Filter Database Objects dialog box

The following figure shows the Filter Database Objects dialog box.

Related information

For information on searching for database objects, see Chapter 4.

Database Browser Options
Overview

The Database Browser displays the names of the currently open databases
and their objects.

What the Database Browser options allow you to do

You can display the Database Browser in one of two states. It can show all
database objects or the results of database filtering that you perform with
the Filter Database Objects dialog box.
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Figure: Database Browser

The following figure shows the Database Browser displaying objects in the
Express XADEMO database.

Related information

For more detailed information about the Database Browser, see Chapter 4.
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Selector
Overview

The Selector is a set of tools that you use to create a saved selection for a
dimension and to limit the data that is displayed on the Data tab of the
Modify Formula, Modify Relation, and Modify Variable dialog boxes.

What the Selector allows you to do

The Selector tools allow you to select a set of dimension values without
having to enter commands at the Express Command window. The
following table shows each tool and its function.

Button Function

All tool — Selects or deselects all values of a dimension or dimension
hierarchy

List tool — Selects or deselects values from the list of values in a
dimension

Match tool — Selects dimension values that contain a specified string of
characters

Level tool — Selects or deselects dimension values at one or more levels
of a hierarchy

Family tool — Selects or deselects dimension values based on a family
relationship with a particular dimension value

Attribute tool — Selects or deselects a group of dimension values that
have a common attribute such as color or size

Exception tool — Selects or deselects dimension values based on a
comparison of measure values to another value or values

Top/Bottom tool — Selects or deselects the largest or smallest data values
in a given measure

Range tool — Selects or deselects a range of time periods

Saved Selection tool — Selects or deselects dimension values in a saved
selection

Sort tool — Sorts dimension values using criteria that you specify
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Figure: Selector

The following figure shows the Selector for the Budget variable in the
XADEMO database.

Related information

For more information about using the Selector, see Chapter 4.

Context Sensitive Right Mouse Menu
Overview

The right mouse button popup menu is context sensitive. It includes
different items depending on whether you select an item in the Database
Browser, or place the cursor in the application window outside the
Database Browser.
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Import from Discoverer Files
Overview

You can now import data that has been exported from a Discoverer session.
This feature, used in conjunction with the Discoverer integration provided
in Oracle Express Objects 2.2, allows you to transfer data between Express
and Discoverer, in either direction.  This feature is only available with
Discoverer 3.1.
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CHGDFN command
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closing databases, 190
code databases

defined, 381
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Compiled property, 248
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assigning names to unnamed, 299
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412

defined, 25
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defining single-dimension, 291
how to delete base dimension
values, 313

how variables can share, 287
limit on number of values, 285
limiting base dimensions, 315
named, 293
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defined, 47
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overview of ways to add, 35
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Data Dictionary

defined, 27
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data loader
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data slice, 5
data storage, 22
Data Type property, 238
data variables, 8
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efficiency, 327
ensuring good performance, 113
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maintenance, 227
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mapping data to Express objects,
97

organizing data, 98
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overview of adding data, 35
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password, 349
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upgrading an Express 5, 415
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DATABASE command, opening a
database with permission, 349, 359
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Database Wizard
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backup, 330
closing, 190
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converting, 191
creating security applications for,
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multifile, 332
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opening automatically, 195
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saving disk space, 326
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order, 18

Dimensioned By property
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DimensionType property, 239
disconnecting from Express, 63
Discoverer database, importing data

from, 213
domain authentication, when

connecting to Express, 60
Drill Direction property, 239
drilling, 74

E
Edit Window, 262
editing

programs, 262
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EIF files
exporting data, 222
importing data, 211

embedded-total dimensions
described, 16

errors, fixing compilation, 265
evaluating expressions

changing the default behavior, 306
default behavior, 305

executing Express commands, 256
executing programs, 266
exporting data

status, 222
to EIF files, 222

Express
default connection, 50
disconnecting, 63
performance tips, 341
prompting at startup, 50
running without, 62

Express 5 database
upgrading to Express 6, 415

Express Command Window, 256,
257

Express commands
=, 304
ALLSTAT, 270
CHGDFN SEGWIDTH, 308
CHGDFN with COMPOSITE
keyword, 412

CHGDFN with DIMENSION
keyword, 413

DEFINE COMPOSITE, 299
executing, 256
FILEREAD, 307
MAINTAIN, 313
REPORT, 315
ROLLUP, 172
STATUS, 273

Express data
exporting, 222
importing, 211

Express Server
memory usage, 330
running on same machine as
Administrator, 57

expressions, defined, 25
Extendsize property, 189
extension files, of multifile databases,

333

F
fastest varying dimension, 279
FILEREAD command, 307

maintaining conjoint dimensions,
410

files
Administrator INI, 61
client application INI, 61
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database, needed by Administrator,
46

multifile databases, 332
ruled, 205
structured, 205
supporting database, 57
XPDDDATA.DB, 29

Filesize property, 189
finding database objects, 82
foreign keys, 7
FormatFormula property, 249
formulas

data-driven, 252
defined, 24
saving space in database files, 327
setting number format defaults, 252

H
Help

context-sensitive, 91
invoking, 90

hiding dimensions, 246
hierarchical dimensions

calculating the hierarchy, 162
depth, 18
embedded totals, 16
levels, 15
rolling up data for, 21
setting up, 159
using the ROLLUP command, 172
using the ROLLUP command with
multiple hierarchies, 173

using the Rollup Wizard, 171
hierarchies

copying, 179
creating additional, 178
deleting, 235

determining, 102
for use with Oracle Express Web
Agent, 158

modifying, 176
hierarchy data, importing, 215
host authentication

when connecting to Express, 60

I
importing data

from EIF files, 211
hierarchy data, 215

integrity, database, 22
IsAttribute property, 239, 249

L
language dimension

dangers of deleting values, 198
described, 197
providing name expressions, 240

Language Dimension property, 189
languages for databases, 197
LD property

dimension, 239
measure, 249

levels
described, 15

LIMIT command
described, 270
for valuesets, 182, 260

limiting access to data, 350
locating

application databases, 196
data databases, 195
database objects, 82

login temporary variables, 370
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LongLabelVar property, 239

M
main files, of multifile databases, 332
main menu bar, 70
main window, 68
MAINTAIN command, 313
maintaining hierarchies, 176
master database, 381
MDBSource property, 239, 249
Measure Dependency property, 249
measures

defined, 24
property list, 248
setting number format defaults, 252
setting properties, 248

memory
conserving, 330
efficient use of, 330

menus, 70
metadata

defined, 158
prefixes, 216

models, defined, 25
modifying hierarchies, 176
monitoring batch jobs, 228, 341
multidimensional data model, 8
multifile database, 333

N
NA values, 326
name expression properties for

dimensions, 240
Name property, 239
named composites

changing to unnamed, 300

converting to conjoint dimensions,
413

creating, 293
defined, 293
getting a list of, 301
getting information about, 301

number format
defaults, 252
setting default, 254
using defaults, 254

O
OBJ function

using to find information about
named composites, 301

using to find the parent relation,
172

objects
database, 10
database, defining, 156

ObjectType property
dimension, 239
measure, 249

OCI, which versions of Express use,
364

ODBC data source, setting up for
SQL reach-through, 365

ODBC driver, required compliance
levels for Administrator, 365

OLAP, 7
OLTP, 7
opening databases, 186
options, 75
order of dimension values, 18
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P
pages, units of storage, 323
paging behavior, adjusting, 342
parent relation, 17, 23
password, database, 349
PathName property, 189
pattern of sparsity, 287
performance

considerations, 113
identifying poor, 320
object definition affects, 325
of loading and accessing data, 308
overview of strategies, 37
preventing file fragmentation, 344

permission
assigning to a dimension, 357
assigning to a dimensioned
variable, 353

assigning to an object definition,
350

creating for a database, 349
establishing permission conditions,
351

limiting access to data, 350
PERMIT command, 350
PERMIT_READ and

PERMIT_WRITE programs, 349,
359

pointers, mouse, 91
popup menus, 90
Post-Attach Program property, 189
Post-Detach Program property, 189
Pre-Attach Program property, 189
Pre-Detach Program property, 189
primary keys, 7
programs

compiling, 265
debugging, 267

defined, 25, 262
editing, 262
executing, 266
fixing compilation errors, 265
how to define, 262
run at the client application
shutdown, 200, 267

scheduling, 228, 340
SQL data loader, 210
when to regenerate, 234, 235

prompting for Express, 50
properties

database, 188
defined, 87
dimension, 238
measure, 248
name, 251
setting for dimensions, 241

Property Inspector
Advanced tab, 89
closing, 89
described, 87
displaying, 88
setting properties, 241

Q
QDR, 370
qualified data reference, See QDR

R
random sparsity, 283
ReadOnly property, 189
rebuilding databases, 328
Registry, 199
Relational Access Administrator,

starting from Administrator, 385
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relational database
connecting to non-Oracle, 367
connecting to Oracle, 367
fetching data from, 368
how Administrator connects, 364
how Express connects to a non-
Oracle, 364

how Express connects to an Oracle,
364

importing data from, 209
setting up an ODBC data source,
365

relational databases, accessing, 380
relations, defined, 23
RENAME command, 300
renaming database objects, 232
REPORT command, 315
roll up

defined, 20
maintaining programs, 227
overview, 36, 221
partial, 230
starting the Rollup Wizard, 222
when to regenerate programs, 234,
235

ROLLUP command
for sparse variables, 317
rolling up data, 172

ruled files, defined, 205

S
saved selections, See selections
saving a database in multiple files,

332
scheduling programs, 228
scoping, with the PERMIT command,

350

searching for database objects, 82
security options in connecting to

Express, 59
security, overview, 39
segment, 336
segment width of variables, 309
segments

optimal number of, 337
specifying size of, 337

selections
dynamic type, 242
overview, 242
static type, 242

Selector dialog box, 84
server connections, security options,

59
setting properties

for databases, 188
for dimensions, 241

ShortLabelVar property, 239
ShortName property

dimension, 239
measure, 249, 251

ShortNameExp property
dimension, 239
measure, 249, 251

ShortNamePlural property, 239
ShortNamePluralExp property, 239
siblings, 18
slice of data, 5
slowest varying dimension, 279
source expression, 304
Sparse Dimensions property, 249
sparse variables

assigning data to, 303
creating a, 284
defined, 284
rolling up data, 317
selecting values, 315
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sparsity
controlled, 279
of data, 279
pattern, 287
random, 283

SQL data, importing, 209
SQL databases, connecting to, 364,

368
SQL reach-through, setting up an

ODBC data source, 365
SQL,defined, 7
starting Administrator, 34, 68
status bar, 91
STATUS command, 273
status of dimensions, defined, 268
StorageType property, 249
structured files, defined, 205
support files required for connecting,

46
system shutdown program, 76

T
target variable, 304
temporary variables, 326
text data, importing, 205
time dimensions, data types, 13
toolbar, 71
toolbar, customizing, 80
toolbar, options, 79

U
unnamed composites

converting to conjoint dimensions,
413

naming, 299
upgrading an Express 5 database, 415

User Data property, 189
UserVisible property

dimension, 240
measure, 250

V
values

dimension, 15
dimension, adding, 159
dimension, adding to a dimension
hierarchy, 162

dimension, adding to dimension
list, 161

valuesets
defined, 26
editing, 183, 261
how to define, 182, 260

variables
data, 8
defined, 22
determining segment size, 308
editing, 168
entering data in a, 168
how stored, 323
saving data from a formula, 325
setting number format defaults, 252
sparse, 284
sparse data, 279
target, 304
temporary, 326
temporary for login, 370
that share composites, 287

varying dimensions, 279

W
Width property, 240, 250
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WIN.INI file, 199
worksheets, 26

X
XPDDDATA.DB, 29
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